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About This Book 

This book covers the applications found on the unit - including 
those by both Palm Computing and GeoWorks. 

The first chapter covers basic topics that apply to all of the 
applications covered in this book; the second chapter covers the 
Palm applications (PalmAddress, PalmSchedule, PalmNotes, and 
World Clock); and the third chapter covers general topics pertinent 
to all the Geo Works applications. If you have never used a GEOS 
application before, you should look in these chapters. 

The rest of the book is devoted to the details of using the 
following applications: 

• Calculator. An on-screen calculator. 

• Text File Editor. An application for editing DOS text files. 

• Scrapbook. An electronic scrapbook for storing pictures and 
text. 

• Preferences. An application that allows you to customize the 
unit. 

• GeoComm. A telecommunications application. 

• GeoWrite. A What-You-See-Is-What-You-Get word processor. 

• GeoCalc. A powerful spreadsheet with built-in charting. 

• GeoFile. A flat-file database with powerful page layout 
features. 

• GeoManager. An easy-to-use file and folder manager. 
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TYPOGRAPHICAL CONVENTIONS USED IN THIS BOOK 

The following printing conventions are used throughout this book: 

• Italic type is used to introduce a new term. 

• Boldface is used for the names of keys on the keyboard, such 
as Enter or Insert. 

• When you see two key names with a + symbol between them, 
press both keys at the same time. For example, when you see 
Ctrl+Esc, you should hold down the Ctrl key while you press 
the Esc key. 

CONVENTIONS FOR PROCEDURES 

II ABOUT THIS BOOK 

Procedures are step-by-step instructions that tell you how to 
perform tasks in applications. Procedures in this book always have 
an italic heading beginning with the word "to." Each step in a 
procedure first has you perform an action, which is followed by an 
explanation of the application's reaction. When you can do a task 
in more than one way, you will see the word "or" on its own line, 
and then an alternate method of completing the step. 

Some procedures consist of one step, while others have multiple 
steps. 

Single-Step Procedures 

Single-step procedures have a square, black bullet C•) beside the 
instruction telling you what to do. The following example shows a 
single-step procedure with two alternative ways to do the task. 

To start Geo Write (All Levels) 

• Locate the GeoWrite icon and double-tap it. 

or 

Choose GeoWrite from the Express menu. 

Multi-Step Procedures 

Multi-step procedures have sequentially numbered steps that you 
should follow in a specific order. The following example shows 
three steps from a multi-step procedure. 



To select a day and view its events (All Levels) 

1. If the Calendar window isn't showing, choose Calendar from the 
View menu. The Calendar window appears. 

2. Tap to select a day in the Calendar window. The day highlights. 

3. The events for the selected day appear in the Events window. If 
the Events window isn't showing, choose Events from the View 
menu. The Events window appears. 

USER LEVEL NOTATION 

ALL LEVELS 

Every procedure head is followed by a parenthetical note 
specifying at which user levels the task can normally be 
accomplished. The following are two examples of procedures 
found in this book: 

To start Geo Write (All Levels) 

To show empty days (Level 3) 

In addition, sections are marked with text similar to the one shown 
in the margin at left. This text, because it says "All Levels," 
indicates that the section applies to all levels in the application. If it 
had said "Level 2," it would indicate that the section only applied 
to Level 2 of the application. 

For more information about user levels in applications, see "About 
User Levels" in Chapter 3. 
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Using the Touch Pen 

1.2 GETTING STARTED 

The touch pen is the tool you use to start applications and perform 
most of your work within applications. The pen allows you to 
point to items on the screen and perform actions on those items. It 
also allows you to write or draw directly on the screen. You can 
choose to have the unit recognize your writing as text and 
translate it into typewritten characters. This is called handwriting 
recognition. Handwriting recognition is described in this chapter. 

Here are some basic pen actions you will use as you work with 
applications: 

Tap. Touch the pen to the screen and then lift it off. Tap when 
you want to select an application, icon, menu, or command. You 
can cancel a selection by tapping elsewhere on the screen. 

Double-tap. Tap the pen twice. Double-tap to open an 
application, or to select a word of text. 

Drag. Touch the pen to the screen, then keep the pen on the 
screen as you move the pen. Drag to select text, an area on a 
sketch page, or icons in GeoManager. To select text, touch the pen 
to the text and hold it down for a second or two. Then move the 
pen across the text, lifting the pen off the screen at the end of the 
selection. To select an area on a sketch page, drag the pen 
diagonally on the screen to form a rectangular selection box. 

Handwriting recognition. Using the pen, print characters 
directly on the screen. As soon as you print a character, the unit 
converts it to a typed character. 



HANDWRITING RECOGNITION 

Use handwriting recognition when you want to store and display 
what you print as typed characters. 

I 
A• 

Tap the Text tool to tell the unit to 
recognize your printing, then print with the 
pen. Your ink is converted to text. 

Ect1t F1elct 

x ~ OK I Cancel I 
•Fax -lfll 

555-22221 F--" 

~ 
[1] 

NOTE 

If you are using Palm applications, you can use the Powerlnk 
feature when you want to write or draw with the pen and you want 
to keep what you enter as you have written it, rather than as typed 
characters. 

Handwriting Recognition Tips 

The unit recognizes handwritten, printed letters and numbers. You 
can enter hand-printed characters in text fields or on a sketch 
page. When you use hand-printed characters in a field or on a 
sketch page while the Text tool is active, your hand-printed 
characters are converted into typed characters. 

The following tips will help the unit to recognize your 
handwriting: 

• Print each letter or number clearly. Each character needs to be 
clear enough to be recognized. You can use uppercase ot 

lowercase letters. 

• Keep your letters upright. Try not to write letters with a slant. 

• Use as few strokes as possible in writing a letter. 

USING THE TOUCH PEN 1.3 



• Make sure you keep the pen on the screen as you write - you 
don't need to press down hard, but you don't want to hold the 
pen so lightly that it doesn't make solid contact with the screen. 

• Don't write too slowly. 

• Print large characters. You can use the whole screen as long as 
you begin writing in the dialog box. 

• If the position in which the ink appears on the screen doesn't 
match the position of the pen, you need to recalibrate the pen. 

• To write several words, write one below another so that the 
unit inserts spaces between the words correctly. 

• Write the letter Z with a slash through it to distinguish it from 
the number 2. 

• Write the letter 5 in two strokes instead of one to distinguish it 
from the letter S. 

• Write the number 0 in two strokes with a slash through it to 
distinguish it from the letter 0. 

• Write the number 1 with a line across the bottom (it should look 
like an upside-down 1) to distinguish it from other characters 
such as an I or L. 

• Write the letter l like a script 1 (it should look like a loop) to 
distinguish it from other characters such as the letter I or the 
number 1. 

• Dot a lowercase i to identify it as an i. 

USING THE FLOATING KEYBOARD 

1.4 GETTING STARTED 

The unit provides a floating keyboard that appears to "float" on 
top of an application window. You use the floating keyboard just 
as you would any other keyboard, except that you tap the keys 
with the pen. 



You cannot use 
keyboard 
accelerators or 
mnemonics from the 
floating keyboard. 

Displaying and Using the Floating Keyboard 

To display the floating keyboard, tap the floating keyboard hard 
icon. The keyboard also appears automatically when an 
application or dialog box requires text entry. 

Tap the Exit icon to 
hide the keyboard. 

Tap here to switch to 
a different keyboard. 

Tap the keys to enter text. 

NOTE 

If the keyboard appears gray, you cannot use it to enter text. This 
occurs when you need to tap the pen in a text area to indicate 
where you want to enter the text, or when you are in Powerlnk 
mode (in which handwriting is not converted to text). 

Switching Keyboards 

In Preferences (see Chapter 4), you can select the language of the 
keyboard you want to use. Also, within any language, you can 
choose from six different keyboard layouts. 

When the keyboard is available (not dimmed), you can switch to 
another keyboard layout. Tap the upper right corner of the 
keyboard to select from a drop-down list of layouts. The default 
layout is the Keyboard layout, which looks just like a standard 
keyboard. 

These are the available keyboards: 

Keyboard. Provides the standard qwerty (typewriter-like) 
keyboard in the current language set in Preferences. 

Alphabetic. Displays the letters of the alphabet in alphabetical 
order, starting at the top left of the keyboard. 

Symbols. Provides common symbols such as the bullet, copyright, 
percent, dollar sign, and so on. 

International Provides characters with accents, umlauts, tildes, 
and so on. 
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Math Symbols. Provides numbers and mathematical symbols 
such as plus, minus, equals, square root, and so on. 

Writing Grid. Gives you the ability to convert each character you 
write into letters on the screen. 

USING THE WRITING GRID 

1.6 GETTING STARTED 

When you select the writing grid keyboard, you write each 
character in a box and the unit converts it into a letter on the 
screen. Blank boxes between letters translate as spaces between 
typed letters or words. 

You use the arrow controls to display boxes for additional 
characters and to move along the writing grid. 

Tap this control to move to the beginning of the boxes. 

Tap this control to move the boxes back one screen. 

Tap this control to move back one box. 

Tap this control to move forward one box. 

Tap this control to move forward one screen. 

Tap this control to move to the end of the boxes. 

Tap this button to go into insert mode. The box will darken in insert 
mode. Tap it again to get out of insert mode. The characters you type in 
insert mode will insert a character in front of the character you write on 
top of. When you are not in insert mode, the characters you type will 
write over existing characters. 

Understanding Pen Gestures 

When you write or edit with the pen, certain gestures have special 
meanings. The following table explains these gestures. 



To DO THIS EXAMPbE 

Enter a space as Leave a space between 

spaoe t WO WO rd5 you're writing words as you write, or 
if using handwriting 
recognition, write a 
"space character" Cb 
with a slash through it). 

Select a word with Quickly tap the word 
the pen twice. seected!lll 

Select more than Hold down the pen 
one word (pause for a moment) more than one@MllMI 

and drag it across the 
words. 

Erase a selected Draw a vertical line up 
word or words through the selected delete a word'#l 

text and put a loop or 
pigtail at the end 
(called the pigtail 
gesture). 

Insert text within Tap the pen in the 
existing text desired location of the irlSerl a cha¢:1er °' text. Then write the 

character or word 
somewhere in the text 
field or screen. 

Insert text in a text Write the next 
field after existing characters; what you 

a.dd chara:ters to thel e n at 
text enter gets added at the 

end of existing text. 

Insert a new line Tap the pen in the 
desired location of the adj a new Ii ne __J 
line. Then write the 
new-line gesture. 

USING AN EXTERNAL KEYBOARD 

In addition to the floating keyboard, you can attach an IBM-XT 
compatible keyboard to the unit. The external keyboard is the only 
way you can enter data in the DOS environment. 

USING THE TOUCH PEN 1. 7 



Keyboard 
accelerators only 
work with an 
external keyboard. 

1.8 GETTING STARTED 

The external keyboard can work in conjunction with the floating 
keyboard. However, each keyboard works independently of the 
other when you enter special characters, such as bullets and em 
dashes. You enter these characters by using keystroke 
combinations, so you cannot enter the first keystroke from the 
external keyboard and the second keystroke from the floating 
keyboard. 

NOTE 

You will not be able to exit to DOS unless you have an external 
keyboard attached to the unit. 



Exploring the Basics 

The first application you see when you start the unit is 
GeoManager. Typically, the GeoManager window is always open, 
although it will close automatically whenever you start large 
applications such as GeoWrite or GeoFile. For more information 
about GeoManager, see Chapter 9. 

Maximize-Restore button Window Control button 

Express button Menu bar Minimize button 

Folder icons Title bar Help button 

Iree !!tlllties 

A 
Amerlco Onl... GeoCBlC Geocomm GeoFlle 

.. ~ ~ 00 
GeoWrite Pt1lmAddress PBlmNotes 

I 
ext F11e Edi... 

;_I, 
Connect-Disconnect button 

WORLD, DOCUMENT, and DOSROOM folder buttons 

I Drive buttons 

Application icons 
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Window Control button. This button opens the Window Control 
menu, a special menu for performing tasks such as closing, 
minimizing, or maximizing the window. Double-tap to close both 
the window and application. 

Express button. This button opens the Express menu, a special 
menu for quickly performing common operations. You can start an 
application, switch between applications, check your printing job, 
or exit directly to DOS. 

Title bar. This bar across the top of the window shows the names 
of the application and the currently opened document. 

Menu bar. This bar contains all the drop-down menus for the 
application. Tap one of the names to open the menu. 

Help button. This button opens the Online Help window. 

Minimize button. This button removes the window from the 
screen temporarily. The application appears as an icon at the 
bottom of the screen. Double-tap the icon to restore the window 
to its previous size and position. 

Maximize-Restore button. This button enlarges a window to fill 
the screen completely. When a window is full-size, it cannot be 
moved or resized. Tap it again to restore the window to its original 
size and position. 

Application icons. These represent GEOS and DOS applications. 
You can double-tap an application icon to start the application. 

Document icons. Each type of document has a unique icon. This 
icon usually contains the icon of the application used to create the 
document. If you double-tap the icon, the application starts and 
automatically opens the document. For more information, see 
"Opening and Closing Applications and Documents" in this 
chapter; also see Chapter 9. 

Folder icons. Folder icons in the folder window represent 
directories. The terms "folder" and "directory" are often used 
interchangeably, in much the same way as "file" and "document" 
are. To open a folder, double-tap its icon. 

Wastebasket. Drag items to the wastebasket to delete them. Items 
are immediately deleted and unretrievable. 

WARNING 

You cannot recover or retrieve items from the Wastebasket. When 
you place an item in the Wastebasket or use Delete, the item is 
permanently removed from the unit. Be careful to delete only those 
files you know you will not need later. You can set up warnings 



MENUS 

(through the Options menu) to appear before you delete or throw 
away an item. For more information, see Chapter 9. 

WORLD, DOCUMENT, and DOSROOM folder buttons. Tap 
these buttons to open their respective folders. You can also copy 
and move documents and folders to these folders by dragging their 
icons onto the appropriate button. For more information about 
these folders, see Chapter 9. 

Connect/Disconnect button. Tap this button to connect to or 
disconnect from a computer that is running GeoHost. The icon on 
the button changes depending on the connection status - it is a 
connect button when there is no connection, and a disconnect 
button when the unit is connected to another computer. For more 
information about connecting and transferring files to another 
computer, see Appendix C. 

An application menu, like a restaurant menu, contains a list of 
choices. When you select a choice from a menu, the application 
initiates a corresponding action. For example, to print a document, 
you choose Print from the File menu. 

This is an example of a typical menu: 

......... 
S~itch Document ... 

§ave 

f'.rint ... 

Ctrl S Menu choices 
Ctrl P 

F3 

Every GEOS application has its own set of menus. The names of all 
the menus appear on the menu bar. For example, you will see the 
following menu names in GeoCalc: 

• File 

• Edit 

• View 

• Options 

• Cell 

• Formula 

• Properties 
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-~ 
Eile 

Al 

16 
17 
18 .. 

Menu names Menu bar 

For.mula froper'ties 

You do not see the menu itself until you tap on the menu name. 
This is called opening a menu. 

Many GEOS applications share basic features such as opening, sav
ing, copying, and printing documents. Applications often have 
similar menus because shared features work the same way in each 
application. Almost every GEOS application has a File, Edit, View, 
and Options menu. Once you know how to use choices from 
these menus in one application, you know how to use them in 
other GEOS applications. 

When you open a menu, it appears on your screen so you can 
make selections from it. Menu choices that are not currently 
available appear dimmed; if you select a dimmed menu choice, 
nothing happens. For example, in GeoFile, the Cut, Copy, and 
Delete choices in the Edit menu are dimmed if you do not have 
anything selected . 

. -M 
CuJ 
\;·op~J 

.ea~·:1 t.(; 

'..JhiH D\~I 

Ctrl lml 

'..JhiH lns 

~elect All ctrl I 

To choose from a menu, tap the name of a menu on the menu bar 
and its menu appears. Tap the choice you want. As long as you 
select an undimmed choice, a corresponding action is initiated and 
the menu closes. 
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Selecting Menu Choices With Check Boxes 

Some menu choices can be turned either on or off. When one of 
these choices is turned on, a small button next to the choice is 
darkened. When a choice is turned off, the button is not darkened. 
There are two types of buttons that can appear in a menu: check 
boxes and radio buttons. Radio buttons come in groups of two or 
more, and only one button in the group can be on at any given 
time. Check boxes can come in any number, and any number can 
be on at a given time. For more about check boxes and radio 
buttons, see "Responding to a Dialog Box" in this chapter. 

Pinning Menus 

If you want to make several selections from the same menu, you 
can pin it to keep it from closing after you make the first choice. 
Pinning a menu is a lot like pinning a piece of paper to a wall. A 
pinned menu stays open until you close it. 

To pin and un-pin a menu 

1. Tap the menu name. The menu appears . 

2. To pin a menu, tap the pin icon. The menu changes to a window 
with a title bar and Window Control button. You can move the 
menu by dragging the title bar. 

3. To un-pin a menu, double-tap the Window Control button. 

THE EXPRESS MENU 

e 
.Qesk Accessories 
!1ain Applications 
Other 

Printer Control Panel ... 
Go to GeoManager 
];xii to DOS 

.. .. .. 

The Express menu is a special menu that lets you quickly start an 
application, switch between applications, check your printing, or 
exit directly to DOS. The Express menu works just like any other 
menu in GEOS. But to see it, instead of tapping a menu name, you 
tap the Express button, which is located in the upper left corner of 
the active window. Once the Express menu is open, you can then 
make your choice. 

Here are the items you have to choose from in the Express menu: 

Desk Accessories. This displays the names of any applications 
that you have put in the Desk Accessories folder. For more about 
using the Desk Accessories folder, see "Desk Accessories" in this 
chapter, "World Clock" in Chapter 2, and "Calculator" in Chapter 4. 
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Main Applications. This displays a submenu from which you can 
start any GEOS application in the WORLD folder. For more 
information about the WORLD folder, see Chapter 9. 

Other. This displays a submenu of other folders in the WORLD 
folder. 

Printer Control Panel. This opens the Printer Control Panel 
dialog box, where you can see the documents you are currently 
printing or waiting to print. You can also cancel printing a 
document. For more information about printing, see "Printing" in 
this chapter. 

Go to GeoManager. This brings the GeoManager window to the 
front, making it the active window. For more information about 
GeoManager, see Chapter 9. 

Exit to DOS. This shuts down GEOS and returns you to the DOS 
prompt. 

NOTE 

You will not be able to exit to DOS unless you have an external 
keyboard attached to the unit. 

This section provides information about working with windows, 
including how to scroll, resize, and move them. 

Changing the Size of a Window 

You can change the size of a window in different ways. You can 
maximize a window, restore it, minimize it, or make it larger or 
smaller by dragging its edges. You can use these features to do the 
following: 

• See a window or document more clearly. 

• Reduce clutter on your screen. 

• Move something out of the way temporarily. 

Not all windows can be resized in the same ways. Some windows 
can only be resized by dragging their edges, but cannot be 
maximized. Other windows, such as those for the World Clock 
and Calculator, cannot be resized at all. 



Maximize-Restore 
button 

? "D 

Minimize 
button 

? "D 

To maximize a window means to make it full-screen. You use the 
Maximize-Restore button, which is shown on the left, to maximize 
a window, or to restore it to its original size once it has been 
maximized. The Maximize-Restore button's appearance changes 
depending on whether or not the window is maximized. You can 
also use the Maximize and Restore choices on the Window Control 
menu to maximize and then restore a window. 

To minimize a window means to reduce it to an icon, which is 
then placed at the bottom of the screen. You use the Minimize 
button, which is shown on the left. To restore a minimized 
window, double-tap the icon. 

You can resize a window to the exact size you want. You can 
make a window larger or smaller by dragging its borders or its 
corners. Maximized windows cannot be resized. 

To make a window larger or smaller, drag a border or corner of 
the window in the desired direction until the window becomes the 
size you want. If you drag a border, the window size changes only 
on the side of the border you drag. If you drag a corner, the two 
adjoining sides that form the comer move at the same time. 

NOTE 

Each window has a minimum allowable size. If you try to make a 
window smaller than it can be, it will automatically resize itself to its 
minimum size. 

Moving a Window 

You can move most GEOS windows. Typically, you move a 
window because it is obscuring all or part of another window you 
need to see. You cannot move a maximized (full-screen) window. 
To move a window, drag its title bar to another location on the 
screen. 
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Scrolling Through a Window 

Sometimes a document has more information than can fit in its 
window. Scroll bars on both the right side and the bottom of a 
window allow you to view more of its contents. Using these scroll 
bars is called scrolling. The vertical scroll bar on the right side of a 
window lets you scroll to portions of a document above and 
below the displayed contents. The horizontal scroll bar across the 
bottomlof a window lets you scroll to portions of a document to 
the right and left of the displayed contents. 
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A scroll bar includes scroll arrows, paging areas, and a slider, 
which are shown in the illustration on the left. Using these 
elements, you can view the entire contents of a window in several 
different ways. 

When an application needs more information from you or needs to 
alert you to something, a dialog box appears. There are two major 
types of dialog boxes. 

The first type of dialog box functions like other windows. This 
type has a title bar, which you can use to move the dialog box, a 
Window Control button, and a Window Control menu. You can 
keep this type of dialog box open and switch between it and other 
windows. An example of this type of dialog box is the dialog box 
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•Move 
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•Rotate 
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o Delete 

that appears after you choose Page Size from the File menu in 
Geo Write: 

Window Control button 

Type: +[f.'.aper1 <> Envelope 
Size: r-/aper Layoutl 
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The second type of dialog box requires a response from you 
before you can continue. These dialog boxes have a thick solid 
border. An example of this type of dialog box is the one that 
appears after you close a document that you have not saved. You 
cannot take any other action until you respond to this type of 
dialog box. 

Save changes to Document? 

l:Yes!I J:'!o 

Responding to a Dialog Box 

There are various ways for you to enter information and make 
choices in dialog boxes. These are described below. 

To respond to a dialog box, you select options and type text in text 
entry boxes. When you have finished, tap one of the buttons at the 
bottom of the dialog box to apply what you have set or chosen 
and continue. 

Radio buttons appear in groups of two or more. As with the 
buttons on an old car radio, one - and only one - button in a 
group of radio buttons can be selected. Tapping one radio button 
turns on that button and turns off any other buttons in the group. 
When you tap a radio button, it darkens to show that it is selected. 

A check box allows you to select and deselect an option. When a 
check box is darkened, the item is selected and on; otherwise it is 
deselected and off. Check boxes are like light switches; tapping a 
check box switches the box from on to off or from off to on. 
Unlike radio buttons, you can select more than one check box in a 
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group. When you tap an empty check box, it darkens to show that 
the item is selected. 

A text entry box allows you to enter text. For information about 
working with text, see "Working With Text" in this chapter. 

A value selector has up arrow and down arrow buttons for moving 
through options or increasing or decreasing a value (a number). 
Tap the up arrow button to move to the preceding item or increase 
the value. Tap the down arrow button to move to the next item or 
decrease the value. You can also enter the value directly into the 
text field part of the value selector. 

In dialog boxes, you often need to select an item from a list. There 
are two types of lists in dialog boxes: scrolling lists and drop-down 
lists. A scrolling list is already open when the dialog box appears. 

A drop-down list looks like a regular button with a horizontal mark 
on the right side of the button. The current selection in the list is 
shown on the button. To choose a new selection, tap the button to 
see the list. 

Every dialog box has buttons that initiate actions when you tap 
them. If a button label is followed by an ellipsis(. .. ), tapping it 
leads to another dialog box. Common dialog box buttons include 
the following: 

Apply. Applies the current settings, but leaves the dialog box 
open so you can continue to adjust the settings. 

Close. Closes the dialog box. The current settings are applied only 
if you have previously used the Apply button. 

Reset. Resets the box to its original settings, undoing any changes 
you have made. 

OK. Applies the current settings and closes the dialog box. 

Cancel. Closes the dialog box without applying your changes. 

Stop. Ends the task in progress at the next possible stopping 
place. 

Yes. Answers yes to the question in the dialog box. The dialog 
box closes. 

No. Answers no to the question in the dialog box. The dialog box 
closes. 



ONLINE HELP 

One way to get quick answers to your questions about the unit is 
to use the online help. Help is often just a single tap away - just 
tap a Help button, like the one pictured on the left. When you are 
in a dialog box, you will see a button like this one. When you tap 
it, you will see help text about that particular dialog box. 

When you are using an application, there is a Help button at the 
top of the application window. Tap this button to see help about 
the application. The Help window appears: 

lcon!entsl [{\<>fl.'.~::~) l!:!istory-1 
Table of Contents - Geo Write Help :.. 

• Getting Started with GeoWrite 

• Common Problems and Questions 

• Entering and Changing Information 

• Changing the Look of Your Text 

• Using Color and Borders 

• Changing Margins and Indenting 

• Saving and Retrieving Your Work 

• Printing Your Work 

• Finishing Up 

• • Advanced Topics 

When the Help window is open, it remains in the foreground until 
you exit Help. Nevertheless, even with the Help window open, 
you can perform actions in other windows and dialog boxes by 
tapping them. If the Help window is obscuring something you 
want to see, move the Help window out of the way by dragging its 
title bar. You can also uncover other screen items by reducing the 
size of the Help window. See "Changing the Size of a Window" in 
this chapter for more about resizing windows. 

Often, not all the help text for a topic fits in the Help window. To 
see more help text, scroll through the text using the scroll bars in 
the Help window. You can also increase the size of the Help 
window to see more help text. 

Help screens are organized by topic. Most of the topics are 
centered around common questions about the unit. Online help is 
not an online manual. It is not designed to be read from beginning 
to end, like a novel. It is designed so that you can easily jump from 
topic to topic. This way you can quickly find answers to your 
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questions. The buttons at the top of the Help window help you 
move easily between topics. 

GeoManager has a folder called Desk Accessories. The desk 
accessories are the World Clock and the Calculator. 

A desk accessory works exactly like an application, except for one 
difference: A desk accessory's window always remains in front of 
other windows, even if you tap another window to make it active. 
Normally, an application's window disappears behind any other 
application window that you tap. (However, if you tap the 
window of another desk accessory, it will appear on top of the first 
desk accessory window.) 

The behavior of a desk accessory is useful if you want an 
application to remain visible on the screen at all times. 

The illustration below shows how a desk accessory stays in front 
of an active application. 
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l 
You can make any application a desk accessory. Just drag it to the 
Desk Accessories folder (in the WORLD folder). 



Opening and Closing Applications and 
Documents 

There are two ways to start an application: You can start an 
application by opening it directly, or you can start an application 
by opening a document that was created with the application. 
When you start an application, its window appears, ready for use. 
When you are finished using an application, you exit it. Closing an 
application closes its window and frees up system resources. If 
you reopen an application, it is brought to the foreground. 

OPENING AN APPLICATION 

The icons for the GEOS applications are available in the WORLD 
folder in GeoManager. 

From GeoManager, you can open an application by doing one of 
the following: 

• Double-tap the application icon. 

• Double-tap the icon of a document created by the application 
you want to open. 

• Select the icon for the application, then choose Open from the 
File menu. 

• Select the icon for a document created in the application, then 
choose Open from the File menu. 
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From anywhere else in the system, you can open an application by 
doing one of the following: 

• Tap the hard icon for the application. For more information on 
using hard icons, see Chapter 9. For information on changing 
the applications assigned to hard icons, see "Preferences" in 
Chapter 4. The default hard icon assignments are as follows: 

Keyboard 
1. GeoWrite 
2. GeoCalc 
3. GeoFile 
4. Calculator 
5. PalmAddress 
6. PalmSchedule 
7. PalmNotes 

• Choose the application from the Express menu. 

CREATING AND OPENING DOCUMENTS 

The particular 
buttons that appear 
in the New/Open 
dialog box depend 
on the application 
you are using and its 
current user level. 
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Whenever you want to create a new document or open an existing 
one, you see a variation of the New/Open dialog box. The 
New/Open dialog box lets you create and open documents from 
within an application. Each application may have a different 
New/Open dialog box, but in every application it functions in a 
similar way. 

If you open an application that does not already have an opened 
document, the New/Open dialog box appears so that you can 
open a document. 

If you're working on an open document and want to use another 
document within the same application, you can switch documents 
by choosing Switch from the File menu. When you choose Switch, 
the New/Open dialog box is displayed. 

The New/Open dialog box can have some or all of the following 
buttons: 

New. Allows you to create a new, empty document. 

Open. Allows you to locate and open a document that already 
exists. For more information about opening documents, see the 
GEOS application chapters, including Chapter 5, Chapter 6, 
Chapter 7, and Chapter 9. 

Template. Allows you to use a predesigned template to create a 
new document. 



Import. Allows you to create a new document by reading in 
information from another application, such as a DOS word 
processor. 

Change User Level. Allows you to change the application user 
level. This is the same as choosing Change User Level from the 
Options menu. By changing user levels, you specify how simple or 
complex you want the application to be. For more information, 
see Chapter 3. 

Exit or Cancel. Exit allows you to exit the application, provided 
there is no document open in the application. If there is a 
document open, then this button becomes Cancel. 

NAMING DOCUMENTS 

Colons () and 
backslashes (\) are 
not permitted in the 
names of GEOS 
documents. 

The first time you open a document, you have to give it a name. 
The best way to name a document is to describe its contents so 
that you'll recognize it easily. 

Some applications, such as Text File Editor, can create DOS 
documents; these documents must have DOS file names. If you 
need to use a DOS file name, the application you are using will 
specify this. However, most documents use GEOS document 
names, which are more flexible. 

Naming a GEOS Document 

There are some rules to follow when you name a GEOS document. 
The name can be up to 32 characters long and may contain both 
uppercase and lowercase characters. For example, you can name a 
document "Seva's Birthday Card" or "Financial Report 6/14". Each 
space you enter counts as one character. 

Naming a DOS File 

To name a DOS file, you must use DOS file-naming conventions. 
These are described in Appendix D. 
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CLOSING DOCUMENTS AND EXITING APPLICATIONS 

SAVING DOCUMENTS 

When you close a document, you also exit the application. You 
can exit an application at any time, but it is a good idea to save 
any open documents before you do. If you exit without first 
saving, the application gives you the opportunity to save your 
document. 

There are three ways to exit an application: 

• Choose Exit from the File menu. 

• Double-tap the Window Control button. 

• Choose Close from the Window Control menu. 

NOTE 
There may be times when an application is closed transparently. 
This happens when you already have one or more applications 
open and you open another. If there are insufficient resources to 
keep all the applications open at the same time, one (or more) is 
closed automatically. This occurs transparently - you don't see it. 
When you reopen the closed application, it will be in the state you 
left it in. 

When you exit the last open application, GeoManager is restarted 
automatically. You will never see an empty screen. 

To save your document at any time, choose Save from the File 
menu. If you switch documents and have not saved, a 
confirmation message appears, allowing you to save the first 
document before switching to the second document. 

STANDARD FILE SELECTORS 
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A standard file selector is a special type of dialog box that appears 
whenever an application needs to know where to store a file you 
want to save, copy, or move, or where to find a file. Although 
different file selectors contain slightly different text, depending on 
what you are doing, they generally look and operate the same 
way. Common standard file selectors appear when you want to 
select an existing document to open, when you want to save a 



new document (or save an existing document under a new name), 
or when you want to create a copy of a document. 

There are two ways to store documents, a simple way and a more 
complex way. These are described below. 

Storing and Retrieving Documents the Simple Way 

Since the DOCUMENT folder is where GEOS assumes you are 
storing and retrieving documents, it's easiest to store documents in 
your DOCUMENT folder. By doing so, you avoid the trouble of 
changing folders and drives. 

The simple standard file selector displays only the contents of the 
DOCUMENT folder. You can retrieve a document from this folder 
or store a document in it. The Advanced button appears at the 
bottom of this dialog box to allow you to switch to the advanced 
file selector. 

Storing and Retrieving Documents the Advanced Way 

If you need to store or retrieve documents on another drive or in a 
folder other than your DOCUMENT folder, you can use the 
advanced standard file selector to open and close folders and 
select files on any drive or directory you have access to. The 
following illustration is an example of an advanced standard file 
selector: 

Go to Document folder b utton 

l Path drop-down list 

• -

~ath -J r(i(;10;k~%3-;$~Pl1 ~~i:~::, 
tt=SJDOCUMENT 

~ 
L.LJESSAYS 
LLJLETTERS 
LL:Jpapers 
L.LJSCHEDULES 

1• • -
L Ii 

IQpenl l~implel I Cancel I [I] 

r Open folder I Folder and file list 
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The folder at the top of the list is the open folder and its contents 
appear beneath it. 

These buttons appear in an advanced standard file selector: 

Path drop-down list. Tap this button to display the Path drop
down list. The folder at the bottom of the drop-down list is the 
current folder. Use this list to open, close, and change to other 
folders. 

Go to Document folder button. Use this button to move 
immediately to your DOCUMENT folder. 

Drives drop-down list. Tap this button to change from one disk 
drive to another. 

Simple button. Tap this button to switch to the simple file 
selector. 



Working With Text 

When you use most GEOS applications, you enter text. The 
techniques for working with text are the same no matter which 
application you use. Once you have entered text, you can make 
changes to it. 

ENTERING AND EDITING TEXT 

If there is no text in 
the text area, you 
cannot move the 
insertion point. 

Positioning the Insertion Point 

The insertion point is the blinking vertical line that indicates where 
the characters you type appear on the screen. You can move the 
insertion point anywhere in the text by tapping the desired 
location. 

Selecting and Replacing Text 

When you want to make changes to text, first you must select the 
text you want to change. Selected text appears highlighted. 

To select text, quickly tap the appropriate number of times as 
follows: 
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2 taps 

3 taps 

4 taps 

5 taps 

Selects a word, but not the space after the word 

Selects a line 

Selects a paragraph 

Selects the entire document 

The text you want to delete, replace, or change is selected. 

If you change your mind after making a selection, you can cancel 
the selection by tapping anywhere in the text area. 

The fastest way to replace text is to select it and then type the new 
entry. 

Cutting, Copying, and Pasting 

GEOS lets you move text around within your document, as if you 
were cutting and pasting with scissors and glue. 

When you select text, you can cut it to move it elsewhere, or copy 
it to paste a replica of it in another place. The selection you copy 
or cut is placed on the clipboard, an electronic holding space. 
When you choose Paste from the Edit menu, the contents of the 
clipboard are pasted into the active document. The active 
document can be the document that contains the original 
selection, another document in the same application, or another 
document in another application. 

When you copy or cut a selection to the clipboard, it replaces 
whatever is currently on the clipboard. 

To move or copy a selection 

1. Select the item or text you want to move or copy. 

2. Choose Cut or Copy from the Edit menu. 

When you cut something, the item is removed from your 
document and placed on the clipboard, replacing any item 
previously copied or cut to the clipboard. 

When you copy something, the item remains in your document 
and also goes to the clipboard, replacing any other item previously 
copied or cut there. 

3. Move the insertion point to the desired location. 

4. Choose Paste from the Edit menu. The contents of the clipboard 
are inserted into the document. 
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NOTE 

When you paste an item into a document from the clipboard, the 
item also remains on the clipboard unless you replace it. 



Since this method 
does not use the 
clipboard, the 
contents of the 
clipboard remain 
intact. 

Therefore, you can continue to paste the same item from the 
clipboard to multiple locations in your document. 

Deleting Text 

You can delete text from any document. Select the text you want 
to delete and tap the Backspace or Delete key on the floating 
keyboard. Or choose Cut from the Edit menu after you have 
selected the text. 

NOTE 
Those methods that delete items by cutting place the selection on 
the clipboard. You can paste the selection from the clipboard to 
another location as long as you have not cut or copied another 
item to the clipboard. 

Moving and Copying Text Using a Mouse 

If you have an external mouse attached to the unit, you can use 
the following method to quickly move or copy a selection without 
using the clipboard. 

To move or copy a selection using a mouse 

1. Select the text you want to move or copy. 

2. Position the mouse pointer over the selected text, then press and 
hold down the right mouse button. The pointer changes to the 
drag and drop pointer (shown at left). 

3. Drag to the new location, and release the mouse button. The 
selected text is moved or copied to the new location. 

As you drag, the square at the tail end of the pointer indicates 
whether the drag and drop will be a move or a copy: If the square 
is hollow, it will be a move; if the square is filled, it will be a copy. 

You can override the GEOS decision by using the Ctrl key (which 
forces a copy) or the Alt key (which forces a move) on the floating 
keyboard. To do this, tap the appropriate key on the floating 
keyboard to highlight the key before dragging and dropping. 

Using Undo 

Sometimes you may delete some text, or change the way it looks, 
and immediately decide this is not what you wanted to do. If you 
have not done anything else, in some applications you can choose 
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FORMATTING TEXT 

Afont is a typeface, 
the design of the 
individual 
alphabetic and 
numeric characters. 
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Undo from the Edit menu to restore the text to its previous 
condition. Undo "undoes" the last editing change you made. 

Once you choose Undo, its name on the Edit menu changes to 
Redo so that you can undo what was undone. Not all applications 
include Undo, and not all operations can be undone. 

NOTE 

Undo does not restore any changes made to the clipboard. 

Working in Insert or Overstrike Mode 

The method for entering text described in this manual is called 
insert mode. That is, the characters you type appear at the 
insertion point, pushing all existing characters to the right to make 
room for the new characters. You can use the Look & Feel options 
in Preferences to enable overstrike mode, in which the characters 
you type replace the characters to the right of the insertion point. 
This feature is normally disabled, but if you enable it in Prefer
ences, you can use the Insert key to switch between insert and 
overstrike modes. 

For more information on enabling the Insert key to switch 
between insert and overstrike modes, see "Preferences" in 
Chapter 4. 

Typing Special Characters 

You can type special characters, such as a bullet ( •) or an em dash 
(-),with special key sequences. You can also type letters with 
accents, such as e. To include special characters, use the 
international keyboard. 

You can use the same techniques to enter text and change its 
characteristics in every application. 

Changing the Font 

There are two ways to change a font: from the Style tool bar arid 
from a menu. 



To change the font using the Style tool bar, select the text you 
want to change and tap the Fonts drop-down list button on the 
Style tool bar. (The Fonts drop-down list button has the name of 
the currently selected font on it.) Choose the font you want from 
the drop-down list. 

To change the font from a menu, select the text you want to 
change and choose Fonts from the Character menu. (In some 
applications, use the Properties menu or Fonts menu.) Choose the 
font you want, then tap Apply. 

Viewing a Font 

If you want to see how a font looks, you can use the Font Viewer 
option. If you like the design of the font, you can apply it to the 
selected text. 

To view a font, select the text, then choose Fonts from the 
Character menu. Choose Font Viewer from the Fonts submenu. 
Select the font you want to see. The font is displayed at the bottom 
of the Font Viewer dialog box. 

If you want to change the selection to the font you specified, tap 
Apply, then close the dialog box. 

Changing the Text Size 

Text size is usually measured in points, a measurement used in the 
printing industry. A point is approximately 1/72 of an inch. 
Therefore, 72-point text is one inch tall, and 12-point text is 1/6 of 
an inch tall. Most books and magazines are printed with 10- or 12-
point text. 

You can make text any size from 4 to 792 points. There are a 
limited number of preset text sizes available from the Sizes menu. 
If you want a size that is not listed, you can select a custom size. 

You can change the text size from the Style tool bar or from the 
Sizes menu. 

To change the text size using the Style tool bar, select the text you 
want to change, then tap the Sizes drop-down list button on the 
Style tool bar. (The Sizes drop-down list button shows the 
currently selected size.) Choose the text size you want. 

To change the text size from a menu, select the text you want to 
change, then choose Sizes from the Character menu. (In some 
applications, use the Properties menu.) Choose the size you want 
from the list. 
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You can quickly make text the next larger or smaller predefined 
size. Select the text and tap the Larger or Smaller button on the 
Style tool bar. You can also choose Sizes from the Character menu. 
(In some applications, use the Properties menu.) Then choose 
Larger or Smaller from the Sizes submenu. 

Changing the Text Style 

Text can appear plain, like the text in this sentence, or you can 
change text to any of the following styles: 

• Bold 

• Italic 

• Underline 

• StFil<e ThFu 

• Superscript 

• Subscript 

To change the text style from the Style tool bar, select the text you 
want to change. Then tap the text style you want to use. 

You can also change the text style by choosing the style from the 
Styles submenu in the Character menu. (In GeoCalc and GeoFile, 
use the Properties menu.) 



Changing the Text Alignment 

The alignment, or justification, of text determines where the text 
lines up along a margin. For example, when text is left-aligned, the 
rows of text line up along the left margin (excluding specified 
indentation) and the right ends of the lines are ragged. When text 
is full-aligned, both the left and right sides of the text line up 
evenly along the left and right margins. See the illustration below 
for examples of the available alignments. 

I Aligned with left margin 

rrrus is a.n example of left i 
~igned text. All the text is ! 
!J.ined up evenly on the left side.! 

This is an example of ri3h~ 
_a1is,..d text. All the··~· i•-• - Aligned with right margin 

lined up evenly on the n.sh'li 
side.! 

. . 
1This is a.n example of cenmred j 

text. All the text in this · 
paragraph is centered. 

mus is an example of full-i 
!a].igned text. All the text is! 
~ned up evenly on the left and] 
lrisht side. 

i 

Centered between margins 

I Flush against both margins 

You can change the text justification from the Style tool bar or 
from a menu. 

To change the text justification using the Style tool bar, make sure 
the insertion point is in the paragraph you want to change. Tap the 
justification button you want on the Style tool bar. 

To change the text justification from a menu, make sure the 
insertion point is in the paragraph you want to change. Choose the 
type of justification from the Paragraph menu. (In GeoCalc and 
GeoFile, use the Properties menu.) 
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Printing 

Typically, you print documents from within an application by 
choosing Print from the File menu. This section describes many 
common printing features and functions. However, the specific 
printing options you see will depend on the application and the 
printer you are using. 

SETTING UP A PRINTER 

Before you can print anything, first you must let GEOS know what 
printer you have attached to the unit. Use Printer Options in the 
Preferences application to set up your printer. For more 
information, see "Preferences" in Chapter 4. 

PRINTING WITH STANDARD SETTINGS 
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The Print dialog box comes with standard settings that work well 
to print most documents. The standard settings assume you want 
to print one copy of an entire document on 8.5'' x 11" paper. If the 
standard settings do not meet your needs, see "Printing With 
Customized Settings" in this chapter. If you are using a color 
printer, you may also want to review "Tips for Users of Color 
Printers" in this chapter. 



To print a document with standard settings 

1. Choose Print from the File menu. The Print dialog box appears. 

2. Tap the Print button at the bottom of the dialog box. A message 
appears, informing you that your document is printing. The 
document prints with the standard settings. 

PRINTING WITH CUSTOMIZED SETTINGS 

The Print dialog box allows you to set various printing options 
before you print a document. The available settings vary by 
application and by printer. A typical Print dialog box with some 
common options is shown here: 

lPrinter Options 

. 
Printer O~tionJ 

Printer: I HP LaserJet Ill on LPT 1 -I 
Width: 8.5 in Height: 11 in I Options ... I 

Document Options 
Print Quality: +High <>Medium <>Low (Fast) 

o Text Only (Fastest) 

Print Pages: +All f'r'on< lX!~ to [1! 
Number of Copies: 

, __ ; ·' < . , ~B ""Coll'°:it«' 

Ii Print JI I Cancel I [TI 

Document 0 tions p 

The Print dialog box is typically divided into two sections: Printer 
Options and Document Options. Depending on your application 
and printer, your Print dialog box may also have other sections. 

Printer Options. Includes items such as the selected printer, 
paper width and height, paper source, and advanced printer 
options. 

Document Options. Includes items such as Print Quality and 
Number of Copies. 

PRINTING 1.35 



When printing on a 
color printer, you 
may get the best 
results by using the 
medium-quality 
setting. 

Changing Document Options 

The following procedure describes how to change the most 
common Document Options. The printer and application you are 
using determine which of these options are available to you. 

To change Document Options 

1. Choose Print from the File menu. The Print dialog box appears. 

2. Fill in the dialog box, selecting from the Document Options 
section as follows: 

Pr-int 

.---------Printer Options------~ 
HP Laser.Jet 111 on LPT I -I Printer: 

Width: 8.5 in Height: I I in I Options ... I 

-------Document Options;-------., 
Print Quality: + High <> Medium <> Low (Fast) 

o Text Only (Fastest) 

:::~::":,s~.::~, 68 J~~~':: !T ~ 
l!Print!I I cancel I [ZJ 

Document Options 

Print Quality. Tap the radio button that represents the print 
quality you want to use. High quality produces the most 
professional-looking documents, but it takes longer to print than if 
you use low quality. Low quality prints much more quickly, but 
produces draft-quality documents. Typically, you would want to 
print at low quality when you are working on drafts and printing 
speed is important. Select high quality to print final documents. 

Text Only. Text Only is the fastest way to print a draft because it 
uses an approximation of the fonts you see on screen and does not 
print any graphic images. Select the Text Only option if you want 
to get a printout of a document quickly. 

Print Pages. Select All to print all the pages in the document, or 
specify a range of pages to print by using the up or down arrows. 

Number of Copies. If you want to print more than one copy, 
change the number of copies by tapping the arrow buttons or 
typing a number in the Number of Copies box. 

Collate. If you are printing multiple copies of multiple-page 
documents and you want them collated, check Collate. When you 
collate copies of a document, one copy of the entire document is 
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printed before the second copy is printed. Collating a document 
may require more time than not collating it. If you do not collate 
multiple copies, all copies of page 1 print before all copies of page 
2, and so on. 

3. Tap Print when you are ready to print the document with the new 
settings. If you want to change Printer Options before you print, 
see "Changing Printer Options" in this chapter. 

Changing Printer Options 

You are not likely to need to change Printer Options very often. 
Typically, you only change Printer Options, including size, type, 
and layout, if you change the paper in your printer. 

Printer Options must always reflect the actual physical setup of 
your printer. That is, regardless of the size of your document on 
screen, if your printer is set up with 8.5" x 11" paper, the paper 
size in Printer Options must be 8.5" x 11 ". You can use the Page 
Size choice from the File menu to specify the size of your 
spreadsheet. 

The following procedures describe how to print to a different 
printer, change paper options, change the paper source, and print 
to a file. 

To print to a different printer 

1. Choose Print from the File menu. The Print dialog box appears. 

2. In the Printer Options section of the dialog box, locate the Printer 
option. Make sure the printer you want to use is selected. If it is 
not, use the drop-down list to select it. 

+ HP Laser Jet Ill on LPT 1 
0 Canon BJC-800 (B/W) on LPT 1 
O Tl microLaser XL PS 17 (PostScri t) v52. 1 on LPT 1 

You need to have previously added this printer to your list using 
Preferences. For more information about Preferences, see 
"Preferences" in Chapter 4. 

3. Tap Print when you are ready to print the document to the current 
printer. If you want to change paper options, change the paper 
source, or print to a file, see the following procedures. If your Print 
dialog box includes other options, see the chapters that describe 
the particular application you are using. 
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Tbe settings in the 
Options dialog box 
must match the size 
and orientation of 
the paper in your 
printer. 

To change paper options 

1. Choose Print from the File menu. The Print dialog box appears. 

2. Make sure the printer you want to use is selected. If it is not, use 
the drop-down list to select it. 

+ HP Laser Jet Ill on LPT I 
<> Canon BJC-800 (B/W) on LPT I 
<> Tl microLaser XL PS 17 (PostScrl t) v52. I on LPT I 

3. Tap the Options button that is below and to the right of the printer 
selection. The Options dialog box appears. It will look similar to 
the following, though it will vary depending on the printer you 
selected: 

Paper type 

ptions to change the 
configurati n of your printer. Th se will 

he layout of your document. 
+[~.~i~--~·:.·J <>Envelope 

JIS 85 Letter 

Width: I s.s in I B Height: I 1 1 in I B 
Print To: +Printer <>File 

Paper Source: I Upper Tray -I 
I OK I I save Options I cancel ? 

Width and height 

4. Fill in the dialog box, changing the options you want, as follows: 

Type of Paper in Printer. Change the paper type if it is 
incorrect. 

Size of Paper in Printer. If the selected paper size is not the size 
of the paper in your printer, select the correct size from the paper 
size list. 
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Portrait Layout 

Landscape Layout 

I 1.tq I 

Width and Height. If you want to use a custom paper size that is 
not included in the paper size list, use the Width and Height value 
selectors to enter the width and height of the paper you want to 
use. 

Paper Feed. Select either portrait or landscape paper feed, 
depending on the direction of the paper in the paper tray- not 
on the layout that you have selected in the application. (In other 
words, if you set up your document with a landscape orientation, 
you do not need to alter the Paper Feed option; this option should 
only be changed if the paper feeds into the printer in an unusual 
manner.) Portrait layout is a page printed so that, as you read it, 
the width of the page is less than its height. A horizontal layout is 
called landscape. 

5. Tap OK if you want the changes you have made to remain in 
effect for the current session. 

or 

Tap Save Options and then tap OK if you want the changes to 
remain in effect every time you print on this printer from now on. 
You can, of course, return to the Options dialog box whenever 
you want and change any of these options again. 

You return to the Print dialog box. 

6. Tap Print when you are ready to print the document with the new 
settings. If you want to print to a file or change the paper source, 
see the following procedure. If your Print dialog box includes 
other options, see the chapter that describes the particular 
application you are using. 

NOTE 

You should only change the printer settings in the Options dialog 
box when they do not match the physical settings on your printer. 

To change the paper source 

1. Choose Print from the File menu. The Print dialog box appears. 

2. Make sure the printer you want to use is selected. If it is not, use 
the drop-down list to select it. 

+ HP Laser Jet Ill on LPT I 
<>Canon BJC-800 (B/W) on LPT I 
<> Tl microLaser XL PS 17 (PostScri t) v52. I on LPT I 

3. Tap the Options button that is below and to the right of the Printer 
selection. The Options dialog box appears. It will look similar to 
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With some printers, 
the Paper Source 
options appear as 
radio buttons. 

the following, though it will vary depending on the printer you 
selected: 

Options 

Use these options to change the 
configuration of your printer. These will 
not affect the layout of your document. 
Type of Paper in Printer: + Paper <> Envelope 

JIS BS Letter 

Width: j a.s in I B Height: j 1 I in I B 
Print To: +Printer <>File 

Select the paper source from 
the drop-down list. 

4. Use the Paper Source drop-down list to select the location of the 
paper you want to use. The available options depend on the 
printer you are using. 

5. Tap OK if you want the change you have made to remain in effect 
for the current session. 

or 

Tap Save Options and then tap OK if you want the change to 
remain in effect every time you print on this printer from now on. 
You can, of course, return to the Options dialog box whenever 
you want and change the paper source again. 

You return to the Print dialog box. 

6. Tap Print when you are ready to print the document with the new 
settings. If you want to print to a file, see the following procedure. 
If your Print dialog box includes other options, see the chapter that 
describes the particular application you are using. 
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SETTING THE PAGE SIZE FOR PRINTING 

The Page Size dialog box allows you to set various page size 
options before you print a document. 

1. Choose Page Size from the File menu. The Page Size dialog box 
appears: 

~p here to select paper type. 

--==i_ J Select page size from list . 
. . . 

Type: _±f'a er]l_ Envelo e 
0 p m p l 

Size: . . I [a~er Layout-i 
lus Legal __c 111 El I ----t 

Width: l 8.S in JB Height: [ 11 in JB 
_flppl .iJ I Close I [II 

t- Select portrait 
or landscape 
layout. 

Displays height of select ed page. 

Dis la p ys width of selected a e. pg 

2. Fill in the dialog box, changing the options you want, as follows: 

Type. Select Paper if the document is to be printed on a regular 
sheet of paper. Choose envelope if the document is for an 
envelope. 

Size. Select the size from the paper size list. 

Width and Height. If you want to use a custom paper size that is 
not included in the paper size list, use the Width and Height value 
selectors to enter the width and height of the paper you want to 
use. 

Paper Layout. Select either portrait or landscape. Portrait layout 
is a page printed so that, as you read it, the width of the page is 
smaller than its height. A horizontal layout is called landscape. 

3. Tap Apply to accept the changes you have made to the document. 
The changes are displayed on the screen, and the dialog box stays 
open to allow you to make more changes. 

4. When you have completed making the changes you want to, tap 
Close. 

PRINTING 1.41 



PRINTING TO A FILE 

Printing a document to a file creates a DOS file with all of the 
information that would have been sent to the printer, including all 
printer and graphic codes. This is especially useful when you want 
to have a document printed by a service bureau, such as when you 
want to create a Postscript file for a high-resolution 
phototypesetter. Printing to a file usually creates an extremely 
large file unless you are printing a Postscript file or are printing 
with the Text Only setting. 

NOTE 

One page of a complicated document can require over 1 MB of 
disk space. Make sure you have sufficient space before you print a 
document to a file. 

To print to a file 

1. Choose Print from the File menu. The Print dialog box appears. 

2. Make sure the printer for which you want to create a file is 
selected. If it is not, use the drop-down list to select it. 

You need to have previously added this printer to your list using 
Preferences. For instance, if you want to create a file for a 
PostScript printer, you will first need to install a PostScript printer 
selection using Preferences even if you do not have that printer 
physically attached to the unit. For more information on 
Preferences, see "Preferences" in Chapter 4. 

3. Tap the Options button that is below and to the right of the Printer 
selection. The Options dialog box appears. 

4. Tap the Print To: File radio button. 

Print To, '(Printer r File 

Select to print to a printer or file. 

5. Tap OK if you want the change you have made to remain in effect 
for the current session. 
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or 

Tap Save Options and then tap OK if you want the change to 
remain in effect every time you print on this printer from now on. 
You can, of course, return to the Options dialog box whenever 
you want and change printing to a printer again. 

You return to the Print dialog box. 



When the Print to 
File option is set, the 
Print button becomes 

Print to File to 
remind you of the 

change. 

6. Tap the Print to File button at the bottom of the Print dialog box. 
The Print to File dialog box appears: 

File name: ~NNAMED.RAW "--

lPrint To Filej 

Enter DOS file name here. 

7. Use the file selector to select the folder you want to store your file 
in. For more information, see "Opening and Closing Applications 
and Documents" in this chapter. 

8. Enter the name of the file in the text entry box. You must use a 
DOS file name. For more information, see "Opening and Closing 
Applications and Documents" in this chapter. 

9. Tap Print to File. The document is printed. 

CHECKING AND CANCELING PRINTING DOCUMENTS 

If you want to check the list of your print jobs or cancel a print job, 
choose Printer Control Panel from the Express menu. 

GEOS keeps track of all the requests you make to print documents 
in a list called the print queue. Documents that you send to the 
printer are called jobs. You can send as many jobs to a printer as 
you like. You do not need to wait for one job to finish printing 
before you send another. 

You can easily check the status of files in the print queue. To see a 
list of files being sent to a printer, use the Printer Control Panel, 
which you select from the Express menu. 

To move a document to a different place in the print queue 

You can move a document to the front or to the end of the print 
queue. 

1. Choose Printer Control Panel from the Express menu. The Printer 
Control Panel list appears. 

2. Select the document you want to print after any documents that 
are currently printing. 
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3. Tap either Make Next or Make Last. The document you selected 
moves to the appropriate position in the queue. 

To remove a document from the print queue 

If you decide you do not want a document to print after you have 
sent it to the print queue, it is easy to remove it from the queue. 

Choose Printer Control Panel from the Express menu, then select 
the document you want to remove from the Printer Control Panel 
list. Tap Cancel Document. If it is not already printing, the 
document you selected is removed from the list. 

TIPS FOR USERS OF COLOR PRINTERS 

1.44 GETTINGSTARTED 

None of the applications in this manual support color printing, 
although other GEOS applications do, which is why all the color 
printing options are preserved. If you have a color printer that you 
are using with the unit, and you have configured it to print in color 
using Preferences, you may want to install the black-and-white 
printer selection for that printer using Preferences. 

You can tell that a printer is configured for color by looking at the 
name that appears on the Printer drop-down list in the Printer 
Options section of the Print dialog box. If it has the word "color" in 
parentheses at the end of its name, then it is a color printer 
configured to print in color. If it has "b/w" in parentheses, then it is 
a color printer configured to print in black and white. If it has 
neither, then it is not recognized as a color printer. 

You can set up both the b/w and color versions of the printer 
selection and simply choose the one you want from the drop
down list. When printing black-and-white documents, it is much 
faster to use the b/w version of the printer selection. 

For more information on selecting and installing printers, see 
"Preferences" in Chapter 4. 





Palm Application Basics 

STARTING AND EXITING PALM APPLICATIONS 

All of the Palm applications are available through GeoManager. 
PalmAddress, PalmSchedule, and PalmNotes are in the World 
folder; World Clock is in the Desk Accessories folder. 

To start any of the Palm applications, double-tap the 
corresponding icon. 

To exit a Palm application, double-tap the Exit icon. Any changes 
you have made are saved automatically. 

SPECIAL PALM TOOLS 

There are five tools that are specific to the Palm applications. They 
are: 

Ink tool button 

Text tool button 
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Allows you to use the pen and Powerlnk 
TM to write directly on the screen. 

Allows you to use one of the three text 
options: handwriting recognition (which 
translates what you write with the pen 
into typed text), the floating keyboard, or 
an optional external keyboard. 



POWERINK 

THE SKETCH PAGE 

Clear button Allows you to clear the entry or page. 

Backspace button Allows you to backspace and delete text 
character by character. In ink mode, tap 
this button to delete the last ink stroke. 

Show /Hide Sketch Allows you to display the Sketch tools. 
Tools button You use these tools to draw and edit text 

and ink on the Sketch page. 

The Ink tool, the Text tool, and Powerlnk are described below. 
Handwriting recognition is described in Chapter 1. 

Powerlnk allows you to write or draw with the pen. The actual 
lines, circles, curves, and other images you create on the screen 
are called Powerlnk, or ink for short. When you use the pen, the 
graphic images (letters, numbers, drawings) are stored exactly as 
you handwrite or draw them. You can use the pen on Sketch 
pages and in fields. 

You can also convert your handwriting to typed characters (text) at 
any time through the use of handwriting recognition. (For more 
information on handwriting recognition, see Chapter 1.) 

CAUTION 

Text written with the pen takes up to 1 O times more memory to 
store than text entered with handwriting recognition or with a 
keyboard. 

In PalmAddress, PalmSchedule, and PalmNotes, you use a Sketch 
page to draw, make handwritten notes, enter text, or combine all 
three. In PalmSchedule, for example, you could use a Sketch page 
to draw a map showing the route to a conference, handwrite the 
conference coordinator's name, and type a list of items to bring. 
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On the Sketch page, you use the Ink tool to draw and write with 
the pen and the Text tool to enter text with handwriting 
recognition, with the floating keyboard, or with an optional 
external keyboard. You can also write, draw, and edit text and ink 
on the Sketch page with the Sketch tools. These are an additional 
set of Sketch tools that are displayed when you tap the Tool box. 
(See "Sketch Tools" in this chapter for information on using these 
tools.) 

To use the Sketch page 

1. From the PalmNotes table of contents, tap the page you want to 
use. In PalmSchedule, display the day view and tap the Sketch tab. 
In PalmAddress, display the entry page and tap the Sketch tab. 

2. To enter ink, tap the Ink tool, then draw ink. 

3. To enter text, tap the Text tool. 

After tapping the Text tool, you can use the floating keyboard, the 
optional external keyboard, or handwriting recognition to enter 
text. When you use handwriting recognition, whatever you print 
with the pen is converted to text. 

4. Tap Backspace to erase the last letter or ink segment you entered. 
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THE SKETCH TOOLS 

This section provides detailed instructions on using the Sketch 
tools. You may want to skip this section until you need to use a 
Palm application that allows you to use the Sketch tools. 

The Sketch tools allow you to draw, write, and edit text and ink on 
the Sketch page. They are grouped together in the Tool box and 
are displayed on a drop-down list when you tap the Tool box. The 
following table describes the Sketch tools: 

TAP To NAME 

Write or draw in ink with the pen Sketch pen 

Erase by hand (as if using a pencil eraser) Eraser 

Select a portion of the Sketch page 
(drag the pen to select) 

Select tool 

Cut the selected portion of ink or selectedCut icon 
text 

Copy the selected portion of ink or 
selected text 

Paste the cut or copied portion of ink 
or selected text (must cut or copy 
something first) 

Zoom in on the selected portion 

Return to normal-size view 

Copy icon 

Paste icon 

Magnify In 

Magnify Out 

Using the Sketch Tools 

You can cut or copy an item, and then paste it somewhere else on 
a Sketch page. You can also magnify an area for editing or adding 
details. 

To cut or copy and paste an ink item 

1. Tap the Ink tool. 

2. Tap the Select tool. 

3. Drag the pen diagonally to draw a boundary around the ink you 
want to edit. 
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Imagine a rectangle for the area you want to select. Start at one 
corner of this imaginary rectangle. Drag the pen on the screen 
diagonally until the rectangle is the size you want. 
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4. Tap the Cut tool to remove the item, or tap the Copy tool to copy 
the item. 

5. Display the Sketch page where you want the item to go. 

6. Tap the Paste tool. 

7. Tap the place where you want the item to go. 

To cut or copy and paste a text item 

1. Tap to select the Text tool. 

2. Hold down the pen and drag it across the text you want to edit. 

3. Tap the Cut tool to remove the item, or tap the Copy tool to copy 
the item. 

4. Display the Sketch page where you want the item to go. 

5. Tap the place where you want the text to go. 

To paste the text within existing text, tap the place where you 
want the text to start. The text will be pasted after the insertion 
point. 

6. Tap the Paste tool. 

To magnify an area 

1. Tap the Select tool and drag the pen diagonally to draw a 
boundary around the area you want to magnify. 
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2. Tap the Zoom In tool to magnify the selected area. 

You can add text or ink in the magnified area. 

3. Tap the Zoom Out tool to return to normal magnification. 

Copying or Cutting a Whole Sketch Page 

You can copy or cut everything on a Sketch page (including all 
text and ink) at once. Then you can paste the whole page on 
another Sketch page in PalmSchedule, PalmNotes, or 
PalrnAddress. 

NOTE 
Pasting a whole page onto another Sketch page replaces the 
contents of the destination Sketch page. 

To copy or cut a whole Sketch page 

1. Display the Sketch page that you want to copy or cut. 

2. Choose Copy All or Clear All from the Edit menu. 

If you choose Clear All, you see a message asking you to confirm 
the deletion. 

3. Display the Sketch page where you want the information to go. 

4. Choose Paste All from the Edit menu. 

If something is already present on the Sketch page, you see a 
message warning you that the contents of the Sketch page will be 
replaced. Select Yes to replace or No to cancel. 

SENDING AND RECEIVING PAGES 

This section provides detailed information on sending and 
receiving pages. You may want to skip this section until you are 
familiar with the Sketch Page and you need to use a Palm 
application that allows you to send and receive pages. 

You can send pages to another unit and receive pages from 
another unit by using Send and Receive from the Page menu. In 
PalmSchedule and PalmNotes, you can send and receive Sketch 
pages only. In PalrnAddress, you can send and receive both 
Address pages and Sketch pages. 

Before you can transfer information, you need to do the following: 

• Verify that both machines are running Palm applications. 
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PRINTING 

• Set the page send/receive options and attach the two machines 
with a serial cable. For information about setting the 
send/receive options, see "Preferences" in Chapter 4. 

CAUTION 

When you receive a Sketch page from another unit, your current 
Sketch page is automatically replaced with the Sketch page from 
the other unit. To save your current Sketch page, you should add a 
new blank Sketch page. This will prevent any received pages from 
overwriting your current page. 

To send or receive pages 

1. Connect the two units with a serial cable. 

2. On the sending unit, open the application and display the Sketch 
page or Address page you want to send. 

3. On the receiving unit, display a blank Sketch page or Address 
page for the information. 

4. On the sending unit, choose Send from the Page menu. A dialog 
box appears. 

S. On the receiving unit, choose Receive from the Page menu. A 
dialog box appears. 

6. Tap Send in the Send dialog box. 

7. Tap Receive in the Receive dialog box. 

You can print the following from the Palm applications: 

• An Address page, a Sketch page, or a range of pages from 
PalmAddress. 

• An Event page, a To Do page, or a Sketch page for a single day 
or a series of days from PalmSchedule. 

• A Sketch page or a range of pages from PalmNotes. 

First install a printer, then connect the unit to the printer. (For 
more information, see "Preferences" in Chapter 4.) 

To print a page from PalmAddress, PalmSchedule, or PalmNotes 

1. Go to the page you want to print. 

2. Choose Print from the File menu. The Print dialog box appears. 
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3. Choose the print quality: High, Medium, or Low. High quality 
generally takes longer to print than low quality. 

4. To print all the pages in PalmAddress and PalrnNotes, choose All. 

or 

To print a range of pages, select the starting and ending page 
numbers (PalmAddress, PalmNotes) or the starting and ending 
dates (PalmSchedule). 

or 

To print just one page, make the starting and ending page 
numbers the same (PalmAddress, PalmNotes) or the starting and 
ending dates the same (PalmSchedule). 

5. Choose the type of page you want to print: 

Address or Sketch (PalmAddress) 

or 

Event, To Do, or Sketch (PalmSchedule). 

6. Tap Print. 
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PalmAddress 

PalmAddress is like an office card file to help you keep track of the 
names and addresses of your contacts and other information about 
them. 

VIEWING PALMADDRESS 

PalmAddress has two views: an index of address book entries and 
the address book entry view. 

You use the index view to display a list of names in your address 
book. 
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You use the address book entry view to store contact information: 

Tap the change view icon to 
return to the address book index. 

Name: Monroe, Mary 

Addres9' 1000 Star Bhod. 
Hollywood, CA 91113 

Work Phone: 1114)555-1123 -----ff-Tap a field to enter information. 
Home Phone: 1114)555-1131 

Birthday: )-.\(.ly 15 

Sketch 

Each PalrnAddress entry also has a Sketch page: 
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Birthday: )-.\(.ly 15 
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Use the sketch page to take 
notes for the contact or draw 
a map. 

See "Sketch Page" and "Sketch Tools" in this chapter for a 
description of the Sketch page and information on using the 
Sketch tools. 
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ADDING A PALMADDRESS ENTRY 

The Address page displays place holders (called fields) for address 
information. To add a new entry, enter information in the fields. 

To add a new entry 

1. Tap the New button above the letters in the index view, or if you 
are on the Address page or the Sketch page, choose New Entry 
from the Page menu. You do not have to be in the letter that 
matches the name of your entry. PalmAddress alphabetizes the 
entries for you. The Edit Field dialog box appears: 

The current field 

~ ~EJ @lcancell 
•Name - f:l1 

2. Enter the information into the current field. 

The current field is the Name field. Address entries are 
alphabetized by the Name field for each entry. Enter the last name 
in the Name field, or enter the last name and the first name, 
separated by a comma. You must enter something in the Name 
field or PalmAddress cannot save the entry. 

3. To add information to another field in this entry, select the field 
from the list of fields. 

When you tap the current field, a pop-up list of fields appears. In 
the list of fields, the current field is marked with a circle next to it. 
Fields marked with a circle are displayed on the Address page. 
Fields not marked with a circle are not displayed, though any data 
you enter into them is saved. You can change which fields are 
displayed. See "Changing How Fields are Displayed" in this 
chapter. 

4. When you finish, tap OK. 
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NOTE 

If you enter a name with the pen without handwriting recognition, 
PalmAddress cannot alphabetize the entry. When you exit the Edit 
Field dialog box, a dialog box appears in which you can specify 
under which letter the entry should be alphabetized. See the steps 
for moving an entry in "Editing an Entry" in this chapter. 

To add information to the Sketch page for an entry 

1. Tap the Sketch tab to display the Sketch page for the current entry. 

2. Enter ink or text on the Sketch page. 

See "Sketch Page" and "Sketch Tools" in this chapter for a 
description of the Sketch page and information on using the 
Sketch tools. 

Editing a PalmAddress Entry 

You can change the information in an existing entry, delete an 
entry from your address book, or move an entry's position in the 
index. 

To change an existing entry 

1. Display the entry you want to change. 

2. Tap the field you want to change. The Edit Field dialog box 
appears. To use handwriting recognition to convert your ink to 
text, tap the Text tool. 

3. Make any changes you want, then tap OK. 

To delete an entry 

1. Display the entry you want to delete. 

2. Choose Delete Entry from the Page menu. A confirmation message 
appears. 

3. Tap Yes to delete, or tap No to cancel the deletion. 

To move an entry 

You can only move entries with ink names. You cannot move text 
entries entered with handwriting recognition, with the optional 
external keyboard, or with the floating keyboard. 

1. Display the entry you want to move. 

2. Choose Move Entry from the Page menu. The Move Entry dialog 
box appears. 

3. Tap the letter. 
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4. Tap OK. PalmAddress places the entry as the last entry on the 
specified index page. 

Duplicating a PalmAddress Entry 

You can duplicate a PalmAddress entry. For example, you may 
have several contacts at the same company. You can duplicate one 
entry and make the appropriate changes to the next entry to save 
time. 

To duplicate an entry 

1. Display the address entry you want to duplicate. 

2. Choose Duplicate Entry from the Page menu. A new Address page 
with the duplicate entry already entered is displayed, and the Edit 
Field dialog box appears. 

3. Make any changes you want, then tap OK. 

CUSTOMIZING FIELDS 

PalmAddress contains four customizable fields. Changing the 
names of the fields changes the names of the corresponding fields 
on all PalmAddress entries. Information already in the fields is not 
lost; only the field names are changed. 

You can also choose to show or hide fields that do not have any 
information in them, and change the way fields are displayed. 

Changing Customized Field Names 

To change a field name 

1. Choose Edit Custom Field Labels from the Options menu. The Edit 
Custom Field Labels dialog box appears: 

Ecl1t Custom F1elcl Labels 

custom Label: + custom 1 
<>Custom 2 
<>Custom 3 
<>Custom 4 

lsirthday1 

I OK I I Cancel I 
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2. Tap the custom field whose name you want to change. 

3. Backspace over the label in the field to enter a new label. 

or 

Use the pen to print a new label (your handwriting is 
automatically converted to text). 

Hiding Empty Fields 

If you use only certain fields on the Address page, you can hide 
the ones you do not use to save screen space. 

To hide fields 

1. Choose Show Empty Fields from the Options menu. The box next 
to the menu item clears, which means the Show Empty Fields 
option is deselected. Now all the empty fields for the entry are 
hidden. Only those fields that contain information are displayed. 

2. Choose Show Empty Fields again to redisplay the empty fields (the 
box is now black). 

HINT 
Fields that contain information but are not displayed do not appear 
on the Address page. To display only fields containing information, 
select all the fields in the Display Fields dialog box, then deselect 
Show Empty Fields from the Options menu. 

Changing How Fields are Displayed 

You can change which fields are displayed in PalmAddress. The 
PalmAddress page is preset to display Name, First Name, Address, 
Work Phone, Home Phone, and Fax. For example, instead of 
displaying the address field and entering the entire address in that 
one field, you can display several fields - address, city, state, and 
zip - and enter part of the address in each field. 

NOTE 
You can enter information in a field that is not displayed. The 
information exists; it just does not appear on the page. 
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To select which fields to display 

1. Choose Display Fields from the Options menu. The Display Fields 
dialog box appears, listing all the fields in the address book. 
PalmAddress displays the fields that have the black boxes next to 
them. 

Display F1elcls 

• Name • Home Phone 
• First Name o Other Phone 
•Address •Fax 
DCity D Email 
D State D AOL Email 
D Zip D Notes 
o country •f~if.fh~~ij]-----+- Selected fields (those with a black box) 
o Title o custom 2 are displayed on the address page. 
o Company o Custom 3 
• Work Phone o Custom 4 

[OK J I Cancel I [II 

2. To display a field, tap it so the box is black. 

3. To remove a field from the page, tap it so that the box is empty. 
You do not lose the information in the field; it just does not appear 
on the page. 

4. Tap OK. 

CREATING A NEW PALMADDRESS DOCUMENT 

When you first start PalmAddress, an addre.ss book document, 
called Address Book, is automatically created for you. You can 
have more than one PalmAddress document - for example, one 
for business contacts and another for personal contacts. 

To create a new PalmAddress document 

1. Choose Switch Document from the File menu. 

2. Tap the New icon. 

3. Give the new document a name, then tap Create New Document. 
The new document becomes the current one. 
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SWITCHING TO A DIFFERENT PALMADDRESS DOCUMENT 

Another way to 
switch is to tap the 
document name at 
the top of the index 
page. 

To switch to another PalmAddress document 

1. Choose Switch Document from the File menu. 

2. Tap Open. A list of PalmAddress documents you have created 
appears. 

3. Tap the document name you want to use. 

4. Tap Open. 
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PalmSchedule 

PalmSchedule works like a desk calendar and an appointment 
book You can schedule meetings and have PalmSchedule remind 
you about them. You can schedule recurring events, such as 
birthdays or weekly meetings. You can also keep track of 
important To Do items. 

VIEWING PALMSCHEDULE 

The Six-month View 
and the Month View 

PalmSchedule has four views: six-month, month, week, and day. 
You can quickly move among the views by tapping with the pen. 
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The Week View and 
the Day View 

Use the Event page 
to plan your day. 
Use the Sketch 
page to take notes 
for the day or draw 
a map to a meeting. 

jll!Ociober f9W 41 ~ ~ 
SUN MON TUE WED THU FRI SAT 8:00 

10 "11 12 "13 "14 "15 "16" 9:00-10:00 Staff Meeting 

10:00 

D D D D 

:! -----a-----_ J] __ fl_ --------
1 

11:00 

12:00· 1:00 Lunch with Paul 

1:00 

2:00 

~ ~ D ~ 
3:00 

4:00 

5:00 

~ D 
D D D 

6:00 
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To Do Sketch 

Each day view has three pages: an Event page, a To Do page, and 
a Sketch page. 
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Use the To Do page 
to make a list of To 
Do items for the 
day. 

? 

Priority I New To Doi 

X Coll Grandma 

2 In.tall new comp,.ers 

3 Wedding gift for Wade and 
Jodr 

Event Sketch 

The Six-Month View 

PalmSchedule outlines the current month with a box and 
highlights the current day. 

Tap the date at the top to 
quickly go to a specific date. 
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Tap the right arrow to view the next 
six months, or tap the left arrow to 
view the previous six months. 

September 
SMTWTFS s M roo1:.""'r----Tap a month to go to the month 

view. The current month is outlined 
with a box. 
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Current date is highlighted (shown in 
reverse). 
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The Month View 

PalmSchedule outlines the current day with a box. Use the month 
view as an index to the days. Tap a day to go to that day. 

Tap the Exit icon to return to the six-month 
view. 

Tap the date at the top to display a screen 
that lets you quickly go to a specific date. 
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Tap the right arrow to view the next 
month, or tap the left arrow to view 
the previous month. 

---t----+---+--+----1--ttt- Tap a day to go to display the day 

17 18 "" 19 20 21 "" 22 

24 "" 25 "" 26 27 28 29 

Tap the Week icon to display 
the week view. 

23 

30 

view. If the day contains an event, it 
appears dog-eared. 

Tap the Tool box to annotate the 
month view with ink 

In the month view, you can use the pen and the special Sketch 
tools to write or draw sketches. See "Sketch Page" and "Sketch 
Tools" in this chapter for information on using the Sketch tools. 
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The Week View 

PalmSchedule outlines the current day with a box. Use the week 
view as an index to the days. Tap a day to go to that day. You can 
also see a visual representation of your time schedule. 

Tap the Exit icon to return to the 
month view. 

Week ol!!1_... 
1993 "II 

SUN MON TUE WED THU FRI SAT 

10"'11 12"'13"'14"'15"'16"' 

Tap the right arrow to view the next 
week. or tap the left arrow to view 
the previous week 

~--++---------1--The current day is outlined with 
1 ~ D D a box. 

:~ ____ 1J ______ _o __ ~---------
D 

D 
D 

D D 

Time usage bars show times where 
you've scheduled events. 

Overlapping events 

If the day contains an event or information, it appears dog-eared. 
The week view shows the durations of the events scheduled for 
each day. Dark areas in the time bars indicate overlapping events. 
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The Day View 

PalmSchedule displays the Event page for the selected day. 

Tap the Exit icon to return to the 
month view or week view. 
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Tap the To Do tab to view the 
to do page. 

Tap the Event tab to return to 
the event page from the to do or 
sketch pages. 

Each day has an Event page, a To Do page, and a Sketch page. 

Going to a Specific Date 

You can quickly display a specific day by choosing Go To Day. 
This is often quicker than moving among the PalmSchedule views. 

To go to a specific date 

1. Tap the date at the top of any of the PalmSchedule views. 

or 

Choose Go To Day from the Options menu_ 
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A dialog box appears: 

October 

SMTWTFS 

2 

3 4 5 6 7 8 9 

10 Ill 12 13 14 15 16 

17 18 19 20 21 22 23 

24 25 26 27 28 29 30 

31 

Tap the up or down arrow to 
change the month and year. 

[@Ell I Today 11 Cancel I [TI 

2. Select the month and year you want by tapping the up arrows to 
move to following months or years, or the down arrows to move 
to previous months or years. 

Tap Today if you are viewing another date and want to go to 
today's date. 

3. When the month and year are correct, tap the day of the month. 

4. Tap OK. PalmSchedule displays the day view for the date. 
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USING THE EVENT PAGE 

The Event page lists your schedule for the day: 

8:00 

9:00-10:00 Staff Meeting 

10:00 

11:00 ------------ttr-- Tap a time period to enter an event 
12: 00- 1:00 Lunch with Paul for that time. 
1:00 

2:00 

3:00 

4:00 

5:00 

6:00 

700- 900 -Seftba\I 

To Do Sketch 

Adding an Event 

On the PalmSchedule Event page, you can: 

• Schedule a one-time event 

• Schedule a repeating event 

• Set an alarm for an event 

You can also change the starting and ending times of the day and 
the durations of the time slots. For information, see "Setting 
PalmSchedule Preferences" in this chapter. 

To schedule an event 

1. Tap the time slot you want to schedule. 

or 

Choose New Event from the Page menu. 
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The Edit Event dialog box appears: 

-Edit Event [6J Ink tool 
A• x +- OK I cancel I 
Time I 10:00 AMI to I 11:00 AMI !Al Text tool 

Date I 12/09/931 [i] ~ 
Staff meeting ~ Clear 

El Backspace 

[i] Set an alami for the event 

~ Repeat the event 

[]] 

PalmSchedule automatically enters the beginning and ending 
times for the event based on the time slot you selected. You can 
change the times to make them more precise or move the event to 
a different time. 

2. Enter a description for the event using one of the following 
methods: 

• Tap the Ink tool and then use the pen. Information is stored as 
you wrote it. 

• Tap the Text tool and then use handwriting recognition, the 
floating keyboard, or the optional external keyboard. (For more 
information, see Chapter 1.) 

3. To change the starting time for the event, tap the starting time 
button, then select the time in the dialog box that appears. Tap 
OK. 

You can indicate that an event has no starting time by tapping 
None. 

4. To change the ending time for the event, tap the ending time 
button, then select the time in the dialog box that appears. Tap 
OK. 

You can indicate that an event has no ending time by tapping 
None. 

To enter an alarm for the event, tap the Alarm icon. A dialog box 
appears: 

Alcinn 

<>No Alarm 
+r~:1:~:!i:~.f~:f._iTI···0e:ro·r:e:···E·;:1"~:~Il 

5 !!J l Minute(s) -J 
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6. Tap Ring Alarm Before Event to set the alarm. 

If you select No Alarm, the alarm does not sound. 

7. Set the amount of time prior to the event that you want the alarm 
to ring by tapping the up or down arrow. 

You can change time prior to the event that you want the alarm to 
ring in minutes to hours or days. Tap Minutes. A drop-down list 
appears. Select Hours or Days. 

8. Tap OK to accept your changes. 

If an alarm is set for an event, you see a black triangle in the right 
comer of the alarm icon. 

9. Tap OK to return to the day view Event page. 

Adding a Repeating Event 

You can add an event that occurs on a regular basis, such as a 
weekly staff meeting, a monthly company meeting, or a birthday. 
You only need to add the event once. You can add the following 
periodic events: 

• Daily (for example, every day at 2:00). 

• Weekly (for example, every Friday). 

• Monthly by date (for example, the 15th of every month). 

• Monthly by day (for example, the second Saturday of each 
month). 

• Yearly (for example, every year on July 18). 

To add a repeating event 

1. On the Event page, tap a time slot. A dialog box appears. 

I ~ I 2. Tap the Repeat icon. A dialog box appears: 

Repeating Event 

Every 1 r.Jl I Week(s) 
Starting I 10/14/931 
<)Until . . 

<>J'.9.r..m•m•mm••••• I 10/ 14/93 I f- Frequency pop-up menus 

+[i=()l::~Y~l::i 1 r.JJ L Day(s) __....Ji-

3. To change the frequency, tap the Frequency drop-down list to 
select Days, Weeks, Month/Date, Month/Day, or Years. 

4. Select the event frequency by tapping the up or down arrow to 
increase or decrease the number after Every. 
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5. Next, select one of the following: ending date, time interval, or 
forever. 

To select an ending date, tap Until. Then tap the date and select a 
new date. 

To select a time interval, tap For. Then select the number of Days 
(or select Weeks, Months, or Years from the drop-down list). 

Select Forever to repeat the event forever. 

NOTE 
If the starting and ending dates are the same, the event does not 
repeat. If you select a time interval less than the repeat interval, 
the event does not repeat. 

6. Tap OK. If the event repeats, you see a black triangle in the repeat 
icon. 

7. Tap OK to return to the day view Event page. The repeating event 
appears in the Event pages. 

HINT 
To enter an event that occurs yearly on a specific day (such as a 
holiday), use the Month/Day event and have it repeat every 12 
months. 

Editing an Event 

You can change the information about an existing event or delete 
an event from your schedule. 

To delete an event 

1. On the Event page, tap the event you want to delete. 

2. Tap the Clear icon, then tap OK. 

To change an existing event 

1. On the Event page, tap the event you want to change. A dialog 
box appears. To convert your ink into text, tap the Text icon. 

2. Make any changes you want, then tap OK. 

To change a repeating event 

1. On the Event page, tap the repeating event you want to change. A 
dialog box appears. 

or 
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Choose Repeating Events from the Options menu. A list of 
repeating events appears. Tap the event you want to change. 

2. Make any changes, then tap OK. 

Showing and Hiding Empty Events 

The Event page lists all time slots in the day, even if you have not 
scheduled an event for each time slot. To save space on the 
screen, you can choose to show only those time slots that contain 
a scheduled event. 

Show Empty Times on the Options menu allows you to display or 
hide empty time slots. 

Showing Event Duration 

The Event page time slots list the starting time for the events. You 
can choose to show the duration for scheduled events - for 
example, 11:00-12:30. 

Show Event Duration on the Options menu allows you to display 
or hide Event duration. 
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USING THE TO DO PAGE 

The To Do page lets you write a list of To Do items for the day. To 
Do items appear on each subsequent day until you mark them as 
complete. 

? 
rage Qptions 

~Monday 11 ~s;r3 ~ 
Priorit)' 

X Call Grandma 

Tap the right arrow to view the to 
do page for the next day, or tap the 
left arrow to view the to do page of 
the previous day. 

2 Install new computers 

2 bry deani~ 
~--tt- Tap the New To Do button to 

entera To Do item. 

3 Wedding gift for Wade and 
Jody 

Event Sketch 

Adding a To Do Item 

On the PalmSchedule To Do page, you can make a list of items to 
remember or accomplish. You can also set a priority for each item. 

To add a To Do item 

1. Tap the New To Do button. 

or 

Choose New To Do from the Page menu. 
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A dialog box appears: 

' Priority pop-up menu 

[614 [Kl,[£] 
Priority [!'.3 
Call Fred 

2. Enter a description for the To Do item using one of the following 
methods: 

• Tap the Ink tool to write with the pen and leave it just as you 
wrote it. 

• Tap the Text tool and then use handwriting recognition, the 
floating keyboard, or the optional external keyboard. (For more 
information, see Chapter 1.) 

3. Tap the Priority drop-down list and assign a priority to the item. 

Priority 1 is the highest; priority 3 the lowest. Items are listed in 
order sorted by priority, and then the date entered. 

4. Tap OK. 

Editing a To Do Item 

You can change the information about an existing To Do item, 
delete the item from your list, or mark an item as complete. 

To change or delete an existing To Do item 

1. On the To Do page, tap the item you want to change or delete. A 
dialog box appears. 

2. Make any changes you wish to edit the item, or tap the Clear icon 
to delete the item. Then tap OK. 
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To mark an item as completed 

1. On the To Do page, tap the item you want to mark as complete. A 
dialog box appears. 

2. Tap Complete to mark the item as complete, then tap OK. 

If the check box is empty, the item is not complete; if it is solid, 
the item is complete. If completed, the item remains on the To Do 
page on the day it was completed, marked with an X. 

Showing All To Do Items 

The To Do page lists the To Do items for the current day. You can 
choose to show all the To Do items in PalmSchedule on the To Do 
page, even those that start in the future, or you can display only 
today's items. 

The To Do items are listed by priority, and then by date entered. 

Show All To Do's on the Options menu allows you to display all 
To Do items or only today's. 

SETTING PALMSCHEDULE PREFERENCES 

You can set these options for PalmSchedule: 

• The duration of each time slot 

• The starting time for each day 

• The ending time for each day 

• The amount of time before an event that the alarm rings 

• The starting day for each week 

The preferences you set apply to the entire PalmSchedule, not a 
specific day. These settings are defaults - preset values 
PalmSchedule uses on the Event page unless you change them for 
a specific event in the Edit Event dialog box. 
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To change PalmSchedule preferences 

1. Choose Preferences from the Options menu. A dialog box appears: 

PahnScf)eclule Prefer-ences 

Event Duration I [JJ Hour(s) 

Day Start Time I [8:00 AM] I 
Day End Time I 8:00 PM I 
Alarm._Advance 5 [JJ I Minute(s) -I 
Week Start Day I Sunday -I 
~ I Cancel I [!] 

2. Change these settings to customize your PalmSchedule: 

Event Duration. Tap the up or down arrow to increase or 
decrease the time slot in the day view by one hour. 

Day Start Time. Tap Time to choose the start time for the Event 
page. Choose hours, minutes, and AM or PM from the dialog box. 

Day End Time. Tap Time to choose the end time for the Event 
page. Choose hours, minutes, and AM or PM from the dialog box. 

Alarm Advance. Tap the up or down arrow to increase or 
decrease the alarm advance time by one minute. Tap the Minutes 
drop-down list to select Hours or Days. 

Week Start Day. Choose a day of the week from the drop-down 
list. The weeks in the week, month, and year views will start on 
this day. 

NOTE 
Events that start before the day starts or end after the ending time 
appear on the day view, but may not show up on the week view. 

PURGING PALMSCHEDULE 

You can remove outdated PalmSchedule items or items up to the 
date you specify. This is useful when you need more memory 
space for other documents. 
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To purge PalmSchedule 

1. Choose Purge from the File menu. A dialog box appears: 

PLwge 

Purge Data Before This Date 

1!09/ 15/93:1 

I Purge I I Cancel I [I] 

2. If you want to change the date listed, tap Date, then set the purge 
date you want. (PalmSchedule initially displays a purge date one 
month prior to the current date.) 

3. Tap Purge. 

PalmSchedule removes all PalmSchedule items (Sketch pages, 
Events, and completed To Do's) that occurred before the purge 
date. Repeating events that repeat after the purge date are not 
removed. 

CREATING A NEW PALMSCHEDULE DOCUMENT 

When you first start PalmSchedule, a date book document, called 
Date Book, is automatically created for you. You can have more 
than one PalmSchedule document - for example, one for 
business events and another for personal events. 

To create a new PalmSchedule document 

1. Choose Switch Document from the File menu. 

2. Tap the New button. 

3. Give the new document a name, then tap Create New Document. 
The six-month view in the new document appears. 

Switching to a Different PalmSchedule Document 

You can switch among your PalmSchedule documents whenever 
you want. 

To change PalmSchedule documents 

1. Choose Switch Document from the File menu. 

2. Tap Open. A list of your documents appears. 

3. Tap the document you want to use, then tap Open. 
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PalmNotes 

PalmNotes is a place to write notes, make lists, draw sketches, or 
store information. 

VIEWING PALMNOTES 

The table of 
contents of pages 
and the Sketch 
page view in 
Palm Notes. 

PalmNotes has two views: a table of contents and a Sketch page. 
You can quickly move between the views with a tap of the pen. 

.=£ . W! . ?I . 
file J;;dit !:'.age Qptions 

Jleference jNewl 
@I A5TRONOMY 1 

~ - - - - - - - -
@I Terms 2 

- - - - - - - - - -
@I n~ Plo.\'1.et:, 3 

- - - - - - - -
@I Planetary Sizes 

- - -
4 

@I Moon Phases 5 
- - - - -

@I Br1~~1'eot 5-kir~ ______ 6 

@I Physics - - - - - - - - - - -
7 

I @I Basic Formulas ___ 8 

! @I Heating Terms - - -
9 

@II 5t~bols_ - - - - - - - - - - - - 10 
. @I Proofreaders Mar 1 I 

@I Diacritical Marks 12 r - -

Ta a a e number or a e p pg pg 
name to see the page. 

-.=£ 
file J;;dit 

~Planetary Sizes 

Edge of the Sun 
0 Mercury 

Q Venus 

0 Earth 

0 Mars 

-~: ~ :_:.::::·: -. Asterods 

0 ""'~ 
Saturn 

Tap the Exit icon to return to 
the table of contents. 

? • 
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You can organize your notebook pages into topics by grouping 
several pages under a main topic page. You can then use the table 
of contents view to display a list of pages or topics in your 
PalmNotes document. 

NOTE 
To move to a page from the table of contents, tap the page number 
or title once with the pen. Holding down the pen on the page 
number or title does not display the page. 

ADDING A PALMNOTES PAGE 

There are several ways to add a new page to your PalmNotes 
document. 

To add a new page from the table of contents 

1. Tap the New button at the top of the table of contents page. 

or 

Choose New Page At End from the Page menu. 

The new page appears at the end of the PalmNotes document. 

2. Tap the page number to display the new page. 

To add a new page from a Sketch page 

• Tap the New button at the top of a Sketch page. 

or 

Choose New Page Here from the Page menu. 

The new page appears after the current page. 

To enter information on the page 

1. To give the page a title, tap the title area. A dialog box appears in 
which you enter the title: 

? 
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This title appears in the table of contents. (A note title is optional, 
but it is a good idea to use one so that you can look up the note in 
the table of contents.) 

2. Enter text or ink on the PalmNotes page. See "Sketch Page" and 
"Sketch Tools" in this chapter for a description of the Sketch page 
and information on using the Sketch tools. 

CREATING GROUPS OF PAGES 

You may want to keep several PalmNotes pages together. You 
group pages by indenting them under the first page. You can show 
or hide the grouped pages in the table of contents. 

To group the new pages under the first page 

1. Create the pages you want grouped together. Make sure that the 
first page of the topic is the first page in the group. 

2. If you are on the Sketch page, tap the Change View icon to return 
to the table of contents. 

3. Drag the name of a page you want to indent to the right. 

Drag the name of a page to the left to return the page to the top 
level. 

NOTE 

The table of contents displays all the pages in a PalmNotes 
document, even those pages grouped under another page. You 
can choose to display only the main page without its grouped 
pages, by "collapsing" the group. 
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EXPANDING AND COLLAPSING THE TABLE OF CONTENTS 

You can show or hide grouped pages in the table of contents. 

I~ . • . ?IQ 
file ~dit fage .Qptions 

Reference jNewl 

~ A5TRONOMY ________ 1 
f"" 

~Terms 2 

~ 
Th{. Pl a.\'1.ct~ -- ------ 3 

- - - - - - - -
~ Planetary Sizes __ . 4 

~ Moon Phases 5 
- - - - -

~ Br1~~te>I- 5-l«r~ - - - - - -
6_ t-

I li!!J Physics ___________ 7 

~ 5y11-tb0is 10 
- - - - - - - - - - - - -

~ Proofreaders Mar 11 

~ Diacritical Marks 12 
- . 

~ 

Ta to colla se a es. p p pg 

I--

I-

Group of pages on one topic. 
Grouped pages showing (expanded). 

Grouped pages hidden 
(collapsed). Icon changes to 
show that pages are hidden.Tap 
to expand the pages. 

To hide the grouped pages in a topic 

1. Display the table of contents. 

2. Tap the single-page icon for the main page that has visible 
grouped pages. This hides all the grouped pages. The page icon 
changes to show that the main page has hidden grouped pages. 

NOTE 

You can hide all the grouped pages in the table of contents by 
choosing Collapse All Pages from the Options menu. 

To show the grouped pages in a topic 

• Tap the multi-page icon for the main page that has hidden 
grouped pages. This shows all the grouped pages for that main 
page. 

NOTE 

You can show all grouped pages in the table of contents by 
choosing Expand All Pages from the Options menu. 
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MOVING A PAGE IN THE TABLE OF CONTENTS 

You can move a page to a new location in the table of contents by 
dragging the name of the page to a new location. 

HINT 

If you want to move grouped pages as a group, first collapse the 
group, then move it. 

DELETING A PALMNOTES PAGE 

Once you delete a PalmNotes page, you cannot recover it. 

To delete a PalmNotes page 

1. Display the PalmNotes page you want to delete. 

2. Choose Remove Page from the Page menu. 

CREATING A NEW PALMNOTES DOCUMENT 

When you first start PalmNotes, a notebook document, called Note 
Book, is automatically created for you. 

To create a new PalmNotes document 

1. Choose Switch Document from the File menu. 

2. Tap the New icon. 

3. Give the new document a name, then tap Create New Document. 

The new document is now the current one. 

Switching to a Different PalmNotes Document 

To change PalmNotes documents 

• Tap the name of the new document at the top of the table of 
contents. 

or 

1. Choose Switch Document from the File menu. 

PALMNOTES 2.39 



2. Tap Open. A list of other PalmNotes documents you have created 
appears. 

3. Tap the document name you want to use, then tap Open. 
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World Clock 

World Clock is a desk 
accessory. 

World Clock displays the current date and time for two cities: 
home and destination. The clock also shows time zones and the 
location of the destination city. The daylight bar across the top 
shows where it is daytime and where it is nighttime (the darker bar 
indicates nighttime). 

l:lrfi Worlcl Clock - 10:40 AM Ila 
Selected Time Zone: 
7:40 AM Fri 10/ 15/93 

.-----~---l----J- Tap an area on the map to 
display its time zone and 
check the time there. 

IL..:..:H::::o.:.:m=·::i----~1~0~=4~0~A~M~F~r~i ~10~/~15~9~31_ Tap the Home button to 
Washington, D.C., U.S.A. change the home city. 
l Dest' t' 12:40 AM Sat 10/ 16/93 

Tap the Destination button 
Tokyo, .Japan to change the destination 
I Set Clock Options ... I city. 

NOTE 

To set the time and date for World Clock, use the Date & Time 
option in Preferences. See "Preferences" in Chapter 4 for more 
information. 
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CHANGING THE HOME CITY OR DESTINATION CITY 

You can easily change the home city or destination city. 

To change the home city or destination city 

1. Tap the Home button or the Destination button, as appropriate. 
You see a list of country and city names in alphabetical order. 

2. Tap the country and then the city you want to select as the home 
city or destination city. 

3. Tap OK. 

SELECTING BY COUNTRY OR CITY 

After you tap Home or Destination, a list of countries and cities 
appears. You can display this list in two different formats. In one 
case, the countries appear in a list on the left and the cities in a 
selected country appear in a list on the right. Alternatively, only 
one list of cities, followed by its country, appears. You can switch 
between the two displays by tapping Select by City. 

ADDING YOUR OWN HOME TOWN 

If your home town does not appear on the list of names, you can 
add it and indicate its location. 

To add your home town 

1. Tap Set Clock Options. A dialog box appears: 

Set ( lo( k Options 

!;Jock: Qaylight Sauing5: 
+Home DHome 
<> Destination o Destination 

User City Name: 

lsan Jose 

L Set Location J 
I OK I I Cancel I [!] 
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2. Enter your home town name in the User City Name entry box, 
using handwriting recognition, the floating keyboard, or the 
optional external keyboard. 

3. Tap Set Location. A dialog box appears: 

-=£ 
Selected Time Zone: 
7:4 1 AM Fri 10/ 15/93 

Tap on the map to indicate where 
your city is. When finished tap on OK. 
World Clock determines the time 
from the last location tapped. 

4. On the map, tap the location of your home city. 

5. Tap OK twice to return to World Clock. 

6. Tap Home. 

7. Select Use <your city name> at the bottom of the dialog box and 
then tap OK to close the dialog box. 

CHECKING THE TIME 

To check the time in a specific time zone 

• Tap the map in the desired location. 

The time zone displayed above the map as the Selected Time Zone 
changes to show the date and time in the selected time zone. 

CHANGING TO DAVLIGHT SAVINGS TIME 

You can indicate that a home city or a destination city or both 
observe daylight savings time. 
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To set Daylight Savings Time 

1. Tap Set Clock Options. 

2. Under the heading Daylight Savings, tap Home or Destination (or 
both) to indicate that one or both of these cities currently observe 
daylight savings time. 

NOTE 

Daylight Savings is set for a specific city, not a time zone. The time 
displayed for the city might not match the time displayed for the 
selected time zone. 

CHANGING THE SYSTEM CLOCK 

Normally, you set the unit's system clock using Preferences. The 
unit uses the system date and time for PalmSchedule, for other 
applications, and for date-stamping files. In World Clock, you can 
quickly change the system clock to the time and date of the home 
or destination city. The current system time appears at the top of 
the world map. 

To change the system date and time to those of the destination city 

1. Tap Set Clock Options. 

2. Under the heading Clock:, tap Destination. 

3. Tap OK. A dialog box appears asking you to confirm your 
decision. If you tap Yes, the unit's system clock is set to the date 
and time of the destination city. 

To reset the system clock to the home city's date and time, follow 
the above procedure, but tap Home instead of Destination in 
step 2. 

NOTE 

City names and time differences are based on information 
available as of February 1993. Some of the city and country names 
are abbreviated. 
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CHAPTER 3 

Using GeoWorks 
Applications 

This chapter describes functionality that is common to the 

GeoWorks applications. It includes information about the various 

user levels available in each application and explains how to copy 

and back up documents as well as how to work with templates, 

annotations, and tool bars. Additional information about working 

with GeoWorks applications and documents is provided in 

Chapter 1. 



Working With User Levels 

You can make many of the GEOS applications as simple or as 
sophisticated as you want. Typically, the more functions an 
application has, the more difficult it is to learn. GEOS allows you 
to start using an application with only a few functions so that it is 
simple and easy to use. As you gain experience, you can add more 
functions to an application. Altering the number of functions 
available to you is called changing the user level. 

Each GEOS application has a number of user levels appropriate to 
its size. GeoWrite has four levels; simpler applications, such as the 
Scrapbook, have two levels. Applications used for a specific task, 
like GeoComm, have no user levels at all. 

The following is a general description of each user level: 

Level 1, Introductory Level. Level 1 is for first-time users. It 
includes the application's simplest features. Use Level 1 to learn 
the basic operation of the application. 

Level 2, Beginner Level. Level 2 is for users who are comfortable 
with Level 1 and want to use more of the application's capabilities. 
Level 2 is also designed for infrequent users or those with simple 
requirements. If these are your needs, you may not need to move 
beyond Level 2. 

Level 3, Intermediate Level. Level 3 is for users familiar with 
basic operations who want to learn complex functions and 
procedures. Level 3 includes as much functionality as possible 
without appearing to be overwhelming. 

Level 4, Advanced Level. Level 4 is for users of complex 
functions and procedures. Level 4 includes all the functionality of 
an application. 

3.2 USING GEOWORKS APPLICATIONS 



The first time you start an application with multiple user levels, the 
application will start at Level 1. For information about changing 
your user level, see "Verifying, Changing, and Saving Your User 
Level" in this chapter. 

If you are using an application with fewer than four user levels, 
the highest level of that application may include a task that is 
available only at a higher level in another application. For 
example, a task available at Level 3 in GeoWrite may be available 
at Level 2 in Scrapbook because Scrapbook only has two levels. 

DIFFERENCES FROM LEVEL TO LEVEL 

Within an application, each user level builds on the previous level. 
For example, Level 2 has all the features of Level 1 plus some new 
features. The menu bar displays the functions that are available at 
the selected user level. When you move from one level to the 
next, the menu bar is rearranged to accommodate the features of 
the new level. All the features from the previous level are still 
available, but they may be organized differently across the menu 
bar. 

VERIFYING, CHANGING, AND SAVING YOUR USER LEVEL 

You can change or verify your user level while you're working in 
an application or when the New/Open dialog box is displayed. 
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To verify or change your user level 

1. If the New/Open dialog box is displayed, tap the User Level 
button. Otherwise, choose Change User Level from the Options 
menu. The Change User Level dialog box appears. The highlighted 
button indicates the level at which you are currently working. 

Cf1ange User' Level 

Change User Level 
Introductory text editing and formatting. 

General-purpose word processing. 

Cf) Full-featured word processing with simple 
c:J page layout and graphics. 

r-0~,---1 Desktop publishing and advanced word 
processing. 

To save your user level, choose Save 
Configuration from the Options menu. 

I OK I I .Eine Tune ... I I Cancel I [I] 

2. If you want to change user levels, tap a button for a different level; 
then tap OK. Your user level is changed for the current session 
unless you change it again. 

or 

Tap Cancel if the current level is the one you want to work at. 
Your user level is unchanged. 

If you always want the application to start at the user level you 
have just selected, choose Save Configurations from the Options 
menu. (If the New/Open dialog box is displayed, you will need to 
close it before you can choose from the Options menu.) 

When you save the configuration of an application, your user level 
and other options are remembered after you exit the application. 
For more information about saving your configuration, see 
"Customizing Applications" in this chapter. 

FINE TUNING YOUR USER LEVEL 

Instead of using the preset user levels, you can create your own 
customized user level. Each application has a set of features that 
you can tum on or off. Typically, Level 1 has the fewest features 
turned on; Level 4 has the most features turned on. The features 
you can fine tune vary from application to application. 
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To fine tune a user level 

1. If the New/Open dialog box is displayed, tap the User Level 
button. Otherwise, choose Change User Level from the Options 
menu. The Change User Level dialog box appears. 

2. To see which features make up a user level, tap that user level and 
then tap Fine Tune. The Fine Tune dialog box appear~. The 
combination of features that are turned on and off defines the user 
level you selected. 

Fine Tune 

Fine Tune GeoFile Features 
o Qesign Mode 
o Qraphics Layer 
o Field Qrganizer 
o .!julti-Record Layout 
o Advanced [ield Properties 
o Field !ab Order 
o gecord Order 
• Mar~ Records l 
• f!dvanced Sort ---------<>-Jt- Features that are on 
•Mark ~y Formula 
o Ad~anced Graphics and Text 

l!OK!I I Cancel I [!] 

3. To change the available features, tap any feature to turn it on or 
off. Selected features have a darkened check box. 

4. When you finish selecting and deselecting features, tap OK. The 
Change User Level dialog box reappears. If the changes you made 
coincide with a predefined user level, its button is highlighted. If 
the changes you made do not coincide with a predefined user 
level, none of the user level buttons is highlighted. 

5. Tap OK to return to the document at the user level you have 
defined. 
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Working With Documents 

An application's File menu allows you to create and work with 
documents. Most applications have a File menu with some or all of 
the following choices: 

....... 
S!!:!itch Document... 

~:~five 

Save fls ... 
§ackup 
Qther 

f'.rint... 
Page Si~e ... 
Page Setup ... 

E~it 

Ctr! '.:i 

.... 

.... 

Ctrl P 

F3 

Switch Document. Displays the New/Open dialog box, from 
which you can create a new document, edit an existing document, 
use a template, or import data from a DOS application. 

Save. Replaces the old document with the new, changed version. 

Save As. Saves the current document under a different name. The 
original document is unchanged. The new document is open for 
editing. For more information, see "Saving a Document Using Save 
As" in this chapter. 

Backup. Displays the Backup submenu which allows you to back 
up and retrieve documents. For more information, see "Backing 
Up and Restoring a Document" in this chapter. 
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Other. Displays the Other submenu which includes functions 
such as copying, exporting, and renaming documents. For more 
information, see "Other Submenu Choices" in this chapter. 

Print. Allows you to set various printing options and print the 
document. For more information, see Chapter 1. 

Page Size. Allows you to set various page size and layout options. 
For more information, see Chapter 1. 

Page Setup. Allows you to specify various page attributes. Since 
Page Setup offers different options depending on the application 
you are using, see the chapter for that application for more 
information. 

Exit. Closes the currently opened document and exits the 
application. 

SAVING A DOCUMENT USING SAVE AS 

LEVELS 3-4 You can save a document under a different name using the Save 
As choice on the File menu. When you choose Save As, you create 
a copy of the document and give it a new name. 

Save As serves many useful purposes. For example, suppose you 
wrote a resume last year and named it "Resume 1992." This year 
you want to revise it, but you also want to keep the original intact 
so you can refer to it. You can open "Resume 1992" and 
immediately save it as "Resume 1993." The original document, 
"Resume 1992," is preserved on disk and "Resume 1993" appears 
in the document window so that you can edit it to account for 
changes in the past year. 
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To save a document using Save As 

1. Choose Save As from the File menu. A standard file selector 
appears with the current name of the document in the New Name 
text entry box: 

Save As 

Save document with a new name. 
l'i:'.;;·i.i):] ['6()i()ij()(:~~ir\()i)i! I Dri~es -I 

[!:/'!!~~!~'' •••w~ 
Saving to Folder: DOCUMENT 

New Name: 1111111 
l~imple I ncel 

Your document will be saved 
in the folder listed here. 

Type the new name here. 

For more information about standard file selectors, see "Opening 
and Closing Applications and Documents" in Chapter 1. 

2. Type the new name, which replaces the current name of the 
document. The new name appears in the text entry box. 

3. Tap Save to save the document using its new name. The original 
document is closed and remains as you last saved it. Any recent, 
unsaved changes are saved to the new version only, which 
appears in the window ready for editing. If you continue editing 
the version in the open window, you are editing the new 
document. 

BACKING UP AND RESTORING A DOCUMENT 

LEVELS 2·4 When you back up a document, you make a quick copy of the 
document in its current state. When you restore a document, you 
replace the current document with its most recent backup. 

You can make backup copies of documents manually by using the 
copy function in GeoManager, but it is much easier to use the 
backup features found on the Backup menu. 

Backing up is like freezing a copy of a document in time. When 
you save a document, any changes you've made are saved to disk, 
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Each time you select 
Make Backup, you 
create a backup of 
the current version oj 
the document, which 
overwrites the 
previous backup. 

When you restore 
from a backup, it 
replaces your current 
document, so be sure 
this is what you want 
to do. 

but the changes are only saved to the current version, not to the 
backup copy. This way, if you restore from a backup copy, the 
document reverts to the state it was in when you backed it up, 
even if you have s~ved your document many times since then. 

Backing Up a Document 

Backing up is particularly useful if you are about to make a 
significant change to a document. It lets you keep a copy of the 
current version to protect you if you regret the change. The 
backup feature makes a copy of the current version of a 
document. Each backup you save replaces your most recent 
backup. 

To make a backup of a document, choose Backup from the File 
menu, then choose Make Backup from the submenu. 

Restoring From a Backup 

Restore From Backup recovers the most recent backup copy of a 
document created by using Make Backup. This choice is available 
only if you have created a backup by choosing Backup from the 
File menu. When you restore from a backup, the previously 
backed up version of the document overwrites the current version 
of the document. 

To restore from a backup, first make sure the document you want 
to restore to is open, then choose Backup from the File menu and 
Restore From Backup from the submenu. 

NOTE 

You can recover a backup even if all original copies of the 
document have been destroyed. Backup copies of your documents 
are stored in the GEOWORKS\USERDATA\BACKUP folder. 
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OTHERSUBMENUCHO~ES 

LEVELS 2-4 

LEVELS 2-4 

LEVELS 2-4 

The choices on the Other submenu of the File menu are described 
in this section . 

. -+t 
_!;;opy To ... 

i;xport Document ... 
.QL:icani Chr:mqes 
gename ... 

~ave as Template ... 

Edit Document !::!Otes ... 

Set Document Iype ... 

Empty Document • 

Copying a Document 

To create a copy of a document that is currently open, you can use 
Copy To from the Other submenu. When you choose Copy To, the 
standard file selector appears so that you can create a copy of the 
current version of a document and give it a new name. The copy 
of the document with the new name is saved and closed, while the 
original document is left open so that you can continue editing it. 
This is in contrast to Save As, which saves the current version of 
your document with a new name and leaves it open, while closing 
the original document without saving any changes to it. For more 
information about standard file selectors, see "Opening and 
Closing Applications and Documents" in Chapter 1. 

Exporting a Document 

Export Document allows you to export a document to another 
application. For detailed information on exporting, see the 
chapters for those applications with exporting capabilities. 

Discarding Changes 

Occasionally, you may make changes to your document that you 
do not like. Use Discard Changes on the Other submenu to undo 
changes you wish you had not made. Discard Changes restores a 
document to its last saved version, eliminating any changes you 
have made since you last saved it. 
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LEVELS 2-4 

LEVEL 4 

LEVELS 2-4 

You cannot add 
document notes to 
an untitled docu
ment. You first must 
save the document 
and give it a name. 

You can put this feature to good use when you want to ex
periment. For example, if you want to rearrange your address 
book, you can save it before you begin the experiment, then if you 
do not like the new layout, you can use Discard Changes to go 
back to the original. 

If Discard Changes is dimmed, you have not made any changes 
since the last time you saved. 

Renaming a Document 

When you rename a document, you change its name. You may 
want to rename a document so that its name more closely 
identifies its contents or purpose. You may also want to rename a 
document if you want to use its original name for another 
document. 

If the Rename choice is dimmed, the document is probably a read
only document. For more information about read-only documents, 
see Chapter 9. 

Saving a Document as a Template 

Save as Template allows you to save a document as a template 
when you create a new template or when you modify a template 
you have previously created. For detailed information, see 
"Templates" in this chapter. 

Editing Document Notes 

You can add document notes to any document. Document notes 
consist of important information you might want to record about 
your document. For example, you can use document notes to 
keep a revision history of a document. If someone else modifies 
the document, they can read your notes and add their own. 

Notes accompany a document, but they are not an integral part of 
the body of the document. You can see a document's notes in the 
Notes box of a standard file selector whenever you open an 
existing document. You cannot add document notes to DOS data 
files, including DOS text files edited with Text File Editor. 
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LEVELS 2-4 

Customizing the Empty Document Settings 

When you open a new document in any application, an empty 
document appears. This "empty document" actually contains 
GEOS-defined settings, such as the font and margins. These 
settings are called the def a ult settings. The following are common 
items that have default settings: 

• Page size 

• Margin size 

• Font 

• Text style 

• Text size 

• Tab settings 

• Number format (GeoCalc) 

• Column width (GeoCalc) 

• Field size (GeoFile) 

If you typically use settings in your document that are different 
from the GEOS-defined default settings, you can change the 
default settings for your empty document. 

To change the default settings for an empty document (Levels 2-4) 

1. Create a new document and set the document characteristics as 
you want. 

2. Choose Other from the File menu. A submenu appears. 

3. Choose Empty Document from the Other submenu. A submenu 
appears. 

4. Choose Set Empty Document from the Empty Document submenu. 
A confirmation message appears. 

5. Tap Set Empty Document. Subsequent new documents will have 
the settings you saved, as well as any information that was in the 
document when you saved it. 

NOTE 

Changing and saving the empty document does not change 
existing documents. If you want to change the settings of existing 
documents, you must do so individually. 

To revert to the original GEOS-defined def a ult settings (Levels 2-4) 

1. In any open document, choose Other from the File menu. A 
submenu appears. 
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TEMPLATES 

2. Choose Empty Document from the Other submenu. A submenu 
appears. 

3. Choose Reset Empty Document from the Empty Document 
submenu. (If this choice is dimmed, either the empty document's 
original default settings have not been changed or they have 
already been reset to the original settings.) A confirmation 
message appears. 

4. Tap Clear Empty Document. Subsequent new documents will have 
the original GEOS-defined default settings. 

Most GEOS applications include templates, ready-made documents 
that can save you time because all the layout work is done for you. 
Templates help you create new documents faster and more easily 
and also help maintain a consistent look among documents. In 
addition to the templates provided with the applications, you can 
design your own templates. 

An application's templates are saved in a folder named Templates: 
GeoWrite Templates, GeoCalc Templates, and so on. A template 
contains the text, graphics, formatting, and special layouts 
common to documents of a particular type. For example, if you 
want to write a business letter, you can open the business letter 
template in the GeoWrite Templates folder. 

Using a Template 

When you use a template to create a document, the application 
creates a new document by copying the information from the 
template to a new document. When the new document appears in 
the document window, you simply fill in any missing information 
and change the place holder text. Place holders are text that define 
the type of entry in a location, such as "ZIP CODE". When you use 
a template, you replace the place holders with actual information. 
Changes you make to the new document do not affect the original 
template. 

To create a new document by using a template (All Levels) 

1. If the New/Open dialog box is not visible, choose Switch 
Document from the File menu. The New/Open dialog box 
appears. 
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LEVEL 4 

2. Tap the Template button. A standard file selector appears, listing 
the available templates. 

3. Scroll through the template list. A description of the highlighted 
template, if available, appears in the Notes box. 

4. Tap the name of the template you want to use, then tap the Use 
Template button. A dialog box appears asking you to name the 
new document. 

5. Type a name for the new document and tap Create New 
Document. A new document, based on the selected template, 
appears in the document window. 

6. Fill in any missing information, replace the place holders, and edit 
the document as appropriate. 

NOTE 

When you open a document based on a template, the original 
template is unchanged. Changes you make to the new document 
do not affect the template. 

Creating a Template 

In addition to using the GEOS-defined templates, you can design 
and use your own templates. 

To create a template (Level 4) 

1. Open a new or existing document. 

2. Specify the settings you want to use. For example, in Geo Write, 
you might want to define the following: 

• Page size 

• Margins 

• Text specifications, such as font, size, and style 

3. Add appropriate text and text place holders (such as "City", "State", 
and "Zip Code"). 

4. Add any graphics you want to include (such as a logo). 

5. Choose Other from the File menu. A submenu appears. 
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LEVEL 4 

You cannot modify 
the built-in 
templates, but you 
can modify the 
templates that you 
create. 

6. Choose Save as Template from the Other submenu. A standard file 
selector appears: 

Save As 

Save document as a template. 

Saving to Folder: GeoWrite Templates 

New Name: [ 

f-ijiiv~;··1 I Simple I I cancel I 
J 

7. Enter the name of the new template in the New Name text entry 
box, then tap Save. 

8. A confirmation message appears, reminding you that the 
document is now a template and any changes you make will be 
saved to the template. Tap OK. 

9. If you want to add a document note to describe the template, you 
can use Edit Document Notes from the Other submenu. For more 
information about document notes, see "Editing Document Notes" 
in this chapter. 

10. If you make any additional changes to the template, choose Save 
from the File menu to save your changes. 

Modifying a Template 

You can change any template you have created so that it meets 
your particular needs. You may also want to modify the same 
template in different ways for different situations (such as 
documents for different clients or organizations). 

To change a template you have created (Level 4) 

1. If the New/Open dialog box is not visible, choose Switch 
Document from the File menu. The New/Open dialog box 
appears. 

2. Tap the Template button. A standard file selector appears, listing 
the available templates. 

3. Scroll through the template list. A description of the highlighted 
template, if available, appears in the Notes box. 

4. Tap the name of the template you want to change. 

5. Select the For Editing option in the dialog box, then tap the Use 
Template button. The template appears in the document window. 
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If the For Editing check box is disabled, you cannot change the 
template. 

6. Edit the template until it appears the way you want. 

7. Choose Save from the File menu. 

To create a new template based on an existing template (Level 4) 

1. If the New/Open dialog box is not visible, choose Switch 
Document from the File menu. The New/Open dialog box 
appears. 

2. Tap the Template button. A standard file selector appears, listing 
the available templates. 

3. Scroll through the template list. A description of the highlighted 
template, if available, appears in the Notes box. 

4. Tap the name of the template you want to use as the basis for a 
new template, and then tap the Use Template button. A dialog box 
appears, asking you to name the new document. 

5. Type a name for the new document and tap Create New 
Document. The template document appears in the document 
window. 

6. Make the changes you want to create a new template. 

7. Choose Save as Template from the Other submenu. A dialog box 
similar to the following appears: 

Save Rs 

Save document as a template. 
-. 

L !!!!! Bm:iine~-,,~,, L~;tt.~;r 

L !!!!! Em>~;!()pe " I" 

Saving to Folder: GeoWrite Templates 

l'lew Name: l 
r·~;.;;1;;(;··1 I §imp1e I I cance1 I 

J 

9. Enter the name of the new template in the New Name text entry 
box. 

10. Tap the Save button. 

11. A confirmation message appears, reminding you that the 
document is now a template and any changes you make will be 
saved to the template. Tap OK. 

12. If you want to add a document note to describe the template, you 
can use Edit Document Notes from the Other submenu. For more 
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information about document notes, see "Editing Document Notes" 
in this chapter. 

13. If you make any additional changes to the template, choose Save 
from the File menu to save your changes. 

Removing a Template 

Templates are stored in GEOWORKS\ USERDATA \TEMPLATES. 
You can delete templates from this folder the same way you delete 
any other document. 

NOTE 

You cannot remove the built-in templates because they are stored 
in Read-Only Memory (ROM). You can only remove the templates 
you have created. 
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Changing a Document's View 

You can use the View menu to change the way you view a 
document in a window. 

If you change the view of your window and then choose Save 
Configuration from the Options menu, your settings will be saved. 

ZOOM OUT, ZOOM IN, AND NORMAL SIZE 

Zoom .Qut 
Zoom Jn 

+Normal ~ize 
.Qo to Page ... 
tiext Page 
!:'.reuious Page 

When you open a document, it appears at normal size - the size 
of the document when it is printed. Sometimes you will want to 
make the document smaller on screen, so that you can see more of 
it at once. This is called zooming out. Zooming out is much like 
getting a bird's-eye view of the document. 

Sometimes you will want to make your document look larger, so 
that you can see details more clearly. This is called zooming in. 
Zooming in is like putting a magnifying glass over a small portion 
of the document. 

To reduce the size of a page so that you can see more of it, choose 
Zoom Out from the View menu. Each time you zoom out, you 
reduce the size by 25%. You can reduce the page to 25% of its 
normal size. 

To enlarge the size of a page so that you can see more details, 
choose Zoom In from the View menu. Each time you zoom in, you 
enlarge the size by 25%. You can enlarge the page up to 200%i of 
its normal size. 
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VIEW AT% 

LEVELS 3-4 

SCALE TO FIT 

LEVELS 2-4 

To quickly return to normal size, choose Normal Size from the 
View menu. Normal size is 100% of the size of the document when 
it is printed. 

View at % allows you to choose the percentage of magnification of 
a page. You can choose from any of the preset Zoom Out and 
Zoom In options, or you can set your own percentage. 

To use View at % (Levels 3-4) 

1. Choose View at % from the View menu. A submenu lists the 
standard size reductions and enlargements, plus options for 
normal size, scale to fit, and custom percentage. 

2. To choose one of the standard sizes (including Normal Size and 
Scale to Fit), tap the choice you want. The menu closes and the 
page appears at the selected size. 

or 

To specify a custom percentage between 25% and 200%, choose 
Custom %. The Custom % dialog box appears: 

1:1 Custom % 

Scale (3): ~ B 
~~[I] 

Enter a number or use the arrow buttons to change the value in 
the Scale (%) box. Tap Apply. The percentage you specify is 
applied to the document, and the Custom % dialog box remains 
open so that you can experiment with other values. When you 
have selected the value you want, tap Close to close the dialog 
box. 

Use Scale to Fit when you want to see an entire page of your 
document in the window without scrolling. If you choose Scale to 
Fit, the application automatically sizes the document so that as 
much of it as possible shows in the window. 
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When you choose Scale to Fit from the View menu (or the View at 
% submenu), the view percentage changes, shrinking the docu
ment so that an entire page fits in the window at once, if it can. 

As long as the Scale to Fit option is checked, the document will 
change its size to fit in the window if you change the size of the 
window. This makes it easy to enlarge or reduce your view on the 
page by resizing the window. 

To disable Scale to Fit, you can choose Normal Size from the View 
menu (or the View at percentage submenu) or you can choose a 
percentage from the View at % submenu. 

CHANGING VIEW OPTIONS 

LEVELS 3-4 The View Options choice gives you another way to change the 
way your document appears on the screen by allowing you to hide 
or display the scroll bars. 

When Show Horizontal Scroll Bar is not checked, the document 
window will not display a horizontal scroll bar. Since the scroll bar 
takes up space in your document window, you can hide it to 
increase the available vertical space in which to display the 
document. 

When Show Vertical Scroll Bar is not checked, the document 
window will not display its vertical scroll bar, thereby increasing 
the available horizontal space in which to display the document. 

REDRAWING THE SCREEN 

LEVELS 2-4 When working with a complicated document, you may want to 
use the Redraw choice from the View menu to see an updated 
view of your page. Complicated documents include those with 
many graphic images or customized line spacing. Because it takes 
a long time to redraw a complicated page with complete accuracy, 
GEOS applications opt for speed over accuracy in these situations. 
If you need complete accuracy, use the Redraw choice to 
accurately redraw your complicated page. 
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Working With Tool Bars 

Tool bars provide quick access to menu choices and features in 
the applications. They appear either under the menu bar or to the 
left of the application window. The tool bars contain buttons with 
pictures (icons) representing functions of the application. Some 
tools on the tool bar are buttons that you tap. Others take the form 
of a drop-down list. Tapping a tool is similar to opening a menu 
and selecting a choice. 

The following illustration shows an example of tool bars in an 
application: 

These are the tool bars you can 
see in GeoWrite Level 4. 

Applications can have as many as five tool bars at different levels. 
For example, Level 1 of GeoCalc has no tool bars and Level 1 of 
GeoWrite has only the Style tool bar. 
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Some tool bars contain tools that are unique to an application; for 
example, the Insert Row tool appears only in GeoCalc. 
Application-specific tools are explained in the documentation for 
that application. 

The following are the standard tool bars: 

Style tool bar. Contains tools for changing the format of text. 

Function tool bar. Contains tools for working with documents 
(opening, closing, saving), using the clipboard (cutting, copying, 
and pasting), and performing other functions. 

Drawing tool bar. Contains the drawing tools for drawing objects 
on the page. 

Bitmap tool bar. Contains the bitmap drawing tools for working 
with bitmap objects. 

Graphic tool bar. Contains tools for changing the color, shading, 
and thickness of graphic objects and text. Also contains tools for 
manipulating graphic objects, including duplicating, flipping, 
shuffling, grouping, and ungrouping objects. 

The remainder of this section provides a broad overview of the 
tool bars. For an explanation of individual tools on the tool bars, 
see Appendix A and the chapters for the individual applications 
you are using. 

THE STYLE TOOL BAR 

You can use the Style tool bar to change text characteristics: font, 
text size, and style. In addition, you can use the tools on the Style 
tool bar as shortcuts to perform common word processing 
functions. The following illustration shows the Style tool bar for 
GeoWrite at level 1: 

11~1~1~1 I URW Roman -I I 12 -IIltl OTITII 

The Style tool bar appears at all levels in GeoWrite and at Levels 2 
through 4 in GeoCalc. Text formatting tools from the Style bar 
appear Levels 3 and 4 of GeoFile when you are using Design 
Mode. 
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THE FUNCTION TOOL BAR 

The Function tool bar contains tools to perform file functions, such 
as opening, closing, and saving files. It also contains editing tools 
(cut, copy, paste, and undo) and zooming tools. The tools 
available on the Function tool bar vary depending on the 
application. 

li:i:tl~I 

The Function tool bar is available at Levels 2 through 4 of 
GeoWrite and GeoCalc, though it is not normally shown. Portions 
of the Function tool bar appear at Levels 3 and 4 of GeoFile. 

TOOL BARS FOR DRAWING AND GRAPHICS 

The tools for drawing can be found in one of three tool bars: the 
drawing tool bar, the bitmap tool bar, and the graphic tool bar. 
Because many of the applications support drawing, you will find 
many drawing tools in various applications. 

The Drawing Tool Bar 

IIaC4~1QIAl'1•1•1•1•1Alt"ili""il 

The Drawing tool bar contains the tools for creating graphic 
objects, including lines, circles, and rectangles. 

The Drawing tool bar is available in GeoWrite at Levels 2 through 
4. In GeoCalc and GeoFile the Drawing tool bar is available at 
Levels 3 and 4. 

The Bitmap Tool Bar 

The Bitmap tool bar contains the tools for creating bitmap objects: 

The Bitmap tool bar is available in GeoWrite and GeoCalc at 
Levels 3 and 4. It is not available in GeoFile. 

• 1-1-11 
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The Graphic Tool Bar 

The first part of the Graphic tool bar contains tools for setting the 
color and other attributes (such as line thickness and shading) for 
graphics and text: 

The second part of the Graphic tool bar provides tools for 
manipulating graphic objects, including tools for duplicating, 
flipping, shuffling, grouping, and ungrouping objects: 

The Graphic tool bar is available in Geo Write and GeoCalc at 
Levels 3 and 4. It is not available in GeoFile. 

DISPLAYING TOOL BARS 

Different tool bars are available at different user levels; however, 
the availability of a tool bar does not mean that it is automatically 
displayed. For example, at Level 2 of GeoCalc, the Style and 
Function tool bars are available, but only the Style tool bar appears 
by default. 

You can use the Options menu to tum on and off the display of 
available tool bars. To display a tool bar, choose Show Tools from 
the Options menu. Select the tool bar whose display you want to 
change. If the tool bar was showing, it is now hidden. If it was hid
den, it is now showing. If you want to set the display of tool bars 
for work sessions, choose Save Configuration from the Options 
menu. 
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CUSTOMIZING TOOL BARS 

LEVELS 3-4 You can change the tool bars to fit your needs, choosing to hide or 
display certain tools and to move the tool bars to new locations. 
Tools are organized into groups. The following illustration shows 
the Style Sheet tool group on the Style tool bar in GeoWrite: 

I Style sheet tool group 
~1-~-~1 

1

!12 li:!ill [j] ~ [illjj-:d Normal -I ~ I URW Roman -I I 12 -lll1ll 
IJTlrl:rl · 

You can show or hide individual tools within a group and you can 
move a group of tools as a unit into any position on any tool bar. 
For instance, you can move the document control tools (which 
include Open and Close) from the Function Bar to the Style Bar in 
an application. 

To Hide or Display a Tool (Geo Write Levels 3-4, GeoCalc Level 4) 

1. Display any tool bars you want to work with. 

2. Choose Customize Tool Bars from the Options menu. The 
following dialog box appears: 

Spell Check 
Find and Replace 
Style Sheet 
Justification 
Font 

.. ; !::'.!ove Tool Group ... I Close II}] 

On the tool bars themselves, each individual tool group is 
highlighted with a thick border. 

3. From the list of tool groups, select the name of a tool group. 

or 

Tap a tool on the tool bar. The name of that tool group becomes 
selected in the list. 
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4. Tap Show/Hide Tools in Group. The following dia!Og box 
appears, showing all the tools in the group: 

1:1 St1ow/H1cfe Tools 111 Group 

Select to show, deselect to hide tools: 

Pr-evrous Page Ji'. 
Go to Page 
Next Page 

? 

Any items that are not highlighted are currently hidden. 

5. Tap to toggle the selections on or off. If you want to return to the 
previous display of tools, tap Reset before tapping Apply. 

6. Tap Apply. The tool bars are redrawn according to the selections 
you made. 

7. If you want to show and hide additional tools, you can repeat 
steps 3 through 6 as many times as you like. The dialog boxes stay 
open and you can freely tap in either of them. 

8. When you are finished, tap Close to close the dialog boxes. 

9. If you want to save your customization, choose Save Configuration 
from the Options menu. 

To Move a Tool Group 

1. Display any tool bars you want to work with. 

2. Choose Customize Tool Bars from the Options menu. The 
following dialog box appears: 

Spell Check 
Find and Replace 
Style Sheet 
Justification 
Font 

Group ... I Close IG:] 

3. In the list of tool groups, tap to select the name of a tool group. 

or 
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Tap any visible tool on the tool bar to select that group. 

4. Tap Move Tool Group. The following dialog box appears: 

1:11 Move Tool Group 

Select new location for tool group: 

StL le Bar· (Below menu) :I: 
Function Bar (Below menu) 
Graphics Bar (Below menu) 
Drawing Tools Area (Left side) 

The name of the tool bar where the tool is currently located is 
highlighted. 

If you want to return 5. 
to the previous 

If you want to move the tool group to a different tool bar, select 
the name of the destination tool bar from the list in the dialog box, 
then tap Apply. display of tools, tap 

Reset before tapping 
Apply. 

or 

If you want to move the tool group within the tool bar, tap one of 
the Nudge buttons to move the group in the direction you want. 
Each time you tap one of the Nudge buttons, the tool group moves 
in the direction specified. 

6. If you want to move additional tools, you can repeat steps 3 
through 5 as many times as you like. The dialog boxes stay open 
and you can tap in the tool bars on the window, the Customize 
Tool Bars dialog box, and the Move Tool Group box. 

7. When done, tap Close to close the dialog boxes. 

8. If you want to save your customization, choose Save Configuration 
from the Options menu. 
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Customizing Applications 

ANNOTATIONS 

LEVELS 3-4 

Any graphic object 
can be made an 
annotation. For 
more information, 
see "Advanced 
Graphics" in 
Chapters. 

You can customize certain common features in Geoworks 
applications, to fit better with the way you like to work. 

Annotations are special text and graphic objects that appear on 
your screen but usually do not print. For example, an envelope 
template might show the outline of an envelope so that you can 
see the placement of the addresses. Through the use of 
annotations, the envelope diagram can appear on screen without 
affecting the printout. You can tum these annotations on and off. 

Normally, annotations are set to appear on screen, but not to print. 
By choosing Annotations from the Options menu, you can change 
how annotations behave, such as whether they appear on screen 
and whether or not they print. You can even delete them 
altogether. 

Any changes you make to the Annotations settings are saved as 
part of the document so that you can make your preferred settings 
part of a template. 
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If the options on the 
Annotations 
submenu are 
dimmed, then you 
are probably not 
working with a 
graphics tool. 

RULERS 

Here is an example of the Annotations submenu: 

.--+4 
• J;!raw Annotations 
o f'.rint Annotations 
D!llete Annotations 
Make Annotations ~electable/Editable 
Make Annotations !!nselectable/Uneditable 

Draw Annotations. Displays all annotations on the screen. This 
option is normally checked. Deselect this option to hide all 
annotations. 

Print Annotations. Prints all annotations. Normally this option is 
unchecked so that annotations do not print. 

Delete Annotations. Deletes all annotations. 

Make Annotations Selectable/Editable. Makes all annotations 
selectable so that you can edit them. 

Make Annotations Unselectable/Uneditable. Makes all 
annotations unselectable so that they cannot be edited. 

Most applications use rulers to provide visual measurements. 
Depending on the application, you use rulers to set margins and 
tabs, to work with rows and columns, or to format paragraphs. 

You can change various ruler settings, such as showing or hiding 
the rulers and changing the ruler type and measuring unit: inches, 
centimeters, points, picas, and the system default setting. You set 
the default measurement unit in Preferences. For more 
information, see "Preferences" in Chapter 4. 

DOCUMENT SAFEGUARDING 

You can safeguard your documents by turning on the Safeguard 
feature. When you tum on this feature, GEOS periodically takes a 
"snapshot" of the documents you have open so that they are 
protected in the event of a mishap, such as a power outage. GEOS 
saves a temporary copy of the document automatically so that 
when you restart the unit, the safeguarded copy of the document 
appears. 
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To retrieve your work, you simply open the document you were 
working on. If there were unsaved changes, and document 
safeguarding was able to protect them, a dialog box appears to let 
you know that. Respond to the dialog box and choose Save from 
the File menu to make the changes permanent. 

The document safeguarding feature is different from the "Auto 
Save" feature found in many DOS applications, which actually 
overwrites the document (even if you do not want the changes 
saved permanently). 

You can change how often your documents are safeguarded or 
tum off document safeguarding by using the Look & Feel options 
in Preferences. For more information, see "Preferences" in 
Chapter 4. 

SETTING OPTIONS AND SAVING YOUR CONFIGURATION 

ALL LEVELS You can change an application so that it works the way you want, 
with the tools you like to use and the options set the way you like. 
When you choose these settings, you are configuring the 
application to suit your particular needs. You can change the 
following settings and save them so that they are in effect the next 
time you start the application: 

• Set or fine tune the user level. 

• Adjust the view percentage and view options on the View 
menu. 

• Display and set the ruler. 

• Display and customize the tool bars. 

• Change other options on the Options menu. 

If you want to keep the configuration you have set so that it is in 
effect each time you start the application, save the configuration 
by choosing Save Configuration from the Options menu. 

You can also reset the application so that all options, tool bars, 
and user levels revert to their original settings. To do this, choose 
Reset Configuration from the Options menu. 

3.30 USING GEOWORKS APPLICATIONS 





Calculator 

The Calculator application puts a powerful and versatile calculator 
in your hands. With the Calculator, you can perform simple and 
complex calculations. 

WHAT IS THE CALCULATOR? 

IJ 
Calculator 

The Calculator is a GEOS application. You start the Calculator by 
double-tapping the Calculator icon, which looks like the example 
at the left. 

With the Calculator, you can perform simple task~dding, subtract
ing, multiplying, dividing, and computing percentages. You also 
can perform more complex task~urrency and metric to English 
conversions and trigonometric functions. You can store results in 
the Calculator's memory or paste them into other applications, 
such as GeoComm. You can use worksheets for common 
calculations, such as interest and loan payments. In addition, you 
can customize the Calculator to your liking. 
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THE CALCULATOR WINDOW 

The Calculator is a 
desk accessory. 

When you start the Calculator, the Calculator window appears. 
This window looks like a standard desktop or hand-held 
calculator: 

Menu bar 

Readout bar 

? Q 

file ~dit ~onvert 

Keyboard Paper tape 

The Calculator window includes a menu bar, buttons, readout bar, 
paper tape, and worksheet icons. The window itself is not 
resizable, although items such as the paper tape can be hidden to 
provide more room for calculations. 

The Calculator buttons work like a real calculator's keys. The read
out bar displays numbers you enter and the results of calculations. 
The white area to the right of the buttons works like a desktop 
calculator's paper tap6.'as you enter a transaction, it appears on the 
"paper." The four icons at the bottom of the Calculator window 
allow you to display the various worksheets that are provided with 
the Calculator for performing common calculations. The Calculator 
supports handwriting recognition in the readout bar and other 
input fields. 

BASIC CALCULATOR FUNCTIONS 

You can do the following basic calculations with the Calculator: 
addition, subtraction, multiplication, division, percentage, square 
root, numbers squared, and inversion. You can also store numbers 
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in memory, make measurement conversions, perform complex 
trigonometric functions, and customize the look of the Calculator, 
as described in this chapter. 

The Calculator has two modes you can use: standard or RPN 
(Reverse Polish Notation). Standard mode, sometimes referred to 
as Infix, provides the basic format found on most calculators; you 
use straightforward procedures to enter your calculations. RPN 
mode, also referred to as Hewlett-Packard® style, offers an 
efficient way to enter complex equations, but requires different 
entry procedures from those for a standard calculator. For more 
information on calculator modes, see "Using RPN Mode" in this 
chapter. 

Using the Calculator's Buttons and Keys 

Before performing a calculation, familiarize yourself with the 
buttons that appear in the Calculator window. Some of the 
Calculator's buttons have keyboard equivalent~eys on the floating 
keyboard or on an optional external keyboard that you use to per
form the same action as tapping a button with the pen. The tables 
below describe each calculator button and show the keyboard 
equivalents. 

DELETE AND CLEAR BUITONS 

The following buttons are used to delete or clear your entry. They 
are located just to the right of the readout bar. 

BUTTON KEYBOARD KEV 

C/CE Ctrl+C 

Backspace Backspace ( +--) 
(+--) 
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FUNCTION 

Tap once to reset the current 
number to zero; tap again to reset 
any operations in progress and clear 
the operations from memory. 

Tap the Backspace button or press 
the Backspace key to erase the 
number to the left of the cursor. 
Press the Delete key to erase the 
number to the right of the cursor. 
Press either key or tap the 
Backspace button to erase any digits 
you have selected. 



CALCULATION BUITONS 

The following buttons are used to enter calculations: 

BUTTON 

0 through 9 

* 

+ 

() 

EE 

1/x 

x2 

'lfx 

% 

+/-

KEYBOARD KEY 

0 through 9 

I 

* 

+ 

=or Enter 

() 

E 

Ctrl+l 

Shift+2 

Ctrl+2 

O/o 

Ctrl+-

MEMORY BUITONS 

FUNCTION 

Digits used to create numbers 
needed for a calculation 

Divide 

Multiply 

Subtract 

Add 

Equals (for standard mode only) 

Parentheses (for standard mode 
only) 

Enter E (for entering numbers in 
scientific notation) 

Reciprocal 

Number squared 

Square root 

Percent 

Decimal 

Change Sign 
(If the number has an E in it, the 
sign of the exponent is changed.) 

The following buttons are used with the Calculator's active 
memory function. For more information on active memory, see 
"Using Memory" in this chapter. 

BUTTON 

STO 

RCL 

M+ 

KEYBOARD KEY 

M 

FUNCTION 

Store in memory. 

Recall from memory. 

Add the number displayed in the 
readout bar to the number stored in 
active memory. The sum of these two 
numbers is now stored in active 
memory. 
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M- Ctrl+M 

Performing Calculations 

Subtract the number displayed in the 
readout bar from the number stored 
in active memory. The resulting 
number is now stored in active 
memory. 

You enter both numbers and operators for each mathematical task 
you perform with the Calculator. The numbers you enter are the 
figures to be computed. The operators are symbols (such as + for 
addition) that are used to request a particular type of calculation. 

An operation refers to the combination of an operator with 
numbers. For example, 100 + 200 is an operation. A simple 
calculation consists of only one operation. However, a calculation 
can consist of as many operations as you need. For example, you 
may need to know the result of 100 + 200 x 5. This calculation 
consists of several operations (addition and multiplication). In 
calculations with multiple operations, you can tell the Calculator 
explicitly which operation to do first. For an explanation of how to 
do this, see "Understanding the Hierarchy of Operations" in this 
chapter. 

NOTE 
The following procedures describe how to perform a calculation 
with a standard calculator. If you use an RPN (or HP style) 
calculator, see "Customizing Your Calculator" in this chapter. 

To do a calculation 

1. Enter all numbers and operators of your calculation. 

For example: 1200 x 160 

2.5 x 16 + 22 

14 - 12 x (8.5 - 2.2) 

2. Tap the = button or press Enter. The result appears in the readout 
bar. 

NOTE 

Press the Enter key only once. If you press twice and a previous 
operation is stored in memory, the Calculator will apply this opera
tion to your result. Only operations that apply one number to 
another, such as+,-,*, and+, are stored and repeated in this way. 
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USING TIIE PEN 

You can use the pen in the Calculator to tap buttons and select 
menu items. You can also use it in combination with the 
Backspace button or the Delete key to edit the numbers in the 
readout bar. For example, if you entered the number 124 by mis
take instead of 14, you could select the 2 with the pen or move the 
insertion point between the 2 and the 4 and then tap the 
Backspace button to delete the number 2. 

USING TIIE KEYBOARD 

You may find it easier to use the floating keyboard or an optional 
external keyboard for entering numbers. If you are using the 
numeric keypad on an external keyboard, be sure that the Num 
Lock key is on (the Num Lock light is lit). 

USING COPY AND PASTE 

You can copy calculation results to other GEOS applications. You 
can also select and copy numbers from another document and 
paste them into the Calculator's readout bar. For more information 
on working with text (including numbers), see Chapter 1. 

Understanding the Hierarchy of Operations 

When you enter calculations that include more than one 
operation, the Calculator performs the operations in the following 
sequence: 

• First, any numbers or expressions enclosed in parentheses 

• Second, multiplication and division 

• Third, addition and subtraction 

If you enter arithmetic functions that have the same precedence 
(such as 2 + 5 - 1), the operations are performed from left to right. 

The final result of your calculation will always reflect the above 
sequence. For example, if you enter 3 + 4 x 6, the result is 27 (not 

42). This result is based on 3 + 24 (the Calculator performed the 
multiplication before it performed the addition). 

Parentheses can be used to ensure that a particular operation is 

performed first. For example, you could enter (3 + 4) x 6. The 
parenthetical operation is performed first: 3 + 4 = 7. After that, the 
multiplication operation is performed: 7 x 6 = 42. 
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USING MEMORY 

NOTE 
If you do calculations that include a number of operations, you may 
want to learn about RPN (Reverse Polish Notation) mode. When 
the Calculator is in RPN mode, no parentheses are needed, 
simplifying complex calculations. For information about this type of 
calculator, see "Using RPN Mode" in this chapter. 

Handling Error Conditions 

When the Calculator cannot perform a calculation, the word Over
flow (or Error) appears in the readout bar. This can happen if you 
try to perform a function not allowed by the Calculator, such as 
dividing by zero. When Overflow is displayed, you can clear it by 
tapping the C/CE button. This clears the number and the error. 

You can save the results of your calculation using the Calculator's 
built-in memory. The memory function allows you to temporarily 
store numbers during the current work session. 

There are two types of memory: active and register. Active 
memory is used to store the number displayed in the readout bar. 
You can add to, subtract from, or recall a number stored in active 
memory. For example, active memory is a convenient way to keep 
track of your current bank balance as you write checks. Simply 
store your balance in active memory, then deduct the amount of 
each check from the balance. 

If you need to store more than one figure in memory, you can use 
register memory. Registers allow you to store up to seven 
additional numbers in the Calculator's memory. The registers have 
default names: Registerl, Register2, Register3, and so on. You can 
change the names to describe the type of value you are entering 
into the registers. For example, you can rename Registerl "Savings 
Account" and Register2 "Money Market Account." (For more 
information on register names, see "Using Register Memory" in this 
chapter.) 
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Active and register numbers can be viewed in the Calculator's 
Memory box, which is under Options. The Memory box consists of 
eight rows in which to store numbers. The first row is reserved for 
active memory; the seven rows that follow are used for register 
memory: 

I Tap STO button to 
copy number from 
readout bar to here. 

Use to store number 
in register memory. 

'Use to send 
number to 
Calculator. 

375. 681 ~ [§E] 
i=============l 

!Register 1 23. 451 ~ [§EJ 
~==========: 

IRegister2 34. 561 ~ [§E] 

IRegister3 i==========l 5=8=. 4=l51 ~ [§EJ 
i========~ 

IRegister4 ~ [§EJ 

!Registers ~ [§EJ 
IRegister6 i=============l@E] [§EJ 

i=============l 

IRegister7 ~ [§EJ 

Additional numbers can 
be stored in registers. 

You can leave the Memory box open while you work with the 
Calculator. Drag its title bar to move it out of the way if necessary. 
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The following table summarizes how to use active memory and 
register memory. 

TYPE OF MEMORY 

Active 

Register 

FUNCTION 

The number displayed in the readout bar can be 
copied directly to active memory. 

Only one number can be stored at a time. 

The stored number can be added to or 
subtracted from using the M-/M+ (subtract/add 
keys). 

The register name (Active Memory) cannot be 
changed. 

Numbers can only be edited using the Memory 
box. 

Numbers can be entered directly or by using 
Quick Copy. For more information about 
working with text, see Chapter 1. 

Up to seven numbers can be stored. 

Register names (e.g., Registerl) can be changed 
and saved for the next work session. 

Using Active Memory 

You use active memory as quick, temporary storage for numbers 
copied directly from the readout bar. The following procedures 
describe how to store, update, and recall numbers from active 
memory. 

To store a number in active memory 

1. Display a number in the readout bar. 

2. Tap the STO button to store the displayed number in active 
memory. 

Example: If 100 is displayed and you tap STO, the Calculator stores 
the number 100 in active memory. 

To add to or subtract from a number stored in active memory 

1. Store the number you want to update in active memory. (To do 
this, follow the steps described in the previous procedure.) 

2. Display the amount you want to add or subtract in the readout bar. 
You can enter the number directly or display it as the result of a 
operation. 
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3. Tap M+ to add or M- to subtract the amount from the number 
stored in active memory. 

Example: 100 is currently stored in active memory and you want to 
add 50 to it. To do this, enter 50 in the readout bar and tap M+; the 
Calculator changes the number stored in active memory to 150. 

Example: 150 is currently stored in active memory and you want to 
subtract 20 from it. To do this, enter 20 in the readout bar and tap 

M- ; the Calculator changes the number in active memory to 130. 

To recall numbers from active memory 

• Tap RCL. The number in active memory is copied to the readout 
bar. 

Using Register Memory 

Registers provide storage for up to seven numbers in the Memory 
box. You can store, update, and recall register numbers. You can 
also work with the Memory box while using the Calculator, 
opening and closing it at your convenience. 

To work with the Memory box while using the Calculator 

1. Choose Memory from the Options menu. The Memory box 
appears. 

2. Follow the steps in other procedures described in this section to 
store a number in a register, recall a number stored in a register, or 
rename a register. 

3. If you want to work with the Calculator window, move the 
Memory box out of the way by dragging its title bar. 

4. You can keep the Memory box around to continue working with 
it. 

or 

Tap Close to close the Memory box. 

To copy a number from the readout bar and store it in a register 

1. Use the Calculator to display the number that you want to store. 

rr.;+l 2. 
L.:=....J 

You can enter the number directly in the readout bar, or display 
the number as the result of a calculation. 

In the Memory box, tap the Get from Calculator button (pictured at 
left) located next to the register that you want to use for storage. 
The number is copied from the readout bar to the register. 
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Double-tap or drag 
in the name box to 
select the name and 
edit it quickly. 

The number is stored in the register until you exit the Calculator, 
or until you store a different number in that register. 

To type a number into a register 

• In the Memory box, select one of the register boxes; then type a 
new number or edit the number that is already there. 

The number is stored in the register until you exit the Calculator, 
or until you store a different number in that register. 

To change the name of a register 

1. In the Memory box, select the name of the register you want to 
change and edit the text shown in the box. For example, you may 
want to change the name of Registerl to "Savings Account" or "Car 
Payment". 

2. To make your changes permanent, choose Save Options from the 
Options menu. The names (but not the numbers) are saved for 
later work sessions. The next time you open the Calculator 
application, the names you have saved will be displayed in the 
Memory box. For more information on saving options, see 
"Customizing Your Calculator" in this chapter. 

To recall a number stored in a register 

In the Memory box window, tap the Send to Calculator button 
(pictured at the left) located next to the register with the number 
you wish to recall. The number is copied from the register to the 
readout bar. 

CUSTOMIZING YOUR CALCULATOR 

You can change the look and feel of the Calculator to match your 
particular needs. This section describes how to do the following: 

• Switch between calculator modes and use RPN calculator mode. 

• Choose between regular and scientific notation. 

• Specify the number of decimal places that are displayed. 

• Select the scientific extension to include trigonometric 
functions. 

• Use the worksheets. 

• Hide the paper tape. 

• Save customized settings. 
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Once you've customized the Calculator, you can save your settings 
for the next time you start the Calculator. For instance, you may 
prefer to hide the paper tape to make the Calculator window 
smaller so that it takes up less space on your screen; or you may 
wish to have the scientific extension buttons always showing so 
that you can perform trigonometric calculations at any time. When 
you've found settings you like, use Save Options from the Options 
menu to save them for your next session. 

To customize the Calculator 

1. Choose Customize from the Options menu. The Customize dialog 
box appears: 

1:11 Customize 

Mode: <>,!'!!"f':l(l:ll":::?.!Y.l~L , 
+!Infix (Standard)! 

Notation: o'scieniificfi:2 E•4) 
+Regular ( 12000) 

EJ B Decimal Places 

Extras: D Scientific Extension 
• Worksheets 
• Papertape 

2. Select options in the dialog box, then tap Apply. The Calculator 
changes to reflect your settings. 

3. Tap Close to close the dialog box. 

4. To keep your settings for the current work session only, continue 
using the Calculator as you normally would. When you exit the 
Calculator, the settings are restored to their previous state, 

or 

To save your settings for future work sessions, choose Save 
Options from the Options menu at any time before you exit the 
Calculator, Your settings are saved for the next time you open the 
Calculator. 
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Using RPN Mode 

Calculator mode refers to the keyboard layout and how 
calculations are entered. Two different modes are available with 
the Calculator: standard (Infix) and RPN (Reverse Polish Notation 
or Hewlett-Packard style). Standard mode is described and 
illustrated in "Basic Calculator Functions" in this chapter. RPN 
mode is shown below. 

=:11\J Calculator II• 
file !;dit Qptions !:;onvert 

RPN mode offers an efficient way to enter complex calculations 
using a method similar to that found on many Hewlett-Packard 
calculators, especially those models targeted at the mathematics 
and scientific community. In RPN calculations, you enter the 
numbers first, and then you perform an operation. For instance, if 
you want to add two numbers, such as 8 and 5, you first enter 8, 
then enter 5, and then perform the addition operation. As you 
enter numbers they are "pushed" onto a stack; they are later 
"popped" off the stack and used in operations. For more 
information, see "Understanding the Hierarchy of Operations" in 
this chapter. 

The buttons available in RPN mode are basically the same as those 
available on a standard calculator, with the following differences: 

BUTTON 

Enter 

x<>y 
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KEYBOARD KEY 

=or Enter 

x 

FUNCTION 

Plac~r "push"the number on the 
readout bar onto the stack. You 
perform calculations by typing the 
first number, tapping Enter, typing the 
second number, and then tapping an 
arithmetic function. 

Exchange the number in the readout 
bar with the top number on the stack. 
This is useful in switching the order of 
numbers to be subtracted or divided. 



Roll R 

CLx Ctrl+C 

Roll the numbers up the stack by one 
placGNtie top number goes to the 
bottom of the stack. This is useful for 
seeing what numbers are in the stack. 

Tap once to erase the number you are 
currently entering. Tap twice to clear 
the entire stack. 

You otherwise use the same keys on the keyboard and tap the 
same buttons in the Calculator window to activate RPN mode. 

To switch between standard and RPN calculator modes, choose 
Customize from the Options menu. When the dialog box is 
displayed, select the mode button that identifies the type of 
calculator you want. Apply this change and close the dialog box. 
The calculator buttons change to represent the calculator mode 
you chose. 

To peiform an RPN calculation 

1. Enter the first number, as you would for a standard calculator. 

2. Tap Enter to "push" the number onto the stack. 

3. Enter the second number. Do not tap Enter this time. 

4. Tap the arithmetic function you want. The result shows in the 
readout bar. You can use this result as the first number in another 
calculation. 

NOTE 

Do not tap Enter after typing the second number. This will both 
store the number on the stack and leave it on the display. If you tap 
an operation, the operation will use the number on the display and 
the top number on the stack - the same number. 

EXAMPLES OF RPN CALCUIATIONS 

To get a feel for how RPN calculations work, it helps to look 
through some examples. Notice that in each of these calculations, 
the approach is to enter values first (pushing them onto the stack) 
and then to perform operations in order of precedence, from 
highest precedence (innermost parentheses) to lowest precedence. 
Also notice that Enter is only pressed between successive 
numbers. When the last number in a group is reached, the 
operator button is pressed instead of the Enter button. (For more 
information on the order of operations and precedence, see 
"Understanding the Hierarchy of Operations" in this chapter.) 
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Example: Calculate 1032 + (15 - 12 x (9 + 3)) 

BUTTON PRESSES DISPLAY 

1032, Enter 1032 

15, Enter 15 

12, Enter 12 

9, Enter 9 

3, + 12 

x 144 

-129 

+ -8 

Choosing Regular or Scientific Notation 

Two different notation styles are available: regular (for standard 
calculations) and scientific (for extremely large or small numbers). 
Use the regular style if you want to enter numbers in the standard 
way. For example, if you enter 0.2 x 0.2 in the regular style, the 
result is .04. Use the scientific style when you require a numerical 
shorthand for very large or small numbers that would be difficult 
to view on the display bar. For example, if you enter 0.2 x 0.2 with 
scientific style selected, the result is 4.0000E-02 (or 4 x 10 to the 
power of -2). 

To choose a notation style, choose Customize from the Options 
menu. When the dialog box is displayed, select the notation 
button that identifies the notation style you want. Apply this 
change and close the dialog box. The calculator will display the 
results of new calculations in the notation you have specified. 

Changing the Decimal Places Displayed 

The Calculator stores 12 decimal places internally for each 
number, but displays only the number of decimal places that are 
currently set in the Customize dialog box. In this dialog box, you 
can specify the exact number of decimal places to be displayed in 
your calculations, from 1 to 12. For example, if you are working 
with dollars and cents, you may want to set the number of decimal 
places to 2. All values will then be rounded to two decimal places 
when displayed. 
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To change the number of displayed decimal places, choose 
Customize from the Options menu. When the dialog box is 
displayed, tap the arrow buttons in the Decimal Places field to se
lect the number of decimal places displayed for calculations. (If 
you select a value of zero, the Calculator displays all significant 
digits.) Apply this change and close the dialog box. The calculator 
will display the results of new calculations with the precision you 
have specified. 

Using the Scientific Extension 

You can expand the Calculator (in both RPN and standard mode) 
to include scientific functions by choosing the scientific extension 
option. This option provides additional buttons that enable you to 
do trigonometric calculations, exponents, factorials, and 
logarithms. 

Tap here to switch 
trigonometric functions 

to their inverse. 

Scientific extension to 
the calculator. 

? • 

At the top of the scientific extension area are the following options 
that affect trigonometric calculations: 

OPTION 

DEG 
RAD 
GRD 

KEYBOARD KEY 

Ctrl+D 
Ctrl+R 
Ctrl+G 

FUNCTION 

Select from this group of buttons to 
specify whether trigonometric angles 
are expressed in degrees, radians, or 
grads. 
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Inv i Select this option to switch the 
trigonometric buttons to their inverse. 
For instance, when this option is on, 
the sine (sin) function becomes an 
inverse sine (sin-1). 

To show the scientific extension option, choose Customize from 
the Options menu. When the dialog box is displayed, tap Scientific 
Extension so that the check box is darkened. Apply this change 
and close the dialog box. The calculator buttons change to show 
the scientific extension. To remove the scientific extension, follow 
these steps again, but this time tap the Scientific Extension option 
so that the check box is off. 

To calculate the sine, cosine, or tangent of an angle 

The sin, cos, and tan buttons calculate the sine, cosine, or tangent 
of the supplied angle. 

lll#M RAD I GRD I 1. Select the unit of measurement for the angle: DEG, RAD, or GRD. 

Tbe inverse sine, 
cosine, and tangent 
are sometimes 
referred to as the 
arcsine, arccosine, 
and arctangent. 

Inv 

2. Enter a value for the angle. 

3. Tap one of the trigonometric buttons: sin, cos, or tan. 

4. The result appears in the readout bar. 

To calculate the inverse sine, cosine, or tangent of an angle 

When the Inv option is checked, the sin, cos, and tan buttons 
become their inverse: sin-1, cos-1, and ran-1. These buttons now 
calculate the inverse sine, inverse cosine, or inverse tangent. The 
result is expressed as an angle. 

1. Select the unit of measurement for the result: DEG, RAD, or GRD. 

2. Enter the value you want to use in the calculation. 

3. Tap the Inv check box. The sin, cos, and tan buttons change to 
show their inverse functions (sin-1, cos-1, and tan-1). 

4. Tap one of the inverse trigonometric buttons. 

5. The result appears in the readout bar, expressed in the unit of 
measurement specified in step 1. 

To raise one number to the power of another 

You can use the yx button to raise one number to the power of 
another. 

1. Enter the first number and tap the yx button. For instance, if you 
wanted to calculate 105, you would enter 10 in the readout bar. 
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2. Enter the exponent, the power to which you wish to raise the first 
number. 

3. Tap the = button. The result appears in the readout bar. 

The following buttons are available with the scientific extension: 

BUTTON 

1t 

e 

sin or 
sin-1 

cos or 
cos-1 

tan or 
tan-1 

In 

log 

x! 

KEYBOARD KEY 

p 

e 

s 

c 

t 

n 

I 

! (Shift+ I) 

N 

L 

A (Shift+6) 

FUNCTION 

Recall the value for the 
mathematical constant pi. 

Recall the value for the 
mathematical constant e (Euler's 
constant). 

Calculate the sine of the number 
in the readout bar. Or, when 
inverse sin is available, calculate 
the inverse sin. 

Calculate the cosine of the 
number in the readout bar. Or, 
when inverse cos is available, 
calculate the inverse sin. 

Calculate the tangent of the 
number in the readout bar. Or, 
when inverse tan is available, 
calculate the inverse tan. 

Calculate the natural logarithm of 
the number in the readout bar. 

Calculate the logarithm (base 10) 
of the number in the readout bar. 

Calculate the factorial of the 
number in the readout bar. 

Raise the constant e to the power 
shown in the readout bar. This is 
the inverse natural logarithm. 

Raise 10 to the power shown in 
the readout bar. This is the 
inverse logarithm. 

Raise the value in the readout 
display to the power of the next 
value entered. (Enter the first 
value, tap yx; enter the second 
value, tap =.) 
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Using the Worksheets 

Worksheets are templates provided with the Calculator for 
performing common calculations such as loan interest and de
preciation. There are four types of worksheets: home and family, 
retail, statistical, and financial. 

I Statistical 

~ .d. 
When you tap a worksheet button, a dialog box is displayed that 
lists all the worksheets for that type. You tan then choose a 
worksheet by double-tapping the name of the worksheet you wish 
to use. 

i:::I Loan (total mterest) 

Calculate the total of interest payments over the life of a loan. 

Monthly payment: I 111111111$ 

Interest rate: I al 3/year 

Loan term: I sl years 

Total interest paid: 

? 
I _!;;alculate I 

To hide the worksheet buttons 

1. To hide the worksheet buttons, choose Customize from the 
Options menu. 

2. When the dialog box is displayed, tap Worksheets to turn off this 
option. 

3. Apply this change and close the dialog box. The worksheet 
buttons disappear. 
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Hiding the Paper Tape 

You can hide the paper tape to make your Calculator window 
smaller so that it takes up less space on your screen: 

l:IE;i Calculator~ DB 
file .!;dit Qptions ~onvert 

To hide the paper tape, choose Customize from the Options menu. 
When the dialog box is displayed, tap Paper Tape to tum it off. 
Apply this change and close the dialog box. The paper tape 
disappears. To redisplay the paper tape, follow these same steps, 
but this time tap the Paper Tape option so that the check box is 
darkened again. 

Saving Your Customized Settings 

To use the settings you have selected for the current work session 
only, continue using the Calculator as you normally would. When 
you exit the Calculator, the settings are restored to their previous 
state. 

To save your settings for future work sessions, choose Save 
Options from the Options menu at any time before you exit the 
Calculator. Your settings are saved for the next time you open the 
Calculator. 

CONVERTING MEASUREMENTS 

The Calculator provides a handy way to convert one unit of 
measurement, such as gallons, to another unit, such as liters. You 
can convert angles, length, volume, height, temperature, and cur
rency, and also set the exchange rate for currency conversions. 
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To peiform a conversion 

1. Enter the number you want to convert in the readout bar. 

2. Choose the conversion from the Convert menu . 

• . 
. --+t 

f!ngle ... 
J:ength ... 
~olume ... 
Height ... 
Iemperature ... 
J. Dollars to Yen 

.?;. Yen to Dollars 

Set E~change Rate ... 

If a submenu appears, choose the appropriate conversion from it. 
The conversion is applied and displayed on the readout bar. 

To change currency conversion names and exchange rates 

1. To change the names of the currency conversions and the rates for 
those conversions, choose Set Exchange Rate from the Convert 
menu. The Set Exchange Rate dialog box appears: 

Set Exchange Rate 

1.00 jDollars 

I Cancel I 

2. Enter your changes in the appropriate fields. To change the name 
of a currency, tap in the name field and enter the new name; to 
change an exchange rate, tap in the rate field and enter the new 
rate. Tap OK. 

The Convert menu changes to reflect any currency name changes. 
If the currency names are Dollars and Yen, and you change 
Dollars to Francs, the Convert menu commands, Dollars to Yen 
and Yen to Dollars, would change to Francs to Yen and Yen to 
Francs. 
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Text File Editor 

You can use Text File Editor to make quick notes, to view the 
"readme" files that often come with applications, and to read 
documentation that comes with public-domain software. 

NOTE 

Text File Editor does not support handwriting recognition. Although 
you can use the on-screen keyboard to type and edit Text File 
Editor documents, it is strongly recommended that you use an 
optional external keyboard. 

Text File Editor is simple to use. However, it is not a full-featured 
word processing program. You will want to use a word processing 
application, such as Geo Write, if you need the following features: 

• Adjustable margins and tab stops 

• Variable text styles and fonts, line spacing, and justification 

• Page break control 

• Graphics in your document 

• Document safeguarding 

This chapter assumes you are familiar with the information 
presented in Chapter 1, which provides an overview of the skills 
you need to use any GEOS application. 

Text File Editor has no user levels. 
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THE TEXT FILE EDITOR WINDOW 

i 
Text File Edi... 

The Text File Editor icon appears in the WORLD directory and 
looks like the example at the left. You can use the Text File Editor 
icon to start Text File Editor. For more information about starting 
GEOS applications, see Chapter 1. 

After you start Text File Editor, a document window appears. You 
enter and edit text in the document window. 

l Menu bar 

~ ?j •Jl:!!:l 
file J;dit Si~es 

~ 

Enter text here. 

USING TEXT FILE EDITOR 

In Text File Editor, you enter and edit text just as you would in any 
GEOS application. For detailed information on entering and 
editing text, see Chapter 1. 

NOTE 

Text File Editor cannot paste text that contain special characters. If 
you use another application, such as GeoWrite, to copy some text 
to the clipboard that includes some special characters - such as 
smart quotes, for example - and then switch to Text File Editor, 
the Paste menu choice will be dimmed and unavailable. 

4.24 THE GEOWORKS ACCESSORIES 



In Text File Editor, 
the length of the line 
changes with the 
width of the window. 

Word Wrap and Line Endings 

When your text reaches the right edge of the window, it wraps 
automatically to the next line. This feature is called word wrap. 
Word wrap means that you do not have to press the Enter key 
(the Return key on a typewriter) to start a new line of text. This 
keeps the lines and sentences together in the same paragraph. 
When you are ready to begin a new paragraph, you press the 
Enter key. 

If you change the width of the window, text wraps at the new 
window edge. If there is more text than can fit in the window, use 
the scroll bar to see different parts of the document. 

1:1 Text File Ecl1tor - Document DD[52] 
File Edit Sizes 

This is cm examp I e of a sentence that w i l I wrap oround c:i w i ndowl no 
~atter what size the window is. 

file ~dit Si~es 

This is an examp I e of a sentence that w i I I wrap 
around a window no matter what size the window 
is. 

NOTE 

DOS text files are often line-oriented, which means each line is 
kept apart from the others by pressing Enter at the end of each 
line, instead of pressing Enter only at the end of each paragraph. 
An example of a line-oriented text file is a DOS batch file, in which 
each line is a separate DOS command. You may find it easier to 
edit one of these files by resizing the Text File Editor window so 
that it is as wide as possible. This way you can see where lines 
actually end because Enter has been pressed, and you need not 
be confused by where Text File Editor is wrapping them. 
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CHANGING THE TEXT SIZE 

Text size is measured 
in typographical 
units called points; 
9-point is 1/8" high. 

You can change the size of the text displayed in any Text File 
Editor document. Text File Editor provides three sizes of text: 

• 9 point 

• 12 point 

• 14 point 

Text File Editor displays all the text in a document at the same 
size. If you choose a different size, an the text in the document 
changes to the size you select. The size setting stays in effect even 
if you close one document and open another. Regardless of the 
text size you choose, Text File Editor always prints documents 
using the built-in fonts in your printer. 

To change the text size 

• Choose a new size from the Sizes menu. All text in the document 
changes to the new size. 

CHECKING YOUR SPELLING 

Text File Editor includes a spelling checker that helps you find and 
correct misspelled words in your documents. You can check the 
spelling of a single word, or of the whole document. 

The spelling checker tries to match each word in your document 
to its exact duplicate in an extensive electronic dictionary. If the 
spelling checker does not find an exact match, it flags the word as 
misspelled. Some uncommon words, such as names or technical 
terms, may not be in the standard dictionary. You can prevent the 
spelling checker from flagging uncommon words by adding them 
to the user dictionary. For more about checking your spelling and 
adding words to the user dictionary, see "Formatting Geo Write 
Documents" in Chapter 5. 

FINDING AND REPLACING TEXT 

You can use Find and Replace to quickly find a word or phrase in 
your document and, optionally, to replace it with a different word 
or phrase. You can also replace all occurrences of a word or 
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phrase in a document. For more information about finding and 
replacing text, see "Formatting GeoWrite Documents" in 
Chapter 5. 

PRINTING A DOS TEXT FILE 

In Text File Editor, you choose Print from the File menu to print a 
document, just as you would in any GEOS application. However, 
you should be aware of the following two differences when 
printing Text File Editor documents: 

Line Length. The length of a line in the printed document is not 
always the same as the length of the same line shown in the Text 
File Editor window. In the Text File Editor window, text wraps at 
the right edge of the window. When you print, however, text 
wraps at the right edge of the page. (However, if you end a line by 
pressing Enter, this line ending is preserved when you print the 
document.) 

This difference in line length occurs because Text File Editor 
always prints documents using the printer's built-in fonts. 
Although a built-in font may be a different size from the font in 
your document, documents printed using built-in fonts print very 
quickly. 

Text Size. The size of printed text may be different from the size 
of the text displayed in the Text File Editor window. Regardless of 
the text size you choose from the Sizes menu, Text File Editor 
always prints documents using the built-in fonts in your printer. 

For more information about printing in GEOS applications, see 
Chapter 1. 

WORKING WITH DOS TEXT FILES 

Working with DOS text files in the Text File Editor is similar to 
working with documents in other GEOS applications. However, 
there are some differences .you should be aware of: 

Document Safeguarding. Document safeguarding works only 
with GEOS files, not with DOS files. Since Text File Editor 
documents are DOS files, they are not protected by document 
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safeguarding. Be sure to save your Text File Editor documents 
often. 

DOS File Names. All documents you create with Text File Editor 
are DOS text files. Therefore, when you save them, you must give 
them names that follow the DOS rules for naming files. DOS file 
names can be up to eight characters long, optionally followed by a 
period and three more characters. You may want to use 1XT 
following the period to indicate that your file is a text file. You 
cannot include spaces in a DOS file name. For more information 
about DOS file names, see Appendix D. 

Creating a DOS Text File 

It is easy to create a new Text File Editor document from within 
Text File Editor. For more information about creating a new DOS 
text file, see Chapter 1. 
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Scrapbook 

The Scrapbook application gives you a place to store graphics and 
bits of text so that they are available at a moment's notice. The 
notes, pictures, and other items that you store in the scrapbook are 
called scraps. 

The advantage of a GEOS scrapbook over a real scrapbook is that 
you can quickly copy items from a GEOS scrapbook to other 
GEOS documents. 

This chapter assumes you are familiar with the information 
presented in Chapter 1, which provides an overview of the skills 
you need to use any GEOS application. 

USER LEVELS IN SCRAPBOOK 

ALL LEVELS There are two user levels in Scrapbook: 

• Level 1 is the easiest to use and includes most features that you 
will need to store and retrieve items in a scrapbook. 

• Level 2 allows you to import items from non-GEOS 
applications, go to a specific page in a scrapbook, and paste 
items at the end of a scrapbook document. 

For more information about changing and saving user levels, see 
Chapter 3. 
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THE SCRAPBOOK WINDOW 

ALL LEVELS 

Screpbook 

When you start Scrapbook, you automatically open the def a ult 
scrapbook. If you have not copied any scraps into the default 
scrapbook, the document is empty. If you have already entered 
scraps, the contents of the first page are displayed in the View box. 

This area is the View box. It shows pages in the scrapbook 

File ~It Options 
Lonim. ipSIUj dolor slt.unet, conaetllltlltr adipise?in,s tlit, Hd dii.m :ncmumm!j' nibh euismod tincidunt ut lao1utdolote :r.tlAjtla 

:!.~~ ~0:'!"'~~1 wi:shnim. ad miNm wm...m., qi.1il nostmd 1:i:tri::i tl.tion Wlami:o:per SASdpitloboltis llisl ut aliqmp e:n: 

Dllis .mlem. 1l 11.1M irtun. dolor in Mndruit in yulput&tll "nlit lilS:S8 molutiil collfilElquat, vel ilium dolole eu feu,siat nulla 

~~1:c~i.:=~~d:::=::~:~:a:~i:::~:,~dd':::n=1:~~uis~=!!~~~ait 
doloni ~ija ahqumnu.t.tvolutpa.t. 

JPage 2 of 2 
N~me: orem lpsum 

[oo to Page .. J [Previous][ Next] 

1 Tap to go to a specific ~to go to the 
page in the scrapbook previous or the next 

page in the scrapbook 
The name of the page appears here. 

If you want to start storing scraps now, you can use the default 
scrapbook. If you plan to keep a large collection of scraps, you 
may want to create new scrapbooks. For more information about 
working with scraps, see "Working with Scraps" in this chapter. 
For more information about creating new scrapbooks, see 
"Creating a New Scrapbook Document" in this chapter. 

WORKING WITH SCRAPS 

You can copy scraps from most GEOS applications to your 
scrapbook. For example, you can use the drawing tools in 
GeoWrite to design a letterhead, then copy it to your scrapbook so 
that it is easily available when you want to use it again. At Level 2, 
you can also import scraps from non-GEOS applications. For more 
information about importing, see "Importing a Scrap From a DOS 
Application" in this chapter. 
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ALL LEVELS 

ALL LEVELS 

Adding Scraps to a Scrapbook 

Each time you paste an item from another application to your 
scrapbook, you automatically add a new page to the scrapbook. 

To add a scrap to a scrapbook (All Levels) 

1. Within an application, copy the item to the clipboard. For more 
information about how to copy items, see Chapter 1. 

2. Choose Scrapbook from the Express menu. 

3. Choose Paste from the Edit menu. The scrap appears on a new 
page in front of the current page. This pushes all subsequent 
scraps back one page. 

or, at Level 2: 

Choose Paste at End from the Edit menu. The scrap is pasted on 
the last page of the scrapbook. 

NOTE 

If you want to insert the scrap on another page, use the Previous or 
Next button to go to the page that you want to follow the new scrap. 
For example, if you want to add a scrap to page 3 of the 
scrapbook, go to page 3. When you paste in the scrap, the new 
page becomes page 3 and the old page becomes page 4. 

Copying a Scrap to Other Applications 

You can copy any item from a scrapbook to another application 
that allows you to paste something from the clipboard. For 
example, you can copy a letterhead from Scrapbook into 
GeoWrite, and then type your correspondence. 

To copy from Scrapbook to other applications (All Levels) 

1. Go to the scrapbook page that has the scrap you want to copy. 

2. Choose Copy or Cut from the Edit menu. 

• The Copy choice copies the scrap to the clipboard and leaves a 
copy of it in the scrapbook. 

• The Cut choice places the scrap on the clipboard and deletes it 
from the scrapbook. 

3. Open the document in the application to which you are copying 
the scrap. 

4. Place the insertion point where you want to paste the scrap on the 
page. 
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ALL LEVELS 

ALL LEVELS 

LEVEL 2 

5. Choose Paste from the application's Edit menu. The scrap is pasted 
into the document. 

Deleting a Page 

You can easily delete a page that you no longer need. A deleted 
page is not stored on the clipboard. 

To delete a page from a scrapbook (All Levels) 

1. Go to the page that you want to delete. 

2. Choose Delete from the Edit menu. The page is deleted from the 
scrapbook. 

Naming a Page 

You can assign a name to each page in a scrapbook. Using page 
names to describe the type of scrap stored on the page can be 
helpful when you want to locate particular items in a large 
scrapbook. Page names are shown in the Name box at the bottom 
of the Scrapbook window; the names are also listed in the Go to 
Page dialog box. 

To name a page (All Levels) 

1. Locate the page that you want to name. 

2. Tap the Name box, and enter a descriptive name for the page. 

Importing a Scrap from a DOS Application 

You can import images from other DOS applications to a 
scrapbook. An item is imported when it is transferred from a non
GEOS application to a GEOS application. For example, you can 
import text or images that are in a variety of formats to your 
scrapbook. 

To import an item from another application (Level 2) 

1. Open the scrapbook in which you want to place the image. 

2. Locate the page that you want to follow the imported page. 
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3. Choose Import Scrap from the File menu. A dialog box appears: 

l Select the file you want to import. 

'"'"°' '"" ••• ···1 .. , ....... Formats 
• A •••• A 

I rath _, f'6()••••t:·;; .. ··6·;;·~.~i~·;··;;:;·;~·t:] I Dri~es -I ASCII or Plain Text .. ~ DisplayWrite 2 - 4 (DCA/RFT) 

' @I MONALISA.PCX I ~ DisplayWrite s (DCA/RFT 

' @I SCAN l.TIF HebrewWrite (DCA/RFT) 

File Mask,) 

!1irii~<iJ I cancel I [I] 

I Click to import the file. 

Select the format of the im p orted file. 

4. Select the format (TIFF, PCX, and so on) of the image you are 
importing. All files matching the format you selected are listed 
above the formats. 

5. Locate the name of the file you want to import. Use the file 
selector to change disk drives and folders as needed. 

6. Double-tap the name of the file you want to import. It may take 
several seconds for the image or text to be imported and placed in 
the scrapbook. You cannot interrupt this process. 

WORKING WITH DOCUMENTS 

ALL LEVELS 

ALL LEVELS 

Scrapbook provides a standard document called "Default 
Scrapbook" in your DOCUMENT folder. Whenever you start 
Scrapbook, this document opens automatically, making it easy to 
keep all of your scraps in one place. If you only need one 
scrapbook document, you should use this document. 

However, you may want to keep additional scrapbook documents. 
For instance, you may find it easier to keep your scraps organized 
by project. Simply create a scrapbook for each project. 

Creating a New Scrapbook Document 

It is easy to create a new scrapbook document from within 
Scrapbook. For more information about creating a new document, 
see Chapter 1. 
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Setting Another Startup Document 

When you start Scrapbook, the default scrapbook from the 
DOCUMENT folder opens. In Level 2 of Scrapbook you can set 
another scrapbook document to use as your empty startup 
document. For more information, see "Working With Documents" 
in Chapter 3. 

PAGING THROUGH A SCRAPBOOK 

ALL LEVELS 

I _erevious II ~ext I 

I _go to Page ... I 

You can quickly flip through the pages of a scrapbook to scan its 
contents. At Level 2, you can go directly to a specific page. 

To jump one page at a time (All Levels) 

• Tap Next to go to the next page, or Previous to go the previous 
page. If you are on the last page, the Next button takes you to the 
first page. If you are on the first page, the Previous button takes 
you to the last page. 

In Level 2, you can use the Go to Page button to jump to a specific 
page in a scrapbook. 

To jump to a specific page (Level 2) 

1. Tap the Go to Page button. The Go to Page dialog box appears: 

1:1 Go to Page 

Select page to view: 

2. Cat 
3. Barn 
4. House 

• 5. Bicycle 

l_l,liew Page I lc1osel [1J 

2. Tap the page number or page name that you want to view. Then 
tap View Page to display the page in the Scrapbook window. 

or 

Double-tap the page number or page name to display the page 
immediately in the Scrapbook window. 

3. Tap Close when you are finished. (You can also drag the dialog 
box to the corner of the screen so you can refer to it later.) 
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Preferences 

This section explains how to change various options on the unit so 
that each time you use GEOS applications, these options are 
automatically set. 

WHAT IS PREFERENCES? 

Preferences 

Preferences is a GEOS application that allows you to tailor the unit 
to meet your specific needs and likes. For example, you can use 
Preferences to turn sound on and off, to install a new printer, or to 
change your password. 

Preferences is made up of sixteen groups of options: text, modem, 
printer, connections to other devices, date and time, hard icon 
assignments, hardware, international formats, keyboard, look and 
feel, memory allocation, optional mouse, password security, pen, 
port assignments, and power management. 

You start Preferences by double-tapping the Preferences icon, 
which looks like the example at the left. For more information 
about starting GEOS applications, see Chapter 1. 
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THE PREFERENCES WINDOW 

When you start Preferences, the Preferences window appears: 

1:n~'.J Pt efet ences oa~ 
Eile 

~~w 
Modem Printer Connect 

~ 
~ 

Date & Time 

~ ijw~ [{ft1 • 1~a 
Hard loons Hardware International Keyboard look & feel 

~ ~ ~ p~.IU§?JI 
~ 

Power Mgmt 

CHANGING YOUR PREFERENCES 

This procedure explains how to change options. 

To change Preferences options 

1. Open Preferences. The Preferences window appears. 

2. Tap the button for the group of options you wish to set or change. 
A dialog box for that set of options appears. 

3. Tap the appropriate radio buttons, enter information, select items 
from list boxes, or tap arrows to set or change the option(s) you 
want. 

4. You can set or change some option(s) in one dialog box. To set or 
change other options, you may need to enter (or edit) information 
or select settings in several dialog boxes. If necessary, tap the 
appropriate button to go to another dialog box and then set or 
change the option(s) you want. 

5. Tap OK or Close to apply your new settings and exit the dialog 
box. 

or 
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TEXT OPTIONS 

Tap Reset to reset the options to their original settings and then tap 
Close to exit the dialog box. 

or 

Tap Cancel to cancel any changes and exit the dialog box. 

You will need to repeat this step for each dialog box you have 
selected until you return to the Preferences window. 

If you change some options, such as international, keyboard, or 
mouse options, a dialog box appears requesting you to restart the 
unit so that the change can take effect immediately. Tap Yes to 
restart the unit, or tap No to delay your changes until the next time 
you restart the unit. 

Use the Text options if you want to change spell-checking options, 
edit the user dictionary, or choose a new main dictionary. You can 
also turn smart quotes on or off in this dialog box. Unless you 
specify otherwise, unit applications use straight quotation marks (" 
"or''). When you turn smart quotes on, typographer's quotation 
marks appear (" " or ' '). However, be aware that any quotation 
marks you have already typed as straight quotation marks will not 
change when you turn smart quotes on. 

When you tap the Text button, the following dialog box appears: 

Text 

Change these options to configure the system-wide text 
functions like Spell Checking. 

Smart Quotes: 0 On +["qf.f.j 
.----------spell Checker Options;--------~ 
Automatically Suggest Spellings: 
Automatically Start Checking Selected Text: 

Reset Skipped Words List when Spell Check Complete: 

OYes +No 

oves +No 

oves +No 

To change smart quotes and spell-checking options, use the 
following options as necessary: 

Smart Quotes. Turn on typographer's quotation marks for text. 

Automatically Suggest Spellings. Let the Spelling Checker 
suggest corrections for spelling errors. 

PREFERENCES 4.37 



MODEM OPTIONS 

Automatically Start Checking Selected Text. Let the Spelling 
Checker automatically start checking text you have selected. 

Reset Skipped Words list When Spell Check Complete. Let 
the Spelling Checker skip all occurrences of misspelled words "for 
one spell-checking operation. You must also tap Skip All in the 
Spelling Checker in order for this option to work. 

Dictionaries 

To change the user dictionary, tap the Edit User Dictionary button. 
Your user dictionary is a dictionary that contains words you add to 
it. These words typically do not appear in the main dictionary for 
the Spelling Checker; rather, you add them to the user dictionary 
to expedite spell checking. To add a new word, type the new 
word in the box, then tap Add New Word. To remove a word from 
your user dictionary, select the word from the list, then tap Delete 
Selected Word. 

To choose another main dictionary, tap the Choose New Main 
Dictionary button. After you select a new dictionary from the list, 
tap Use This Dictionary. 

Use the Modem options if you want to change your modem 
settings. Before you can use your modem, you need to be sure to 
identify the communication port and port speed. Refer to your 
modem manual for more information. 

When you tap the Modem button, the following dialog box 
appears: 

~ 
Modem 

Modem 

Use these options to install and 
configure your modem. 

Serial Port: +[i;;i"(j,"f1e·: <> COM 1 <> COM 2 <> COM 3 <> COM 4 
: ..................... ; 

Dial Type: +Tone <>Pulse 

I Speed and Format Options ... I 
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PRINTER OPTIONS 

You can change the serial port or dial type from this dialog box. 

Speed and Format Options 

To change the modem speed and format options, tap Speed and 
Format Options. Change the following options as necessary: 

Baud Rate. The speed at which data is transmitted between your 
unit and the remote system. 

Parity. Used for error checking during transmission. 

Word Length. The number of bits used to convey each character 
transmitted. (The term data bits is sometimes used to refer to the 
word length.) 

Stop Bits. Used to indicate the end of each character as it is 
transmitted. 

Handshake. Used to enable unit communications software, such 
as GeoComm, to control the flow of information in and out of the 
unit. When hardware handshaking is enabled, you can set these 
options: 

Stop Remote. Lets you select the appropriate method to start data 
flowing out of your unit. 

Stop Local. Lets you select the appropriate method to start data 
flowing into your unit. 

Use the Printer options if you want to install a different printer, 
make changes to the current printer options, or test your 
connected printers. You can also set up a printer to format your 
text the way that best meets your printing needs. This is especially 
convenient if you print envelopes and labels, or use a number of 
different paper sizes. 

NOTE 

Connect a printer through the printer port on the rear panel of the 
unit. 
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When you tap the Printer button, the Printer dialog box appears: 

Printer caJ Use these options to install, configure, 
and test your printer (or printers). 

Pr-inteF 

Printers Installed: 

Im . . . . . 
Canon LBP-8 Mark Ill (Postscript) on LPT 1 1 IBM 4019 ( 17 Fonts) (Postscript) v52. 1 on LPT 1 

Default Printer: 
HP Laser Jet lllP on LPT 1 

I Default Sizes ... I 
I New ... I I Edit... I I Make Default I I Qelete I I Test I I Close I [I] 

Use the buttons in the Printer dialog box as follows: 

Default Sizes. Tap to set the paper size and layout for printing. 
For more information, see "Default Sizes" in this chapter. 

New. Tap to add a new printer. The New Printer dialog box 
appears in which you can set the type and options for the new 
printer. For more information, see "Installing a New Printer or 
Editing an Existing One" in this chapter. 

Edit. Tap to edit the settings for the selected printer. The Edit 
Printer dialog box appears. This dialog box is identical in all but 
name to the New Printer dialog box. For more information, see 
"Installing a New Printer or Editing an Existing One" in this 
chapter. 

Make Default. If you have more than one printer installed, tap 
this button to make the selected printer the one used by default. 

Delete. Select a printer in the list and tap this button to delete it 
from the list. 

WARNING 

Use the Delete button with extreme care. When you tap the Delete 
button, the selected printer is immediately removed from the list 
without any confirmation. 

Test. Select a printer and tap this button. A test page prints from 
the printer. You will need to connect a printer to the unit before 
you can test it. 

Installing a New Printer or Editing an Existing One 

To use a printer, you must attach it to the unit. In addition to 
simply attaching the printer, you must tell GEOS what kind of 
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printer it is - you need to install it. This section describes how to 
install a new printer or change the settings of one you have 
already installed. 

To install or edit a printer 

1. To install a new printer, tap New in the Printer dialog box. To edit 
an existing printer, select the printer, then tap Edit. The following 
dialog box appears: 

New Pnnter 

Printer: .. - .. , 
Adobe LJ II Cart w/Type c·art 1 (Postscript) 

Adobe LJ II Cart w/Type cart 2 (Postscript) 
AEG Olympia NP 136-24 (Epson Mode) 

AEG Olympia NP 136-24 (IBM Mode) 

Port: 

COM 1 (serial) 

Printer Name: Adobe LaserJet II Cartridge (Postscript) on LPT 1 

Printer. Select the type of printer you are adding. If you have a 
keyboard attached to the unit, type a letter to scroll immediately to 
the first printer name that begins with that letter. The selected 
printer name appears in the Printer Name box. 

Port. Select a port for the new device. If you select a serial port, 
you can set the serial port options using the Serial Port Options 
button. 

Serial Port Options. You can choose Serial Port options to set 
the baud rate, parity, word length, stop bits handshake, stop 
remote, and stop local. 

2. When you are satisfied with the settings, tap OK. The Printer 
dialog box reappears, where you can test the printer, make it the 
default, or add and edit other printers. 
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CONNECT OPTIONS 

Default Sizes 

Default sizes include the type of paper you are printing to, the size 
of the paper, the paper layout, and the margins of the paper. To 
change the default paper size, tap Defaul,t Sizes. A dialog box 
appears: 

Default Sizes 

, ......................... , Default Page Size 
Type: +if':>".1.P~F] <> Envelope 
Size: 

us Legal 
A4 Letter 
JIS BS Letter 

[[aper Layout. 1 111~1 

Width: 18.5 in I B Height: I 1 I in I B 

Margins: Left: \0.25 in IB Right: ;=l0~_-2_s_i_n--.IB 

Top: l0.2s in IB Bottom: \0.2s in IB 

I Cancel I [!] 

Type. Choose the type of paper you plan to print to: Envelope or 
Paper. 

Size. Choose the paper size from the scrolling list. 

Paper Layout. Choose the orientation of the paper in the printer. 

Width. Use the up and down arrows to select a custom paper 
width. This field is automatically filled in when you choose a size 
from the Size list. 

Height. Use the up and down arrows to select a custom paper 
height. This field is also filled in when you choose a size from the 
Size list. 

Margins. Set the margins for the paper in the printer. These 
margins provide unprintable boundaries on the page. 

Use the Connect module to set the options for connecting to 
another computer that is nmning GeoHost, or the Palm page Send 
and Receive options. These options include the name of the device 
to which you are connecting (up to 32 characters), the 
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communications port, and the connect speed (baud rate). For 
more information about GeoHost and transferring files between a 
desktop computer and the unit, see Appendix C. For more 
information about the Palm page Send and Receive, see Chapter 2. 

When you tap the Connect button, the following dialog box 
appears: 

~ 
Connect 

Connect 
Configure how your unit can be 
connected to other devices. 

~------Connect O~tions------~ 

Name: Remote! 
J 

Port:! ..... __ c_o_M_1 ___ -_I 
Baud Rate: <> 2400 <> 4800 + 9600 <> 19200 

I Page Send/Receive Options ... I 
["6i<"] I Cancel I [I] 

Change the following options as necessary: 

Name. Set the name of the device to which you are connecting. 

Port. Set the communications port you are using for the 
connection. 

Baud Rate. Set the connection speed between the unit and the 
other device. 

Page Send/Receive Options. Tap to set the serial port and baud 
rate you would like to use for sending and receiving sketch pages. 
For more information about sending and receiving sketch pages, 
see Chapter 2. 

DATE & TIME OPTIONS 

Use the Date & Time options if you want to change the date or 
time that you currently see on your unit. If you have changed the 
date and time format in International options, you must enter your 
new date and time in the correct format. 
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When you tap the Date & Time button, the following dialog box 
appears: 

Date & Tune 

~ Change these options to 
set your computer's 

Date & Time built-in clock. 

Current Date: 12/9/93 

Month: ~B Day: EJB Year: 
BB 

Current Time: 4:17:05 PM 

Hours: EJ B Minutes: ~Bseconds: 
EJB 

<>AM +PM 

ii.)i<"I 1···p·;:~·;::~·;:~·r.···1 I Cancel I [fl 

The dialog box shows the current date, the current time, and 
whether the time of day is AM or PM. To change a setting, use the 
up and down arrows next to the option item. 

HARD ICONS OPTIONS 

Use the Hard Icons options if you want to change the application 
programs that are assigned to the hard icons. You can assign a 
hard icon to any GEOS application. 

When you tap the Hard Icons button, the following dialog box 
appears: 

Hard Icons 
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Hare! Icons 

Use these options to change the settings 
for icons 1-7 on your hard icon bar. Tap 
the Icon ID button to change the icon's 
assignment. 

Icon ID: Assigned Application: 

~ Keyboard 
I: 1 .. ; I GeoWrite 

[I] GeoCalc 

[I] Geofile 

@] Desk Accessories\Calculator 

@:;] PalmAddress 

@;] PalmSchedule 

[I] PalmNotes 



HARDWARE OPTIONS 

To change a hard icon assignment, tap the button for the hard 
icon. A file selector appears from which you can select the 
application you want to assign to the button. (Only GEOS 
applications appear in the list. For DOS applications, you should 
first create a DOS application launcher for each application you 
want; then you can assign a hard icon to the application launcher. 
For information on creating a DOS application launcher, see 
Chapter 9.) 

Use the Hardware options to tum off sound for the various errors 
and alarms and to change the video display mode. 
NOTE: The unit will always run at 16 Mhz even if the Set Clock Speed 

is set to 8 Mhz by Preferences. 

Har cf ware 

~ You can turn sound on and off, and 
IC.lJ~ change the speed and video mode 
Hardware Of your unit. 

Sound: +l.§:~.l <> Off 
Set Clock Speed: + 16 Mhz <> 8 Mhz 

Video Mode: + Standard <>Reverse 

["°6i< .. J !i:i(,;~,;·(,)i .. I I Cancel I [!] 

INTERNATIONAL OPTIONS 

Use the International options if you want to change the standard 
formats for currency, numbers, date, quotation marks, and time for 
a country other than the United States. You can also edit the long 
or short date formats. 
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When you tap the International button, the following dialog box 
appears: 

lnten1at1onal 

[Fjjjjil Use these options to change your time and 
~ date display formats, currency and number 

International formats, and other default characters. 
Choose format to edit Examples-----~ 

Cun encl .A 
Number 
Quotation marks 
Long date 
Short date 
Time 

Edit ... 

Currency 

($13.22) 

Close 

To change the currency format, select Currency from the list, and 
then tap Edit. Change the following options as necessary: 

Symbol and Negative Placement. Change the placement of the 
currency symbol and negative sign. Tap the button to the right of 
"Symbol & Negative Placement" to display a drop-down list. Select 
the appropriate choice from the list. 

Space Around Symbol Set the distance between the symbol and 
the value. Tap the button to the right of "Space Around Symbol" to 
display a drop-down list. Select the appropriate choice from the 
list. 

Symbol Set a new currency symbol by highlighting the existing 
symbol and entering a new symbol. 

Leading Zero. Add a zero before the currency format. Tap the 
button to the right of "Leading Zero" to display a drop-down list. 
Select the appropriate choice from the list. 

Decimal Digits. Set the standard number of decimal places by 
tapping the up and down arrows. 

Number 

To change the numbers format, select Number from the list, and 
then tap Edit. Change the following options as necessary: 

1000 Separator. Type a character that is used to separate 
thousands (for example, the use of commas in 1,000,000). 
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Decimal Separator. Type a character that is used as a decimal 
point. 

Decimal Digits. Change the number of decimal places. 

Leading Zero. Turn the leading zero on or off. Tap the button to 
the right of "Leading Zero" to display a drop-down list. Select the 
appropriate choice from the list. 

List Separator. Type a character that you see as the separator in a 
series of numbers (for example, the use of commas in "1, 2, 3"). 

Measurement System. Change the measurement system to 
Metric or English. Tap the button to the right of "Measurement 
System" to display a drop-down list. Select the appropriate choice 
from the list. 

Quotation Marks 

To change the quotation marks format, select Quotation Marks 
from the list, then tap Edit. Type the symbol you want to use for 
the first single quotation mark, the last single quotation mark, the 
first double quotation mark, and the last double quotation mark. 

Long Date 

The long date format shows the day of the week, month, year, and 
date. To change the long date format, select Long Date from the 
list; then tap Edit. Change the Format Elements options as neces
sary. With each option, tap the button for the item you want to 
change to display a drop-down list. Select the appropriate choice 
from the list. 

In each of the separator boxes, type a character you want to 
appear as the separator between the elements (for example, the 
use of slashes in Mon/01/01/93). 

Short Date 

The short date format shows only the month, day, and year. To 
edit the short date format, select Short Date from the list, then tap 
Edit. Change the Format Elements options as necessary. With each 
option, tap the button for the item you want to change. A drop
down list appears. Select the appropriate choice from the list. 

In each of the separator boxes, type a character you want to 
appear as the separator between the elements (for example, the 
use of slashes in 01/01/93). 
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KEYBOARD OPTIONS 

Time 

To edit the time format, select Time from the list, then tap Edit. 
Change the Format Elements options as necessary. With each 
option, tap the button for the item you want to change to display a 
drop-down list. Select the appropriate choice from the list. 

In each of the separator boxes, type a character you want to 
appear as the separator between the hours, minutes, and seconds 
(for example, the use of colons in 12:35:30). 

Use the Keyboard options to change the keyboard delay, the 
keyboard repeat rate, and the type of keyboard you are using. 

When you tap the Keyboard button, the following dialog box 
appears: 

~ Use these options to change your keyboard 
~settings. 
Keyboard 

i--:-Keyboard Delay---i Key Options 
!<>5h0rt +Medium <> Longj o Right Alt key functions like Ctrl+Alt 
r--Keyboard Repeat Rate--i o Pressing Shift releases Caps Lock 
Li> Slow +Medium <> Fasu o Exchange Ctrl and Caps lock keys 

~~~~~~~~~Keyboard,~~~~~~~~~ 

Change the following options as necessary: 

Keyboard Delay. Set the amount of time you can hold down a 
key before the character is repeated. This option applies only to an 
optional external keyboard. · 

Keyboard Repeat Rate. Set how fast a character or space is 
repeated while you hold down a key. This option applies only to 
an optional external keyboard. 

Key Options. Redefine various key combinations. 

Keyboard. Select the type of keyboard and its language from the 
list. The floating keyboard will change to reflect the new setting. 
This option applies to both the floating keyboard and an optional 
external keyboard. 
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NOTE 

The only options in this dialog box that apply to the floating 
keyboard are the Alt and Ctrl key options and the Keyboard type. 
All other settings apply only to an optional external keyboard. 

LOOK & FEEL OPTIONS 

MEMORY OPTIONS 

When you tap the Look & Feel button, the following dialog box 
appears: 

Look & Feel 

~ Use _these options to configure the look & feel of your 
~ appl1cat1ons. 
look & Feel 

~---Font Size Document Safeguarding 

The size of the system text is: 
<:>Small <:>Medium +[~~fii~l 
Sample text in selected 
font size. 

Change these options as necessary: 

Safeguarding: +On <:>Off 

Time (minutes): ~ B 
Overstrike mode 

<:> Uia insert key 
+Always disabled 

Font Size. Set the size that you see in menus, menu bars, window 
title bars, and dialog boxes. 

Document Safeguarding. When document safeguarding is on, 
the unit automatically saves the current version of your document 
as often as you specify. For more information on document 
safeguarding, see Chapter 3. 

Time. Specify the number of minutes you want between saves. 

Overstrike Mode. Overstrike mode determines whether or not 
you can toggle between overstrike and insert modes. Tap Via 
Insert Key to allow toggling between overstrike and insert mode; 
use the Insert key on an external keyboard. Or tap Always 
Disabled to use insert mode all of the time. 

Use the Memory options if you want to change the size of the RAM 
disk and the amount of EMS memory. 
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MOUSE OPTIONS 

CAUTION 

Changing Memory settings completely erases any data that you 
have stored in the RAM disk. Do not use these options unless you 
have additional memory or you want to completely reconfigure the 
unit. 

When you tap the Memory button, the following dialog box 
appears: 

Mernor·~ 

~ You can change the size of your 
~ RAM disk and the amount of EMS 

11emory memory available. 
If you alter these settings, you will 
completely erase the contents of your RAM 
disk, with no chance of recovery! DO NOT 
change these numbers unless you wish to 
completely reconfigure the unit. 

RAM Disk Size: B EMS Size: ~B 
@:!{] I Cancel I [!] 

~--!:=====-~--==-~~ 

Use the up and down arrows to adjust the memory values in 16K 
increments. If you use the pen or a keyboard to enter the numbers, 
you can enter amounts only in multiples of 16K. If you enter a 
number that is not a multiple of 16, the unit rounds the number to 
the nearest multiple of 16. The minimum EMS size is 640K. 

The RAM Disk Size and EMS Size fields interact to maintain a 
constant total; as the number in the RAM disk field is increased, 
the number in the EMS field is decreased an equivalent amount. 

Use Mouse options if you want to change the acceleration or 
double-dick time for an optional mouse. In addition, you can 
change the type of mouse you have. If you are not sure what type 
of mouse you are using, check the documentation you received 
with your mouse. 
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When you tap the Mouse button, the following dialog box 
appears: 

Mouse 

~ 
These options let you change the behavior of 
your mouse. 

House 

+!_~low: <>Medium <>Fast Current Mouse: 
r-:=l:l.()!Jble Click Tim[],---Type of Mouse-

I Double Click Test I (none) 
Selected Port: 
Not needed for this 

~Mouse Acceleration;;;-] driver 

I Change ... I <>Slow +Medium <>Fast 

[()!(] fp;;;.;;;q I cancel I [!:] 

To change double-dick time and mouse acceleration, set the 
following options as necessary: 

Double Click Time. Determines how fast you need to double
dick to initiate an action. After you select the double-dick interval, 
you can test how fast or slow you need to double-dick with the 
Double Click Test button. When you double-dick the button at the 
correct speed, the button flashes and your unit beeps. 

Mouse Acceleration. Mouse acceleration determines how far the 
mouse pointer moves when you quickly move your mouse. Select 
the mouse acceleration speed you want. A slow setting moves the 
pointer the same distance as the mouse. With a fast setting, the 
mouse pointer moves further when you quickly move your mouse. 

Installing a Mouse 

If you would like to use a mouse with the unit, you must attach it 
to the unit and then tell GEOS what type of mouse you have. 
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To install or change the type of mouse 

1. Tap the Change button. The Change dialog box appears: 

None 
No idea 

Change 

Arrow Key Mouse (Use Ins, Del, and F4.) 
Artec AM-2 I Plus (Microsoft Mode) 

[Cancel I 

2. Change the options as necessary: 

Mouse. Select a mouse from the list. 

Serial Mouse Port. Select a serial mouse port for your mouse 
when one is required. This option is dimmed if it does not apply to 
the kind of mouse you have selected. 

Interrupt Level. Set an interrupt level. If the Interrupt Level box 
is dimmed, you are using a mouse that does not require you to 
specify an interrupt level. 

3. Tap OK. A dialog box appears, asking you to test your mouse. 

4. Click the Click here to test button. The button will flash and the 
unit will beep if you have set up your mouse correctly. If the 
mouse does not react to your movements or you are not able to 
click the button, tap the button with the pen, tap Cancel, and try 
changing the settings. 

5. Tap or click OK. The Mouse dialog box disappears. 

PASSWORD OPTIONS 

Use the Password options if you want to set a new password, or 
change or remove your existing password. Your password can be 
up to eight characters long and is case-sensitive. 
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When you tap the Password button, the following dialog box 
appears: 

~ 
Passt.Uord 

Passwonl 

Enter your new password, and then 
re-enter it for confirmation. You 
cannot handwrite the password. For 
security, only asterisks appear as 
you type. 

Enter New Password: [ 
:==~~~~~~~~~===: 

Uerify New Password: [ 

~ lcanceil 

To set a password when there is no existing password, enter your 
password in the Enter New Password entry box and then in the 
Verify New Password entry box. You must enter the password 
twice, to prevent typing mistakes. To prevent someone from 
reading your password over your shoulder, only asterisks are dis
played as you type your password, so type carefully. 

If the unit already has a password, you must enter it first before 
you can remove the password or set a new one. The following 
dialog box appears if you already have a password: 

This machine has a password. You 
must enter that password here 
before you can change the 
password or turn password 
protection off. You cannot 
handwrite the assword. For 

Enter Your Password: 

I Change Password ... I I Clear Password I~ [1J 

Change Password. Tap to change your password. A dialog box 
appears in which you can enter a new password. 

Clear Password. Tap to turn off password protection. 

PEN DIGITIZER OPTIONS 

Use the Pen Digitizer options to recalibrate the tablet if you feel 
that it is not accurate. This option displays the calibration screen 
seen during the startup program. If a mouse driver (other than 
"none") is loaded, the mouse pointer appears during the 
calibration process, but it does not affect pen calibration. 
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PORTS OPTIONS 

When you tap the Pen Digitizer button, the following dialog box 
appears: 

~ You can adjust the accuracy of the 
~ pen digitizer by recalibrating it. To 

Pen Digitizer recalibrate the digitizer, touch the 
"Recalibrate·· button. 

IL~ecalibrate .. ; I 

To recalibrate the pen digitizer, tap the Recalibrate button. A Pen 
Calibration screen appears, with flashing crosses in each corner of 
the screen. Touch the pen to each flashing cross until it stops 
flashing. 

Use the Ports options if you want to change serial and parallel port 
assignments. The Ports options also allow you to enable or disable 
the built-in serial and parallel ports. 

When you tap the Ports button, the following dialog box appears: 

Ports 

~ You can configure the built-in ports, and 
~ determine how PCMCIA 1/0 cards will be 

Ports configured wJ:len inserted. 
Built-in Serial Port: +[¢(jf11] <> COM2 <>Disabled 

Built-in Parallel Port: • LPT 1 <> LPT2 <> LPT3 <>Disabled 

PCMCIA Slot 1: <>COM 1 + COM2 <> COM3 <> COM4 

PCMCIA Slot 2: <>COM 1 <> COM2 + COM3 <> COM4 

The built-in serial port can be COMl or COM2. Optional ports can 
be COMl, COM2, COM3, or COM4. 

The unit can have as many as three serial ports active at one time: 
the built-in serial port and two PCMCIA serial port cards. 

The built-in parallel port can be LPTl, LPT2, or LPT3. 

POWER MANAGEMENT OPTIONS 

Use the Power Management options if you want to change how 
long the unit will wait (from 1 to 15 minutes) before shutting down 
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when it is not in use. You can also set the unit to resume if the 
modem rings while the unit is suspended. 

When you tap the Power Management button, the following dialog 
box appears: 

Power Mgmt 

IIDl Use these options to control your unit's power 
~ management. 

PoUJer Mgmt 

Global Power Management: +Enabled O Disabled 

Wake on Modem Ring: + Enabled O Disabled 

Automatic Power-Off: +Enabled O Disabled 

Automatic Power-Off Goes Into Effect After:~ B Minutes 

'()v] Pesetj I cancel I [fJ 

Change the following options as necessary: 

Global Power Management. Choose Enabled if you want the 
unit to "doze" during periods of inactivity to conserve power. 
Doze mode slows down the processor, but it does not turn off the 
unit. Doze mode takes effect only when you are in DOS; for 
power management in GEOS, enable both Global Power 
Management and Automatic Power-Off. If you disable Global 
Power Management, Automatic Power-Off will also be disabled. 

Wake on Modem Ring. Choose Enabled if you want the unit to 
wake up when the modem rings. Choose Disabled if you do not 
want the unit to wake up when the modem rings. To conserve the 
most battery power, choose Disabled. This mode takes effect only 
when you are in GEOS. 

Automatic Power-Off. Choose Enabled if you want the unit to 
turn itself off during periods of inactivity to conserve power. 
Choose Disabled if you don't want the unit to turn itself off 
automatically. 

The unit will not automatically power-off in the following 
situations: 

• The unit is running under AC power. 

• A serial port is open. This is the case when you are using a 
mouse, a modem, or a serial printer, or GeoComm is open. 

• A parallel port is open. This is the case when you are printing to 
a parallel printer. 

Automatic Power-Off Goes Into Effect After. Enter the number 
of minutes the unit must remain idle before powering down 
automatically. You can enter the number by tapping the up and 
down arrows or by entering it directly. 
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GeoComm 

WHAT IS GEOCOMM? 

If you have a modem attached to the unit, you can use GeoComm, 
the communications application, to communicate with other 
computers, online services, bulletin board systems, and mainframe 
computers at colleges and corporations. 

GeoComm is an application that allows the unit to communicate 
with another computer or with an online service over standard 
telephone lines by means of a modem. A modem is a hardware 
device that translates the various telephone and computer signals 
that enable the unit to "talk" to another computer. 

NOTE 

While GeoComm is running, the battery-saving features of 
Advanced Power Management are disabled, and the unit may not 
be turned off until the GeoComm application is closed. 

STARTING GEOCOMM 

GeoComm 

In GeoManager, the GeoComm icon looks like the example at the 
left. 
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I 

D 

To start GeoComm 

• Locate the GeoComm icon and double-tap it. 

The GeoComm window appears: 

Cursor 

File Edit Uiew qetions Dial 

I 

The GeoComm window is where you send and receive messages. 
After you connect to another computer, any text you enter using 
the floating keyboard or an external keyboard is sent to the other 
computer. Any messages sent to you by the other computer also 
appear in the GeoComm window. 

When you first open the GeoComm window, the cursor, a 
rectangular box, is displayed in the top left comer. At this point, it 
is hollow. The cursor changes from hollow to solid, depending on 
what tasks are taking place. 

When the cursor is solid, generally it means that text you enter is 
displayed in the GeoComm window and is sent to the computer 
you are connected to. 

When the cursor is hollow, generally it means that text you enter is 
not sent to the other computer. You could be filling in a dialog 
box or receiving information from another computer. 

NOTE 
GeoComm does not support handwriting recognition. 
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CHOOSING THE PROTOCOL SETTINGS 

When you first open GeoComm, the Protocol Options dialog box 
appears automatically. Protocol is a set of rules established 
between two devices that allow and govern the orderly exchange 
of information. You use this dialog box to select the protocol 
settings for your modem. The modem's protocol settings tell your 
modem such things as how fast to transmit information, which 
communications port to use on your unit, and what type of phone 
line you have. 

1:1 Protocol 
t!odem Port: <>Com] <> Coml; <> ComJ C()m4. 

!!aud Rate: <> 300 + 1200 <> 2400 <> 4800 <> 9600 <> 19200 
Qata Bits: <> s <> 6 <> 7 + 8 

farity: + None <> Odd <> Even <> Mark <> Space 

~top Bits: + I 15 <> 2 

!:!andshake: o Hardware • Software (XON/XOFF) o None 

l·!anJwan; t·!amishakin9 Optiom:i: 
St.()p f.!em()te: u fHR 1111 RlS 

Stop _\,,QCl'l!: 11111 CT5 U DCO !:::! D'.:JR 
ITTru 
l.:::!:;J 

The settings you see displayed in the Protocol Options dialog box 
are the default settings; that is, every new GeoComm application 
starts with these settings. GeoComm obtains the default settings 
from the Modem settings, located in the Preferences application. 
For more information about the Preferences application, see 
"Preferences" in this chapter. 

The protocol settings you choose must match those of the 
computer to which you want to connect, so find out what settings 
that computer is using. 

To choose the protocol settings 

1. Fill in the dialog box, changing the settings as necessary. 

Modem Port. The modem port is the serial port on your unit used 
by your modem (for example, COMl). 

Baud Rate. The baud rate is the rate of speed at which your 
modem can send and receive information. Examples of baud rates 
are: 300, 1200, 2400, 9600 and 19200. The most commonly used 
baud rates are 1200, 2400, and 9600. In most cases, you can just set 
the maximum rate for your modem, and the other system will 
match that rate. 
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Data Bits. Data bits are the number of bits that form a character. 
The most common setting is 8. 

Parity. Parity is an error-checking mechanism used to ensure 
error-free transmission of information. The most common setting is 
None. 

Stop Bits. Stop bits are used to indicate the end of each character 
as it is transmitted. The most common setting is 1. 

Handshake. Choose Software (XON/XOFF), and GeoComm will 
monitor the flow of information from the other computer. This 
ensures that you receive all the information sent to you by the 
other computer. 

2. Tap Apply to save your settings. 

3. Tap Close to close the dialog box. 

To change the default protocol settings 

Each time you open GeoComm, the Protocol dialog box is 
displayed so you can change the settings to suit your particular 
needs. If you want the settings you choose to be permanent, 
change them using the Preferences application. When you open 
GeoComm any time after doing this, the Protocol dialog box is not 
displayed. 

1. Locate the Preferences icon and double-tap it. 

2. Tap the Modem icon to open it. The Modem Options dialog box 
appears: 

Moel em 

~ Use these options to install and 
~ configure your modem. 

Modem 

Serial Port: +fN§fr~) 0 COM I 0 COM 2 0 COM 3 0 COM 4 
Dial Type: +Tone O Pulse 

I Speed and Format Options ... I 
i()i<] if;i~;;;~:q I Cancel I [2J 

3. Fill in the dialog box, changing the settings to match those you 
made in the Protocol Options dialog box in GeoComm. 

4. Tap OK to save your changes. The dialog box closes. 

5. Tap Close to close the Preferences application. 

6. Tap the GeoComm window to activate it again .. 
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CHOOSING THE TERMINAL SETTINGS 

You can make your copy of GeoComm emulate(or act like) many 
other terminals. A terminal is a computer that does not do its own 
computing - another computer does the work. Often, terminals 
are not computers in themselves. They are merely a keyboard and 
a monitor (and sometimes a mouse) that are connected to a central 
computer. The central computer provides the processing 
capabilities for that terminal and many others. 

There are several standard types of terminals - TIY, VT52, 
VTlOO, WYSE50, and ANSI - that GeoComm can emulate. The 
emulation, however, is not complete. You may find that some 
features do not work as you would expect with a particular type of 
terminal. Despite this, the terminal emulation should be adequate 
for most situations. 

The value of being able to emulate another terminal is that a great 
many online services that you may want to talk to are written to 
support these terminals rather than your unit. When you sign up to 
use these services, they will tell you if you need to emulate a 
specific terminal in order to use the service. 

The Terminal Options dialog box contains special choices that 
allow you to specify the behavior of your terminal. 

To establish the terminal settings 

1. Choose Terminal from the Options menu. A dialog box appears: 

= I enninal 

Select Terminal: Duplex: 
TTY f <>Half (local echo) 
UT 52 +Full (full echo) 

lU•ltD • Wrap Lines at Edge 

WYSE 50 o Auto Linefeed 

ANSI - I Host !;ode Page ... I 
IBM 3101 

r··i~"r;·r;1\~J 1···R·€:;·;::l.f:;·r.··] l CloseJ [?] 

2. Fill in the dialog box, changing the settings as necessary. 

Select Terminal. Select the type of terminal you need from the 
list. 

Duplex. The Duplex setting controls the way information flows 
between two computers. At full duplex, information can flow 
between two computers at the same time. At half duplex, 
information can flow only in one direction at any given time. 
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If you do not know whether you need full or half duplex, simply 
type a few characters on your screen. If what you type appears 
twice on your screen, you need full duplex, so choose Full (full 
echo). Otherwise, choose Half (local echo). 

You must be actively connected to another computer to test the 
duplex setting. For more information about connecting to another 
computer, see "Dialing and Hanging Up" in this chapter. 

Wrap lines at Edge. This setting allows you to display all the text 
you are receiving. If you have this option selected, long lines of 
text will break at the edge of your screen and continue on the next 
line. If you do not select this option, lines of text that go beyond 
your screen's edge is not displayed. However, if you capture this 
text to a DOS file, you capture all the text, even the text that did 
not fit on your screen. 

Auto linefeed. This setting converts each incoming carriage 
return (end of line) to a carriage return and new line. Otherwise, 
each new line of incoming text might overwrite the last line. If all 
your incoming lines display as double-spaced text, do not choose 
Auto Linefeed (unless you prefer double spacing). 

Host Code Page. This setting allows you to choose a language for 
your text. When you select this option, a dialog box with a list of 
languages appears. Choose the appropriate language from the list. 

3. Tap OK to save your terminal settings. 

or 

Tap Close to close the dialog box without making any changes. 

The dialog box closes and you are returned to the GeoComm 
window. 

CONFIGURING YOUR MODEM 

Before you can use your modem, you need to set up, or configure, 
your modem to work with your telephone equipment and your 
unit. The Modem settings work only with Hayes®-compatible 
modems. Hayes is a popular modem that is recognized as an 
industry standard. 

NOTE 

If your modem is not Hayes-compatible, see your modem manual 
for the proper settings. 
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To configure your modem 

1. Choose Modem from the Options menu. A dialog box appears: 

Modem 

Pl).<:>..r.1..~ . .I.YP~.= ..... Modem Speaker: Speaker Uolume: 
+!Touch Tone! +On Until Connect <>High 
<>Rotary.. <>on Unless Dialing +Medium 

<> Always On <> Low 

t---~:=ii=·r;=i;=1;~=·i--<>_Always o_r_r_r=c=1o=s=e...------,.[I]=?=;----i 

2. Fill in the dialog box, changing the settings as necessary. 

Phone Type. This setting identifies your phone line as being 
either Touch Tone or Rotary. If you have a push-button phone, 
you probably have Touch Tone service. If you have a rotary-dial 
phone, you probably have Rotary service. 

Modem Speaker. This setting controls whether or not you hear 
signals your modem is processing. Select one of the Modem 
Speaker settings: 

• On Until Connect. This setting allows you to make sure your 
modem is successfully dialing and connecting to the computer 
your are calling. You will be able to hear the dial tone, the 
phone number being dialed, and the connection being made. 
After the connection is made, the speaker is off. 

• On Unless Dialing. The setting allows you to hear your modem 
except when it is dialing. 

• Always On. This setting allows you to have your speaker on at 
all times. 

• Always Off This setting allows you to have your speaker off at 
all times. 

Speaker Volume. This setting allows you to control the modem 
speaker volume. Choose High, Medium, or Low. 

3. Tap OK to save your modem settings. 

or 

Tap Close to close the dialog box without making any changes. 

The dialog box closes and you are returned to the GeoComm 
window. 
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CHANGING LINE AND COLUMN SETTINGS 

You can change the number of lines and columns that are 
displayed in the GeoComm window. 

To change the number of lines or columns in the GeoComm 
window 

1. Choose the Window Size option from the View menu. A dialog 
box appears: 

1:1 Wmcfow 51ze 

Window Lines: ~ B 
Window Columns: 8 B 
~~[I] 

2. Choose the number of lines or columns you want to appear in the 
window. 

3. Tap Apply to save your changes. 

GeoComm resizes the window according to your settings. 

4. Tap Close to close the dialog box. 

DIALING AND HANGING UP 

Once you have chosen your protocol, terminal, and modem 
settings, you are ready to communicate with another computer. 
This section describes how to dial the phone number as well as 
how to hang up when you are finished with your communication 
session. 

Eventually, you may want to automate certain tasks that you need 
to perform to set up for and initiate a communication session. For 
example, you may want to have the phone number dialed 
automatically, or you may want to have your unit hang up 
automatically. This section introduces the basics of creating and 
running a script, a file you create that performs these tasks for you. 
For more information about writing scripts, see "Using the 
GeoComm Scripting Language" in this chapter. 
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Using Quick Dial 

The Quick Dial option makes it easy to dial the phone number of 
another computer. 

To use Quick Dial 

Before you dial, make sure you have made any necessary changes 
to the protocol, terminal, and modem settings as discussed in this 
chapter. 

1. Choose Quick Dial from the Dial menu. The following dialog box 
appears: 

2. Enter the number you want to dial, then tap Dial. Depending on 
how you have your modem speaker set, you may hear your 
modem dialing and making the connection to the other computer. 
For more information about the modem speaker, see "Configuring 
Your Modem" in this chapter. 

If you need to access an outside phone line (for example, by 
dialing "9"), you need to tell the modem to pause for a moment 
before it dials the phone number. This is indicated with a comma 
in the phone number. For example, "9,5551212" tells the modem 
to dial 9 first to get an outside line, then pause, arid then to dial 
5551212. 

When the connection has been made, "CONNECTED" is displayed 
in the GeoComm window. 

3. Once your unit is connected to the other computer, tap Close to 
close the Quick Dial dialog box. 

Hanging Up 

When you are finished communicating with another computer, 
you need to hang up. 

To hangup 

If you dial into a computer system that requires you to log in (such 
as a bulletin board or online service), you often must log out 
before you hang up. If you don't log out first, you may continue to 
be billed for your online time. 
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1. Choose Hang Up from the Dial menu. A confirmation message 
appears. 

2. Tap Yes to hang up. 

Using Scripts 

GeoComm allows you to automate many of the commands that 
you otherwise have to type manually to communicate with 
another computer. 

For example, you can write a script that instructs your unit to dial a 
phone number, provide the necessary configuration information to 
establish a connection, and log you into an online service. 

Scripts are useful if you subscribe to several communications 
services, each of which may require different settings to your 
modem. Instead of reestablishing your modem settings each time, 
you just run the script. 

Scripts eliminate typing errors and are faster than commands you 
enter from the keyboard. 

GeoComm comes with several sample scripts that you can use to 
see how a script works. You can also modify these sample scripts 
to suit your particular communication needs. The sample scripts 
are in the folder \GEOWORKS\ USERDATA \COMMACRO. 

To create a script 

1. Use Text File Editor to create a text file containing your script 
commands. For more information about Text File Editor, see "Text 
File Editor" in this chapter. For a list of the script commands, see 
"Using the GeoComm Scripting Language" in this chapter. 

2. Save the file with a valid DOS file name with the extension .MAC. 
For example, MYSCRIPT.MAC is a valid script name. 

3. Place this file in \GEOWORKS\USERDATA\COMMACRO. You are 
now ready to run the script. 
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To nm a script 

1. Choose Scripts from the Dial menu. The following file selector 
appears: 

= Scnpts 

2. Select the script you want to run. 

3. Tap Run. The Script Display window appears and displays each 
line of the script as your unit executes it. This gives you a progress 
report on your script. 

the port, comm, term, 
phone number, account name 
and password fields. 
DIALING 

Stop Running Script 

NOTE 

If your script stops abruptly, it may be because you made an error 
in the script. 

To stop a script 

• Tap Stop Running Script to stop the script and return to the 
GeoComm window. 

SHOWING LINE STATUS 

The Show Line Status option allows you to monitor the quality of 
your connection. In other words, Show Line Status allows you to 
"see" how good the connection is. Data communication is similar 
to a regular phone call in that sometimes the connection is 
"bad" - there is a lot of noise on the line. Usually, you just need 
to hang up and redial to correct the situation. Based on 
information provided from Show Line Status, you may decide that 
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the quality of the connection is poor. In that case, you can hang up 
and try again later. 

To monitor the line connection quality 

• Choose Show Line Status from the Options menu. The following 
status window appears: 

1:1 511ow Line Status 

Read Errors: 0 Write Errors: 0 

Frame Errors: 0 Parity Errors: 0 

I: Reset Counters] I I Close I [fl 

The line status errors monitored by GeoComm are the number of 
errors in reading the message being received or writing the 
message being sent. Specifically, GeoComm checks the parity bit 
(see "Choosing the Protocol Settings" in this chapter) for 
transmission errors in each block (or frame) of information 
received or sent. 

GeoComm automatically tracks and counts these errors during 
your communication sessions. It is normal to have a small number 
of errors. However, if you see hundreds of errors encountered 
during a session, consider hanging up and retrying your 
connection. 

To reset the counters to zero errors 

It is a good idea to reset the counters every time you start a 
communication session. Otherwise, the error count for the current 
session will be added to any existing values. This results in an 
inaccurate count of the number of errors in the current session. 

1. Tap Reset Counters. The counters are all reset to zero values. 

2. Tap Close to close the window and return to the GeoComm 
window. 

SENDING A BREAK SIGNAL 

At some point during send or receive operations at your terminal, 
you may want to send a break signal. A break signal interrupts 
some command you've entered or some process taking place, 
perhaps because it is taking too long. A break signal takes effect 
immediately. 
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To send a break signal 

• During an operation in GeoComm that you want to interrupt, 
choose Send Break Signal from the Dial menu. Whatever is 
displaying in the window is stopped. 

NOTE 

A break signal does not work if your terminal is set to half duplex. 

SENDING INFORMATION 

GeoComm allows you to send various types of information to 
another computer, from brief messages to the receiving computer 
that you type on your keyboard to complex computer applications 
or text files that you have stored in memory. 

There are four ways to send information to another computer: 

• Typing and sending a message using the Message choice on the 
Edit menu. Use this method when your messages are brief and 
spontaneous, and when you want to send them to the other 
computer immediately. 

• Sending text that you have copied into the clipboard. Use this 
method when you have a file that you've created in a GEOS 
application, and you want to send information from that file to 
the other computer. 

• Sending a DOS text file. Use this method when you want to 
send a DOS text file. 

• Sending files using XMODEM. Use this method when you are 
sending entire files, large amounts of information, or 
applications to another computer. It provides error checking to 
ensure that your files or applications arrive intact. 

Sending Brief Messages 

The Message option on the Edit menu allows you to create brief 
messages either offline (meaning you are not connected to another 
computer) or while you are connected to another computer. It 
gives you time to compose and edit your message before sending 
it. 

The Message choice does not perform error checking. In other 
words, using Message does not guarantee that all your characters 
are reaching the other computer. This is usually not a problem for 
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short text files messages like "Hello, how are you?" If a message 
this brief gets corrupted by a poor connection and arrives "Hello, 
how are ?ou" the receiving party can probably still decipher it. 

However, it is not acceptable for sending long files and large 
amounts of information. Suppose you are sending your income tax 
figures to your accountant and the number that represents your 
gross income is corrupted. What started out as "35,000.00" may 
have arrived as "$&5*#00.00." Your accountant is not likely to 
figure this out. To send long files, use the XMODEM protocol, 
discussed in "Sending Text Files Using XMODEM" in this chapter. 

To compose and send a brief text message 

1. Select Message from the Edit menu. The following dialog box 
appears: 

2. Enter your message in the dialog box as you would any text. 

3. Edit the text as needed. 

4. Tap Send when you are ready to send your message. GeoComm 
both displays the message in your window and sends it to the 
receiving computer, where it displays in that computer's window. 

5. Tap Close to return to the GeoComm window. 

Sending Text Using the Clipboard 

You can copy text from other GEOS applications and send it to 
another computer. For example, suppose you have an 
announcement that you have written using Text File Editor. You 
can open the appropriate Text File Editor file and copy the 
message to the clipboard. Then you can paste the contents of the 
clipboard into the GeoComm window. When you do this, 
GeoComm sends the text to the other computer just as if you had 
entered it directly into GeoComm. 

NOTE 
This method of sending text works with GEOS applications, but not 
with regular DOS applications. 
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To send the contents of your clipboard 

1. Open the file containing the text you want to send. 

2. Select the text you want to send. 

3. Choose Copy from the Edit menu to copy the text to your 
clipboard. 

4. Close the file and open the GeoComm application. 

5. Choose Paste from the Edit menu. GeoComm pastes the contents 
of your clipboard into the GeoComm window and sends it to the 
other computer. 

Sending DOS Text Files 

This option allows you to send entire DOS text files that you have 
saved in memory or perhaps on a diskette. This method does not 
perform error checking, so there is no guarantee that the 
information will arrive error-free. 

NOTE 

This method of sending text is for files created in DOS applications, 
as well as in Text File Editor. 

To send an existing DOS text file 

Before sending an existing DOS text file, it is good practice to 
verify whether or not the receiving computer requires linefeeds. 
Linefeeds prevent text from being typed over preceding text. 

1. Choose Type From Text File from the File menu. The following file 
selector appears: 

1:1 Type Ft'Otn Text File 

l5re~~~~jf~;;{;;~ii~?c:~i7~=-;)tl I Dri~es -I 
i:~··@i!ll ···~~ 

•Strip Linefeeds From Text 

2. Locate and select the DOS file you want to use. 

3. Select Strip Linefeeds From Text if the computer you are sending 
to does not need linefeeds after carriage returns. Most computers 
need linefeeds, so you normally will not need to select this option. 

4. Tap Type when you are ready to send the DOS file. 
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GeoComm displays a status window to show how your file 
transfer is proceeding. When the file transfer is completed, 
GeoComm returns to the GeoComm window. 

Sending Text Files Using XMODEM 

The XMODEM protocol is a method of transmission that you can 
use to send entire files and large amounts of information to 
another computer. The advantage of using XMODEM is that it 
detects a transmission failure, and it resends the information. 

NOTE 
Before you can use XMODEM to transfer files, verify that the other 
computer is set up to receive an XMODEM transfer. Do this by 
calling before you establish your connection or, once you are 
connected, by sending a message to the receiving computer 
indicating that you want to use XMODEM. 

To send a file using XMODEM 

1. Establish the connection with the computer to which you want to 
send a file using XMODEM. 

2. If necessary, make sure the receiving computer is ready to receive 
a file using the XMODEM protocol. 

3. Choose Send XMODEM from the File menu. The Send XMODEM 
file selector appears: 

1:1 Send XMODEM 

Packet Size: + 128 bytes <> I K blocks 

4. Locate and select the file you want to use. 

5. Select the size of the data packet. Large files are broken up into 
small data packets to facilitate transferring them to another 
computer. The recommended selection is 128 bytes. 

6. Tap Send. The Send Status window appears and shows the 
progress of the transfer, reporting any errors. XMODEM 
automatically resends those portions of the transmission that have 
errors. However, if the error count increases suddenly, you 
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probably have a problem in the phone line and may want to retry 
the transmission later. 

Send Status 

Sending: DOCUMENT 

Packets Sent: 0 

Packet Errors: 0 

Timeouts: 0 

RECEIVING INFORMATION 

This section describes how to receive information sent to you from 
a remote computer during a communication session. You can 
receive the types of messages and files discussed in "Sending 
Information" in this chapter. 

You should always disable call waiting when using the phone line 
for data communication. Failure to do so may cause the other 
computer to disconnect if someone else tries to call while you're 
connected. To find out how to disable call waiting, consult your 
local telephone company. 

Before you receive information, it is a good idea to determine 
what you intend to do with it. Depending on the type and volume 
of information, there are various ways to accept, store, and save it, 
including the following: 

• Scrolling through the text as it arrives without saving it. 

• Copying the text to a file's clipboard. 

• Saving the text in a text file. 

Scrolling Through the Text Displayed in the Window 

As the text arrives at your unit and is displayed in the window, the 
first part of the text may scroll off the screen. If the message is 
longer than 175 lines, consider copying it to the clipboard. See 
"Copying Text to the Clipboard" in this chapter. 

To scroll through the text in your window 

• Tap the up or down arrow on the scroll bar. 
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Copying Text to the Clipboard 

If you want to save small amounts of text that appear in your 
window, use the Copy and Paste commands to paste the text into 
another GEOS application file, such as a Text File Editor file. You 
can copy and paste information a screenful at a time, or you can 
wait until the entire message has arrived, as long as the message 
does not exceed 175 lines of text. 

NOTE 

Only the last 175 lines of text received are saved. If the message 
exceeds 175 lines, newly arriving text is written over the text that 
has already arrived. For a method of capturing more than 175 lines 
of text, see "Saving Text in a File" in this chapter. 

To copy text from your clipboard to a file 

1. Select the text in the GeoComm window that you want to copy. 
You can select text using the pen, the same way you would select 
text in Text File Editor, for example. For more information about 
selecting text, see Chapter 1. 

2. Choose Copy from the Edit menu. 

3. Open the desired file and place the insertion point where you 
want to insert the text. 

4. Choose Paste from the Edit menu. The text is pasted into the file. 

Saving Screen and Scroll-Back Buffer Text to a File 

GeoComm saves the last 175 lines of text in the scroll-back buffer. 
This is an area that stores the text that scrolls off the screen out of 
view. GeoComm stores the information in the scroll-back buffer so 
that you can redisplay it by scrolling back through the window. 
Otherwise, all the text that scrolls off your screen would be lost. 
By saving text in a file, you can prevent the loss of incoming text. 
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To save the contents of your screen and scroll-back buffer 

1. Choose Save Buffer from the File menu. The Save Buffer file 
selector appears: 

1:1 Suue Buffer 

Select folder and enter new filename for save: 

Save File: 

OK Close 

Save Contents of: 
+Screen Only 

'.:Jcroll-Back B~1H~~r Onl~J 
Scroll-Back B~1H~~r and Scre~~n 

2. Locate and select the directory you want. 

3. Enter a DOS file name (a DOS file name contains up to eight 
letters or numbers, optionally followed by a period, then a three
letter extension). For more information about DOS file names, see 
Chapter 1. 

4. Select Screen Only to save only what you see on your screen. 

or 

Select Scroll-Back Buffer Only to save only what is hidden in the 
scroll-back buffer. 

or 

Select Scroll-Back Buffer and Screen to save both. 

5. Tap OK to save the text to the file you have specified. 

Saving Text in a File 

You can "capture" all incoming text as it arrives and have it placed 
in a file immediately. Since GeoComm usually saves only the most 
recently received 175 lines of text that displays in the window, this 
method of saving text ensures that all the text is saved in the file 
you specify. It is also faster than using the Copy and Paste method. 

To save all incoming text to a file 

You need to be set up before you can start capturing incoming text 
to a file. 
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1. Before text you want to save starts arriving in the window, choose 
Capture to Text File from the File menu. A file selector appears: 

1:1 Capture to Text File 

Select folder and enter filename for capture: 
I fath -I[(;() i() f)()(;1;r;;;;r)i 11 Dri~es -I 

r·M!IUI"" ···~~ 
• End Lines With CR/LF 

Capture File: IE@!iidi 

I !;;apture I I Close I IIJ 
2. Locate and select the directory you want. 

3. Type a DOS file name (a DOS file name contains up to eight letters 
or numbers, optionally followed by a period, then a three-letter 
extension). For more information about DOS file names, see 
Chapter 1. 

4. Select End Lines with CR/LF if you want the end of each line to 
contain a carriage return and linefeed. If you are unsure, it is a 
good idea to select it. 

5. Tap Capture to start saving screen text. GeoComm displays a status 
window to report this activity while you are online: 

Capturing to: capture.txt 

!:stop Capture:! 

6. Tap Done in the Capture Status window when you are finished 
capturing text. 

Saving Text Files Using XMODEM 

You can receive text files and be assured that they arrive without 
transmission errors. The other available choices for receiving files 
do not provide error checking or correction. 

NOTE 

Before you can use XMODEM to receive files, verify that the other 
computer is set up to send files using XMODEM. Do this by calling 
before you establish your connection or, after connecting, by 
sending a message to the sending computer indicating that you 
want to use XMODEM. Also, find out what error-checking 
mechanism is supported, Checksum or CRC. 
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To receive a file using XMODEM 

1. Establish the connection with the computer from which you want 
to receive a file using XMODEM. 

2. If necessary, send a message telling the sending computer that you 
want to use the XMODEM protocol. 

3. Choose Receive XMODEM from the File menu. The Receive 
XMODEM file selector appears: 

Receive XMODEM 

Select folder and enter filename for receive: 
I _eath -I 1.6() i() f)(;;;;~rr\{;;;;l I ori!,'es -I 

rHUiUl!!!I ~ 

File Type: O Text +Binary 

Xmodem Protocol: + Checksum 0 CRC 

Receive File: 

IBeceive I 

4. Locate and select the directory you want. 

5. Select the type of file you are receiving. You have the following 
two choices: 

• Text. Select this if the file you are receiving is a basic DOS text 
file (straight ASCII). 

• Binary. Select this if the file you are receiving is more complex, 
like a word processor file, or a graphic file (not straight ASCII). 

6. Select the type of error checking to be performed by XMODEM. 
There are two choices, each of which ensures error-free file 
transfer: 

• Checksum. This is a simple method of checking for file 
corruption during sending and receiving. 

• CRC (Cyclic Redundancy Check). CRC is more sophisticated 
than Checksum. It is a good idea to select it if the sending 
computer supports it. 

7. Enter the name of the file you want the text saved to. The name 
should be appropriate for the type of file you are expecting. (For 
example, a DOS text file would have a .TXT extension.) 

4.76 THE GEOWORKS ACCESSORIES 



8. Tap Receive. The Receive Status window appears: 

Receive Status 

Receiving: Schedule 

Packets Received: 0 

Packet Errors: 0 

Timeouts: 0 

l!Abort Transfer'! 

The Receive XMODEM Status window shows you the progress of 
the transfer. If errors increase dramatically, you may have a poor 
line connection. In that case, consider canceling the transfer and 
trying again later. 

USING THE GEOCOMM SCRIPTING LANGUAGE 

You can package a series of commands into one file, called a 
script. You then use this file to instruct GeoComm to perform a 
series of tasks. This means that you do not need to respond to 
prompts or worry about mistyping information. 

For example, suppose you use your GeoComm application to 
connect to a subscription service to receive a file that lists 
statistical information. Every day, you open GeoComm, select the 
Quick Dial option, enter the same phone number, and respond to 
requests for the same information. 

You can simplify this process by writing a script that automatically 
dials the phone number, logs into the service, receives the file, and 
places it in the proper directory in your unit's memory, then logs 
out and hangs up. You don't need to wait around to respond to 
prompts or to log out. 

This section introduces the script language commands. In many 
cases, each command is the equivalent of a menu choice. 

For more information about how to create and run a script, see 
"Using Scripts" in this chapter. 

Script Syntax Guidelines 

All GeoComm scripts must follow specific guidelines for syntax 
(the "grammar" for the commands) and treatment of text. These 
guidelines are: 
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• All GeoComm commands must be in uppercase; for example, 
CLEAR, DIAL, END. 

• All commands are case-sensitive (if a capital A is required, you 
cannot use a lowercase a). 

• Words shown enclosed in angle brackets ( < >) are place holders 
for the actual words you need to type; for example, where you 
see <baud>, you type the actual baud rate, such as 2400. Do not 
include the angle brackets. 

• A line that starts with a colon is treated as a label or comment. 
This means that GeoComm displays that line of text, but it does 
not attempt to process or execute anything. 

Script Commands 

The script commands are listed below in alphabetical order. If 
available, the equivalent menu choice or other function is 
provided to help you visualize what happens when you use a 
command. 

You will see a few examples of how these commands are actually 
used. It is good practice to start with a simple script, then build on 
it by adding more commands. Try to see if you can build a script 
that performs an entire communications session from dialup to 
hangup without requiring your intervention. For more information 
about running your scripts, see "Using Scripts" in this chapter. 

:<IABEL> 

Any line beginning with a colon is treated as a label (although the 
colon isn't actually part of the label). Use the GOTO command to 
jump to a label line. Labels can be in upper- or lower-case, but you 
must be consistent. If you have a label defined as ":GoHere'', you 
must refer to it exactly the same way in GOTO statements ("GOTO 
GoHere"). Here is a sample label line: 

:JurnpToThisLabel 

ABORT 

GeoComm goes to this special label when you tap Stop in the 
Script Display window. The word "ABORT" must be all uppercase. 
This is how the abort label should appear in your scripts: 

:ABORT 
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BELL 

This command sounds a beep. Use this in your script to alert you 
to an activity that is taking place or one that has been completed. 
For example: 

BELL 

CLEAR 

This command clears the Script Display window. For example: 

CLEAR 

COMM <BAUD-DATABITS-PARITY-STOPBITS-DUPLEX> 

This command allows you to specify the baud rate, data bit value, 
parity setting, stop bit value, and duplex settings all on one line. 

This command is the equivalent of specifying Baud Rate, Data Bits, 
Parity, and Stop Bits in the Protocol dialog box and of specifying 
Duplex in the Terminal Options dialog box. For more information, 
see "Choosing the Protocol Settings" and "Choosing the Terminal 
Settings" in this chapter. 

For example, if you're using a 2400-baud line with eight data bits, 
no parity, and one stop bit, you would put this command in your 
script (put dashes between settings): 

COMM 2400-8-N-1-FULL 

DIAL "<NUMBER>" 

This command dials the phone number you specify after DIAL. 
The phone number must be enclosed in quotation marks. Use 
commas to make GeoComm pause in the dialing. For more 
information, see "Dialing and Hanging Up" in this chapter. 

To dial 9 (for an outside line), a pause, and then 555-1212, you 
would put the following line into your script: 

DIAL "9,555-1212" 

END 

This command stops the script and returns control to you. It does 
not jump to the :ABORT label. Use this command to continue 
manually what the script has started for you. 
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This is useful for beginning script users as a way to implement a 
basic script to see how one works. For example: 

DIAL "9,555-1212" 

END 

This script dials the phone number, 9,555-1212, then returns the 
GeoComm window back to you just as if you had used the Quick 
Dial option on the Dial menu. 

GOTO <LABEi> 

This command instructs GeoComm to go to the line specified by 
the label. You can use the GOTO command to jump to specified 
label lines (lines that begin with a colon). You must enter the 
GOTO label commands exactly the way you entered the label (be 
sure to leave off the colon, though). For example, the following 
line: 

:JumpToThisLabel 

must be referred to in a GOTO command as: 

GOTO JumpToThisLabel 

MATCH <TEXT> GOTO <LABEL> 
PROMPI' <NUMBER> 

The MATCH and PROMPT commands work together to make 
GeoComm perform some action based on text received from 
another computer. 

First, the MATCH command makes GeoComm look for <text> in 
the text that is transmitted by the other computer. You can specify 
many MATCH commands but after them all, you must include a 
PROMPT command. 

The text for the MATCH commands must be entered inside 
quotation marks(" "). 

4.80 THE GEOWORKS ACCESSORIES 



The PROMPT command specifies the amount of time your unit 
waits for the sending computer to supply the MATCHing text. 
PROMPT time values are in sixtieths of a second. (That is, 3600 
sixtieths is a minute.) If the MATCH command is satisfied within 
the time specified in the PROMPT command, the script goes to the 
given label. Otherwise, GeoComm goes to the next line in the 
script. For example: 

MATCH "password?" GOTO DoPass 

MATCH "System is down" GOTO SystemDown 
PROMPT 3600 
PRINT "No Response" 

The first MATCH command looks for the text "password?" from the 
remote computer. If the text is sent, the script goes to the label 
"DoPass"; otherwise, it continues with the next MATCH statement. 
If the second MATCH is made, the script goes to the label 
"SystemDown." If neither condition is met in the allotted minute 
(PROMPT 3600), the script prints "No Response" in the Script 
Display window. 

PAUSE <NUMBER> 

This command causes GeoComm to pause for the amount of time 
specified. The number value is in sixtieths of a second. The default 
is 60, or one second. To have your script pause for one minute, 
use the following line: 

PAUSE 3600 

PORT<PORT> 

This command instructs GeoComm to use the COM port specified. 
(This is a serial port on your unit where your modem is 
connected.) 

This command is the equivalent of specifying Modem Port in the 
Protocol dialog box. For more information, see "Choosing the 
Protocol Settings" in this chapter. The following command tells 
GeoComm to use COM port 2: 

PORT 2 

PRINT "<TEXT>" 

This command instructs GeoComm to print <text> in your Script 
Display window. This message is not sent to the other computer. 
Use this command as an indication of what the script is doing. You 
can have as many PRINT statements in your scripts as you want. 
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To force carriage returns after the text display, enter ",CR" at the 
end of each line, or add another print command: 

PRINT CR 

For example: 

PRINT "Enter Password Now" ,CR 

PRINT "Password:" 

This displays on your screen as: 

Enter Password Now 

Password: 

PUISE 
TONE 

These commands cause GeoComin to use pulse or tone dialing 
when it dials a phone number. Otherwise GeoComm uses 
whatever you have set in your Modem settings. For more 
information, see "Configuring Your Modem" in this chapter. To 
force your script to use pulse dialing, use the following command: 

PULSE 

SEND "<TEXT>" 

This command sends the specified text to the other computer. Use 
a ",CR" at the end of the text if you want to insert a carriage return 
after the text. For example, to send the word "password" followed 
by a carriage return to the other computer, you would put the 
following line in your script: 

SEND "password" ,CR 

TERM <TERMINAL 'IYPE> 

This command instructs GeoComm to emulate the type of terminal 
specified. 

This command is the equivalent of specifying Select Terminal in 
the Terminal Options dialog box. For more information, see 
"Choosing the Terminal Settings" in this chapter. For example, to 
make GeoComm emulate a standard TTY terminal, you would put 
this command in your script: 

TERM TTY 

4.82 THE GEOWORKS ACCESSORIES 





WHAT IS GEOWRITE? 

GeoWri te 

5.2 GEOWRITE 

GeoWrite Basics 

This section describes the Level 1 functions of GeoWrite. You can 
use every feature of this basic set at all levels of Geo Write. When 
you know these basic skills, you can compose memos, letters, and 
reports with ease using the power of Geo Write. 

This chapter assumes you are familiar with the information 
covered in Chapter 1 and Chapter 3, which give an overview of 
the skills you need to use any GEOS application. 

GeoWrite is a word processing program. It lets you put words on a 
page - and it lets you change them easily and quickly! 

When you type, GeoWrite moves the text to accommodate your 
adding and deleting words, paragraphs, or whole chapters. You 
can make changes throughout an entire document with a few 
simple keystrokes. For example, you can change every occurrence 
of the word problem to the word opportunity. You can improve 
any document without tedious retyping. 

NOTE 

GeoWrite does not support handwriting recognition. Although you 
can use the floating keyboard to type and edit, we strongly 
recommend that you use an optional external keyboard. 



USER LEVELS IN GEOWRITE . 

To accommodate your experience and needs, GeoWrite has four 
user levels. Typically, you begin using an application at Level 1, 
which is the simplest and most basic level. As you gain experience 
and comfort with GeoWrite, you can add more functions by 
increasing your user level. For more information about changing 
and saving user levels, see Chapter 3. 

GeoWrite Level 1. Level 1 includes the basics of manipulating 
text, using the Style bar, moving around in a document, using 
templates, and checking spelling. This section of Chapter 5 
describes the features available at Level 1. 

GeoWrite Level 2. Level 2 introduces ways to enhance a 
document by adding headers, footers, and a title page. You can 
format text and use color to change the way text looks. This level 
makes it easy to use styles to give your documents a consistent 
look. 

GeoWrite Levels 3 and 4. Levels 3 and 4 introduce advanced 
techniques for creating documents using graphics, sections, and 
page layout features. At these levels, you can create documents 
with multiple columns, insert special characters (such as page 
breaks), and create templates and tables of contents. You can even 
merge data from other applications into your GeoWrite document. 
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THE GEOWRITE WINDOW 

5.4 GEOWRITE 

The GeoWrite window looks like this: 

Left indent markers 

l Ruler Right indent marker l 
f)le J;;d_1 !,llew J!pt1ons faragraph Fonts Si;:;es ;:ityles 

~1 JI] ~ ~ 8:1t~J!!!J J URI-I Roman -J [ 12 ~I}t 

~== ~e: Friday'sP~ 

~ part;y Friday will start at 3:30i:n:t00m :lXI. Pleas:esiJ:t1.up onthilistth.i.t:il:baine p&Dfld 
juound tN! of~e ifYQU would liha to brlna somethina. I will be pla.nnins some aroup mi:ll:ar 
lgames arid Kim will be takinQi c:~ of thl d1c:0Wions.I 

Text area Insertion point 

lill 

The rnler shows you the size of the page and the locations of 
margins and tab settings. You can change these settings by 
tapping and dragging the symbols on the ruler. When you start a 
new document, these settings are automatically set for 1-inch 
margins, giving you a 6-1/2 inch wide text area on an 8-1/2 inch 
wide page. 

Left Indent Marker. The two-part left indent marker enables you 
to set the indentation of the first line and of all succeeding lines. 

Right Indent Marker. The right indent marker allows you to set 
the right indentation. 

Tab. Tab stops appear automatically every 1/2 inch, as shown by 
the tiny T symbols on the ruler. You can add or delete tab stops 
where you need them. 

The text area is the area inside the margins of Geo Write. 
Characters you enter using an external or floating keyboard appear 
in this area. 

NOTE 

You cannot use the pen to write by hand directly in the text area. 



ENTERING TEXT 

ALL LEVELS 

The insertion point, the blinking vertical line, indicates where the 
characters you enter appear in the document. 

You can change the way a document appears on the screen by 
zooming in and out. You can zoom in to make a document appear 
larger or zoom out to make it appear smaller. For more 
information, see Chapter 3. 

When you type on the external keyboard or tap characters on the 
floating keyboard, the words appear in the text area. As the words 
reach the end of a line, they automatically wrap down and 
continue on the next line. This feature is called word wrap. Word 
wrap means that you do not have to tap Enter on the floating 
keyboard to start a new line of text. This keeps the lines and 
sentences together in the same paragraph. When you are ready to 
begin a new paragraph, tap Enter on the floating keyboard. 

Positioning the Insertion Point 

The insertion point is the blinking vertical line that indicates where 
the characters you enter appear on the screen. On a blank page, 
the insertion point appears in the upper left corner. As you enter 
characters, the insertion point moves to the right, appearing after 
the last word. When you need to make changes to text you have 
already entered, you can move the insertion point. 

To move the insertion point (All Levels) 

• You can use the pen or an external keyboard to move the insertion 
point. 

• Use the pen to tap the text area where you want to start the 
insertion. The insertion point moves to the new location. 

• If you are using an external keyboard, you can use its keys to 
move the insertion point without moving or changing the text. 
The following table shows the key combinations for moving the 
insertion point with the external keyboard: 

KEY COMBINATION 

Home 

Ctrl+Home 

MOVEMENT 

To the beginning of the current line. 

To the beginning of the document. 
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End 

Ctrl+End 

Arrow Keys 

Ctrl+Left Arrow 

Ctrl+Right Arrow 

Inserting Text 

To the end of the current line. 

To the end of the document. 

One character or line in the direction of 
the arrow. 

To the beginning of the current word or, if 
it is already there, to the end of the 
previous word. 

To the end of the current word or, if it is 
already there, to the beginning of the next 
word. 

Once you position the insertion point, anything you type is 
inserted into the document at that location. Any text to the right of 
the insertion point moves over to accommodate the inserted text. 

CORRECTING AS YOU ENTER TEXT 

If you make a mistake entering text and notice it immediately, you 
can tap the Backspace key on the floating keyboard to erase 
characters to the left of the insertion point. Tapping the Delete 
key on the floating keyboard erases characters to the right of the 
insertion point. 

STARTING A NEW PARAGRAPH 

When you want to start a new paragraph, tap Enter on the 
floating keyboard. The insertion point moves to the left margin of 
the next line. If you want to split an existing paragraph into two 
paragraphs, position the insertion point where you want to split 
the paragraph and tap Enter on the floating keyboard. 

Entering Numbers 

Numbers you enter appear in the text area. You can enter numbers 
using the alphanumeric section at the top of the floating or 
external keyboard, the numeric keypad on the external keyboard, 
or the numeric keypad on the Math Symbols floating keyboard. 



MOVING AROUND IN YOUR DOCUMENT 

ALL LEVELS 

SELECTING TEXT 

ALL LEVELS 

As a document gets larger and you cannot see all of it on the 
screen, you will need to move through it in various ways. Here are 
some methods you can use to display other parts of the document: 

Scrolling. Tap the scroll bars to look at different areas of your 
document. Scrolling does not move the insertion point. See 
Chapter 1 for more information about scrolling. 

KEY COMBINATION 

Page Up 

Page Down 

Ctrl+Page Up 

Ctrl+Page Down 

MOVEMENT 

To scroll the screen back toward the 
beginning of the document. 

To scroll the screen foiward toward the 
end of the document. 

To scroll the screen right. 

To scroll the screen left. 

Leafing Through Pages. The Next Page and Previous Page 
choices on the View menu move the document forward and back 
one page at a time. 

Go to Page. You can go directly to a specified page in a long 
document. 

To go to the next or previous page in a document (All Levels) 

Tap the Next Page or Previous Page button on the Style bar. 

or 

Choose Next Page or Previous Page from the View menu. 

To go to a specific page (All Levels) 

1. Choose Go to Page from the View menu. A dialog box appears. 

2. Enter the page number you want. 

3. Tap Go to Page in the dialog box. The page you specified appears. 

When you want to make changes, such as rewording a sentence or 
moving a paragraph, first you must select the text you want to 
change. Selected text appears highlighted. Once you select text, 
you can manipulate it in many ways, including the following: 

• Delete or replace a selection. 
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• Cut, copy, and paste text using the clipboard. 

• Change the font, text size, or text style. 

• Change the space between lines. 

• Change the paragraph alignment. 

You can use either the pen or an external keyboard to select text. 

Using a Pen 

To select text using a pen, you can choose between two selection 
methods. You can drag the pen from the beginning of the text you 
want to select to the end of the text, or you can quickly tap the 
pen the appropriate number of times: 

2 taps. Selects a word, but not the space after the word. 

3 taps. Selects a line. 

4 taps. Selects a paragraph. 

5 taps. Selects the entire document. 

If you change your mind after making a selection, you can cancel 
the selection by tapping anywhere in the text area. 

Using an External Keyboard 

You can also use the external keyboard to select text. The table 
below shows how to select text and reduce or extend selections by 
using two or more keys at the same time. 

KEY COMBINATION 

Shift+ Right Arrow or 
Shift+ Left Arrow 

Ctrl+Spacebar 

Ctrl+Shift+Right Arrow 

Ctrl+Shift+Left Arrow 

Shift+Up Arrow 
or Shift+ Down 
Arrow 

SELECTION 

Selects one character in the direction of the arrow; 
reduces or extends the selection a character at a time in 
the same way. 

Selects the current word; the insertion point must be 
within the word. 

Selects to the end of the current word. If already at the 
end of a word, selects to the beginning of the next 
word; extends or reduces the selection in the same 
way. 

Selects to the beginning of the current word. If already 
at the beginning of a word, selects to the end of the 
previous word; extends or reduces the selection in the 
same way. 

Selects from the insertion point one line up or down in 
the direction of the arrow; extends or reduces the 
selection in the same way. 



Shift+ Home 

Shift+ End 

Selects from the insertion point to the beginning of the 
line; extends or reduces the selection a line at a time 
toward the beginning of the document. 

Selects from the insertion point to the end of the line; 
extends or reduces the selection a line at a time toward 
the end of the document. 

Ctrl+Shift+Up Arrow or Selects to the beginning or end of a paragraph in the 
Ctrl+Shift+Down direction of the arrow; extends or reduces the selection 
Arrow in the same way. 

Ctrl+Shift+Home 

Ctrl+Shift+End 

Ctrl+/ 

Selects from the insertion point to the beginning of the 
document. 

Selects from the insertion point to the end of the 
document. 

Selects the entire document (the same as choosing 
Select All from the Edit menu). 

For more information about selecting text, see Chapter 1. 

USING THE STYLE BAR 

ALL LEVELS The Style bar appears above a GeoWrite document. Its tools allow 
you to move from page to page of your document and to change 
text characteristics of selections: font, text size, and text style. The 
Style bar provides an easy way to select choices that can also be 
found on menus. 

Previous page button 

Current page 

Next page button 

Spell check 
Text alignment: left, 
centered, right, and full 

URW Roman -

Click to see a list of fonts. 

Click to see a list of font sizes. 

Font size: increase and decrease 

Text styles: plain, bold, italic, and underlined 
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EDITING TEXT 

ALL LEVELS 

See Appendix A for complete information about the buttons on the 
Style bar. 

To use a tool on the Style bar (All Levels) 

• After selecting the text you want to change, tap the appropriate 
tool button. The selected text changes. 

Once you have selected text, you can edit it. You can replace it 
with different text, delete it, move it somewhere else, or make a 
copy of it. You will often use the clipboard to edit text by cutting 
or copying text to the clipboard and then pasting that text into 
your document. If you make a basic change and immediately 
decide that it is not what you want, you can undo the change. For 
more information about editing text, see Chapter 1. 

CHANGING THE WAY TEXT LOOKS 

ALL LEVELS 

5.10 GEOWRITE 

GeoWrite has many options for creating attractive, easy-to-read 
text that conveys your ideas visually. You can change the 
appearance of the characters you use, as well as the alignment, 
indentation, and spacing of lines in a paragraph. 

The way a character looks on screen and when printed is 
determined by its font, size, style, and other attributes. You can 
apply character attributes in two ways: 

• Select the text you want to change, then choose the attribute 
you want. 

• Select the attributes you want, then enter new text. GeoWrite 
applies the current attribute settings to any new text you enter. 

In Geo Write, the location of the attribute menu choices for 
changing a font, size, or style varies slightly depending on your 
user level. At Level 1, you select the Fonts, Sizes, or Styles menu 
directly from the menu bar. At Levels 2-4, you choose Fonts, Sizes, 
or Styles from the Character menu. You can also select font, size, 
and style attributes by tapping the appropriate button on the Style 
bar. For more information about text attributes, see Chapter 1. 



Using the Ruler 

When you open a new document, the margins are set for a 6-1/2 
inch text area and the tab stops are 1/2 inch apart. You can use the 
ruler to change left and right indentations and to insert different 
tab stops. 

The indentations and tab stops you see on the ruler affect the 
paragraph containing the insertion point. If you want to change 
the setting for the whole document, you must first select the 
document by choosing Select All from the Edit menu or by quickly 
tapping the pen five times. 

First line indent 

Hanging indent 

I Tab stop Right indentl 

1 ~ ~ ~ .A ...!>. -"-
~ IT ~ 

Ma rg in indicator 

NOTE 

Levels 2 and above include additional options for changing 
paragraph indentation and setting tab stops. For more information, 
see "Formatting GeoWrite Documents" in this chapter. 

At Level 2 and above, you can change headers and footers. 
However, ruler changes do not affect header and footer text. For 
more information, see "Formatting GeoWrite Documents" in this 
chapter. 

INDENTATIONS 

The text of each paragraph wraps within the indentation setting, 
which you can change using the indentation markers on the ruler. 

The right indent marker is a single triangle that you can drag to a 
new location to specify the right edge of the text. 

The left indent marker includes two triangular markers: 

• The upper triangle sets the indentation of the first line of the 
paragraph. 
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• The lower triangle sets the indentation for the remaining lines 
of the paragraph (the hanging indent). 

If both of the left indent triangles are together, all lines in the 
paragraph align beneath the markers. If the top triangle is to the 
right of the bottom triangle, the paragraph indents in the standard 
way, with the first line indented. 

If you want to specify a hanging indent to create a special 
indentation for a list with numbers or bullets, move the lower 
triangle to the right. The upper triangle shows the indentation of 
the first line in a paragraph, and the lower triangle shows the 
indentation of all subsequent lines of the paragraph. 

To indent the first line of a paragraph (All Levels) 

1. Select all of the paragraphs you want to indent. If you want to 
indent only a single paragraph, simply move the insertion point 
into that paragraph. 

2. Drag the first indent marker (the upper triangle) the distance you 
want for the indentation. The existing text or the text you enter 
will be indented as specified, as shown in the following example: 

Indented paragraph 

To create a hanging indent (All Levels) 

Hanging indents allow you to align the text when you use bullets 
or numbered lists. 

1. Select the paragraphs for which you want a hanging indent, or 
move the insertion point to the location where your hanging 
indent will begin. 

2. Drag the hanging indent marker (the lower triangle) to the 
location where you want the second and subsequent lines to align, 
as shown in the following example: 



Hanging indent 

TAB STOPS 

Tab stops are the locations where the insertion point stops when 
you tap Tab on the floating keyboard. Automatic tab stops appear 
every 1/2 inch, and you can add your own by tapping the ruler. 

At Level 2 and above, you can set tab stops with more precision 
and use more options, such as decimal tabs and tab leaders. For 
more information, see "Formatting GeoWrite Documents" in this 
chapter. 

I JZ: 
+.1 

~Date: July 21st 

jplace: Madison Buildin..s, 132 Main Street, 10th floor, Green Room 

rarlidpants: All fa:m.ilies and their guests 

To create tab stops (All Levels) 

1. Select the paragraphs for which you want to create tab stops. If 
you want to add a tab stop to a single paragraph, move the 
insertion point into that paragraph. 

2. Tap the ruler at the location where you want the new tab stop to 
appear. The new tab marker appears and the automatic tab 
markers disappear to the left of the new tab marker. 

If the tab marker is not exactly where you want it, drag the marker 
to the correct location. 

3. Continue tapping and dragging, if necessary, until you have placed 
all the tab markers you need. 

When you tap Tab on the floating keyboard while entering text in 
the paragraphs you selected, the text aligns under the tab markers. 

NOTE 

With your document set at normal size, you can place tabs at 1/4-
inch intervals. To place tabs with more precision, zoom to a higher 
percentage. 
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To clear a tab stop (All Levels) 

• Drag any tab marker off the ruler to remove it. 

Aligning Text 

You can decide how text lines up along a margin: left aligned, 
centered, right aligned, or full left and right aligned. Alignment is 
also called justification. For example, when text is left aligned, the 
rows of text line up along the left margin (excluding any specified 
indentation) and the right ends of the lines are ragged. 

I Aligned with left side of the margin 

fnus is .an ex.ampla of liaft ! 
!aiianed text. All the text is ! 
itined up eve:nly on the left side.! 

I This is a.n example of ti.ah~ 
i _al;,gnecl •ez•. Allthete~tis...--Aligned with right side of the margin ! li""d up evenly on the nsh~ I side.I 

!'I1Us is a.n example of centezie:d ! 
! text.Allthetextinthis ' 
! para.,a::ra.ph :Is centered. 

b,;. is .,, example or run-: Centered between sides of the margin 
!alianed text. All the text is! 
!lined up evenly on the left llld! 
!ri.shtside. ; 

1 I 
I Flush against both sides of the margin 

To change text alignment (All Levels) 

1. Select the text or move the insertion point into the paragraph you 
want to align. 

2. Tap one of these buttons on the Style bar: 

BUTTON ALIGNMENT 

~ Left 

~ Center 

§] Right 

~ Full 

or 



At Level 1, choose the text alignment you want from the Paragraph 
menu. At Levels 2 and above, choose Justification from the 
Paragraph menu. A submenu appears from which you choose Left, 
Center, Right, or Full alignment. 

Changing Line Spacing 

Line spacing is the spacing between lines in a paragraph, also 
called leading. 

You may want to add more space between the lines of text in a 
paragraph. You can choose from the following line spacings: 

Single. This is normal spacing. There is no extra line space 
between each row of text. 

One and a Half. There is a half line space between each row of 
text. 

Double. There is a whole line space between each row of text. 

At Levels 3 and 4, you can specify custom line spacing. For more 
information, see "Formatting GeoWrite Documents" in this 
chapter. 

To specify line spacing (Level 1) 

• After selecting the text or moving the insertion point into the 
appropriate paragraph, choose Single, One and a Half, or Double 
from the Paragraph menu. 

To specify line spacing (Levels 2-4) 

1. After selecting the text or moving the insertion point into the 
appropriate paragraph, choose Line Spacing from the Paragraph 
menu. A submenu appears. 

2. Select an option from the submenu. 

CHECKING YOUR SPELLING 

LEVEL 1 Using a spell checker is a good way to find misspelled words and 
typographical errors. Geo Write has an electronic dictionary that it 
checks for spelling errors. When the spell checker finds a word in 
your document that is not in its dictionary, it displays it in the 
Check Spelling dialog box and lets you decide what to do. 
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At Level 2 and above, you can add special words to a user 
dictionary. For more information, see "Formatting GeoWrite 
Documents" in this chapter. 

To check spelling (All Levels) 

ltJ::l 1. ::p the Check Spelling button on the Style bar. 

The Check Spelling 
dialog box at 
Level 1. 

5.16 GEOWRITE 

Choose Check Spelling from the Edit menu. 

or 

If you are using an external keyboard, press F7. 

A dialog box appears. The first misspelled word (or word that is 
not in the GeoWrite dictionary) appears in the Change To: entry 
box. 

Check Spelling 

Status: Misspelled or unknown word 

succed 

Change To: l;;;;;;;j 
~~~~~~~~~~~~~~ 

ls~iPI 
1···i.ii·~;·~~-i~~-~;-~; .. 

l~uggest ... I 

Leave this word as it is 

Get spelling suggestions for the 
misspelled word 

I gult Spell Checking I [!] 

2. Perform one of the following actions, as appropriate: 

• Type or write by hand the correct word and tap the Replace 
button. The spell checker replaces the word with the new 
spelling and continues checking with the next word. 

NOTE 
If you write a word by hand, please check the translation carefully. 

• Tap the Skip button. Use this for special words that appear in 
your document that do not appear in the dictionary. The spell 
checker skips the current word and proceeds with its checking. 

• Tap the Suggest button. The spell checker then looks in its 
dictionary for similarly spelled words. When the suggestions 
appear, tap the one you want to use and then tap Replace. 



If no suggestion is appropriate, then enter the word correctly in 
the Change To: box and tap Replace. The spell checker replaces 
the word with the new spelling and proceeds with its checking. 

• Tap the Quit Spell Checking button to stop. 

3. When you finish checking the spelling of a selection or of an 
entire document, a message window appears. Tap OK to return to 
Geo Write. 

USING PREDEFINED TEMPLATES 

ALL LEVELS A template is a special document that you use as a model to create 
similar documents. It contains the text, graphics, formatting, and 
special layouts common to all documents of a particular type. For 
example, a letter template might contain the following elements: 

Company Logo Letterhead 

+ ............................... ;;,;;·,;,o·,:;,;;·.-

E'~·-···································································1 

:r .... _,.. • 

;::..-=..~.. ; 
~~~=-..:.._..,;· -... .. -5'1111-.--... -.-... .. ... 
~~-~...,;..~ .......... .. 
~:r:=-~at.~.......... -=t::··· 
~·-Fr ........................... "' 

Date 

Address 

Salutation 

:-· Closing I _________ __,_ _ _,__ Name 

: ................................................................................ ; 

GeoWrite comes with several predefined templates that you can 
use to simplify your page layout tasks. All the layout is already 
done - you just need to add your own text. For more information 
about creating and changing templates, see Chapter 3. 

GEOWRITE BASICS 5.17 



The original template 
document is 
unchanged. Changes 
you make to the new 
document do not 
affect the template. 
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To use a template (All Levels) 

1. After choosing Switch Document from the File menu, tap the 
Template button. A dialog box appears that lists the available 
templates. 

2. Tap the name of the template you want to use. The name is 
highlighted and its description, if available, appears in the Notes 
box. Tap Use Template to use the highlighted template. 

or 

Double-tap the name of the template you want to use. 

Geo Write makes a copy of the template and asks you to enter a 
name for the new document. This copy contains everything from 
the template: text, graphics, formatting, styles, special layouts, and 
so on. You can also use the styles from a template without using 
its text. For more information, see "Formatting GeoWrite 
Documents" in this chapter. 



Formatting GeoWrite Documents 

This section describes the features that help you create formatted 
documents quickly and easily. All features described in this section 
are available at Level 2 and above. 

CHANGING THE TEXT FORMAT 

LEVELS 2-4 

LEVELS 2-4 

This section shows you how to use many of GeoWrite's advanced 
text and paragraph formatting features. For an introduction to 
formatting text and paragraphs, see "GeoWrite Basics" in this 
chapter. 

Setting a Custom Text Size 

At Level 2 and above, you can set a custom size for selected text. 
GeoWrite allows you to set custom sizes from 4 to 792 points. For 
more information, see Chapter 1. 
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LEVELS 3-4 

LEVELS 2-4 

5.20 GEOWRITE 

Changing Character Width and Weight 

At Levels 3 and 4, you can fine-tune the appearance of a character 
by changing its weight (thinner or thicker), its width (expanded or 
condensed), and the distance between characters. The following 
example shows what happens when you increase the character 
width: 

!Norrnal Width 
IIn .. creased Widt:.11 

To change character attributes (Levels 3-4) 

1. After selecting the text you want to change, choose Character 
Attributes from the Character menu. A dialog box appears. 

2. Complete the dialog box, selecting the attributes you want: 

Character Weight(%). Select a weight from 75 to 125. 

Character Width (%). Select a width from 25 to 200. 

Character Spacing. Select spacing from -150 to 500. 

3. Tap Apply to apply your changes to the highlighted text. Then 
close the dialog box. 

Formatting Paragraphs 

You can control paragraph formatting such as alignment, custom 
line spacing, paragraph spacing, line and column breaks, borders, 
and hyphenation. For information about using the ruler to change 
paragraph alignment, line spacing, margins, indents, and tab stops, 
see "GeoWrite Basics" in this chapter. 

To format a paragraph, you must first select it by highlighting or by 
putting the insertion point in the paragraph. You do not need to 
highlight all the text in the paragraph. For more information, see 
"GeoWrite Basics" in this chapter. 

SETI1NG CUSTOM LINE SPACING 

At Level 3 and above, you can set custom line spacing for selected 
text. 

To set custom line spacing (Levels 3-4) 

1. After selecting the paragraphs you want to change, choose Line 
Spacing from the Paragraph menu. A submenu appears. 



2. Choose Custom Spacing. A dialog box appears. 

3. Select Automatic for line spacing that depends on the size of the 
characters, or select Manual for more precise control. Then make 
the following adjustments, as appropriate: 

Line Spacing. If Automatic is selected, set Line Spacing the way 
you want. 

Manual Leading. If Manual is selected, set Manual Leading to a 
point size for the precise leading you want. 

4. Tap Apply to apply your changes to the selected paragraphs. Then 
close the dialog box. 

SETI1NG PARAGRAPH SPACING 

Paragraph spacing is the space between paragraphs. 

To change paragraph spacing (Levels 3-4) 

1. After selecting the paragraphs you want to change, choose 
Paragraph Spacing from the Paragraph menu. A dialog box 
appears. 

2. Complete the dialog box, selecting the options you want: 

Space on Top. Select the space you want to appear before a 
paragraph. 

Space on Bottom. Select the space you want to appear after a 
paragraph. 

3. Tap Apply to apply your changes to the selected paragraphs. Then 
close the dialog box. 

SETI1NG INDENTATION 

Indentation is the distance between the text and the page margin. 
You set the page margin in the Page Setup dialog box, and it 
affects every paragraph in the document. The indentation affects 
only individual paragraphs. 

You can change the left and right margins of a paragraph, as well 
as the first line indentation. When you open a document, 
paragraph margins are initially set to zero (O), which means that 
they are the same as the page margins. You can also use the ruler 
to change paragraph indents. For more information, see "Geo Write 
Basics" in this chapter. 

You indent a paragraph to set it off from other paragraphs: 
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This is a paragraph with indented margins and no 
indent in the first line. This format makes the 
paragraph stand out in the flow of text. 

A.first line indent means the first line starts farther from the left 
edge of the page than the rest of the paragraph: 

This is a paragraph with an indented first line. 
This format saves you from tapping the Tab key on 
the floating keyboard at the start of every new 
paragraph. 

A hanging indent means the first line starts closer to the left 
margin than the rest of the paragraph: 

This is a paragraph with a hanging indent. Notice that the 
first line is closer to the left edge of the page than the 
rest of the paragraph. 

• A hanging indent is used for numbered or bulleted 
paragraphs. Notice that the bullet (or number) is the 
hanging element of the paragraph. This layout makes 
it easier for the reader to scan paragraphs. 

You can also use the ruler to change paragraph margins. For more 
information, see "GeoWrite Basics" in this chapter. 

To set paragraph indents (Levels 2-4) 

1. After selecting the paragraphs you want to change, choose Indents 
from the Paragraph menu. A dialog box appears. 

2. Complete the dialog box, selecting the options you want. 

Left Indent of First Line. Select the distance of the first line from 
the left margin of the page. 

Hanging Left Indent. Select the distance of the remaining lines in 
the paragraph from the left margin of the page. 

Right Indent. Select the distance of all the lines in the paragraph 
from the right margin of the page. 

3. Tap Apply to apply your changes to the selected paragraphs. Then 
close the dialog box. 

NOTE 

If you wish to create an indented paragraph with no first-line 
indent, you must set both the Left Indent of First Line and the 
Hanging Left Indent to the same value. 

SETTING TAB STOPS 

A tab stop is the location the insertion point moves to when you 
tap Tab on the floating keyboard. You can use tab stops to create 



aligned columns, such as a table of contents or columns of 
numbers. 

A document initially has automatic tab stops at regular intervals 
(usually every half inch). You can redefine this distance, and you 
can add tab stops anywhere in between. You can also set tab stops 
using the ruler. For more information, see "GeoWrite Basics" in 
this chapter. 

To create a new tab stop (Levels 2-4) 

1. After selecting the paragraphs you want to change, choose Tabs 
from the Paragraph menu. A dialog box appears: 

1 in ~ 1.5 in 
1.75 in 
4.75 in 

~T-a_b_P_o_s_i-t1-. o-n-: -~1=1,_M=_=ll_!= _= _= _=_=_=~~I B 

« cr-eate New Tab » 

Tab Type: +Left <>Center <>Right <>Decimal 

Tab Leader: +None <>Dot <>Line <>Bullet 

~------Uertical Line------~ 

+Off <>On 

2. Complete the dialog box, selecting the options you want. 

Tabs List. Select <<Create New Tab>> in the Tabs list. 

Tab Position. Select the distance of the tab stop from the page 
margin. 

Tab Type. Select the alignment of the text at the tab stop (Left, 
Center, Right, or Decimal). For example, you would use a decimal 
tab to align columns of numbers along the decimal point. 

Tab Leader. Select the character that precedes the tab stop (None, 
Dot, Line, or Bullet). For example, in a table of contents, each 
page number might have a tab with a dot leader, as shown here: 

Chapter 5: GeoWrite ..................................... 5.1 
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Vertical Line. This option, when selected, puts a vertical line at 
the tab position that spans the height of the paragraph. You can 
set the shading, line width, and line spacing. 

3. Tap Apply to create the tab stop. The tab stop is applied to the 
selected paragraphs. Then close the dialog box. 

To change a tab stop (Levels 2-4) 

1. After selecting the paragraphs you want to change, choose Tabs 
from the Paragraph menu. The Tabs dialog box appears. 

2. Select the tab you want to change in the Tabs list. 

3. Fill in the rest of the dialog box, selecting the options you want. 

4. Tap Apply to save your changes to the selected tab stop and to 
apply them to selected paragraphs. Then close the dialog box. 

To delete one or all tab stops (Levels 2-4) 

1. Choose Tabs from the Paragraph menu. The Tabs dialog box 
appears. If you want to delete one tab stop, select it in the Tabs 
list. 

2. Perform one of the following actions, as appropriate: 

• To delete one tab stop, tap Delete Tab in the dialog box. 
GeoWrite deletes the tab stop and shifts the text to the next tab 
stop. 

• To delete all tab stops, tap Delete All Tabs in the dialog box. 
GeoWrite deletes all tab stops, restores the default tab stops for 
selected paragraphs, and adjusts the text if necessary. 

To set the def a ult tab stops (Levels 3-4) 

1. After selecting the paragraphs you want to change, choose Default 
Tabs from the Paragraph menu. A dialog box appears. 

2. Select a default tab (None, Centimeter, Half Inch, or One Inch). 

or 

Set a custom default tab. 

3. Tap Apply to apply your changes to the selected paragraphs. Then 
close the dialog box. 

CONTROUJNG LINE AND PARAGRAPH BREAKS 

You can control whether or not GeoWrite allows automatic line 
breaks within words and automatic column breaks within 
paragraphs. In documents with only one column, column breaks 
have the same effect as page breaks. 



For example, you might want to make sure that a headline appears 
in the same column as the article to which it belongs. Similarly, 
you might want to keep an entire paragraph together on the same 
page rather than have Geo Write split it in the middle, possibly 
leaving widows and orphans. A widow occurs when a single line 
of text is separated from the paragraph it belongs to and is left 
stranded at the bottom of a page. An orphan occurs when a single 
line of text is separated from the paragraph it belongs to and is left 
stranded at the top of a page. 

Word wrap, column breaks, and keeping paragraphs together are 
considered paragraph attributes. 

To change paragraph attributes (Levels 3-4) 

1. After selecting the paragraphs you want to change, choose 
Paragraph Attributes from the Paragraph menu. A dialog box 
appears. 

2. Complete the dialog box, selecting the attributes you want. 

Disable Word Wrap. Disable automatic word wrap and permit 
line breaks in the middle of words. 

Page/Column Break Before. Put a column break ahead of the 
paragraph so that the paragraph appears at the top of the next 
column. 

Keep with Next Paragraph. Keep the current paragraph with 
the next paragraph on the same page, preventing GeoWrite from 
inserting a column break or page break between them. 

Keep Paragraph Together. Keep the entire paragraph on the 
same page, preventing Geo Write from separating the lines of the 
paragraph with a page break or column break. 

Widow and Orphan Control. Permit column breaks within a 
paragraph and specify how many lines to keep together in a 
column. 

At Paragraph Top. If Widow and Orphan Control is selected, 
select the number of lines allowed for widows. 

At Paragraph Bottom. If Widow and Orphan Control is selected, 
select the number of lines allowed for orphans. 

3 . Tap Apply to apply your changes to the selected paragraphs. Then 
close the dialog box. 

SETTING BORDERS 

You can put a border (lines or a box) around a paragraph to add 
emphasis and make it stand out, as in the following example: 
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This is an example of a paragraph with a single-line 
border around it. 

The border width extends to the edge of the left and right 
indentation marker. You can also set the border color to set it 
apart from other text. 

To make a simple border (Levels 3-4) 

1. After selecting the paragraphs you want to have a border, choose 
Borders from the Paragraph menu. A submenu appears. 

2. Select the border option you want (None, Thin, Thick, Double
Line, or Shadowed). 

To make a custom border (Levels 3-4) 

1. After selecting the paragraphs you want to have a custom border, 
choose Borders from the Paragraph menu. A submenu appears. 

2. Choose Custom Border. A dialog box appears: 

1:1 Custom Borcler-

Sides to Border: o[j:;~f~.l o Iop o Bight o §ottom o Draw ]nner Lines 

Border ~idth (points): f 1 pt I B Border _:;!pacing (points): j 2 pt I B 
.----~~~~~~~~~~Border Type:~~~~~~~~~~~~ 

Type: + ~ormal <) S)Jadow <> Qouble Line 

'.'.;tmdotJJ nnctior·: 'l9p Len 'J'()p Right B()tl.om Len Uotl.01.:n Ri\Jht 

'.'ih~JdOtJJ Ni<ittl (points): 1 pt ~ 

Widt.h D~!lween Douf!le Ut«~s (p()inh;): 

3. Complete the dialog box, selecting the options you want: 

Sides to Border. Set the location of the border (Left, Top, Right, 
and Bottom). Select all four to put a box around the text. Select 
Draw Inner Lines to draw lines at paragraph breaks that fall within 
your selection. 

The following example shows a paragraph with a top and bottom 
border only: 

This is an example of a paragraph with a top and 
bottom border. 

Border Width (points). Select the border width in points. 

Border Spacing (points). Select the border spacing in points. 



Border Type. Select the type of border (Normal, Shadow, or 
Double Line). 

Shadow Anchor. If a shadow border is selected, select the 
anchor for the "light source" that creates the shadow (Top Left, 
Top Right, Bottom Left, or Bottom Right). 

Shadow Width (points). If a shadow border is selected, select 
the width of the shadow in points. 

Width Between Double Lines (points). If a double line border 
is selected, select the space between the lines in points. 

4. Tap Apply to apply your changes to the selected paragraphs. Then 
close the dialog box. 

To change the border color (Levels 3-4) 

For more information about using color, see "Using Color" in this 
section. 

1. After selecting the paragraphs you want to have a color border, 
choose Borders from the Paragraph menu. A submenu appears. 

2. Choose Border Color. A dialog box appears: 

1::1 Bonier' Color 

3 Shaded: jmN\ B 
••tllllllllllllBllllBl~llllllll!j!jH;!:::lllllml I I ----tt-- Border color 

Red r;I B Green r;I B Blue r;I Amount of red, 
L_J L_J L_J green, and blue in 

Pattern: [ 1111 l=l88l:SSl~l!:BI the border color 

Border pattern 

3. Complete the dialog box, selecting the options you want. 

% Shaded. Select the percent shading for the border color. The 
lower the number, the lighter the color. When set to zero (0), the 
border disappears. By default, this setting is 100. 

Color tools. Select the border color from the color palette. You 
can also fine tune the color blend by setting the amounts of red, 
green, and blue in the border color. For more information about 
using color, see "Using Color" in this section. 

Pattern. Select the pattern for the border color. By default, the 
pattern is solid. A pattern can be transparent. 

4. Tap Apply to apply your changes to the selected text. Continue to 
make changes as desired until you are satisfied with the way the 
border looks. Then close the dialog box. 
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HYPHENATION 

You can tum on hyphenation for any paragraph or paragraphs 
within your document. Once you apply hyphenation to a 
paragraph, hyphenation changes to accommodate changes you 
make to the paragraph. You can tum off hyphenation in a 
paragraph at any time. 

Geo Write provides default hyphenation settings that you can 
change as desired. Note that some hyphenation can make a 
document easier to read, while too much hyphenation can make it 
more difficult by breaking continuity and looking cluttered. 

NOTE 

GeoWrite hyphenates only those words that appear in its 
dictionary. 

To use hyphenation (Levels 3-4) 

1. After selecting the paragraphs with the hyphenation you want to 
change, choose Hyphenation from the Paragraph menu. A dialog 
box appears. 

2. Complete the dialog box, selecting the options you want. 

On or Off. Select On to allow automatic-hyphenation and to set 
other options in the dialog box. 

Maximum consecutive lines to hyphenate. Too many 
hyphenated lines in a row can clutter a document. Use this setting 
to restrict the total number of lines that can be hyphenated in a 
row. 

Shortest word to hyphenate. Too many hyphenated words, 
particularly if they are short, can clutter a document. Use this 
setting to limit the hyphenation to words of a certain length. 

Shortest prefix. Use this setting to establish the length of the 
·shortest prefix to hyphenate, such as pre in prefix. 

Shortest suffix. Use this setting to set the length of the shortest 
suffix to hyphenate, such as ing in hyphenating. 

3. Tap Apply to apply your changes to the selected text. Then close 
the dialog box. 

Color can add emphasis and appeal to text. Although the display 
of the unit is black and white, you can define colors for selected 



text or for entire paragraphs. Then if you move a file to a machine 
with a color monitor, the colors you defined appear on screen. 
Similarly, if you have a color printer, the colors you defined 
appear on the printed copy of your document. 

You can select colors even if you do not have a color monitor or 
printer - you just cannot see them on screen or in printed 
documents. Instead, colors appear in different shades of gray, 
which provides contrast to a lesser degree. 

Text color is the color of the text. Background color is the color of 
the background on which the text appears. When using colors, it is 
best to use contrasting colors for text and background so that the 
text is easy to read. If the colors are identical, then the text 
"disappears" into the background. By default, text color is black 
and background color is white. Paragraph color is the background 
color for an entire paragraph. 

Although GEOS applications have a standard palette of colors, you 
can create your own variations by adjusting the amount of each 
primary color (red, green, blue) in the color selected from the 
palette. You can also increase or decrease the percentage of 
shading to reduce or sharpen the color intensity. 

You can also choose different patterns to create a different texture 
in the background. 

When you select or change color, a dialog box, similar to the 
following, appears: 

1:1 Text Backgr-oLmcl Color-

+W.i~~.~.~j <> Unfilled % Shaded: 

l•l•l•l•l•l••1~111111111rn1~i::,::uau111~H: 1 1 --~+

Red EJ B Green I 2ss I B Blue I 2ss I 
Pattern: I lllll=li?l::»l:gl~I----------+.-, 

I Apply I I Close I [I) 

Text background 
color 

Amount of red, 
green, and blue in 
the text 
background color 

Text background 
pattern 
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1. After selecting the text you want to change, choose Text Color 
from the Character menu. A dialog box appears. 

2. Complete the dialog box, selecting the attributes you want. 

% Shaded. Select the percent shading for the text color. The lower 
the number, the lighter the color. A setting of zero (O) causes the 
text to disappear. By default, this setting is 100. 

Color tools. Select the text color from the color palette. You can 
also fine tune the color blend by setting the amounts of red, green, 
and blue in the text color; the default values depend on the 
selected color. 

3. Tap Apply to apply your changes to the selected text. You can 
continue to make changes as desired. Then close the dialog box. 

To change the text background or paragraph color (Levels 2-4) 

1. After selecting the text you want to change, choose Text 
Background Color from the Character menu or Paragraph Color 
from the Paragraph menu, as appropriate. A dialog box appears. 

2. Complete the dialog box, selecting the attributes you want: 

Filled or Unf'tlled. Select Filled to set other options in this dialog 
box. By default, the color is unfilled. 

% Shaded. Select the percent shading for the color. The lower the 
number, the lighter the color. If the setting is zero (0), the 
background disappears. By default, this setting is 100. 

Color tools. Select the color from the color palette. You can also 
fine tune the color blend by setting the amounts of red, green, and 
blue in the color you have selected. 

Pattern. Select the pattern for the color. By default, this setting is 
solid. A pattem can also be transparent. 

3. Tap Apply to apply your changes. Continue to make changes as 
desired until you are satisfied with the color. Then close the dialog 
box. 

FINDING AND REPLACING TEXT 

LEVELS 2-4 

5.30 GEOWRITE 

You can use Find and Replace to quickly find a word or phrase in 
your document and, if desired, to replace it with a different word 
or phrase. You can also replace all occurrences of a word or 
phrase in a document. 



To find and replace text (Level 2) 

1. Choose Find and Replace from the Edit menu. A dialog box 
appears: 

Special Characters -J D Ignore Case/Accents o t'.!atch Partial words 

r 6;;;1·-N,,;;:t][iir;·;J 6·eCio1:;;,Jgeplac.eJIRepi·;,;c~;-""ii1i"li Re.pja(.:·e "iii i\(,)i"e"(.:t:i\)!:;·1 
I Close I [!] 

2. Complete the dialog box, selecting the options you want. 

Find. Enter the text you want to find. You can search for any 
combination of numbers, letters, spaces,. and other printable 
characters (such as punctuation marks). 

Replace With. Enter the text that will replace the search text. 

Find Next. When you tap this button, the search starts from the 
insertion point forward. If the application reaches the end of the 
document, it starts searching again from the beginning. If the 
application cannot find the search text, a message appears to that 
effect. If the application finds a match, it highlights the text in the 
document. 

Replace. Tap this button to replace one occurrence of the search 
text. You can stop the search here, or you can tap Find Next again 
to resume the search for another match. 

Replace All. Tap this button to replace all occurrences of the 
search text with the replacement text. 

3. Tap Close to close the dialog box. 

To find and replace text (Levels 3-4) 

1. Choose Find and Replace from the Edit menu. 

or 

Tap the Find and Replace tool on the Function Bar. 

A dialog box appears: 
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1:1 F1ncf ancf Replace 

Find: 

Replace With: 

I ~pecial Characters -ID Jgnore Case/Accents D tiatch Partial Words 
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Close [!] 

2. Complete the dialog box, selecting the options you want. 

Find. Enter the text you want to find. You can search for any 
combination of numbers, letters, spaces, and other printable 
characters (such as punctuation marks). 

Replace With. Enter the text that will replace the search text. 

Special Characters. Tap this button when you want to use 
special characters (such as tabs) and wild cards in your search and 
replace operation. A wild card is a symbol that substitutes for a 
single character(?) or a series of characters(*). You can use wild 
cards to search for words or phrases that are similar or have 
slightly different spellings. When you tap this button, a drop-down 
list appears with the following choices: 

• Match Multiple Characters adds the Multiple Character wild 
card to the text in the Find box. It allows you to match text 
where the beginning or end of the text might vary (such as 
"professor" and "professional"). 

• Match Any Character adds an Any Character wild card to the 
text in the Find box. It allows you to match text where one or 
more characters might vary (such as "arise" and "arose"). 

• Graphic or Special Text adds a character to search for any 
graphic object or any special text character (dates, times, 
numbers, and so on) to the text in the Find box. 

• Tab adds a tab character to the text in the Find or Replace With 
box. 

• Carriage Return adds a carriage return character to the text in 
the Find or Replace With box. 

• Page Break adds a page break character to the text in the Find 
or Replace With box. 

Ignore Case/ Accent. Tap this box to find every occurrence of the 
search text, ignoring uppercase, lowercase, and accent marks. For 
example, if the search string is "Dog", the application could find 
matches for "Dog" and "dog''. 



Match Partial Words. Tap this box to find a portion of a word. 
For example, if the search string is "print", the application could 
find matches for "print," "sprinter," "reprint," and so on. 

Find Next/Find Previous. When you tap Find Next, the search 
starts from the insertion point forward. When you tap Find 
Previous, the search starts from the insertion point backward. For 
forward searches, if the application reaches the end of the 
document, it starts searching from the beginning. For backward 
searches, if the application reaches the beginning of the 
document, it starts searching from the end. If the application 
cannot find the search text, a message appears to that effect. If the 
application finds a match, it highlights the text in the document. 

Replace. Tap this button to replace one occurrence of the search 
text. You can stop the search here, or you can tap Find Next again 
to resume the search for another match. 

Replace All. Tap this button to replace all occurrences of the 
search text with the replacement text. 

Replace in Selection. Tap this button to replace all occurrences 
only within text that you have selected. 

3. Tap Close to dose the dialog box. 
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USING HEADERS AND FOOTERS 

LEVELS 2-4 

5.34 GEOWRITE 

A header contains anything (text, graphics, or both) that you want 
to appear at the top of every page. Likewise, a footer contains 
anything you want to appear at the bottom of each page. Header 
information appears at the top of the page in the top margin. 
Footer information appears at the bottom of the page in the 
bottom margin. 

--------+-- Header area 

--------+-- Footer area 

Headers and footers are optional. Normally, you use them in 
documents with multiple pages. They can contain text formatting 
(such as bold or italicized text) and multiple lines of text. 

You can use a different header or footer on the first page of each 
chapter; for more information, see "Designing GeoWrite 
Documents" in this chapter. Similarly, you can use different 
headers and footers on odd and even pages, thereby putting the 
page number near the outside edge of each page. 

By default, every document has a Header and a Footer style that 
you can format as desired. 

NOTE 

If you set tabs and margins for the Header or the Footer style, the 
settings are relative to the left edge of the page, not the left edge of 
the ruler. 

Setting Up a Header or Footer 

The menus for setting up a header or footer at Level 4 vary slightly 
from those at Levels 2 and 3. 



To set up a header or footer (Levels 2-4) 

1. Choose Edit Header or Edit Footer from the Layout menu. At Level 
4, choose Header or Footer from the Layout menu, and then 
choose Edit Header or Edit Footer from the submenu. 

A page appears with the insertion point in the upper left corner of 
the header or footer area, as shown in the following illustration: 

Header area 

.bayout !!raphics faragraph !;haracter 

~----~· 111;-l;;illill I URW Roman -1112 -llltl 

ber .Qate of Printing Oo§e 

, .. 
This is a speeial type of page that you use for organizing the layout 
of documents, not for entering the body of text. For more 
information, see "Designing GeoWrite Documents" in this chapter. 

2. Enter the header or footer information. You can also use the 
following buttons, located at the top of the header or footer 
window, to insert standard information that gets updated 
automatically: 

Page Number button. Tap to put the page number at the 
insertion point. 

Date of Printing button. Tap to put the date of printing at the 
insertion point. 

3. Tap Close to close the special page. 

USING A TITLE PAGE 

LEVELS 2-4 The title page is typically the first page of a document. It can be 
the cover of a report, test, essay, or book. The title page usually 
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contains descriptive information such as the title of the document, 
the author's name, and the date of printing. 

Page numbering of your document remains the same when you 
add a title page to the front of your document. The first numbered 
page occurs after the title page. 

The menus for adding, moving to, and deleting a title page at 
Level 4 vary slightly from those at Levels 2 and 3. 

To add a title page to a document (Levels 2-4) 

1. Choose Create Title Page from the Layout menu. At Level 4, 
choose Title Page from the Layout menu, then choose Create Title 
Page from the submenu. A dialog box appears asking if you want 
to continue. 

2. Tap Yes to create the title page. GeoWrite creates a new section 
called Title Page at the beginning of the document. An empty title 
page appears, with the insertion point in the upper left corner of 
the text area. If your document has headers or footers, they will 
not appear on the title page. 

3. Design your title page as desired. 

4. Return to the body of your document by scrolling downward or 
tapping the Next Page tool. 

To go to the title page (Levels 2-4) 

• Choose Go to Title Page from the Layout menu. At Level 4, choose 
Title Page from the Layout menu, then choose Go to Title Page 
from the submenu. The title page appears. 

To delete the title page (Levels 2-4) 

1. At Levels 2 and 3, choose Delete Title Page from the Layout menu. 

At Level 4, choose Title Page from the Layout menu, then choose 
Delete Title Page from the submenu. A dialog box appears asking 
if you are sure you want to delete the title page. 

2. Tap Yes to delete the title page. GeoWrite deletes the entire Title 
Page section. 

CHECKING YOUR SPELLING 

LEVELS 2-4 

5.36 GEOWRITE 

At Level 1, you can check the spelling in a document. For more 
information, see "GeoWrite Basics" in this chapter. At Level 2 and 



above, you can also add words to a user dictionary. You can use 
this feature when your document contains correctly spelled words 
not found in the dictionary, such as proper names or special 
terminology. 

To check the spelling of a word or block of text (Levels 2-4) 

You can check the spelling of a single word, a block of text, or the 
text in the entire document. To check the entire document, start 
with step 2. 

1. Select the word or block of text you want to check. 

2. Tap the Check Spelling button on the Style bar. 

or 

Choose Check Spelling from the Edit menu. 

A dialog box appears: 

1:1 Clieck Spelling 

Status: Misspelled or unknown word 

The mating pattern of the native "Ougenheld" bird is one of 
obscure ritual and many loud noises, particularly by the male 
when he finds a suitable fe ... 

Change To: jlllWmDAI 
~~--;======;:--~~~-;::===='~~~~~~-

I SJsip I 
:·R~;i;1;;~;~;··1 

I ~uggest -I 

I SkiQ All I I Add to .\,Iser Dictionary I 
I Edit User Qictionary ... I 

3. Select the amount of text you want to spell check: 

Check All. Tap to check all the text in the document. 

Check to End. Tap to check the text from the insertion point to 
the end of document. 

Check Selection. Tap to check only selected text. 

The first misspelled word (or word that is not in the dictionary) 
appears in the Change To: entry box. 

4. Select the action you want to take on this word. 

Skip. Tap to ignore this occurrence of the spelling. 

Skip All. Tap to ignore all occurrences of the spelling. 

Replace. Enter the word correctly in the Change To: box, then tap 
this button to replace the misspelled word with the new spelling. 
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Replace All. Enter the word correctly in the Change To: box, then 
tap this button to replace all occurrences of the misspelled word 
with the new spelling. 

Suggest. Tap to display a menu of alternative spellings for the 
misspelled word. Tap the spelling you want to use, then tap the 
Use This Suggestion button. If no suggestion is appropriate, tap 
Cancel, then enter the word correctly in the Change To: box. The 
spell checker replaces the word with the new spelling and 
proceeds with its checking. 

Add to User Dictionary. Tap to add the word to the user 
dictionary. From this point forward, the spell checker will accept 
this spelling in this and other documents. 

Edit User Dictionary. Tap to edit the user dictionary. For 
instructions, see the next procedure. 

5. When you are finished checking the spelling, a message window 
appears. Tap OK to return to GeoWrite. 

To edit the user dictionary (Levels 2-4) 

You can add and delete words in the user dictionary. 

1~11. ~:p the Check Spelling button on the Style bar. 

5.38 GEOWRITE 

Choose Check Spelling from the Edit menu. 

A dialog box appears. 

2. Tap Edit User Dictionary. A dialog box appears. 

3. Complete the dialog box, selecting the options you want. 

Words in User Dictionary. This lists the words in the user 
dictionary. 

Delete Selected Word. To delete a word, select it from the list, 
then tap this button. 

New Word. To add a new word, enter it here, then tap Add New 
Word. If you attempt to add a word that already exists, a message 
dialog box appears; tap OK and resume. 

4. Tap Close to close the Edit User Dictionary dialog box. Then close 
the Check Spelling dialog box. 



USING TEXT STYLE SHEETS 

LEVELS 2-4 A style is a collection of text and paragraph formats under a 
common name. A text style sheet is the set of all the named text 
styles used in a document. 

You can use a style to apply all the text and paragraph attributes to 
an object at the same time. You can record the following attributes 
in a text style: 

• Text attributes, including character font, text size, text style, text 
color, and character width and height 

• Paragraph attributes, including alignment, spacing, line spacing, 
indentations, tab stops, paragraph color, and paragraph spacing 

For more information about setting these attributes, see "GeoWrite 
Basics" in this chapter and "Changing the Text Format" in this 
section. 

Styles make it easy for you to apply a group of attributes to text all 
at once. This saves you the effort of setting the same attributes for 
different sections of text. For example, you might want a Title style 
to automatically center title text and display it in a large, bold font. 
You could define the character and paragraph formatting for each 
Title paragraph individually, which might be time-consuming, or 
you could simply apply the Title style to each paragraph and save 
time. 

When you create a style, you give it a name. Styles help ensure a 
consistent look for your text. They also make it easier to reformat a 
document, because changing a style automatically updates 
paragraphs in that style as well as any styles that are based on that 
style. 

You can save styles in a template so that you can use them over 
and over. For more information, see "Designing GeoWrite 
Documents" in this chapter. 

Using Default Styles 

Geo Write provides a set of three commonly used styles. You can 
use them as is, or as a starting point for creating your own custom 
styles. 

Normal. The base style that comes with GeoWrite. 

Header. A standard style for a header of a document. 

Footer. A standard style for a footer of a document. 
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LEVELS 2-4 
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Applying a Style 

You can change the format of a paragraph simply by applying a 
style from the style sheet. 

To apply a style to a paragraph (Levels 2-4) 

1. After selecting the paragraphs you want to change, choose Text 
Style Sheets from the Paragraph menu. A submenu appears. 

2. Choose Apply Style from the submenu. A dialog box appears. 

3. Select the style you want, scrolling the list if necessary. Geo Write 
applies the style formatting to the selected paragraphs. 

To apply a style more quickly (Levels 2-4) 

1. After selecting the paragraphs you want to change, tap the Styles 
drop-down list button on the Style bar. A list of styles appears. 

2. Select the style you want. GeoWrite applies the style formatting to 
the selected paragraphs. 

Storing and Recalling Text Attributes Temporarily 

You can temporarily store the text and paragraph attributes from 
one paragraph and then apply them to another without first 
creating a named style. To do so, you use the Store Style choice. 
While named styles are saved with your document, styles that you 
record with the Store Style choice are not saved when you exit 
Geo Write. 

To store the text attributes (Levels 2-4) 

1. Select a paragraph with the attributes you want to store. 

2. Tap the Store Style button on the Style bar. 

or 

Choose Text Style Sheets from the Paragraph menu, and choose 
Store Style from the submenu. 

Geo Write remembers the attributes of the selected paragraph. 

To recall the text attributes (Levels 2-4) 

1. Select the paragraphs to which you want to apply the stored 
attributes. 

2. Tap the Recall Style button on the Style bar. 

or 



LEVELS 3-4 

Choose Text Style Sheets from the Paragraph menu, and choose 
Recall Style from the submenu. 

GeoWrite applies the saved attributes to the selected text. 

Defining a New Style 

You can add a new style to a style sheet by giving it a name and 
defining its attributes. A base style is a style on which other styles 
depend; new styles are variations on a base style. If you change an 
attribute in the base style, all dependent styles will change except 
those that define the attribute uniquely. 

For example, suppose you define a style called "Head Level 2" 
using another style, "Head Level 1," as its base style. If you add 
bold to "Head Levell," the text in "Head Level 2" also becomes 
bold. GeoWrite updates all text in both styles with the new 
attributes. 

Alternatively, you can define a style so that its unique attributes 
change relative to changes in the base style. For example, if you 
set margins in "Indent Level 2" relative to "Indent Level l," its base 
style, and you increase the left margin in "Indent Level l" by 0.25 
inch, Geo Write increases the left margin in "Indent Level 2" by 
0.25 inch as well. 

You can also define a new style without using a base style. 
GeoWrite uses the default attributes or the attributes of selected 
text as the starting point instead. 

To define a new style (Levels 3-4) 

1. Select a paragraph with attributes identical or similar to the style 
you want to create. GeoWrite uses the attributes in the selected (or 
base) style to define the initial attributes of the new style. You can 
also start from scratch, with no text selected, using the default text 
and paragraph attributes. 

2. Choose Text Style Sheets from the Paragraph menu. A submenu 
appears. 

3. Choose Define New Style from the submenu. A dialog box 
appears. 

4. Complete the dialog box, selecting the options you want: 

Description. Displays a description of the selected style, which 
changes when you define text and character attributes. The base 
style appears first, then any changes you have made to character 
and paragraph formatting. 
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Display in Tool Bar Drop-Down List. Select whether the style 
appears in the Styles drop-down list. 

Apply to Selection Only (Character Style). Select whether you 
want to apply the style attributes to selected text only or to the 
entire paragraph. 

Point Size Relative. Select to make point size relative to point 
size of the base style. Changing the point size in the base style 
changes the point size in the current style by the same amount. 

Margins Relative. Select to make margins relative to margins of 
the base style. Changing the margins in the base style changes the 
margins in the current style by the same amount. 

Leading Relative. Select to make leading (or line spacing) relative 
to leading of the base style. Changing the leading in the base style 
changes the leading in the current style by the same amount. 

Name. Enter a new style name. You can use letters, numbers, and 
spaces. Choose a name that indicates what the style does. For 
example, you could call a style that contains the name of a chapter 
"Chapter Name." 

5. Tap Define New Style. GeoWrite applies the new style to the 
selected text or paragraph. Then close the dialog box. 

Changing Styles 

You can change a style in two ways. You can change its visual 
attributes (text size, paragraph spacing, and so on) or its style 
attributes (point size relative, margins relative, and so on). If the 
style serves as the base style for other styles, changes can affect 
those dependent styles as well. 

CHANGING VISUAL AITRIBUTES 

You can change the visual attributes (text and paragraph 
attributes) of an existing style. Doing so updates all text in the 
changed style with the attributes you selected. 

To change the visual attributes of an existing style (Levels 3-4) 

1. After selecting a paragraph in the style you want to change, set any 
character and paragraph attributes you want for this style. For 
instructions on how to do this, see "Changing the Text Format" 
and "Using Color" in this section. 

2. Choose Text Style Sheets from the Paragraph menu. A submenu 
appears. 



3. Choose Redefine Style from the submenu. GeoWrite updates the 
style with the formatting in the selected paragraph. 

CHANGING STYLE ATIRIBUTES 

You can change the style attributes of an existing style. If the style 
serves as the base style for other styles, changes can affect those 
styles as well. 

To change the style attributes of an existing style (Levels 3-4) 

1. Choose Text Style Sheets from the Paragraph menu. A submenu 
appears. 

2. Choose Manage Styles from the submenu. A dialog box appears 
and the current style is highlighted. 

3. Find the style you want to change, scrolling the list if necessary, 
and then select it. The text in the Description box changes to show 
the style you have selected. 

4. Tap Modify. A dialog box appears: 

l Style attributes 

Modify Style 

Style N ame: lllMIHliil I 
• Displ l'IY in Tool Bar Pop-Down List 

Attributes 

o Apply to Selection Only (Character style) 

o Point Size Relative 

D Margins Relative 

D Leading Relative 

Base Style: 

I IRI ~f!Jl.ilil - -

~ Normal T Header 
Footelj_ 

! I t!Odify I l I Cancel I [TI 
I 

I The current style 

Base S ty les list 
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5. Complete the dialog box, selecting the options you want. 

For a description of these options, see "Defining a New Style" in 
this section. 

6. You can change the base style if you want by selecting it in the 
list. If you do not want a base style, choose <<No Base Style>>. 

7. Tap Modify to change the style definition. The Modify Styles dialog 
box disappears. 

8. Tap Apply. GeoWrite applies your changes to the selected text. 
Then close the dialog box. 

Deleting a Style 

You can delete a style you no longer need. This eliminates clutter 
in the style sheet. Once you delete a style, you cannot recover it. 

NOTE 
You cannot delete the Normal, Header, or Footer style. 

To delete a style (Levels 3-4) 

1. Choose Text Style Sheets from the Paragraph menu. A submenu 
appears. 

2. Choose Manage Styles from the submenu. A dialog box appears. 

3. Select the style you want to delete from the list. If the selected 
style has a base style, the name of the base style appears in the 
style description box. 

4. Tap Delete. GeoWrite deletes the selected style. GeoWrite attaches 
the base style to any paragraphs in the style you just deleted. 
However, Geo Write does not apply the attributes of the base style. 
The selected paragraphs maintain their current attributes. 

or 

Tap Delete and Revert. GeoWrite deletes the selected style, 
attaches the base style to any paragraphs in the style you just 
deleted, and overrides the current attributes of those paragraphs 
with the attributes in the base style. 

5. Tap Close to close the dialog box. 

Reverting to a Base Style 

If you select a paragraph, you can change its attributes from those 
of the current style to those of the base style of the current style. 



LEVELS 2-4 

To revert to the base style (Levels 3-4) 

1. After selecting the text you want to change, choose Text Style 
Sheets from the Paragraph menu. A submenu appears. 

2. Choose Revert to Base Style from the submenu. Geo Write applies 
the base style to selected paragraphs, overriding the current 
attributes of selected paragraphs with the attributes of the base 
style. 

Using Style Sheets from Other Documents 

You can copy style sheets from another document or template into 
a document you are working on. That way, you do not need to 
define the same styles all over again. 

To get styles from another document (Levels 2-4) 

1. Choose Text Style Sheets from the Paragraph menu. A submenu 
appears. 

2. Choose Bring in Style Sheet from the submenu. A dialog box 
appears. 

3. Select a document or template from the list. 

4. Tap Load Style Sheet. GeoWrite imports the styles from the 
template you selected. If two styles with the same name appear in 
the template and the document, GeoWrite uses the template style. 
Then close the dialog box. 

IMPORTING AND EXPORTING DOCUMENTS 

ALL LEVELS You can convert documents from other word processors into 
Geo Write documents. This is called importing a document. The 
process works in reverse as well: you can also convert an entire 
Geo Write document into the format for another word processor. 
This is known as exporting a document. 

NOTE 

GeoWrite does not import or export headers and footers. 
Depending on the format you select, other components of the 
document - such as character and paragraph formatting - may 
be lost as well. 
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To import a document from another word processor (Levels 2-4) 

1. Choose Switch Document from the File menu. The New/Open 
dialog box appears. 

2. Tap Import. A dialog box appears. 

3. Complete the dialog box, selecting the options you want. 

Select File and Format for Import. Use the standard file 
selector controls to select the file you want to import. For more 
information about file selectors, see Chapter 1. 

Fo.:.'ffiats. If you know the format of the file you want to import, 
select it from the Formats list. Then only files with that extension 
will be displayed. If you do not know the format of the file, select 
No Idea (Auto-Detect) in the Formats box. 

File Mask. This box displays the file extension for the selected 
format. For example, if you select Microsoft Word 4.0, .DOC 
appears as the extension, and only files with that extension will 
appear. 

NOTE 

When importing an ASCII text file, you should select ASCII or Plain 
Text from the Formats list. If you choose No Idea (Auto-Detect), it 
may not correctly identify your file as an ASCII file. 

4. Tap Import. The dialog box disappears, and a status box appears 
while the bit map is being imported. It may take a while to convert 
the document to GeoWrite format and open it. You cannot 
interrupt this process. 

When the document has been completely converted, it appears in 
a new GeoWrite window. 

To export your document to another word processor (Levels 2-4) 

1. Open the GeoWrite document that you want to export. 

2. Choose Other from the File menu, then choose Export Document 
from the submenu. A dialog box appears. 

3. Complete the dialog box, changing the options you want. 

Select Folder and Format for Export. Use the standard file 
selector controls to select the file you want to export. For more 
information about file selectors, see Chapter 1. 

Formats. Choose the format for the exported file in the Formats 
box. This should match a format supported by the other word 
processor. 

New File Name. Enter a name for the exported file. The correct 
extension already appears in this box, so you do not need to enter 



it. Be sure to enter a standard DOS file name. For more 
information about DOS file names, see Chapter 1. 

4. Tap Export. An export progress box appears while GeoWrite saves 
the converted document under the new name. If the document is 
large, this process may take several minutes. You cannot interrupt 
the process. 
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Designing GeoWrite Documents 

This section describes the advanced features that help you create 
documents using templates, sections, graphics, and page layout in 
GeoWrite's DTP (desktop publishing) mode. Some features 
described in "Designing GeoWrite Documents" become available 
at Level 2, but most become available at Levels 3 and 4, or at 
Level 4 only. 

MANAGING TEMPLATES 

LEVEL 4 

USING SECTIONS 

LEVELS 2-4 

5.48 GEOWRITE 

A template is a special document that you use as a model to create 
similar documents. It contains the text, graphics, formatting, and 
special layouts common to all documents of a particular type. For 
information about creating, changing, and deleting templates, see 
Chapter 3. 

A section is a portion of a document with custom formatting for 
any of the following characteristics: 

• Headers and footers 

• Page margins (top, bottom, left, and right) 

• Multiple columns with spaces and rulers 

• Left and right pages 



LEVEL 4 

• Starting page number 

• Text and graphics that appear on every page 

Variations in these characteristics can distinguish one section from 
the next. 

Each document has at least one section. When you create a new 
document, GeoWrite creates a section called Main Section. 
Thereafter, you can add as many sections as you want. 

For example, when you create a title page, GeoWrite automatically 
creates a section called Title Page. Similarly, for a document with 
several chapters, you can create a separate section for each 
chapter. That way, you can put a different chapter title in the 
header or footer of each section. 

At Level 2 and above, you can format the section using the Page 
Setup function and Master Pages. At Level 4, you can add, rename, 
and delete sections in a document. 

Planning a Document with Sections 

Sections typically appear in more complex documents, such as 
books or reports, rather than in simple ones, such as short memos 
or letters. Before creating a complex document, think about how 
to divide it into distinct sections and what kind of page formatting 
and layout will be similar for all sections. 

For example, a lab report for a science experiment might have four 
separate sections: the introduction, a description of the 
experiment, the results of the experiment, and conclusions about 
the results. All sections in the report might have the report title in 
the header, the page number in the footer, and a very wide 
margin. The header might also contain the section name, which 
varies from section to section. 

When you have a general idea of how you want to organize and 
format your document, you create it and make any formatting and 
layout changes to the Main Section (such as modifying the page 
setup and the Master Page). Then you create all the other sections 
in the document. GeoWrite copies the section formatting 
automatically to each new section you create, saving you 
formatting and layout time. 

In the lab report example, you would first create the new 
document, then change the headers, footers, and margins in the 
Main Section. Then you would create the other three sections. 
Finally, you would add the section name to the header of each 
section. 
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Managing Sections 

You can add, rename, and delete sections in a document. 

ADDING A SECTION 

You add a new section to a document by either inserting or 
appending it. 

• Inserting puts the new section in front of an existing section. 
This is useful for adding the first section to a document. 

• Appending puts the new section after an existing section. This is 
useful for adding the last section to a document. 

To put a new section between existing sections, you can use either 
method. 

When you add a section, GeoWrite adds a blank page with a 
section break. In the Page display mode, you can see how a 
section break separates sections in a document: 

-.o£ 

A solid line separates 
sections in a document 
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Conclusion 

Second section 

You also add a section when you create a new title page. For more 
information, see "Formatting GeoWrite Documents" in this 
chapter. 

To insert or append a new section (Level 4) 

1. Choose Section from the Layout menu. A submenu appears. 



2. Choose Insert Section or Append Section from the submenu. A 
dialog box appears, containing a list of all current sections. 

3. If you are inserting a new section, select the section ahead of 
which you want to insert the new section. 

If you are appending a new section, select the section after which 
you want to insert the new section. 

4. Enter a name in the New Section Name box. You can use letters, 
numbers, and spaces. The name should indicate what the section 
contains. For example, a logical name for a section that contains 
introductory text would be "Introduction." 

5. Tap Insert Section or Append Section. GeoWrite adds the new 
section to the document. 

RENAMING AND DELETING A SECITON 

You can change the name of any section in a document, including 
the Main Section and the Title Page section, to make the section 
name more descriptive or consistent with other section names. 
You can also delete a section you no longer need. Deleting a 
section deletes all the information it contains. 

To rename or delete a section (Level 4) 

1. Choose Section from the Layout menu. A submenu appears. 

2. Choose Rename Section or Delete Section from the submenu. A 
dialog box appears. 

3. In the sections list, select the section you want to rename or 
delete. 

If you are renaming a section, enter a name in the New Section 
Name box. You can use letters, numbers, and spaces. The name 
should indicate what the section contains. For example, a logical 
name for a section that contains the lab results in a report would 
be "Lab Results." 

4. Tap Rename or Delete. 

NOTE 

You cannot delete a section if it is the only section in a document. 

SELECITNG A SECITON 

To format a section, you must first select it. 
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To select a section (Level 4) 

• Tap the pen anywhere in the section you want to format. 

DISPIAYING IBE SECTION NAME 

The section name can appear in the upper left corner of the 
document to remind you where you are. This is for display 
purposes only; it does not appear on the printed page when you 
print a document. 

To display the section name (Level 4) 

1. Choose Other Settings from the Options menu. 

2. Select Display Section Name. The section name appears in the 
upper left corner of the document. 

SE1TING IBE STARTING SECTION NUMBER 

Sections are numbered sequentially starting with the first section in 
a document. You can use this internal numbering feature to 
display the section numbers for parts of a document or for page 
numbering that includes the section number. By setting the 
starting section number, you can control the number that appears 
for a section. By default, the starting section number is 1. 

Suppose, for example, that a report has three separate chapters 
(Chapters 1, 2, and 3) that are individual sections. By setting the 
starting section number to 1 and inserting the special character 
called Section Number in the chapter title and footer, you can 
display the section number automatically. 

~~~::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::: 

I It also appears in the footer. 

Using the special character Section 
Number, the section number for the 
second section of the document 
appears in the chapter title. 



LEVELS 2-4 

If this document has two other sections ahead of the first chapter, 
such as a title page and a table of contents, you can still achieve 
the same result. Simply set the starting section number to -2. 

To set the starting section number (Level 4) 

1. Choose Section from the Layout menu. A submenu appears. 

2. Choose Set Starting Section # from the submenu. A dialog box 
appears. 

3. Select the starting section number. 

4. Tap Apply to apply your changes. Then close the dialog box. 

Using Page Setup 

You can use the Page Setup option on the File menu to set the 
page margins, columns, left and right pages, and the starting page 
number in one section at a time. 

For example, the following sample document shows the result of 
setting the column characteristics: 

The column setting is two (2). 

Eile .!;dit ~iew Qptitjns 
?l ·_l~ 

!:,ayout earagraph !;;hara_E_ter 
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l 
The distance between 
columns is 0.25 inches. 

The vertical rule is 2 points wide. 

Do not confuse Page Setup with Page Size on the File menu. Page 
Size applies page formatting (type, size, layout, width, and height) 
to the entire document, including all sections. Page Setup applies 
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to one section. If a document has only one section, then it applies 
to the whole document. 

To change the page setup for a section (Levels 2-4) 

1. Tap the pen anywhere in the section where you want to change 
the page setup. 

2. Choose Page Setup from the File menu. A dialog box appears. 

3. Complete the dialog box, changing the options you want. 

Section to Change Page Setup For. Indicates the section to 
which the settings apply. 

Starting Page Number. Select the starting page number for the 
section. Use it instead of Follow Last Section to set the page 
number regardless of any numbering in previous sections. For 
example, if a document has a Title Page section and a Main 
Section, you might want to set the starting page number in the 
Main Section to 1. 

Follow Last Section. Select to continue page numbering from the 
previous section. Use it instead of Starting Page Number. 

Columns. Select the number of columns in the section. 

Spacing. If you have multiple columns in the section, select the 
distance between them (as well as the relative column width). 
Spacing is the same between all columns. By default, this setting is 
0.125 inch. 

Rule Width. If you have multiple columns in the section, select 
the width of a vertical rule. By default, this setting is zero (O) 
points, or no vertical rule. 

Master Pages. Select whether you want a single page or left 
(even) and right (odd) pages that look like mirror images of each 
other. You would select Two, for example, if you wanted the page 
number or section name to always appear on the outside margin 
of a page: the left margin on a left page and the right margin on a 
right page. By default, this setting is one Master Page. 

Margins. Select the left, right, top, and bottom margins. By 
default, these settings are one inch each. 

4. Tap Apply to apply your changes to the selected section. Then 
close the dialog box. 

Using Master Pages 

You can specify the kind of information that repeats on each page 
of a section. For example, you might want a logo to appear on 



every page, or you might want to make the header bigger than the 
body text on every page. 

WHAT IS A MASTER PAGE? 

The Master Page is a prototype of the way text and graphics appear 
on every page in a section. The Master Page defines the section's 
header and footer, the area where the body text appears on a 
page, and graphics (such as a logo) that repeat on every page. 

When you add a page to a section, GeoWrite uses the layout and 
information in the Master Page to create the new page. Once it is 
created, you can modify the document to suit your needs without 
affecting the Master Page. 

Each section has either one or two Master Pages, depending on the 
Master Pages setting in Page Setup. By default, each section has 
one Master Page. The following illustration shows a typical Master 
Page designed with three columns: 

~ .......................................................................... : 
This is the header region. 

~ .......................................................................... : r ..................................... r················ .. .. 

L 1 This is the body region; with 
~-+--~~-~~--+- multiple columns, there are 

three body regions. 

CHANGING THE MASTER PAGE 

There are several ways to change the Master Page: 

• You can change the header and footer. For more information, 
see "Formatting GeoWrite Documents" in this chapter. 

• You can change the column settings, Master Page settings, or 
margins in Page Setup. For more information, see "Using Page 
Setup" in this chapter. 

• You can edit the Master Page directly, which gives you more 
precise control over its contents. 

When you edit the Master Page, GeoWrite updates the pages in the 
document with any changes you have made. For example, if you 
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change the footer on the Master Page, GeoWrite applies t.liat 
change to the footer on every page in the section. 

To edit the Master Page for a section (Level 4) 

1. Select the section for which you want to change the Master Page 
by positioning the insertion point anywhere in that section. 

2. Choose Edit Master Page from the Layout menu. 

3. If the document has left and right Master Pages (that is, Master 
Pages is set to Two in the Page Setup dialog box), a dialog box 
appears, letting you choose which Master Page you want to edit. 
Tap the appropriate button to edit either the left or the right Master 
Page. 

The Master Page appears: 

l:llE:i GeoWrite - Master Page for· Matn Section Dal521 
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Change the elements on the Master Page to your liking. 

Page Number button. Tap this button to put the page number at 
the insertion point. 

Date of Printing button. Tap this button to put the date of 
printing at the insertion point. 

4. Make your changes to the Master Page by doing one of the 
following: 

Add text or graphics you want to the header or footer. 

or 

Resize or move the text region for the header, footer, or body text 
(including columns). For more information, see the next section, 
"Changing Text Regions on the Master Page." 



5. When you are finished, tap Close. GeoWrite updates all affected 
pages in the section with any changes you have made. 

CHANGING TEXT REGIONS ON TIIE MASTER PAGE 

The text region defines where text flows on the page. You can 
move and resize the text region for the header, footer, and body 
text on a Master Page. 

You might want to do this, for example, if you wanted to set a 
custom width for columns on a page. When you set the number of 
columns in Page Setup, GeoWrite calculates the column width for 
you. You can adjust the width or position of these columns by 
editing the Master Page. 

To select a text region (Levels 2-4) 

1. Tap the Pointer tool on the Drawing tool bar. 

2. Tap the pen on a border of the text region (header, footer, or body 
text). Handles appear along the border of the text region to 
indicate that it is selected. 

r·r- -- --
1 

ii • ii 

.................................. ..Jl .................... .. 
I 

Handles show that the text region is 
selected. Selecting a text regions 
allows you to move it or resize it. 

To deselect a text region (Levels 2-4) 

• Tap anywhere outside or inside the border of the text region. The 
handles disappear. 
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To change the size of a text region (Levels 2-4) 

• After selecting the text region you want to resize, drag any handle 
until the text region becomes the size you want. 

To move a text region (Levels 2-4) 

• After selecting the text region you want to move, drag the move 
handle to move the text region where you want it to appear. For 
more information on the move handle, see "Using a Graphic 
Frame" in this chapter. 

To copy and paste a text region (Levels 2-4) 

1. Select the text region you want to copy. 

2. Choose Copy from the Edit menu. 

or 

At Levels 3-4, tap the Copy tool on the Function bar. 

GeoWrite copies the text region to the clipboard. 

3. Tap the insertion point where you want to paste the text region. 

4. Choose Paste from the Edit menu. 

or 

At Levels 3-4, tap the Paste tool on the Function bar. 

GeoWrite pastes the text region to the document. 

To delete a text region (Levels 2-4) 

1. Select the text region you want to delete. 

2. Choose Delete from the Edit menu. 

or 

At Levels 3-4, tap the Cut tool on the Function bar to cut the text 
frame and copy it to the clipboard. That way, you can paste the 
frame into another location. 

REAPPLYING TIIE MASTER PAGE TO A SECTION 

You can make custom changes to individual pages in a document. 
For example, you can move a column on 9ne page without 
affecting the corresponding column position on other pages in the 
same section. 

When you edit the Master Page, you can decide whether or not 
Geo Write applies your edits on the Master Page to all pages in the 
section, overwriting any custom formatting on individual pages. If 
you select Automatic Layout Recalc from Other Settings in the 



Options menu, GeoWrite automatically updates all pages in the 
section with your changes to the Master Page. If you deselect this 
option, GeoWrite does not override individual page formatting 
automatically. 

You can also abandon any changes you make to the Master Page 
before applying them to the pages in the section. For example, 
suppose you change the column widths on the Master Page, but 
later decide that you want to undo those changes because it will 
affect the formatting on specific pages. You can undo them before 
GeoWrite updates pages in the section. 

To apply the Master Page to all pages in a section (Level 4) 

1. After positioning the insertion point in the section whose Master 
Page you want to change, choose Section from the Layout menu. A 
submenu appears. 

2. Choose Reapply Master Page from the submenu. A dialog box 
appears. 

3. Select from the choices in the dialog box: 

Reset, Then Reapply. Tap this button to reset the Master Page 
before reapplying your changes to all pages in this section. 

Reapply Existing. Tap this button to reapply the Master Page 
without resetting it. 

USING GRAPHICS IN A DOCUMENT 

LEVELS 2-4 This section shows you how you can use graphics in a Geo Write 
document. It discusses some, but not all, of the graphics features 
available in GeoWrite. For more information on drawing and 
graphics, see Chapter 8. 

A picture is worth a thousand words. Adding graphics to your 
document can enhance what you are trying to say by illustrating a 
point, clarifying a discussion, or providing more information about 
a topic. 

You can use any graphic image that you can paste from the 
clipboard. For example, you could create a graph in GeoCalc, 
copy it to the clipboard, and paste it directly into a GeoWrite 
report that discusses the graph. 

At Level 2 and above, you can add a graphic frame - a rectangle 
with a simple border around it - anywhere on a page. You can 
paste graphics directly onto a graphic frame, change its 
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appearance, and control the way it fits into the text in a document. 
You can also paste graphics directly into a document without 
using a graphic frame. 

At Levels 3 and 4, you can even create a graphic image within 
GeoWrite using the tools on the Drawing tool bar. That way, you 
can create a drawing without leaving your document. Level 3 
offers many basic drawing tools, and Level 4 offers more advanced 
drawing features. 

Using a Graphic Frame 

A graphic frame is a rectangle you can use to put a frame around 
text or graphics in a document. You can fill a graphic frame with 
color and patterns, change the color and thickness of its border, 
and make text wrap around it, wrap inside it, or even flow right 
through it. 

ADDING A GRAPHIC FRAME 

To use a graphic frame, you must first add it to your GeoWrite 
document. 

To add a graphic frame (Levels 2-4) 

1. Choose Create Graphic Frame from the Layout menu. 

At Level 2, if this is the first graphic frame you have added during 
your GeoWrite session, a dialog box appears explaining that 
graphics tools are available. Tap OK. 

2. Tap the pen where you want to anchor the upper left corner of the 
graphic frame and drag down and to the right until the graphic 
frame is the size you want. An outline shows the borders of the 
graphic frame as you drag it. 



When you lift the pen, the graphic frame appears with handles 
along its borders, as shown in the following illustration: 

The handles along the borders 
of the graphics frame indicate 
that it's selected. To resize the 
graphics frame, drag a handle. 

The text region shows 
where the text goes. 

CHANGING A GRAPHIC FRAME 

To move the graphics frame, 
drag the move handle. 

You can resize, move, and delete a graphic frame. To change a 
graphic frame, you must select it. When you add a new graphic 
frame, it is selected automatically. The border of a graphic frame 
has handles when it is selected. 

You select a graphic frame the same way you select a text region. 
Selecting a graphic frame makes it the target for subsequent 
operations. 

----

• 

~------~____,The handles along the 
borders of the graphics 
frame indicate that it is 
selected. 
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You also deselect, resize, move, copy, paste, and delete a graphic 
frame the same way you perform these procedures with a text 
region. 

SETIING AITRIBUTES 

Color and patterns can add emphasis and appeal to a graphic 
frame. You can define colors and patterns for the inside fill (area 
attributes) and border (line attributes) of a graphic frame. You can 
fill the space inside with color or patterns, or you can leave it 
empty (unfilled). 

Although the unit display is black and white, you can define colors 
for selected graphic frames. Then if you move a GEOS file to a 
machine with a color monitor, the colors you defined appear on 
screen. Similarly, if you have a color printer, the colors you 
defined appear on the printed copy of your document. 

When using color and patterns in a graphic frame, consider their 
impact on text, background, and graphics. Do they also have 
colors and patterns? In combination, do the colors and patterns 
help communicate what you are trying to convey? You might need 
to adjust the colors and patterns for any of these objects to clarify 
any point or message you may be making. 

For more information about setting area and line attributes for a 
graphic frame, see "Using the Drawing Tools" in Chapter 8. 

Pasting Graphics Into a Document 

You can paste any graphic from the clipboard into a GeoWrite 
document. You can paste it into a graphic frame, if you want, or 
directly into the text. 

To copy and paste a graphic object (Levels 2-4) 

1. In the application you are using to draw the graphic (GeoCalc or 
even GeoWrite itself), select the graphic object you want to copy. 
You can select and copy more than one graphic object at a time. 

2. Choose Copy from the Edit menu. 

or 

At Levels 3-4, tap the Copy tool on the Function bar. 

GeoWrite copies the selected graphic object to the clipboard. 

3. Open the GeoWrite document into which you want to paste the 
graphic object. 

4. Tap the location where you want the graphic object to appear. 



LEVEL 4 

5. Choose Paste from the Edit menu. 

6. 

or 

At Levels 3-4, tap the Paste tool on the Function bar. 

GeoWrite pastes the graphic object from the clipboard. 

Resize or move the graphic object as desired. 

To change the size of a graphic object (Levels 2-4) 

• After selecting the graphic object you want to resize, drag any 
handle until the graphic object is the size you want. 

To move a graphic object (Levels 2-4) 

• After selecting the graphic object you want to move, drag the 
move handle to move the object to another location. 

Wrapping Text 

Wrapping text determines how a graphic fits in with the text. Text 
can go outside or inside the borders of a graphic object or it can 
flow right through the graphic object. The following illustration 
shows examples of each option: 
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To set text wrapping (Level 4) 

This text is wrapped 
tightly . 

This text is wrapped 
around the graphics 
frame. 

This text is not 
wrapped. 

-- - This text is wrapped 
inside the object. 

1. After selecting the graphic frame you want to use, choose Wrap 
Type from the Graphics menu. A submenu appears. 
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2. Select an option from the submenu: 

Wrap Tightly. This option wraps text tightly around the borders 
of the selected graphic object. 

Wrap Around Rectangle. This option wraps text around a 
rectangular area that completely encloses the selected graphic 
object. 

Wrap Inside Object. This option wraps text inside the border of 
the selected graphic object. 

Don't Wrap. This option suppresses text wrapping. The text goes 
right through the object. 

USING DESKTOP PUBLISHING MODE 

LEVEL 4 

5.64 GEOWRITE 

GeoWrite has a DTP (desktop publishing) mode that you can use 
for page layout tasks. This section describes when and how to use 
DTP mode to create a GeoWrite document. 

Generally, you use DTP mode for shorter documents that have a 
mixture of graphics and text, lots of layout work on each page, 
and a limited page length. For example, DTP mode would be ideal 
if you wanted to create a four-page brochure with graphs and 
drawings. For short memos, long reports, or books (documents 
with pages of text only), DTP mode may not be necessary. 

When you use GeoWrite as a page layout tool, it gives you more 
direct control over pagination in a document. DTP mode focuses 
more on the design of individual pages than on the flow of text 
through a document. If adding text causes the text to "spill" past 
the end of a page, Geo Write automatically creates an additional 
page. On the other hand, if deleting text removes all the text on a 
page, GeoWrite does not automatically delete the page. This is 
where DTP mode makes things easy for you. 

For example, suppose you lay out a six-page newsletter with 
graphics on every page, and you want to insert two pages between 
the fourth and fifth pages without disturbing the other pages. In 
DTP mode, you simply insert the pages; GeoWrite moves the fifth 
and sixth pages down, including graphics. 

Working with Documents in DTP Mode 

When you activate DTP mode, you can insert, append, and delete 
individual pages in a document. 



ACfIVATING DTP MODE 

You can activate DTP mode so that GeoWrite does not delete 
pages automatically and unexpectedly alter your page count. You 
can do this whenever you want, even after you have started 
editing a document. 

To activate DTP mode (Level 4) 

• After choosing Other Settings from the Options menu, select DTP 
Mode. 

ADDING PAGES 

You can add a page to a document by inserting or appending it. 
Inserting puts the new page before the current page (the page 
where the insertion point is). Appending puts the new page after 
the current page. When you add a page, the text flows onto the 
new page. In DTP mode, you can create the number of pages you 
need first, before filling them with information. 

To insert or append a new page (Level 4) 

1. To insert or append a new page, perform one of the following 
actions as appropriate: 

• To insert a new page, tap the pen on the page before which 
you want to insert the new page. 

• To append a new page, tap the pen on the page after which 
you want to append the new page. 

2. Choose Page Layouts from the Layout menu. A submenu appears. 

3. Choose Insert Page (Before This One) or Append Page (After This 
One) from the submenu. A confirmation message appears. 

4. Tap Yes. GeoWrite adds the new page to your document. 

DELETING PAGES 

You can delete a page you no longer need. Deleting a page 
deletes all the information on the page. However, you can prevent 
GEOS from deleting a page that contains graphics. 

NOTE 

You cannot delete a page if it is the only page in a document. 

To keep pages with graphics from being deleted (Level 4) 

• After choosing Other Settings from the Options menu, select Do 
Not Delete Pages With Graphics. 
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To delete an existing page (Level 4) 

1. Tap the pen on the page you want to delete. 

2. Choose Page Layouts from the Layout menu. A submenu appears. 

3. Choose Delete Page from the submenu. A dialog box appears, 
asking you to confirm that you want to delete the current page. 

4. Tap Yes. GeoWrite deletes the current page. 



Additional GeoWrite Features 

This section describes the additional features of Geo Write that let 
you view documents in different ways, insert special characters, 
work with multiple columns and footnotes, and merge data with 
other GEOS applications. Some features described in "Additional 
GeoWrite Features" are available at Level 2, but most are available 
at Levels 3 and 4, or at Level 4 only. 

VIEWING YOUR DOCUMENT 

LEVELS 3-4 This section shows you how to change the way GeoWrite displays 
a document so that you can see what you have created from 
different perspectives. It also describes how to show invisible 
characters (such as tabs, paragraph marks, and page breaks) in a 
document when you need to know where they are. 

You can also change the way a document appears on screen by 
zooming, scaling, viewing percentages, and using other view 
options. For more information on zooming and scaling, see 
Chapter 3. 

Changing Display Modes 

A display mode determines the amount of information in a 
document that appears on screen. Depending on the display mode 
you have set, GeoWrite displays or hides such elements as 
graphics, text formatting, page layout (multiple columns and 
margins), headers, footers, and so on. 
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GeoWrite has five display modes from which to choose: 

Page. This mode displays all the information on the screen. The 
document appears the way it would look if printed. 

Condensed. This mode displays text and text formatting in a 
single continuous column. Graphics do not appear, but the space 
they occupy appears as white space. 

Galley. This mode is the same as Condensed except that it 
removes any white space that results from page breaks. 

Draft With Styles. This mode displays text and text formatting in 
a single wide column. Graphics are completely hidden. 

Draft Without Styles. This mode displays text in a single font and 
in a single wide column. Graphics are completely hidden. 

You can switch display modes depending on what you want to 
look at and work with in a document. For example, if you want to 
edit text without being concerned about special formatting, page 
layout, graphics, and so on, you can choose the simplest display 
mode (Draft Without Styles). On the other hand, to fine tune the 
way everything looks in a document before printing it, you can 
choose the most complex display mode (Page). 

The simpler display modes are generally faster to work in than the 
more complex ones because GeoWrite does not need to perform 
as many calculations to display a document. Also, the simpler the 
display mode, the less "busy" the screen appears. 

The display mode applies to the way the entire document appears, 
not just to individual sections or pages. Changing the display mode 
does not change the information in a document, nor does it 
change the way the document prints; it merely changes the way 
the document appears on screen. 

To change the display mode (Levels 3-4) 

1. Choose Display Modes from the View menu. A submenu appears. 

2. Select the display mode you want. GeoWrite refreshes the screen 
and displays the document in the display mode you selected. 

NOTE 
Refreshing the screen can take time when you are changing 
display modes, particularly for complex documents that have both 
text and graphics. 



PAGE DISPIAY MODE 

The Page display mode, GeoWrite's default mode, shows you most 
completely what a document would look like when printed. It 
shows you everything in the document, including text formatting, 
page layout (side-by-side columns and margins), graphics, 
headers, and footers. GeoWrite also displays the section name if 
you have selected Display Section Name in Other Settings under 
the Options menu. 

If you have switched to another display mode, you may want to 
switch back to Page display mode to fine tune document 
formatting before printing. Page display mode is the only mode in 
which you can see your page exactly as it will print. It is also the 
only mode in which you can manipulate graphic images, adding, 
deleting, drawing, moving, and resizing them as desired. 

Section name 

Graphic image 

Body 

Margin 

Page background 

Header 

Ne cue; 011 

Side-by-Side columns 

GAllEY AND CONDENSED DISPIAY MODES 

The Galley display mode shows all text formatting but displays 
only one continuous column of text. It hides headers and footers, 

· page layout (side-by-side columns and margins), and the section 
name. It simplifies the display by putting white space where a 
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graphic would appear; however, you cannot manipulate the 
graphic. 

Use the Galley display mode when you want to see and work with 
text and text formatting but not graphics and page layout. For 
instance, you might need to know where graphics appear in the 
text, but not the details of what they look like. 

With summer qtrickly 
approachm,s, many 
people are pl.uwi.n,s 
how to spend their -
vaca:tions. Maybe you 
aze overwhelm.ed by 

number of poss:ibiliti.es of 
here you and your family 

ould visit. Or perhaps the 
st e xcitin.s place you can 

'nk of taki.n.,s your · sis to 
play around in the park 

own the block. Murtnic:k 
avel is happy to offer special 

acation packages to help you 
ut of your dilemma. These 
pec:ials are available from the 

nths of June throu.gh 
u_aust, so come and take 
vant.a.ge of these sreat deals 

I 

1::1 

Body 

The Condensed display mode is the same as Galley mode, except 
that it displays any white space resulting from column or page 
breaks. 

DRAFf WITII SlYLES AND DRAFf WITIIOUT SlYLES DISPIAY MODES 

The Draft With Styles display mode shows you text formatting, but 
displays only one column of text across the entire screen. It differs 
from Galley and Condensed in that it hides the page layout, 
graphics, headers, footers, and section name. 



Use the Draft With Styles display mode to work with text and text 
formatting, but not with graphics and page layout. Because it fills 
an entire screen, this mode is especially useful for editing text in 
sections with multiple columns. You can focus on what you are 
writing, not on how it looks on the page. 

E;J GeoN1 1te - Mur tnrck Nt'uJc, 

!:ayout !Jraphics faragraph !;haracter 

Normal -I •'El;l!l!!!I I URW Roman -I I 12 -I! It I 

"lh. summer qgickly ~pw.1ehil'I,, m.1.ny people are plaIII'lina how IO spe:ru::l their vac:atiorls. Maybe you are 
verwhelmed by the number of possibilities of where you llld your family could v:lsil. Or pll'h.aps the most exe!itin, 
la.c:e youc:an ~nlc of Weins yom kids ii: flO tM playaroand in tha p.t.rkdown the block. Murtnil!lcTravel is happy IO 
fret sp11eW vacation pa.~s to help you out of your dilemma. These specials are avaii.ble fwm thl months of Jur1e 

qh Au.sust, so come and take advantaae of 1Mse ,snat duls now! 

acation Packages 
W.mde-worlJ 

Escape fwm the cold weather and sI1Dwby takm,s: a '1111!.ek-lona trip fD the Wonde.rWorld in Texas. Our family 
acka,se incbu:les a five-day pass to the Wo:ru:lerworld park. You can suy at you::r c:boic:e of Wol'lderWo:dd Rlilso:rts. We 
:!IO include a coupon book with disc:ounD a.1 lhe va.:rious loca.l i.ltrai;:tions you ca.n visit whileyou. ilil! them. Is i. week IOO 
hon~We cancustomia the pa.cki.aoii 10 sui1yom needs. Accomm.oda.ticns and mei.ls ae :iru::hu:led .aJ.0113 with the round 
"p a.ir fam. 11Us is a. special lha.1 you and your family won'1 wa.n1 ~ miss I 

:K:iiDg 
Ma.ybe you don'1 wa.m to esi::a.pe the colcl weather and snow. You would ri.lhei"be 11\:ioyina yo\unlfin the micls1of 
chill by skiil'13. Murttlick offers special skilna \l.M:.a.tic:ns for hmilies and .sroups. Whether downhill. or cmss-co1muy 

kiina i:s yowpwfennce, youca.n ti.le a. trip to .any offi..-e orskiina resonsloca.ted thro113hout1he Unillad States. 
packa.ses :iru::lw::le passes, .M:commoda.tioIIS, and meals. quipnwn1 :rental is •:xtra.. 

iconHi.stOl')' 2bW' 
ahe yo= kids on vacation and 3ive them an oppol'hlnity ID furt~r ~ir a~uc&~on by_ ~81'1iAs: _llP fol- the American 

Style Formatting Body 

You may have an initial delay when switching to or from this 
display mode, because GeoWrite needs to recalculate before it can 
display the information properly on screen. 

Draft Without Styles is the same as Draft With Styles, except that it 
makes text formatting homogenous, displaying all text in a plain 
font instead of the underlying text formatting. This is the fastest 
way to edit text, because GeoWrite does not need to perform as 
many calculations to display text on screen as you scroll the 
document. To ensure fast performance, you cannot zoom the 
document or choose other view options in this display mode. 
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Displaying Invisible Characters 

Invisible characters are non printing characters that you enter but 
do not normally see on screen, such as spaces, tabs, paragraph 
marks (carriage returns), page and column break marks, and 
section break marks. 

abs 
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Section Break Page Break 

You can display invisible characters to see what you have entered 
and to edit them. For example, you might want to know whether 
you have entered unwanted extra spaces in your document. The 
following table shows the on-screen symbols that represent 
invisible characters: 

SYMBOL 

91 

§ 

* 

CHARACTER REPRESENTED 

Paragraph mark (carriage return) 

Tab 

Space 

Section break 

Page break 

To display invisible characters (Levels 3-4) 

1. Choose Other Settings from the Options menu. A submenu 
appears. 

2. Select Show Invisibles. GeoWrite displays the invisible characters. 



DISPLAYING COUNTS 

LEVELS 2-4 Geo Write counts the number of characters, words, lines, and 
paragraphs in a document. You can use this information when 
your document needs to be a minimum or maximum size, as when 
a report must be 250 to 300 words long, or an article that cannot 
exceed 30 lines. 

To view document counts (Levels 2-4) 

1. Choose Counts from the Edit menu. A dialog box appears. 

2. Tap Close to close the dialog box. 

NOTE 

You can make changes to the text while the dialog box is visible, 
then recalculate the counts if you want to see the impact of a 
change to the document. 

To recalculate document counts (Levels 2-4) 

1. Choose Counts from the Edit menu. A dialog box appears. 

2. Make any changes that affect the number of characters, words, 
lines, or paragraphs in the document. 

3. Tap Count Again. Close the dialog box. 

INSERTING SPECIAL CHARACTERS 

LEVELS 2-4 You can insert special characters in a document that display dates, 
times, and numbers. Special characters are useful because they 
save you from entering and calculating information. For example, 
if you want the current date in a letter template to be updated each 
day, use a special character instead of re-entering the date every 
day. Some special characters that are available at Levels 3 and 4 
are not available at Level 2. 

A page break is another kind of special character. For more 
information, see "Controlling Pagination" in this chapter. 

You can search a document for these special characters. For more 
information, see' "Formatting Geo Write Documents" in this 
chapter. 
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Inserting the Current Date or Time 

You can insert the current date in a document. You might do this 
to put a date at the top of a letter or in a memo. You can specify 
either of two formats: longhand or numeric. Alternatively, you can 
insert special date characters to add the current date in a different 
format. For more information, see "Inserting Special Dates and 
Times" in this chapter. 

You can also insert the current time in a document. You might do 
this to "time-stamp" a fax or journal entry. The time appears in the 
HH:MM:SS format (hours:minutes:seconds). Alternatively, you can 
insert special time characters to add the current time in a different 
format. For more information, see "Inserting Special Dates and 
Times" in this chapter. 

To insert the current date or time (Levels 2-4) 

1. After moving the insertion point to the place where you want to 
insert the current date or time, choose Insert Special from the Edit 
menu. A submenu appears. 

2. Select an option from the submenu: 

Longhand Date. Longhand date inserts the current date in a 
longhand format (for example, Friday, December 31, 1993). 

Numeric Date. Numeric date inserts the current date in a numeric 
format (for example, 12/15/93). 

Current Time. This inserts the current time in the HH:MM:SS 
format (for example, 12:45:59 PM). 

The date or time is entered just as if you had entered it yourself so 
that you can change it later. 

Inserting a Number (Counter) 

GeoWrite keeps track of certain information in a document 
automatically, such as the current page number in the current 
section or document, the number of pages in the current section or 
document, the current section number, and the total number of 
sections. To display any of these numbers, you insert the 
appropriate special number character in your document in the 
format you want. 

For example, you might use special numbers in a footer to display 
page numbers that restart in every section; page numbers in the 
first section might be 1-1, 1-2, 1-3, and so on, while page numbers 
in the second section might be 2-1, 2-2, 2-3, and so on. 



For information 
about setting the 
starting page 
number, see 
"Designing Geo Write 
Documents" in this 
chapter. 

LEVELS 3-4 

NOTE 

Once you insert special numbers, you cannot change their values; 
their values depend on internal GeoWrite calculations. 

To insert a special number (Levels 3-4) 

1. After moving the insertion point to the place where you want to 
insert the number, choose Insert Special from the Edit menu. A 
submenu appears. 

2. Choose Number from the submenu. A dialog box appears. 

3. Select the number type from the Type list: 

Page Number. Displays the current page number in the 
document. You can set the starting page number for a document. 

Page Number in Section. Displays the current page number in 
the current section. You can set the starting page number for a 
section. 

Number of Pages. Displays the total number of pages in the 
document. 

Number of Pages in Section. Displays the total number of pages 
in the current section. 

Section Number. Displays the current section number. The value 
of this number depends on the starting section number. For more 
information, see "Designing GeoWrite Documents" in this chapter. 

Number of Sections. Displays the total number of sections in the 
document. 

4. Select the format from the Format list: Number, Uppercase Letter, 
Lowercase Letter, Uppercase Roman, or Lowercase Roman. 

5. Tap Insert in the dialog box. Geo Write inserts the number from the 
list in the format you specified. 

Inserting Special Dates and Times 

GeoWrite keeps track of certain date and time information 
automatically, such as the current date and time as well as the date 
and time a document was created, revised, or printed. To display 
any of these dates or times, you insert the appropriate special date 
or time character in your document, in the format you want. 

For example, you might use special dates or times in a footer to 
display the date or time when you last printed or revised a 
document. 
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NOTE 

Once you insert special dates or times, you cannot change their 
values; their values depend on internal GeoWrite calculations. 
However, you can change the value when you insert the current 
date or time. For more information, see "Inserting the Current Date 
or Time" in this chapter. 

To insert a special date or time (Levels 3-4) 

1. After moving the insertion point to the place where you want to 
insert the date or time, choose Insert Special from the Edit menu. A 
submenu appears. 

2. Choose Special Date or Special Time from the submenu. A dialog 
box appears. 

3. Select the date or time type from the Type list: 

Today's Date (Won't Change) or Now (Won't Change). This 
date or time shows the system date or time (the date or time that 
the unit maintains automatically) when you inserted the character. 
It does not change when the system time changes. 

Date Document Created or Time Document Created. This 
date or time shows when the document was created. 

Date of Last Revision or Time of Last Revision. This date or 
time shows when the document was last saved. 

Date of Printing or Time of Printing. This date or time is 
updated when you print the document. The updated date or time 
appears in the printout of your document but not on screen. 

4. Select the date or time format from the Format list. A sample of the 
selected date or time format appears in the dialog box. 

5. Tap Insert in the dialog box. GeoWrite inserts the special date or 
time from the list in the format you specified. 

CONTROLLING PAGINATION 

LEVELS 2-4 
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GeoWrite treats the text in a document as one continuous flow of 
information. Whenever you insert or delete text or graphics in a 
document, Geo Write automatically calculates the locations of page 
breaks and column breaks and places them accordingly. This 
process is called automatic pagination, and the calculated page 
breaks are called soft page breaks because their locations change 
depending on the amount of information in a document. 



You can force a page break manually by inserting a hard page 
break. You do this whenever you want to start a new page in a 
specific location, such as a bibliography page or an index. 

If you have multiple columns in your document, a page break is 
the same as a column break. A page break in the last (rightmost) 
column on a page moves subsequent text to the next page. A page 
break in other columns moves text to the next column on the same 
page. 

Geo Write inserts a hard page break whenever you add a new 
section. The hard page break occurs at the section break. For more 
information, see "Designing GeoWrite Documents" in this chapter. 

Inserting a Hard Page Break 

You can insert a hard page break by using a menu or by pressing a 
key combination on the external keyboard. 

To insert a page break (Levels 2-4) 

• After moving the insertion point to the place where you want the 
page break, do one of the following: 

• Choose Insert Special from the Edit menu. A submenu appears, 
from which you choose Insert Page Break. 

• If you are using an external keyboard, press Ctrl+Enter. 

If Show Invisibles is selected, the page break marker appears as a 
double-dagger (*) on screen. For more information, see 
"Displaying Invisible Characters" in this chapter. 

Deleting a Hard Page Break 

You can delete a hard page break you no longer need. You delete 
it as you would any other character. After you delete a hard page 
break, the insertion point moves to the bottom of the page, in front 
of the page break marker. GeoWrite removes the page break, 
recalculates pagination, and refreshes the screen. 

MANAGING COLUMNS 

You can have multiple columns of text in a document, just like 
those you see in a newspaper or a magazine. Multiple columns 
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can add visual appeal to a document and make the text easier to 
read. 

By default, a Geo Write document has just one column of text. 
When you specify multiple columns, text flows from the bottom of 
one column to the top of the next in a snake-like fashion. In the 
Page display mode, multiple columns appear side by side on 
screen. 

Setting Multiple Columns 

To set up multiple columns, you specify column options in the 
Page Setup dialog box. These settings apply to the current section 
only or, if a document has only one section, to the entire 
document. For information on Page Setup, see "Designing 
GeoWrite Documents" in this chapter. 

If your document will have multiple columns throughout (as in a 
newsletter), you can save time by setting up columns in the first 
section before adding other sections to the document. That way, 
Geo Write will carry your column settings over to subsequent 
sections. 

When you set multiple columns, you specify the number of 
columns, the gutter (or spacing) between columns, and the width 
of any vertical rules (the lines between the columns). Geo Write 
initially calculates a uniform column width for all columns, based 
on the number of columns, the spacing between columns, the size 
of the page, the page orientation, and the page margins. Later, you 
can change column widths if you want. For more information, see 
"Changing Columns" in this chapter. 



The following sample document shows the result of setting the 
column characteristics: 

The column setting is three (3). 

The distance between 
columns is 0.25 inches. 

The vertical rule is 2 points wide. 

To change the columns for a section (Levels 2-4) 

1. After moving the insertion point to the section for which you want 
to change the page setup, choose Page Setup from the File menu. 
A dialog box appears: 

= Page Setup 
Section to Change Page Setup for: Main Section 

starting Page Number: DB:::: FoHou; La::lt Section 

Columns: [!] B Spacing: 10.248 in I B Rule Width: ~I 2_p_t __ I B 

Master Pages: +One <>Two (Left and Right) 

Margins: Left I 1 in 
IB 

Right I 1 in 
IB 

Top I 1 in IBsottom I 1 in 
IB 

jApply I jc1osel ~ 

2. Complete the dialog box, selecting the column options you want: 

Columns. Select the number of columns in the section. 
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Spacing. If you have multiple columns in the section, select the 
distance between columns (as well as the relative column width). 
Spacing is the same between all columns. By default, this setting is 
0.125 inch; you can increase it up to 1 inch. 

Rule Width. If you have multiple columns in the section and. you 
want a vertical rule, select the width of the vertical rule. By 
default, this setting is zero (O) points, or no vertical rule; you can 
increase this up to 9 points. 

3. Tap Apply to apply your changes to the selected section. Then 
close the dialog box. 

Changing Columns 

Even if you have established columns in your document, you can 
change the number of columns, the distance between columns, 
and the width of the vertical rules, in the Page Setup dialog box. 
GeoWrite simply recalculates the column width and redisplays the 
document with your changes. 

In most cases, you will not need to do anything else. However, 
you can set a custom size and position for each column by editing 
the Master Page. You can also customize columns on a page-by
page basis. For more information, see "Designing GeoWrite 
Documents" in this chapter. 

Using Column Breaks 

You can insert a column break to force GeoWrite to move 
subsequent text to the top of the next column. A column break is 
the same as a page break. For more information, see "Inserting a 
Hard Page Break" in this chapter. 

USING MAIL MERGE 

LEVELS 2-4 
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When you print a GeoWrite document, you have the option of 
merging (combining) information from other GEOS applications. 
Merging allows you to print form letters, envelopes, mailing labels, 
reports, and other types of documents using data you have already 
entered in another application; you do not need to enter them 
again in GeoWrite. 



Merging involves two documents: the data document and the 
merge document. The data document is a GeoCalc or GeoFile 
document that contains data stored in a consistent format. For 
example, a GeoCalc data document might contain monthly budget 
figures, and a GeoFile data document might contain a list of all the 
books you own. 

The information in the data document gets inserted into the merge 
document. The merge document is a GeoWrite document that 
contains the text, graphics, layout, and formatting that will appear 
in each printed copy of the document. It also contains merge fields 
that mark the places where GeoWrite puts the data from the data 
document when you print the document. 

The easiest way to use GeoWrite's merge feature is to follow this 
general sequence of tasks: 

1. Create the merge data in the format you want (in GeoCalc or 
GeoFile). 

2. Create the GeoWrite merge document and position the merge 
fields where you want them. 

3. Copy the information you want to merge from the GeoCalc or 
GeoFile data document to the clipboard. 

4. Merge the information from the clipboard into the GeoWrite 
document. 

This section describes these steps in detail. 

NOTE 

This section assumes you know how to use at least GeoCalc, 
GeoFile, or both. 
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Creating and Copying Merge Information 

You can create and store merge data in GeoCalc and GeoFile. 

USING GEOCALC TO STORE MAIL MERGE DATA 

You can use GeoCalc to store the infonnation you will merge into 
your GeoWrite document. To do so, you must arrange the 
information in the GeoCalc document in a single table. This 
enables GeoCalc to copy the information to the clipboard in a 
standard fonnat that GeoWrite can understand. 

Field names appear in the first row. Each column 
is a different field. Field names are consecutive. 

Field Name 

er ge file 

Entries appear in the rows below. 
Each row is a different entry. 

You can design a GeoCalc document like this one from scratch or 
you can simply rearrange the information in an existing document. 
The following instructions assume that you know how to use 
GeoCalc. For more information about GeoCalc, see Chapter 6. 

To design a GeoCalc data document (All Levels) 

1. Add field names to the first row in the merge table, starting with 
the first cell (such as Al) and proceeding to the right (such as cell 
Bl, cell Cl, and so on) until you have defined a name for each 
field. 

• A field name can be any combination of letters, numbers, 
spaces, and punctuation. You can use any field name you want, 
as long as it matches the name of the merge field in the 



GeoWrite document. A field name usually describes the 
information it contains, such as Customer ID or Fax Number. 

• Field names must be contiguous. You cannot have an empty 
cell between field names. 

2. Fill in the rows beneath the field names. Each row will be used, 
one at a time, to create an individual document when merging. 

To copy the merge data to the clipboard (All Levels) 

1. If you want, change the order of the rows so that the rows at the 
top are the ones you want to merge. For example, at Level 4 of 
GeoCalc, you can sort rows so that the entries appear in 
alphabetical order. 

2. Select the first row (with field names) and any subsequent rows 
you want to merge. 

3. Choose Copy from the Edit menu. GeoCalc copies the field names 
and entries to the clipboard and prepares them for merging. 

USING GEOFILE TO STORE MAIL MERGE DATA 

You can use GeoFile to store the information you will merge into 
your GeoWrite document. You can copy one record, marked 
records, or all records in the GeoFile data document to the 
clipboard. You can take advantage of the data management 
features in GeoFile to store and maintain your data. The following 
instructions assume that you know how to use GeoFile. For more 
information about GeoFile, see Chapter 7. 

To copy records to the clipboard (Levels 2-4) 

1. If you want to copy only marked records to the clipboard, mark 
the records you want to copy. 

2. Choose Other from the File menu. A submenu appears. 
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3. Choose Export Document. A dialog box appears: 

Select Folder and Format for Export 

I~ Luo t.o Doc~wn<~ntJ l Ori~es - Formats 
or nr na Sc pen <1t( d U.iluc 

~ 
i- !~~ Dall:"i dBase Ill 

dBase IU 
Lotus 1-2-3, version 1.0 or 1 A 

~ Lotus 1-2-3, version 2.0 - 2.3 

New File Name: ~11111111111.csu I 
I Map Export Fields ... I 

E::::t~te~~ 
[Export] [Export to Clipboard [cance!.] 

Tap to copy addresses Specify the starting and e nding 
to the di board. p record number. 

4. Complete the dialog box, selecting the options you want: 

Export All. This option exports all records in the database. 

Export Records From/To. This option exports a range of 
consecutive records; you specify the starting and ending record 
numbers. 

NOTE 

Do not use Map Export Fields when merging data. The field names 
in the source database must be identical to the names of the merge 
fields. 

5. Tap Export to Clipboard. GeoFile copies the records you specified 
to the clipboard and prepares the data for merging. 

Setting Up the GeoWrite Merge Document 

The GeoWrite merge document contains the text, graphics, 
formatting, and page layout of the information you want to print. It 
also contains merge fields that correspond to the data in the 
clipboard. 

The field names used in the merge fields must match exactly the 
field names used in the source data document. These fields are 
case-sensitive; that is, they must match uppercase and lowercase 
exactly. For example, a merge field with the name "HomeAddress" 
will not match "Home Address", "Home_Address", or 
"homeAddress". 



To add merge fields in a Geo Write document (Levels 2-4) 

1. Move the insertion point to the location where you want the 
merge field to appear. It can appear on a line by itself or 
embedded in other text. 

2. Using the floating keyboard, tap Ctrl+Alt+ \. A double left chevron 
appears («).This identifies the start of the merge field. 

3. Enter the field name. Remember that the field name you enter 
must be identical to the field name in the source GeoCalc or 
GeoFile document. 

4. Using the floating keyboard, tap Ctrl+Alt+Shift+\. A double right 
chevron appears (>> ). This identifies the end of the merge field. 

5. If you want, specify the character formatting (such as style, size, 
and so on) for the field. 

Repeat this procedure for each merge field in the merge 
document. When you are finished, your merge document can have 
any number of merge fields, as shown in the following example: 

Puts the Full_Name data here. 

? J_ •Jffil 
!:ile ~dit ~t_w Qptions !,ayout _Qraphics earagraph !;haracter 

Normal -1 ll±lo;;l .. I I URW Roman -1112 -llltl 

«City», «State» «Zip_ Code:. 

Dear «Formal_NaJne:t>, 

\First of all, Td hke to .1~ youforallowina Murtru.::k Travel to assist you in your trav£<lplans 
Wehopeours.,,IVtcehas eenMlpfol. 

:Secause you an!a f:raque ttravel@r (our :racords show that you've booked over 50,000 fli,aht 

~!: :: ~~ ;;:·~~~~o~~~ ~~~1::e~}~c!:~t~rw:e~1~ ~: 1;~u~~!y8o; ~~":~~:.tne':!:W 
i1\'led to be plannms a trip! ' 

Puts the Zip_ Code data here. 
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These fields correspond to the following fields in GeoFile: 

GeoFlle - Mail Mer·ge Data Dll~ 
Eile J;dit ~ielu Qptions !,ayout t!ark Qata ~indow 

Mail Merge Database ,. 
This is a data.base which'jouca.n useincoajunction with the GeoWrite templatesM~lMergeB«.-Sines;oLeJt.er 
and MQi.lMegeEnw/,ope.#10. For more about mail merge, see your documentation 

Title (Ms.,M1.tM1s.JD1.Jetc): f§IJ 
Last Name: Fi~ ---------, 
first Name: CIW"les 

Middle Name: or.a.th.an 

Sheet: 123 Brook Lane 

City: Sweetwater State:~ Zip Code: 0003 

Hora e Phone: (510) 55.5-5555 

Work Phone: (510) 55.S.2.222 
}Record Control Panel - Da!!J Enti:y_ L~out 

NoleoI,;,nd of Bill'• /LRJwwlEJ 
Record, DB of l 

Dk 

11~ ·- [§] ' 
im~~I :~ l ti.ii J [2J 

Full - Name Zip_Code 

Printing the Merge Document 

Once you have set up your GeoWrite merge document, you can 
merge and print it 

To print a merge document (Levels 2-4) 

1. Copy the merge information from the source GeoCalc or GeoFile 
document For instructions, see the appropriate procedure in this 
section, 

2. In GeoWrite, choose Print from the File menu, A dialog box 
appears, 

3. Select a merge option: 

No Merge. Prevents merging, If you print a merge document 
without merging, GeoWrite prints the merge fields instead, 

Merge One. Merges the first entry in the clipboard, Use it to test 
the merge document to make sure it works properly before 
printing all entries, 

Merge All. Merges all merge entries in the clipboard, 

4. Tap Print in the dialog box, Geo Write merges one or all of the 
entries in the clipboard with the GeoWrite merge document 

For each merge entry, GeoWrite merges the fields and prints a 
copy of the document 



If a field appears in the clipboard but not in the merge document, 
Geo Write skips it. If a field appears in the d.ocument but not in the 
clipboard, GeoWrite prints the merge field instead: the <<field:» 
text will appear in your document. 

NOTE 

If you see «field>> in a printed document, make sure that you 
selected either Merge One or Merge All. Next, make sure that the 
name of the field in the data document matches the name of the 
merge field in the merge document. 

CREATING A TABLE OF CONTENTS 

LEVELS 3-4 You can use GeoWrite styles to create a table of contents easily. A 
typical table of contents looks like this: 

Content.~ 

InUoduction ...................................................................... 8 

Pan I Freedom of Conscience and Expression ........................ 16 

Part II Judicial Power and Equali ~ Under the Constitu.tion .... 30 

Pan III Ris:hts of the Accused .................... . 86 

Part IV Govem:m., A Nation... . . .................... .............. 110 

PartV 'I'he Constitution- Past, Present and Futme ................ 142 

Bibliosraphy ............................................................. 162 

Jex ................ . ............................................... 170 

Dot Tab Leader I Right Tab Type 

For each heading level in your document, create a style with the 
following characteristics: 

• A right tab type with a dot leader. For more information, see 
"Formatting GeoWrite Documents" in this chapter. 

• Indented paragraphs for each heading level. For more 
information, see "Formatting GeoWrite Documents" in this 
chapter. 

Once you have created the styles, you can simply enter the 
heading text, tap Tab on the floating keyboard, enter the page 
number, then apply the style appropriate to the heading level. 

ADDITIONAL GEOWRITE FEATURES 5.87 







GeoCalc Basics 

This section describes the Level 1 functions of GeoCalc. You can 
use every feature of this basic set at all levels of GeoCalc. 

This section assumes you are familiar with Chapters 1 and 3, which 
give an overview of the skills you need to use any GEOS 
application. 

WHAT IS A SPREADSHEET? 

EJ 
GeoCeilc 

6.2 GEOCALC 

GeoCalc is a spreadsheet application. Spreadsheets make light 
work of data crunching, because GeoCalc does all the calculation 
for you. 

A spreadsheet looks a lot like a general ledger and works on some 
of the same principles. You place data, numbers or labels, in 
spreadsheet cells. Cells can also contain formulas that depend on 
the data in other cells. If you change data in your spreadsheet, 
formulas based on that data will change automatically. 

Because of this, spreadsheets are ideally suited for budgets, 
reports, and playing "What if?" - what if you change the interest 
rate on a loan, what happens to your household budget if you eat 
out every night? 

Spreadsheets can do much more than this. The best way to find 
out what GeoCalc can do is to try creating all sorts of spreadsheets. 
At first it takes a little time, but with practice, you will become 
proficient at turning complicated tasks into easy-to-use 
spreadsheets. 



USER LEVELS IN GEOCALC 

GeoCalc has four user levels, as follows: 

• Level 1 provides the basic features you need to work with a 
spreadsheet. You can enter text, numbers, and formulas. This 
section describes all of the Level 1 features. 

• Level 2 adds the Style bar and Function bar so that you can 
quickly choose actions and set characteristics. In addition, you 
can copy formulas by "filling," show formulas in cells, and add 
charts. 

• Level 3 adds the Drawing tool bar, Graphics tool bar, and 
Bitmap tool bar. At Level 3, you can set printing options, 
display different rulers, add headers and footers, define names, 
add notes, and add text color. Level 3 also gives you more 
options for working with charts. 

• Level 4 allows you to specify calculation criteria, sort 
information, set the row height, and add bitmap graphics and 
splines. 

You can change your user level at any time. For more information 
about changing your user level, see Chapter 3. 

This section describes the basic features of GeoCalc at Level 1, 
though you can use most of the same techniques at Levels 2 
through 4. Once you have mastered the general concepts for 
spreadsheets described in this section, you may want to learn 
more. To have more control over your spreadsheets, set the user 
level to Level 2 and read "Formatting GeoCalc Spreadsheets" in 
this chapter. 
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THE GEOCALC WINDOW 

6.4 GEOCALC 

The GeoCalc window looks like this: 

Smart Select button 

Cell address 

Active cell 

Row headers 

Edit bar 

Cells 

Column headers 

Spreadsheet grid 

You see the following elements in a GeoCalc document: 

The spreadsheet grid. The grid you see in a GeoCalc document 
is like a giant piece of accounting paper comprising cells in a table 
of numbered rows and lettered columns. The grid is your 
spreadsheet. You enter numbers, text, and formulas into the 
individual cells in the grid. 

Row and column headers. The numbers down the left side that 
label each row are called row headers. The letters across the top 
that label each column are called column headers. Tap these 
headers to select an entire row or column. 

Smart Select button. This button is located at the intersection of 
the row headers and column headers; it is not labeled. Tap this 
button to select all cells in the spreadsheet that have entries 
(including all the empty cells in between). 

Cells. Each cell can hold a piece of information, such as text, 
numeric values, or formulas for calculations. The text and numeric 
values you enter appear in the cells of your spreadsheet. If you 
enter a formula, though, the result of the formula appears in the 



cell (not the formula itself). At Level 2, you can display the 
formulas instead of the results. 

Cell addresses. Each cell has an address, like a pair of map 
coordinates, denoting its position in a given row and column. The 
address consists of a row header and a column header. For 
example, B3 means the cell in row 3 of column B. 

The active cell. Your entries in a spreadsheet go into the active 
cell. When you tap a cell to select it, it becomes the active cell. The 
active cell always appears highlighted with a border around it. The 
cell address for the active cell always appears in the Edit bar. 

The Edit bar. The Edit bar displays information about the active 
cell. The Edit bar is where you enter and edit the text, numeric 
value, or formula you want to enter in the active cell. The Edit bar 
includes the following elements: 

Active Cell address Backspace button 

D 10 X .f =A3+BS+C31 

Restore Edit area 
button 

Enter button Alphanumeric button 

• Active cell address. This is the cell address of the active cell. For 
example, ClO means the cell in the tenth row of column C. 

• Restore button. Tap this button to cancel the changes you are 
currently entering in the edit area. The value in the cell reverts 
to the original entry. 

• Enter button. Tap this button when you want to enter the 
contents of the edit area into the active cell. 

• Edit area. This area shows the contents of the active cell. You 
can make changes here, and then tap the Enter button to enter 
the changes into the active cell. This is also the area where you 
create formulas or specify functions from the Formula menu (as 
described in this chapter). 

• Backspace button. Tap this button when you want to back up 
to erase information you've entered in the edit area. 

• Number only button. Tap this button when you want to enter 
numbers (and symbols) only. When you tap this button, the Edit 
bar will accept only numeric and symbol input. This helps boost 
the accuracy of handwriting recognition. 

GEOCALC BASICS 6.5 



• Alphanumeric button. Tap this button when you want to enter 
both letters and numbers. When you tap this button, the Edit 
bar will accept all characters. 

MOVING AROUND IN A SPREADSHEET 

ALL LEVELS A spreadsheet can contain as many as 8192 rows by 256 columns. 
You can scroll through a spreadsheet in much the same way as 
you scroll through any document using the scroll bars. 

SELECTING CELLS AND RANGES 

Highlighted cell 

6.6 GEOCALC 

When you want to enter information in a cell or make changes to 
it, you must first select it to make it the active cell. The active cell 
appears highlighted with a black border around it, as shown in the 
illustration to the left. 

When you want to work with a group of cells, you select the entire 
group. A group of cells is called a range. When you select a range 
of cells, all selected cells appear highlighted. One cell within the 
range is the active cell, and it appears with a border around it, as 
shown in the following illustration: 

I Selected range 

Like individual cells, ranges have addresses. A range address 
consists of the address of the first cell, followed by a colon (:), 
followed by the address of the last cell. In the illustration above, 
the address for the selected range is B3:D10. 



To deselect the 
selection, simply 
select something else. 

To select a cell (All Levels) 

• Tap the cell you want to select. 

or 

Use the arrow keys on the external keyboard to move the 
highlighting to the cell you want to select. 

or 

Double-tap the cell address that appears in the Edit bar. The Go to 
Cell dialog box appears. Enter the address of the cell you want to 
select, tap Go To, and close the dialog box. 

or 

Choose Go to Cell from the View menu, enter the address of the 
cell you want to select, tap Go To, and close the dialog box. 

To select a range of cells (All Levels) 

• Drag from the first cell to the last cell of the range you want to 
select. 

To select an entire row or column (All Levels) 

• Tap the row or column header. 

To select multiple rows or columns (All Levels) 

• Drag from the first row or column header to the last row or 
column header. GeoCalc highlights the rows or columns as you 
drag. 

To select a range including every cell that has an entry (All Levels) 

• Tap the Smart Select button. 

GeoCalc selects a range that includes all cells that have entries 
(and all the empty cells in between). 

To select every cell in the spreadsheet (All Levels) 

If you want to perform some action that would affect every cell, 
such as changing the font for all current and future entries, you 
can select all cells in the spreadsheet. 

• Choose Select All from the Edit menu. 
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WORKING WITH VALUES AND LABELS 

ALL LEVELS 

if you are using the 
numeric keypad on 
an external 
keyboard to enter 
numbers, be sure the 
Num Lock key is on. 

6.8 GEOCALC 

You build a spreadsheet by entering values, labels, and formulas. 

• Values are numbers, such as sales figures for the past four 
quarters. 

• Labels are the titles or descriptive text you enter to describe the 
contents of rows and columns, such as "First Quarter," "Second 
Quarter," "Third Quarter," and "Fourth Quarter." 

• Formulas describe the calculations you want to perform, such 
as totaling the sales for all four quarters. 

This section explains how to enter values and labels in a 
spreadsheet. For more information about formulas, see "Working 
with Formulas" in this chapter. 

Entering Values and Labels 

The procedures for entering values and labels are the same. 
However, some special considerations apply to each. If you want 
to enter dates in a spreadsheet, see "Entering Dates" in this 
chapter. 

To enter values or labels (All Levels) 

1. Select the cell in which you want the entry to appear. 

2. Enter the numbers or words that you want to appear in the cell. If 
you make a mistake, tap the Backspace button in the Edit bar to 
erase characters to the left of the insertion point in the edit area. 



For more about 
selecting ranges, see 
"Selecting Cells and 
Ranges" in this 
chapter. 

3. To complete your entry, tap the Enter button in the Edit bar. In this 
case, the highlighting does not move. 

or 

Use the following keys on an optional external keyboard to 
complete the entry: 

KEY 

Enter 

Shift+ Enter 

Tab 

Shift+ Tab 

Left and Right 
Arrow Keys 

Up and Down 
Arrow Keys 

Ctrl+Enter 

RESULT 

Moves the highlighting down one cell. 

Moves the highlighting up one cell. 

Moves the highlighting to the right one cell. 

Moves the highlighting to the left one cell. 

If the insertion point is at the beginning (for Left 
Arrow) or the end (for Right Arrow) of the Edit 
bar, moves the highlighting one cell in the 
direction of the arrow. 

Moves the highlighting one cell in the direction 
of the arrow. 

Keeps the highlighting in the current cell; the 
active cell does not change. 

Entering Information in a Selected Range 

You can save time by selecting the range of.cells in which you 
want to enter data before you start. Then, if you tap Enter in the 
bottom row of the selection, the active cell automatically moves to 
the top of the next column in the selection. If you tap Tab in the 
rightmost column of the selection, the active cell automatically 
moves to the beginning of the next row in the selection. 

Moving through the selected 
range using the Enter key. 

Moving through the selected 
range using the Tab key. 
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ENTERING LABELS 

If you enter a label that is wider than the cell, the label spills over 
into the next cell to the right as long as that cell is empty. If the 
cell to the right is full, the text appears cut off. The complete text 
of the label is stored in the cell, but you cannot see it unless you 
make the column wider. For more information about changing the 
column width, see "Formatting GeoCalc Spreadsheets" in this 
chapter. 

If you want to enter a number as a label or if you need to enter a 
label that begins with an equal sign ( = ), start by entering an 
apostrophe (') or a double quotation mark ("). When you start an 
entry with a double quotation mark, the entry appears left-justified 
and the double quotation mark does not appear. For example, to 
enter 1993 as a label, you enter "1993. To enter =National 
Average as a label, you enter "=National Average. 

ENTERING VALUES 

If a cell is not wide enough for a value you enter (or for the result 
of a formula), you see the symbol### in the cell, as shown in the 
illustration to the left. The value is stored in the cell, but you will 
not be able to see it unless you make the column wider. For more 
information about changing the column width, see "Formatting 
GeoCalc Spreadsheets" in this chapter. 

You can enter values between 10-4932 and 10+4932. All numbers and 
calculations are accurate to 15 decimal places. Even when 
GeoCalc rounds a number to fewer than 15 decimal places, it uses 
all 15 decimal places in calculations. 

Do not enter commas when you enter values, although you can 
specify a format that adds commas automatically. (See "Changing 
the Format for Values" in this chapter.) 

You can use any of the following characters in the values you 
enter: 

1234567890+-Ee. 

Use E ore to specify scientific notation. For example, to enter 3.75 
x 1015, you can enter either 3.75e15 or 3.75E15. 



Entering Dates 

You can enter dates in your spreadsheet in two ways: as labels, or 
as formulas. 

ENTERING DATES AS LABEIS 

When you enter a date as a label, GeoCalc stores it just as you 
entered it. If you want to change the format, you must reenter the 
date in the format you want. 

To enter a date as a label (All Levels) 

• Enter the date just as you would any other label. Enter the date 
exactly as you want it to appear. 

For example, you could enter any of the following: 

• Jan 15, 1993 

• January 15, 1993 

• 1/15/93 

• 93-01-15 

ENTERING DATES AS FORMULAS 

You can also enter a date as a formula, using a special date 
function. When you do this, GeoCalc stores the date as a serial 
number representing the number of days since January 1, 1900. 
January 1, 1900 is stored by GeoCalc as serial number 1. January 1, 
1993 is stored as serial number 33969. 

When a date is stored as a serial number, you can use GeoCalc to 
change its format automatically, and you can use the date in 
formulas. For example, you can change Jan 15, 1993 to 1/15/93 
without retyping; also you can "subtract" May 3, 1990 from 
June 15, 1991 to determine the number of days between the two 
dates (408). To take advantage of these features, you first enter 
your date as a formula using the built-in DATE function. 

To enter a date as a formula (All Levels) 

1. Select the cell in which you want to enter a date. 

2. Enter =DATE. The characters appear in the edit area. 
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3. Enter an open parenthesis, followed by numbers representing the 
year, month, and day of the date you want to enter. Then enter a 
close parenthesis. Be sure to enter the year, month, and day in that 
order, with commas between them. For example, the entire entry 
for February 17, 1993 is as follows: 

=DATE(1993,2,17) 

4. Tap the Enter button or tap the Enter key. The serial number for 
the date appears in the cell. For example, if you specify 
February 17, 1993, GeoCalc displays 34016. 

Unless you want the date to appear in your spreadsheet as a serial 
number, you will probably want to change the date format. The 
next section explains how to do this. 

NOTE 

You can also enter time values (hours, minutes, and seconds) 
using a similar technique. Instead of the DATE function, you use 
the TIME function; instead of entering the year, month, and day, 
you enter the hours, minutes, and seconds. 

Changing the Format for Values 

Each number, date, or time value in a spreadsheet is displayed in a 
particular format. When you enter one of these values, GeoCalc 
automatically displays it in a standard format; however, you can 
change the format to suit your needs. The following table shows 
the available number formats. 

FORMAT IF YOU ENTER GEOCALC DISPLAYS 

General 1234567 1234567 

Fixed (two decimal places) 123.4567 123.46 

Fixed with Commas 1234.567 1,234.57 

Fixed Integer (rounded to a 1234.567 1235 
whole number) 

Currency 1234.567 $1234.57 

Currency with Commas 1234.56 $1,234.57 

Currency Integer (rounded to 1234.567 $1235 
nearest dollar) 

Percentage (times 100) .085 8.5% 

Percentage Integer (times 100, .4275 43% 
rounded to whole percent) 

Thousands (divided by 1000 and 1234567 1234.57 
rounded) 



Millions (divided by one million 123456789 
and rounded) 

123.46 

Scientific 1234. 5678 1.23E+03 

The following table shows the available date and time formats. 

FORMAT 

Date - Long 

Date - Long, Condensed 

Date - Long, No Weekday 

Date - Long, Condensed, No 
Weekday 

Date - Short 

Date - Short, Zero Padded 

Date - Long, Month & Day 

Date - Long, Month & Day, No 
Weekday 

Date - Short, Month & Day 

Date - Short, Month & Year 

Date - Year 

Date - Month 

Date - Day 

Date - Weekday 

Time - Hour Min Sec 

Time - Hour Min 

Time - Hour 

Time - Min Sec 

EXAMPLE 

23456 = Saturday, March 21st, 1964 

23456 = Sat, Mar 21, 1964 

23456 =March 21, 1964 

23456 =Mar 21, 1964 

23456 = 3/21/64 

23456 = 03/21/64 

23456 = Saturday, March 21st 

23456 = March 21st 

23456 = 3/21 

23456 = 3/64 

23456 = 1964 

23456 = March 

23456 =21st 

23456 = Saturday 

1234.567 = 1:36:29PM 

1234.567 = 1:36 PM 

1234.567 = 1 PM 

1234.567 = 36:29 
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To change the format of values (All Levels) 

1. Select the cells containing the values whose format you want to 
change, and choose Number Format from the Properties menu. 
The following dialog box appears: 

1:1 NumtJet- Fonnat 

~------Formats------~ 

General 

Fixed With Commas 
Fixed Integer 
Currency 

0.00; -0.00 

1234.56 7 = 1234.57 

-0.567 = -0.57 

--l-1-- GeoCalc displays an 
example of the 
selected fonnat here. 

2. Select the format you want from the Formats list. An example of 
the format appears in the dialog box. 

3. Tap Apply, then close the dialog box. GeoCalc changes the format 
of the selected cells. 

WORKING WITH FORMULAS 

ALL LEVELS 

6.14 GEOCALC 

Formulas describe calculations you want GeoCalc to perform. 
When you start to use formulas, you see the power of a 
spreadsheet. Each time you change the contents of a cell 
anywhere in your spreadsheet, GeoCalc automatically recalculates 
every formula in the spreadsheet. 

Formulas are made up of the following elements: 

• References to particular cells or ranges, such as Al or Bl2:C18 

• Operators such as + and - for addition and subtraction 

• Values such as 5, 100, and 0.25 

• Built-in functions such as DATE, SUM, and AVG 

The following sections explain how to combine these elements in 
a formula that performs a specific calculation. 

CAUTION 

GeoCalc uses floating-point math. While floating-point calculations 
have advantages such as speed, they are inherently inaccurate. All 
spreadsheets based on floating-point math produce errors in the 
17th or 18th significant digit. While this is often not detectable, the 



errors become apparent in some calculations, especially when you 
use financial functions such as IRR and NPV. GeoCalc adheres to 
the IEEE 754 standards for floating-point calculations. However, 
you should consult a financial specialist before you invest 
significant sums of money based on floating-point calculations from 
any source. 

Entering Formulas 

You begin a formula by typing= (an equal sign). Then you use 
references, values, operators, and built-in functions to describe the 
calculation you want to perform. The following illustration shows 
how you might use a formula to add the expenses for an evening 
on the town: 

B4 Bl + B2 + B3 

R c D 

Cell B4 contains the following formula: 

=Bl+B2+B3 
This formula tells GeoCalc to add the values in cells Bl, B2, and 
B3 and to display the result in cell B4. Here are the elements of 
this formula: 

• The equal sign ( =) indicates a formula. All formulas must start 
with an equal sign. 

• Bl, B2, and B3 are references. 

• The plus signs ( +) are operators. 

To enter a formula (All Levels) 

1. Select the cell in which you want to enter the formula. 

2. Enter = to begin the formula. The equal sign appears in the edit 
area. 

3. Enter the reference for the first cell you want to use in the 
calculation. 

4. Enter the operator you want to use. For example, enter + for 
addition. 

5. Enter the reference for the next cell you want to use. 
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If you are not sure 
whether to use an 
absolute or a relative 
reference, it is 
usually safer to use 
an absolute 
reference. 

6.16 GEOCALC 

6. Continue typing operators and cell addresses until the formula in 
the Edit bar appears as you want it. 

7. Tap the Enter key. The result of the formula appears in the cell. 

Using References in Formulas 

A reference identifies a cell or a range of cells. The reference tells 
GeoCalc where to look to find the values you want to use in a 
formula. Most formulas include at least one reference. 

You can use two types of references in the formulas you create: 
relative references and absolute references. Your choice depends 
on how you want GeoCalc to treat the references when you copy 
or move the formula from one cell to another. 

RELATIVE REFERENCES 

A relative reference tells GeoCalc how to find a particular cell 
starting from the cell containing the formula. For instance, from 
this cell, go two rows up and one column to the right. Relative 
references are like telling someone how get to your house from 
theirs: go three blocks east and then four blocks south. 

When you copy a formula that contains relative references from 
one location to another, GeoCalc adjusts the references in the 
formula relative to the new position of the formula. For example, 
in an annual budget spreadsheet, you could use a formula with 
relative references to add the numbers in the January column; 
then, when you copy the formula to the columns for February 
through December, GeoCalc adjusts the relative references so that 
each formula totals the numbers for the column in which it 
appears. 

Relative references look just like cell addresses. The following are 
examples of relative references: B4, DS, Al, B2:F8. 



ABSOLUTE REFERENCES 

An absolute reference tells GeoCalc the specific address of a cell. 
Whereas relative references depend on the starting point, absolute 
references always reference the same cell, regardless of the 
starting point. An absolute reference is like telling someone your 
exact address: 3628 Sixteenth A venue. 

When you copy a formula from one location to another, GeoCalc 
does not adjust absolute references. Use an absolute reference 
when you want to refer to the same cell, regardless of where you 
may copy the formula in the spreadsheet. 

For example, if you are calculating loan payments, you might want 
to refer to a cell containing the interest rate used in the PMT 
function. In the following example, when you want to copy the 
formula, the reference to B3 must not change. Otherwise each 
calculation would be based on a different interest rate. To ensure 
that all copies of the formula use the value in B3, you enter the 
absolute reference $B$3. 

86 

To enter an absolute reference, enter the address with dollar signs 
before the column and row indicators. B3 is a relative reference. 
$B$3 is an absolute reference. You can create hybrid references, 
making either the column or row absolute and the other relative, 
as shown in the following table: 

REFERENCE 

B3 

$B$3 

B$3 

$B3 

TYPE 

Relative reference 

Absolute reference 

Relative colunm, absolute row 

Absolute colunm, relative row 

Using Operators in Formulas 

Operators describe the type of calculation you want to perform, 
such as addition or subtraction. The following table shows the 
operators you can use in formulas. 
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OPERATOR DESCRIPTION EXAMPLE 

% Percentage A14*22% 

/\ Exponentiation 13113 

*and I Multiplication and division A14*B12, A14/B12 

+and- Addition and subtraction A14+Bl2, A14-B12 

& Concatenation "Rate "&Al&"%" 

When you use more than one operator in a formula, GeoCalc 
performs the calculations in the order shown in the table -
percentages first, exponents second, and so forth. If you use more 
than one operator with the same priority (such as + and-), 
GeoCalc performs those calculations from left to right. 

You can alter the order of calculations by enclosing within 
parentheses those expressions you want calculated first. GeoCalc 
evaluates expressions enclosed in parentheses first, and then uses 
those results to calculate the rest of the formula. The following 
table shows some examples: 

FORMULA 

50+100/2 

(50+100)/2 

RESULT 

100 

75 

Using Built-in Functions in Formulas 

Built-in functions perform common calculations automatically. 
You use them in formulas to simplify your work. For example, the 
SUM function totals a group of numbers; the AVG function 
computes the average of a group of numbers; and the NPV 
function computes the net present value of an investment. 

GeoCalc provides functions you can use to perform the following 
types of calculations: 

• Financial 

• Information 

• Logical 

• Math 

• Print 

• Statistical 

• String 

• Time & date 

• Trigonometric 



This section gives the general procedures for using built-in 
functions. Detailed descriptions of all the built-in functions are 
included in Appendix B. 

KEYWORDS AND ARGUMENTS 

Each built-in function includes a keyword such as SUM or AVG. 
Most functions also require that you specify arguments. Arguments 
are the data that functions use in a calculation. For example, if you 
are summing a group of numbers, the arguments for the SUM 
function are the numbers you want to total. An argument can be a 
value, text string, reference, function, or formula. The arguments 
determine the result of the function. 

For example, the financial function PMT calculates the payment 
required for a loan. The arguments for the PMT function are the 
principal amount, interest rate, and term of the loan. The following 
illustration shows how you might use the PMT function to 
compute a loan payment: 

Al =PMT( 10000, 8. 75%/ 12, 48) 

c D 

2 

Cell Al contains the following formula: 

=PMT(l0000,8.75%/12,48) 

F 

This formula uses the PMT function to tell GeoCalc to compute the 
monthly loan payment for a 48-month loan of $10,000 at an 
interest rate of 8.75% per year. 

PLACEHOIDER ARGUMENTS 

When you insert a function in a cell, you can automatically insert 
placeholders for the arguments. For example, when you insert the 
PMT function, the placeholders remind you to enter the principal 
amount, interest rate, and term of the loan, as shown in the 
following illustration: 

X J =PMT(principal, interest, term) 

c D E 
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Entering= 
is optional. 

6.20 GEOCALC 

Since each function has different arguments, the placeholders can 
help you remember what arguments to enter for a particular 
function. 

After inserting the function, you replace the placeholders with the 
actual arguments you want to use, as shown in the following 
illustration: 

Al MT( 10000, 8. 753/ 12, 48) 

c D E F 

If you are pasting a function into the edit area, you must replace 
the placeholder arguments with the values or cell addresses you 
want to use in the calculation. If you want to use a fixed value, 
replace the placeholder with the value. For instance, to enter a 
fixed value for the term of a loan replace TERM with a value in 
months. 

It is important to enter the arguments in the specific order shown 
in the dialog box and in Appendix B. Inserting placeholders will 
help you to remember the order in which to enter arguments. 

ENTERING BUILT-IN FUNCTIONS 

To include a built-in function in a formula, you can e.ither enter the 
function and all of its arguments, or insert the function using the 
Insert Function choice on the Formula menu. When you use the 
Insert Function choice, you have the additional option of inserting 
placeholder arguments. 

To insert a function using the Formula menu (All Levels) 

1. Select the cell in which you want the result of the calculation to 
appear. 

2. Enter= to begin the formula. The equal sign appears in the edit 
area. 

3. Choose Insert Function from the Formula menu. A dialog box 
appears. 

4. Select the function you want to use from the Functions list on the 
right. Optionally, you can select a function type from the list on 
the left so that the Functions list shows only functions of the type 
you select. 

5. Select the Paste Arguments option (the default) if you want to 
insert placeholder arguments with the function. Deselect the 



option if you simply want the function to appear in the Edit bar, 
without placeholder arguments. 

6. Tap Paste, and close the dialog box. The function appears in the 
edit area. If you selected Paste Arguments, the arguments also 
appear in the edit area. 

7. In the edit area, double-tap the first argument to select it. 

8. Enter the text, value, formula, or cell reference you want to use for 
the argument. Your entry replaces the placeholder argument. 

9. Continue replacing arguments as needed. For specific information 
about each argument, see Appendix B. 

10. Tap the Enter button or tap the Enter key. 

When the calculation is complete, the result appears in the 
spreadsheet. If the calculated result is not what you expect, make 
sure that you entered the formula correctly. 

To insert a function by typing (All Levels) 

1. Select the cell in which you want the result of the calculation to 
appear. 

2. Enter = to begin the formula. The equal sign appears in the edit 
area. 

3. Enter the function name. 

4. Enter the arguments, enclosed in parentheses. Be sure to include 
commas between arguments. 

5. Tap the Enter button or tap the Enter key. 

When the calculation is complete, the result appears in the 
spreadsheet. 

To use a function within a Junction (All Levels) 

You can embed one function within another. For example, to sum 
a range of values and get its integer value, you could enter 
=INT(SUM(A3:A9)). 

1. Insert the first function. 

2. In the edit area, select the argument you want to replace with a 
function. 

3. Insert the second function. 

4. Continue in this manner until the formula is complete. 

5. Tap the Enter button or tap the Enter key. 
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NOTE 

When you embed one function within another, it is easy to lose 
track of where the parentheses belong. If you insert the function 
with placeholder arguments, GeoCalc inserts the parentheses 
accurately. 

EDITING THE SPREADSHEET 

ALL LEVELS 

6.22 GEOCALC 

After you have created a spreadsheet, you may want to make some 
changes. You may want to delete information or insert rows or 
columns to make room for new information; you may want to 
copy or move information to a new location; or you may need to 
correct an error you made. 

Editing the Contents of a Cell 

Often you will need to modify entries you have made in a 
spreadsheet. To do this, you select a cell to make it active so that 
you can change its contents. Then you can enter new information, 
delete it, move it, or copy it. You can delete information 
permanently, or you can transfer it to the clipboard so you can 
move the information to another location. For more information 
about editing text, see Chapter 1. 

Copying and Moving Information 

As you work with GeoCalc, you may find it convenient to copy 
and move information in a spreadsheet. There are two ways to 
copy and move information in GeoCalc: 

• You can use the Fill choices on the Cell menu to copy the 
contents of the active cell across a row or down a column. 

• You can use the Cut, Copy, and Paste choices on the Edit menu 
to copy or move information to any other location in a 
spreadsheet. Alternatively, at Level 2 and above, you can tap 
the clipboard tools on the Function bar, if it is displayed. 

In either case, the result depends on what kind of information you 
are copying or moving. When you copy or move values and labels 
from one location to another, they appear the same in both 
locations. When you copy or move formulas, however, GeoCalc 
automatically adjusts relative references for the new position of the 
formula. You can override this automatic adjustment by using 



absolute references. For more information about relative and 
absolute references, see "Using References in Formulas" in this 
chapter. 

COPYING TO ADJACENT CEllS 

The Fill Right and Fill Down choices provide a handy shortcut 
when you want to copy the contents of the active cell across a row 
or down a column. This is particularly useful when you copy 
formulas. In a budget spreadsheet, for example, you can enter a 
formula to calculate the total for the January column, and then 
copy the formula to the columns for February through December, 
as shown in the following illustration: 

You enter the 
formula in this cell. 

When you copy the formula, GeoCalc automatically adjusts the 
relative references so that the total is correct for each month. 
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To copy a formula to adjacent cells (All Levels) 

1. Select a range of cells starting with the cell containing the formula 
you want to copy and ending with the last cell to which you want 
to copy the formula, as shown in the following example: 

Formula 

C D 
February !March ! 

1 500.00; 1 oo-:ti°OT 

You can copy the formula into 
the range to the right 

2. Choose Fill Down from the Cell menu to copy the formula to the 
selected cells beneath it. 

or 

Choose Fill Right from the Cell menu to copy the formula to the 
selected cells to its right. The formula appears in the new 
locations. 

USING CUT, COPY, AND PASTE 

Using these menu choices, you can copy or move a single cell or a 
range of cells to any other location in a spreadsheet. Cut, Copy, 
and Paste work the same way in GeoCalc they do in other GEOS 
applications. Cut and Copy place the selected cells on the 
clipboard; Paste retrieves any previously cut or copied information 
from the clipboard. For more information about the clipboard or 
about using these menu choices, see Chapter 1. 



Inserting and Deleting Rows and Columns 

After you have created a spreadsheet, you may need to add a row 
or column to accommodate additional information. When 
information becomes obsolete, you will want to delete a row or 
column. 

To insert a row or column (All Levels) 

At Level 2 and above, if the Function bar is displayed, you can use 
tools to insert a row or column quickly. Rows are inserted above 
the active cell, columns to the left of the active cell. 

1. Select a cell, and choose Insert Row/Column from the Edit menu. 
(To insert multiple rows or columns, first select the rows or 
columns that you want to insert and then choose Insert 
Row/Column.) A dialog box appears. 

2. Select either Row or Column in the dialog box, and tap Insert. 

To delete a row or column (All Levels) 

At Level 2 and above, if the Function bar is displayed, you can use 
tools to delete a row or column quickly. 

1. Select a cell in the row or column, and choose Delete 
Row/Column from the Edit menu. (To delete multiple rows or 
columns, first select the rows or columns that you want to delete 
and then choose Delete Row/Column.) A dialog box appears. 

2. Select either Row or Column in the dialog box, and tap Delete. 

Filling a Range of Cells with Incremental Values 

Using the Fill Series choice on the Cell menu, you can 
automatically fill a range of cells with a series of incremental 
values. You select the range of cells and specify the starting value 
and the increment. GeoCalc does the rest. 

If the first cell in a series contains a 1, the next cell will contain 2, 
the following 3, and so on. If the first cell contains a date, Fill 
Series increments the date; Monday increments to Tuesday, 
Wednesday, Thursday, and so on. Time increments from 1:00 to 
2:00, 3:00, and so on. 

To fill a range with incremental values (All Levels) 

1. Enter the value or date you want to increment. 

2. Select the range of cells you want to fill, starting with the cell 
where you entered the value or date you want to increment. 
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3. Choose Fill Series from the Cell menu. A dialog box appears: 

Fill Series 
Fill By: + ~ows O _!;;olumns 
!,!nits: +!:!umber 

O!!ay 
O!:::!eekday 
O Jjonth 
oyear 

Progression: + !,inear O _geometric 

~tep=D 

4. Complete the dialog box, specifying the fill options you want: 

Fill By. Select whether to fill rows or columns. 

Units. Select the type of units for the fill: Number, Day, Weekday, 
Month, or Year. 

Progression. Select the progression you want GeoCalc to use: 
Linear or Geometric. A linear series is additive; each step adds a 
constant to the previous number. For example, a linear 
progression starting at 1 and incrementing by 1 is 1, 2, 3, 4, 5. A 
geometric series progresses by a specific multiplier at each step. 
For example, a geometric series starting at 1 with 3 as the 
multiplier is 1, 3, 9, 27, 81, 243. 

Step value. For a linear progression of numbers, enter the 
increment you want for each value. For a geometric progression of 
numbers, enter the multiplier you want to use for each value. For a 
progression of dates, enter the number of units (days, weekdays, 
months, or years) by which you want to increase each value. 

5. Tap Fill. The range is filled as you specified. 

NOTE 
If you select Day, Weekday, Month, or Year in the Fill Series dialog 
box, GeoCalc creates the series differently depending on how you 
originally entered the date. 

If you entered the date as a label, GeoCalc creates additional 
dates as labels. If you entered the date as a serial number, 
GeoCalc creates additional dates as serial numbers; however, the 
cell must have a date format. To fill date information as text (such 
as "Sunday" or "January"), enter the first value as text. For 
numbers, such as a year value, to fill in a progressive series of 
years, enter the year as a text value ("1990), not a number. For 
more information, see "Entering Dates" in this chapter. 



Formatting GeoCalc Spreadsheets 

None of the features 
described in this 
section are available 
Level 1 of GeoCalc. 

You can use a number of options to change the appearance of 
your spreadsheet. These options do not affect calculations; they 
simply make the spreadsheet more attractive and allow you to 
highlight information to show its importance. You will find these 
visual enhancements particularly helpful if you want to make 
presentations. 

SHOWING GRID LINES 

LEVELS 2-4 A grid is the matrix of horizontal and vertical lines dividing the 
spreadsheet into rows and columns. Each individual line is a grid 
line. You can show grid lines on screen and print your spreadsheet 
with or without the grid lines. The default setting for grid lines is to 
display them; however, you can create interesting effects by 
turning off the grid lines and adding cell borders as described in 
the next section. 

To show or hide grid lines (Levels 2-4) 

• Select Draw Grid Lines from the Options menu to show grid lines. 

or 

Deselect Draw Grid Lines from the Options menu to hide grid 
lines. 

At Levels 3 and 4, you can print grid lines whether they are visible 
on screen or not. To do so, however, you must use Page Setup on 
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the File menu to specify printing grid lines. For more information, 
see "Additional GeoCalc Features" in this chapter. 

SHOWING CELL BORDERS 

LEVELS 3-4 To create an interesting visual display of your numeric 
information, you can display borders for cells in various 
configurations, as in this example: 

ll'US SC:liEllULE 

Morning Schedule 
Street GBus HBus RBus VBus YBus 
12th Street 8:30 8:45 8:25 8:35 8:40 
23rd Street 8:40 -···- 8:35 8:45 8:50 
West Avenue 9:12 --·-- 9:07 ---·· 9:22 
Washington Square 9:45 9:30 9:40 ----- 9:55 
Ad iso n Avenue 10:05 9:50 10:00 10: 08 10:15 
Marian Plaza 10:30 ----- 10 25 10:33 10:40 
Seaside Drive 10:35 ----- 10:30 10:38 10:45 
Main Street 10 42 10:20 10:37 ----- 10:52 
1 03rd Street 11:00 10:38 10:55 ----- 11:10 
205th Street 11:08 10:46 11:03 11: 10 1118 
Turner Place 11:20 ----- 11: 15 11:22 11:30 
Willinger Avenue 11:56 10 15 11:51 11:56 12:06 

To display cell borders (Levels 3-4) 

1. Select the cells you want borders for, and choose Cell Borders 
from the Properties menu. A dialog box appears. 

2. Select the borders you want. The Outline option displays a border 
around the selection and deselects Left, Top, Right, and Bottom. 

3. Tap Apply to apply your changes, and close the dialog box. 

ADJUSTING ROWS AND COLUMNS 

6.28 GEOCALC 

GeoCalc sets each column to a standard width when you create a 
spreadsheet. As you enter data, GeoCalc automatically adjusts the 
row height to accommodate the text size you use. You can 
manually change both the row height and the column width to suit 
your needs. 



LEVELS 1-4 

A standard column 
is 64 points wide. A 
point is 1172 of an 
inch. 

LEVEL 4 

Adjusting Column Width 

GeoCalc provides several ways to change the width of a column. 
You can drag the column marker with the touch pen or use the 
Column choices (Narrower, Wider, and Best Fit) on the Cell menu. 
Alternatively, you can set an exact column width with the Column 
Width choice on the Cell menu. 

To set a column width exactly (Levels 3-4) 

1. Select the column for which you want to set the width. To do so, 
you can either tap the column header or select a cell in the 
column. 

2. Choose Column Width from the Cell menu. A dialog box appears. 

3. Enter the number of points you want to use for the column width. 

4. Tap Apply to apply your changes. The dialog box remains on the 
screen until you close it, so that you can keep adjusting the width. 

Adjusting Row Height 

Normally the height of each row adjusts automatically to 
accommodate the text size you use. However, you can manually 
change the row height if you want to use a different setting. 

To set a row height manually (Level 4) 

1. Select the row for which you want to set the height. You can either 
tap the row header or select a cell in the row. 

2. Choose Row Height from the Cell menu. A dialog box appears. 

3. Enter the number of points you want to use for the row height. 

4. Tap Apply to apply your changes. 

USING HEADERS AND FOOTERS 

LEVELS 3-4 Headers and footers are the text that prints at the top or bottom of 
each page (headers appear at the top, and footers at the bottom). 
They can be as simple as the page number, or they can include 
more descriptive information, such as the following: 

• Date the document was created or printed 

• Name of the document 

• Your name or the name of your department, business, or school 
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USING COLOR 

LEVELS 2-4 

if you do not have a 
color printer, the 
colors print as gray 
tones. 

6.30 GEOCALC 

• Graphics, such as a logo or drawing 

To create a header or footer (Levels 3-4) 

You can specify that GeoCalc use text you have entered in a cell as 
the header or footer of the spreadsheet when it is printed. The text 
appears in the cell and as the header or footer. 

1. Enter the header or footer text in a cell or range of cells. 

NOTE 

It is a good idea to enter the text for headers and footers in cells 
that are not part of the main information in your spreadsheet. Then, 
when you print the spreadsheet, select a print range that excludes 
the cells containing the header and footer text. 

2. Select the cell or range. 

3. Choose Header/Footer from the Cell menu. A submenu appears. 

4. Choose either Set Header or Set Footer from the submenu. The 
selected information will print at the top or bottom of the page, as 
you have indicated. 

To number pages consecutively (Levels 3-4) 

• Use the PAGE function in the header or footer cell. For more 
information about the PAGE function, see Appendix B. 

Although the unit uses only black, white, and shades of gray in its 
display, you can use color to highlight your spreadsheets when 
you print worksheets on a color printer. You can use color for the 
following elements in a spreadsheet: 

• Text 

• Background 

• Cell borders 



In each of these cases, the dialog box you choose colors from is 
similar. It looks like this: 

1:1 Text Color 

3 Shaded: l11m1IB 
•all!ll!llllllBllllllll~l!llllH1Hl:H::'imlmil•• 

Red EJ B Green EJ B Blue EJB 

You can refer to this illustration as you read the procedures for 
choosing colors, described below. 

To change the color of text (Levels 2-4) 

1. Select the cells that contain the text you want to color. 

2. Choose Text Color from the Properties menu. A dialog box 
appears. 

3. Complete the dialog box, selecting the options you want: 

% Shaded. Select the percent shading for the text color. The lower 
the number, the lighter the color. By default, this setting is 100. 

Color tools. Select the text color from the color palette. You can 
also fine tune the color blend by setting the amounts of red, green, 
and blue in the text color; the default values depend on the 
selected color. 

4. Tap Apply to apply your changes. 

To change the color of the background (Levels 2-4) 

The background is the cell itself. If you set the background color 
to blue and the text color to black, the cell entries will appear as 
black text on a blue background when printed on a color printer. 
In the unit display, the background color will appear as a shade of 
gray. 

1. Select the cells for which you want to change the background 
color. 

2. Choose Text Background Color from the Properties menu. A 
dialog box appears. 

3. Complete the dialog box, selecting the options you want: 

Filled or Unfilled. Select Filled to set other options in this dialog 
box. By default, the text background color is unfilled. 
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LEVELS 3-4 
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% Shaded. Select the percent shading for the text background 
color. The lower the number, the lighter the color. A setting of 
zero (0) causes the background color to disappear. By default, this 
setting is 100. 

Color tools. Select the text background color from the color 
palette. You can also fine tune the color blend by setting the 
amounts of red, green, and blue in the text background color; the 
default values depend on the selected color. 

4. Tap Apply to apply your changes. 

To change the color of cell borders (Levels 3-4) 

If you have added cell borders, you can change the color of those 
borders. 

1. Select the cells for which you want borders. 

2. Choose Border Color from the Properties menu. A dialog box 
appears. 

3. Complete the dialog box, selecting the options you want: 

% Shaded. Select the percent shading for the text color. The lower 
the number, the lighter the color. By default, this setting is 100. 

Color tools. Select the text color from the color palette. You can 
also fine tune the color blend by setting the amounts of red, green, 
and blue in the border color; the default values depend on the 
selected color. 

4. Tap Apply to apply your changes. 

You can add notes that provide additional information about the 
contents of your spreadsheet. They can be a reminder to check a 
reference, a note about the logic you used for a formula, or a 
message to a reviewer of the spreadsheet information. 

For example, if you want to check a value that seems too high, 
you can attach a note to the cell containing the questionable value. 
The cell displays a special note indicator so that you know there is 
a note attached: 



The note does not appear in the document; instead, it appears in a 
special box that you can print with the spreadsheet if you want. 

1:1 Notes 

Check this figure, it 
seems high. 

To attach a note (Levels 3-4) 

1. Select the cell you want to attach a note to. 

2. Choose Notes from the Cell menu. A dialog box appears so that 
you can enter the note. 

3. Enter the note text in the dialog box. 

4. Tap Apply when you are finished entering the note text, and close 
the dialog box. A small square appears in the upper-right corner of 
the cell to indicate that a note is attached. This is the note 
indicator. 

If you want to check notes frequently, you can keep the Notes 
dialog box displayed on screen so that you can see the notes 
easily. 

To show or hide the note indicators (Levels 3-4) 

1. Choose Other Settings from the Options menu. A submenu 
appears. 

2. Select Show Notes to display the note indicators in cells that have 
attached notes. 

or 

Deselect Show Notes to hide them. 

To print notes (Levels 3-4) 

When you print the spreadsheet, you can also print the attached 
notes. 

1. Choose Print from the File menu. A dialog box appears. 

2. Select Print Cell Notes. 

3. Tap Print. GeoCalc prints the spreadsheet with the notes attached. 
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Advanced GeoCalc Formulas 

"GeoCalc Basics" describes how to create formulas and use 
functions to make complex formulas easy. In this chapter you will 
also learn to show and hide formulas, assign names to cells and 
ranges so you can use the names in formulas, tum automatic 
recalculation on and off, use circular references and iteration in 
calculations, and use advanced functions. 

SHOWING AND HIDING FORMULAS 

LEVELS 2-4 

6.34 GEOCALC 

In order to see a formula in a single cell, you can select the cell 
and look at the formula in the Edit bar. If you want, you can 
display all of the formulas in the spreadsheet cells. This can be 
helpful if you have entered several formulas and want to see them 
all at once. 

·····sACEs· .............................. 

····· E<iuii0mei1i··· 

When you show all formulas, formulas appear in cells as if they 
were labels. That is, if a formula is too long for a cell, it may spill 
over into the next cell if that cell is empty. If the adjacent cell is 
not empty, the formula appears cut off. 



To show or hide all formulas (Level 2) 

• Select Show Formulas from the Options menu to show all 
formulas. 

or 

Deselect Show Formulas from the Options menu to hide all 
formulas. 

To show or hide all formulas (Levels 3-4) 

1. Select Other Settings from the Options menu. A submenu appears. 

2. Select Show Formulas from the submenu to show all formulas. 

or 

Deselect Show Formulas from the submenu to hide all formulas. 

NAMING CELLS AND RANGES 

LEVELS 3-4 When you create a formula, you normally include references to 
the cells and ranges you want to use in the calculation. Although 
you can refer to a cell or a cell range by its address, it is sometimes 
easier to name the cell or range and then use the name in 
formulas. For example, the formula 

=B4=B2+B3 

is easier to read if you name the cells, like this: 

INCOME=SALARY +TIPS 

Cell names can be up to 40 characters long and can include letters 
and the underscore (_) symbol. Cell names cannot contain 
numbers, spaces, or other characters. If you enter a space, 
GeoCalc inserts an underscore. Cell names are not case-sensitive; 
for example, to GeoCalc, the name "Expenses" is the same as 
"EXPENSES" or "expenses." 

Defining a Name 

You define a name that refers to a specific cell or range. For 
example, you might define RATE as A3; then, when entering 
formulas, you can enter RATE instead of entering A3. 

You can use both absolute and relative references when you 
define a name, but it is easier to use absolute references. 
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Use absolute cell 
addresses unless you 
want the named 
range to reflect a 
relative position. 

6.36 GEOCALC 

The names you define are saved with your spreadsheet. You can 
copy formulas that use named cells from one spreadsheet to 
another; however, the names are replaced by addresses in the 
second spreadsheet. 

To define a name (Levels ?,4) 

1. Choose Define Name from the Formulas menu. A dialog box 
appears, listing any names you have previously defined. 

2. Tap New. A dialog box appears. 

3. Complete the dialog box, specifying the name and reference you 
want to use: 

Name. Enter the name for the cell or range of cells. 

Definition. Enter the reference for the cell or range you want to 
name. You can use relative and absolute references. 

4. Tap OK and close the dialog box. The name appears in the list in 
the Define Name dialog box. 

To insert a name in a formula (Levels ?,4) 

Once you have defined a name, you can use it in any formulas you 
create. To do so, you simply enter the name in the formula. If you 
prefer, you can also select the name from a list in a dialog box, as 
explained in the following procedure. 

1. Select a cell and begin entering a formula. 

2. When the insertion point in the Edit bar is in the position for the 
name you want to use, choose Insert Name from the Formula 
menu. A dialog box appears. 

3. Select the name you want to insert. 

4. Tap Paste, and close the dialog box. The name appears in the Edit 
bar. 

Modifying a Name 

You can rename a named cell, change the definition of a· name, 
and delete a name. The procedures for each of these are similar, 
starting with choosing Define Name from the Formula menu. 

If you change the definition of a name, the reference changes in 
existing formulas that contain that name. For example, if you have 
a range called Expenses that includes B5:Bl 7 and you extend the 
range to B5:B24, all formulas using the name "Expenses" will be 
recalculated automatically to include the seven additional cells in 
the range. 



To rename a cell or change the definition of a name (Levels ~4) 

1. Choose Define Name from the Formula menu. A dialog box 
appears. 

2. Select the name you want to modify. 

3. Tap Change. 

4. Do one of the following: 

• To rename a named cell, enter the new name in the Name box. 

• To change the definition of a name, change the cell or range 
specification to suit your needs. 

5. Tap OK, and close the dialog box. All formulas are updated to 
reflect the change. 

To delete a name (Levels ~4) 

1. Choose Define Name from the Formulas menu. A dialog box 
appears. 

2. Select the name you want to delete. 

3. Tap Delete. A confirmation message appears. 

4. Tap Yes to delete the selected name. GeoCalc deletes the name 
and, for formulas using the deleted name, replaces the name with 
the cell or range address it referenced. 

CONTROLLING AUTOMATIC RECALCULATION 

LEVEL 4 GeoCalc normally recalculates every formula in your spreadsheet 
every time you make a change. If your spreadsheet is large or 
contains many complex formulas, this recalculation can be time
consuming. In that case, you may want to tum automatic 
calculation off. When automatic recalculation is off, you 
recalculate the spreadsheet manually whenever you want to. 

To turn automatic recalculation on or off (Level 4) 

1. Choose Calculation from the Options menu. A dialog box appears. 

2. Select Automatic or Manual to specify the type of calculation you 
want. 

3. Tap Apply to apply your changes, and close the dialog box. 
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To recalculate manually (Level 4) 

When automatic recalculation is off, you must recalculate the 
spreadsheet manually in order to see the effects of any changes 
you make. 

liJ • Tap the Calculate button on the Function bar. 

or 

Choose Calculate Now from the Options menu. 

USING ITERATION AND CIRCULAR REFERENCES 

LEVEL 4 

6.38 GEOCALC 

Occasionally, you may want to create a formula in which a 
calculation depends on its own result. This is called a circular 
reference. Consider the following example: to calculate gross 
profit, you subtract expenses from income. If one of the expenses 
is based on a percentage of the profit - commission, for 
instance - the formula has to rely on the outcome of the 
calculation. 

A B 

i;:;·c;c;·;;:;;;··· ....................... j ......... 1.ooo:"Ci"Dt ...... .. 

. ~'.~~r.;~~~~~~:::-:1~:i.;~1~~l~:c:~. 
Total Expenses /=83 + 84 i F>ioiii"" ............................. I~"i32:s§ ........ r ... . 
............................................... ! ............................... 1···· .. .. 

If you calculate this formula in BS more than once, each 
successive calculation results in a smaller value. This is called 
iteration. Iteration is the process of recalculating a circular 
reference repeatedly, until convergence occurs, when the 
difference in the result of each successive calculation is no longer 
significant. 

The following table shows the results of another simple iterative 
calculation so that you can see how the calculation converges: 

ITERATION A3 A4 A5 

=A4+A5 =.5*A3 =100 

1 0 0 100 

2 100 50 100 

3 150 75 100 
4 175 87.5 100 

5 187.5 93.75 100 



6 193.75 96.875 100 

7 196.875 98.4375 100 

8 198.4375 99.21875 100 

9 199.21875 99.609375 100 

10 199.609375 99.8046875 100 

Notice, in the table that the value in A3 approaches 200 and the 
value in A4 approaches 100. GeoCalc stops the iteration when the 
results of a circular reference converge on a single value. If 
convergence does not happen within the number of recalculations 
you specify in the Calculations dialog box, GeoCalc automatically 
stops the iteration. You can specify the limit for the convergence 
with Maximum Change in the dialog box. If you specify zero for 
the maximum change, iteration will not stop until it converges (or 
reaches the maximum number of iterations). 

Before using circular references, you must turn on iteration, using 
the Calculation choice on the Options menu. If you enter a 
formula with a circular reference but have not specified that you 
want to use iteration, the result of the formula appears as #CIRC#. 

To specify iteration (Level 4) 

1. Choose Calculation from the Options menu. A dialog box appears. 

2. Complete the dialog box, specifying the options you want: 

Allow Iteration. Select the Allow Iteration option if you are going 
to use iteration in your spreadsheet. 

Maximum Iterations. Enter the maximum number of iterations 
you want. 

Maximum Change. Enter the maximum change you want to 
allow. 

3. Tap Apply, and close the dialog box. 

4. Create the formula with a circular reference. GeoCalc recalculates 
the formula the specified number of times or stops when the stated 
value for maximum change is calculated. 

ADVANCED FUNCTIONS 

ALL LEVELS The "GeoCalc Basics" section of this chapter explains how to use 
basic functions and enter the arguments for functions. Complex 
functions involve the following capabilities: 
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See Appendix B for 
brief descriptions of 
the functions organ
ized by function 
type, and an alpha
betical listing of 
functions with a 
complete description 
and syntax for each. 
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• Conditional statements 

• Text strings 

• Arrays 

• Lookup 

GeoCalc includes the following types of functions: strings, time 
and date, financial, mathematical, statistical, trigonometric, 
information, logical, lookup, and print. 

Logical functions and lookup functions are described in more 
detail below. 

You can use a list of values, separated by commas and enclosed in 
parentheses, as arguments for many functions. If the function uses 
a list for its arguments, then each item in the list is evaluated. For 
example, the following two functions are equivalent: 

SUM(Al:A4) 

SUM(Al,A2,A3,A4) 

NOTE 
Named cells and ranges are particularly useful as arguments for 
functions. For more information on how to name ranges, see 
"Naming Cells and Ranges" in this chapter. 

Using Logical Functions 

A logical function says, "If this is true, then do that." For example, 
"If the value of B12 is larger than 10,000, then display 50 in this 
cell." To create conditional statements, you use the IF function. 

The logical functions evaluate relationships and return "true" or 
"false" results. For example, the IF function looks at a condition, 
such as whether the contents of Bl3 = 500, and returns a true or 
false result. 

USING TIIE IF FUNCTION 

IF statements consist of the following three components: 

• The condition you want to test 

• The result you want if the condition is true 

• The result you want if the condition is false 

For example, you might want to calculate escalating bonuses for a 
sales team based on a percentage of the sale. For sales under 
$10,000, the bonus is 2%. For sales over $10,000, the bonus is 4%. 
The formula for such an IF statement is as follows: 



BONUS = IF(SALES<lOOOO, .02*SALES,.04*SALES) 

In this example, SALES<lOOOO is the condition you want to test; 
.02*SALES is the result you want if the condition is true, and 
.04*SALES is the result you want if the condition is false. Therefore, 
if the SALES figure is $15,000, the IF statement returns false, and 
GeoCalc computes the formula in the following way: 

BONUS = .04*SALES 

BONUS = $600.00 

If, on the other hand, the SALES figure is $7,500, the IF statement 
returns true, and GeoCalc computes the formula as follows: 

BONUS = .02*SALES 

BONUS = $150.00 

USING LOGICAL OPERATORS 

You can also use conditional operators that result in a value of 0 if 
false or 1 if true. These operators are used with IF functions. 

SYMBOL OPERATION EXAMPLE 

Equals Al4=Bl2 

> Greater than Al4>Bl2 

< Less than Al4<Bl2 

:2'. (Ctrl+Alt+<) Greater than or equal to 100:2'.Al4 

::-::; (Ctrl+Alt+>) Less than or equal to 100::-:::A 14 

-:;t. (Ctrl+Alt+=) Not equal Al4tB12 

USING TIIE AND AND OR FUNCTIONS 

By combining IF with the AND and OR functions, you can create 
even more complex conditional statements. Consider the 
following example: 

IF(AND(Al> 100,Bl> 100,Cl> 100),5,0) 

The result of this formula is 5 only if the values in Al, Bl, and Cl 
are all greater than 100. Otherwise, the result is 0. You can apply 
the same principle using the OR function, as shown in the 
following example: 

IF(OR(Al> 100,Bl> 100),50,0) 

The result of this formula is 50 if either Al or Bl is greater than 
100; otherwise, the result is 0. 
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Tbe index entries 
must be sorted in 
ascending order. For 
HLOOKUP, the index 
is the first row in the 
selection. For 
VLOOKUP, the index 
is the first column. 
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Using Lookup Functions 

Lookup functions create a table within a spreadsheet that acts like 
a database. You can enter values in the table and then extract 
information from the table depending on your specifications. 

Lookup tables are good for discounts, tax rates, and commission 
percentages. For example, the following table shows a discount 
(row 4) that increases with the number of units sold (row 3): 

R l B l c D l 

7 l 

You can create a formula that looks up the correct discount if you 
give it the number of units sold. For example, if you enter the 
number of units sold (1257) into Bl, and you insert the following 
formula into B6: 

HLOOKUP(Bl, B3:F4, 1) 

the formula returns 10%, as shown above. 

You can extract values horizontally (from rows) with HLOOKUP 
and vertically (from columns) with VLOOKUP. 



Charting in GeoCalc 

WHAT IS A CHART? 

TYPES OF CHARTS 

GeoCalc lets you use your spreadsheet data to create a variety of 
charts that visually represent numeric trends or results. You can 
include a chart as a part of your spreadsheet, or after creating a 
chart, you can copy it to the clipboard and use it in other GEOS 
applications such as GeoWrite. 

A chart is a graphic representation of numeric data. For example, 
you can create a chart to show the value of the consumer price 
index over a period of years, the total revenue for a company 
broken down by region, or the average age of people by country. 

Charts show the relationships among a series of values broken 
down into categories. For example, in a chart of monthly 
expenses, the series would include January, February, March, and 
so forth; the categories would include items such as Rent, Food, 
and Utilities; and the values would be the actual expenditures 
incurred. 

GeoCalc lets you create the following types of charts: 

• Column 
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• Bar 

• Line 

• Area 

• X-Y plot 

• Pie 

• High/Low 

All but the High/Low chart offer variations you can choose once 
you have created the chart. Each of the seven standard charts is 
illustrated in the following sections. 

Column Chart 

A column chart (or a vertical bar chart) plots each category in a 
series as a vertical bar. The height of the bar corresponds to the 
value of that category. The following illustration shows a typical 
column chart: 

59 
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49 

44 

Variations on the standard column chart include the following: 

Overlapped. The columns within each category overlap each 
other slightly. 

Stacked. The columns within each category are stacked vertically 
on top of each other. The height of the stacked column is the sum 
of the values in the category. 

Stacked Percentage. The columns in each category are stacked 
so that the total height represents 100%. The height of each value 
is shown as that value's percentage of the whole category. This is 
like a vertical pie chart. 

One Color with Values. Columns all have the same color or 
shade and are labeled with their numeric values. 

One Color with No Space Between Categories. Columns all 
have the same color or shade, and the last column in category 1 
abuts the first column in category 2 with no space between them. 



Bar Chart 

A bar chart is like a column chart with the bars plotted 
horizontally rather than vertically. 

The same variations are available for bar charts and for column 
charts. 

Line Chart 

A line chart plots a point indicator for each value on one axis in 
relation to the text label on the other axis, and connects the points 
in each series with straight lines. This type of chart is useful for 
showing how a value changes over time. The following illustration 
shows a typical line chart: 
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Variations on the standard line chart include the following: 

Lines Only. Draws only the lines connecting the points in each 
series; does not draw the markers for each point. 

Markers Only. Draws only the markers for each point; does not 
connect the markers with lines. 

Drop Lines. Draws the markers for each point, and then connects 
the points in each category with a vertical line; does not draw lines 
connecting the values. 
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Area Chart 

An area chart is a line chart in which the area below the line is 
filled with a pattern or solid color. The following illustration shows 
a typical area chart: 
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Variations on the standard area chart include the following: 

Stacked Percentage. Like the column stacked percentage chart, 
this area chart shows the areas for each category stacked to a 
constant height representing 100%, and the values are shown as 
percentages. 

Drop Lines. Draws a vertical line to connect the points in each 
category. 

Series Name. Prints the name of each series in the center of its 
filled area. 

X-Y Plot Chart 

An X- Y plot chart, sometimes called a scatter plot, looks similar to 
a line chart, but there is a significant difference between the two. 
Line charts plot a value against a label (see the preceding line 
chart illustration), whereas X-Y plot charts plot one value against 
another. X-Y plot charts are unique in that they take categories 
two rows at a time and plot them against each other. 

The following illustration shows a typical X-Y plot chart: 
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Another difference between X-Y plot charts and line charts is that 
on an X-Y plot chart, the tick marks along each axis (Xis the 
horizontal axis, Y is the vertical) are spaced according to their 
values, which may not always be at regular intervals because of 
the potentially random nature of the data. On a line chart, one axis 
always contains text labels, which are usually evenly spaced for 
visual clarity. 

Variations on the standard X-Y plot chart include the following: 

Lines Only. Draws only the lines connecting the points in each 
series; does not draw the markers for each point. 

Markers Only. Draws only the markers for each point; does not 
connect the markers with lines. This choice makes an X-Y plot that 
looks like a traditional scatter plot. 

Pie Chart 

A pie chart is a circular chart in which the size of each "slice" is 
proportional to its percentage of the whole. Pie charts are unique 
in that they draw only one category of data. The illustration below 
shows a typical pie chart: 

Variations on the standard pie chart include the following: 

Category Titles. Inserts the category titles into the chart. 

One Color with Category Titles. Shows all the wedges of the 
pie in one color, with category titles. 

First Wedge Exploded. Pulls the wedge that starts near the 12 
o'clock position out slightly from the rest of the pie. 

All Exploded. Pulls all the wedges apart slightly. 

With Percentages. Shows the percentage of the whole pie that 
each wedge represents. 
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CREATING CHARTS 

LEVELS 2-4 
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High/Low Chart 

A high/low chart is useful for tracking pairs of data that mark a 
high and low or a start and end value, for things such as the price 
of stocks or the day's temperature range. Each pair of data points is 
plotted as a single vertical line. You can also show a third or fourth 
relative value along with each pair, such as the stock's daily 
closing price or the average temperature. High/low charts require 
two categories of data, and may show up to four categories. The 
third category places tick marks to the left; the fourth category 
places tick marks to the right. 
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No variations are available for high/low charts. 

To create a chart you must first define the data that is to appear in 
the chart. You can select a portion of an existing spreadsheet, or 
use a blank spreadsheet in which you enter just the data you wish 
to chart. For example, the data in the sample line chart that 
appears in this chapter are one row of data from a larger budget 
spreadsheet. The spreadsheet shown in the following procedure 
was developed specifically to generate a chart. 

The following illustration shows the general format for data on 
which you base a chart and an example of how this format 
translates to a column chart: 

You use the following elements in typical chart data: 



Chart Title. The title of the chart. This label is optional. If you do 
not place any text in this cell, the chart will not be titled. You can 
title it later using the Titles and Legends choice on the Chart menu. 

Series Name. The series names are the labels of the spreadsheet 
columns. For a definition of series, see "What is a Chart?" in this 
chapter. 

Category Name. The category names are the labels of the spread
sheet rows. For a definition of category, see "What is a Chart?" in 
this chapter. 

Value. The numeric data values that GeoCalc charts. Each 
category you wish to chart should have at least one value for each 
series. Empty cells in your spreadsheet will be interpreted as zeros 
in your chart. 

NOTE 

Do not use numbers for the chart title, series names, or category 
names. For example, instead of naming categories 1, 2, and 3, use 
something like Day 1, Day 2, and Day 3. If you must use numbers, 
such as 1993 and 1994, place a quotation mark (") before each 
number so GeoCalc will interpret it as text. 

To create a chart (Levels 2-4) 

Once your labels and data are in place on the spreadsheet, you 
create charts using either the Charts menu or the charting buttons 
on the Style bar. 

1. Open the spreadsheet that contains the data you want to chart. 

or 

Open a new spreadsheet and enter the data you want to chart. 

2. Select the cells that contain the data you want to chart. 
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When you select cells, GeoCalc activates the Chart Menu and 
Chart buttons on the Style bar. 

Column tool button 

Bar tool button 

High/Low tool button 

Pie tool button 

Point tool button 

Area tool button 

3. Decide which type of chart will best depict the data. Remember 
that a pie chart can only represent one category, X-Y plots 
compare two or more categories, and high/low charts require from 
two to four categories of data. Use pie charts for percentages, line 
charts for trends, bar charts for comparing amounts for fixed time 
intervals, and X-Y plots to show cause and effect. 

4. Select the desired type of chart on the Style bar. 

or 

Open the Chart menu and select the basic type of chart from the 
Create submenu. The chart appears as a graphic object in the 
lower right corner of the GeoCalc window. For more information 
about charts as graphic objects, see "Manipulating Charts" in this 
chapter. 

CHANGING THE TYPE OF CHART 

LEVELS 2-4 
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You can choose a different type of chart to get a different view of 
your information. To do so, simply tap the appropriate chart 
button. 

Once you have created a chart, GeoCalc activates additional 
commands on the Chart menu. Use the Change Type choice on the 
Chart menu to change the basic type or to change the chart to one 
of its type variations. Alternatively, if you want to change just the 
type, not the variations, you can use the Chart buttons on the Style 
bar instead. 



To change the type of chart (Levels 2-4) 

1. Select Change Type from the Chart menu. A dialog box appears. 

2. Select the type of chart or variation you want. 

3. Tap Apply, and close the dialog box. GeoCalc changes the chart. 

MANIPULATING CHARTS 

LEVELS 2-4 When you create a chart, it appears in your spreadsheet as a 
graphic object with small filled boxes around its perimeter, and a 
diamond-shaped spot in the center. These handles indicate that 
the chart is the currently selected object. 

You can use the handles to manipulate your chart just as you 
would manipulate any graphic object. The diamond-shaped 
handle in the center is the move handle. You use the move handle 
to move the chart, and you use the other handles to resize it. 

The procedures in this section explain how to perform basic 
operations with graphic objects. For more information about 
working with graphic objects, see Chapter 8. 

Moving a Chart 

You can move the chart to any location in your spreadsheet. The 
general procedures for moving graphic objects are described in 
Chapter 8. 

CHARTING IN GEOCALC 6.51 



If you are using an 
optional external 

To move a chart (Levels 2-4) 

1. If the chart is not selected, tap the edge of the chart to select it. 
Handles appear around the chart frame and the move handle 
appears in the center. 

West Region Sales 

Supplies 

-----+- Move handle (the handle 
in the center) 

~------~------~ Resize handles (the handles 
around the edges) 

2. Drag the chart to the position you want. The chart appears in the 
new position. 

Resizing a Chart 

You can make a chart larger or smaller by using the handles to 
resize it. 

To resize a chart (Levels 2-4) 

keyboard, you can • Place the pen over one of the handles that surround the chart, then 
drag the chart. Dragging toward the center of the chart reduces it, 
while dragging away from the center enlarges it. 

maintain the chart's 
aspect ratio by 
holding down the 
Shift key while 
dragging. 
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Changing Chart Properties and Attributes 

Attributes are visual elements such as color, line thickness, and fill 
pattern. If you select a chart and then tap one part of it, such as a 
wedge of a pie chart, you can change the attributes of that part of 
the chart. 

To change text properties in a chart (Levels 2-4) 

1. Select the chart by tapping it. Handles appear around the chart. 

2. Select the text item within the chart that you want to change by 
tapping on it. (If you are using an optional external keyboard, you 
can select multiple text items by holding down the Ctrl key as you 
tap.) Handles appear on the item to indicate that it is selected. You 



cannot move any labels that the chart has generated, though you 
can edit text labels using the Text tool. 

3. Choose the text property (font, style, size, or color) you want to 
change from the Properties menu or the Style bar. 

4. GeoCalc applies the change to the selected text. 

To change an attribute of an element in a chart (Levels 3--4) 

1. Select the chart by tapping it. Handles appear around the chart. 

2. Select the object within the chart that you want to change by 
tapping on it. Handles appear on that object to indicate that it is 
selected. You cannot move the component parts of the chart or 
any labels that the chart has generated, though you can edit text 
labels using the Text tool. 

3. Choose the attribute you want to change from the Graphics menu. 

Many of these choices have dialog boxes. For information specific 
to the choices on this menu, see Chapter 8. 

4. Tap Apply to apply your changes, and close the dialog box. 

Deleting a Chart 

You can delete a chart you no longer need. 

To delete a chart (Levels 2-4) 

1. If the chart is not selected, tap the edge of the chart to select it. 
Handles appear around the chart frame, and the move handle 
appears in the center. 

2. Choose Delete from the Edit menu. 

or 

Tap Delete. GeoCalc deletes the selected chart. 

Using a Chart in Another Application 

You can copy a chart to a document you create with another 
GEOS application. For example, you may want to use a chart in a 
report you have created in GeoWrite, or in an illustration you have 
created using the drawing tools. 

To copy a chart to another application (Levels 2-4) 

1. Select the chart you want to copy by tapping it. Handles appear 
around the chart. 
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2. Choose Copy from the Edit menu. 

3. Go to the other application and choose Paste from the Edit menu. 
The chart appears. 

ADDING TITLES AND A LEGEND 

LEVELS 2-4 

6.54 GEOCALC 

A picture is worth a thousand words, but sometimes you need to 
add a few words of explanation, especially for a chart. 

To add titles and a legend to a chart (Levels 2-4) 

1. Tap the pointer tool to select the chart. 

2. Choose Titles & Legend from the Chart menu. A dialog box 
appears. 

3. Complete the dialog box, selecting the options you want: 

Chart Title. Select this option to add a title to the chart. GeoCalc 
looks for title text in the upper left of the selected chart range. If it 
cannot find any text, a text object with the words "Chart Title" 
appears at the top of your chart. You can change the title later. 

X-Axis Title. Select this option, if applicable, to add a title to the 
chart along the X-axis. 

Y-Axis Title. Select this option, if applicable, to add a title to the 
chart along the Y-axis. 

Legend. Select this option if your chart shows more than one cate
gory and you want to define the colors or patterns GeoCalc uses to 
differentiate between categories. You can also select its position 
on the chart: Horizontal (below chart) and Vertical (at right of 
chart). 



4. Tap Apply to apply your changes, and close the dialog box. 

~ 1. 
2. 

3. 

4. 

~ 5. 

GeoCalc adds the items you selected to your chart, as shown in the 
following example: 

Y-axis Chart title 

Chart title 

59 

~ 54 

;>< 

[;:;:;:;;;;;;;:;:;:;:mi 
Salesfisw.so 1991 

49 FBIMH¥!1tBB1'''E!!4ij' 
Sales figures: 1992 

44 !st 2nd :mi 4th 

X .Axis 

1 X-axis 

To change text in the chart title or axis titles (Levels ~4) 

Select the Text tool from the Drawing tool bar. 

Tap the text object you want to change. The text object is outlined 
and a vertical bar indicates the insertion point for text. 

Use the Backspace and Delete keys to remove text you do not 
want, or highlight the unwanted text and choose Delete from the 
Edit menu. 

Enter the new text. 

When you are finished with the Text tool, select the pointer tool 
from the Drawing Tool Box and tap an empty area of the chart to 
remove the outline around the text (so that further changes are not 
accidentally made to the text). 

You can apply a variety of style features to the text. For more 
information about using text features, see Chapter 1. For more 
information about using text in graphics, see Chapter 8. 
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CHANGING MARKINGS 

LEVELS 2-4 

6.56 GEOCALC 

There are three different types of chart markings you can change: 
axis markings, grid markings, and the marker shapes that indicate 
values on a chart. 

Setting Axis and Grid Markings 

Axis markings and grid markings are useful visual aids that can 
help people understand your chart. Axis markings are the tick 
marks that divide the axis lines. Grid markings are vertical and 
horizontal lines that can cover the chart area between the axes. 

To add axis and grid markings to a chart (Levels 2-4) 

1. Select the chart. 

2. Choose Axis from the Chart menu. The Axis dialog box appears. 

or 

Choose Grid Lines from the Chart menu. The Grid Lines dialog box 
appears. 

3. Select the type of axis markings you want, and tap Apply. 

or 

Select the axis from which you wish the grid lines to originate, and 
tap Apply. 

4. Tap Close to close the dialog box. 

The following illustration shows a chart with tick marks along the 
X-axis: 

Ch.rt title 

59 

49 
sales fiau:ceso 199Z 

44 

XAxis 



The following example shows the grid lines in a chart: 

Grid line 

Chart title 

59 

~ 54 

;>< 

49 ''"'''"'"'"'"' Sales fi,smes: 1992 

44 

XA:xis 

Changing Marker Shapes 

Markers are the points in line charts and X-Y plot charts. Changing 
the shape of the markers in one or more categories can help make 
the chart easier to read. 

To change the marker shape (Levels 2-4) 

1. Select the markers you want to change by tapping one of them in 
your chart. The markers in that category are surrounded by 
outlines to indicate that they are selected. 

2. Open the Charts menu and choose Marker Shape. The Marker 
Shape dialog box appears. 

3. Tap the marker shape you want and tap Apply, then close the 
dialog box. The selected markers change shape as specified. 
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Additional GeoCalc Features 

GeoCalc has many additional features to help you create accurate 
and attractive spreadsheets. 

TOOL BARS IN GEOCALC 

LEVELS 2-4 

6.58 GEOCALC 

At Level 1 in GeoCalc, no tool bars are available. At Level 2 and 
above, you can use the Style and Function bars. For general 
information about using tool bars, see Chapter 3. 

Using the Style Bar 

The Style bar appears when you open GeoCalc at Level 2. It allows 
you to change the text format of values and labels. In addition, 
you can use the tools on the Style bar to add and delete rows and 
columns and to create charts from the spreadsheet data. 

The Style bar also contains charting tools that are unique to 
GeoCalc. For more information about working with charts, see 
"Charting in GeoCalc" in this chapter. 

For a complete list of tool bars, see Appendix A. 

Using the Function Bar 

The Function bar contains tools for performing file functions such 
as opening, closing, and saving files, as well as tools for editing 
and for zooming in and out. You must display these tools before 



PRINTING 

ALL LEVELS 

you can use them; for more information, see Chapter 3. For a list 
of the standard tools on the Function bar, see Appendix A. 

The following tools are unique to GeoCalc: 

TOOL NAME DESCRIPTION 

Insert Row Adds one row above the current row. If you 
have selected multiple rows, Add Row adds the 
same number of rows above the selection. 

Delete Row Deletes the current row. If you have selected 
multiple rows, Delete Row deletes the rows 
containing the selected cells. 

Insert Column Adds one column to the right of the current 
column. If you have selected multiple columns, 
Add Column adds the same number of columns 
to the right of the selection. 

Delete Column Deletes the current column. If you have selected 
multiple columns, Delete Column deletes the 
columns containing the selected cells. 

Sort Forward Sorts the selected cells in alphabetic or numeric 
order. 

Sort Backward Sorts the selected cells in reverse alphabetic or 
numeric order. 

Calculate If you have specified manual calculation using 
Calculate on the Options menu, you can tap this 
button to make GeoCalc calculate all formulas in 
the spreadsheet. 

NOTE 
Not every tool shown in the table above is available at every level. 

For more information on manipulating rows and columns, see 
"GeoCalc Basics" in this chapter. 

For more information about sorting cells, see "Sorting" in this 
chapter. 

For more information on recalculating formulas, see "Advanced 
GeoCalc Formulas" in this chapter. 

At Levels 1 and 2, you can print your spreadsheet but you cannot 
specify any special printing options. This section describes the 
additional printing features that are available at Levels 3 and 4. 
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LEVELS 3-4 

LEVELS 3-4 

6.60 GEOCALC 

For general information about printing, see Chapter 1. 

Printing Spreadsheets 

At Levels 3 and 4, you can set various printing options using the 
Page Setup choice on the File menu. For more information, see 
"Setting Page Setup Options" in this chapter. After setting any 
special printing options, you are ready to print your spreadsheet. 

NOTE 

At Level 4, you can specify manual calculation prior to printing. If 
you specified manual calculation, be sure to recalculate your 
spreadsheet before printing it. For more information about 
calculation, see "Advanced GeoCalc Formulas" in this chapter. 

Setting Page Setup Options 

Before you print, you can set print options with the Page Setup 
choice on the File menu. 

To set print options (Levels ?,4) 

1. Choose Page Setup from the File menu. A dialog box appears. 

2. Complete the dialog box, changing the options you want: 

Starting Page Number. The default starting number is 1, but you 
can specify a different starting number for your spreadsheet. Either 
tap the up and down arrows or enter a new number. The page 
number appears when you use the PAGE() function in a cell and 
designate that cell as a header or footer. This option does not 
affect the number of pages printed. 

Print Sideways. Normally, the spreadsheet is printed as a 
standard upright page. Select this option if you want to print it 
sideways. 

Scale to Fit on One Page. Select this option if you want to 
enlarge or reduce your spreadsheet to fit on a single page. If your 
spreadsheet is too large, it may be reduced so much that you 
cannot read it. 

Continuous Printing. Use this option if you want your 
spreadsheet printed as one long continuous page. This is 
particularly effective for dot matrix printers that use continuous
form, fan-folded paper. If you print on single sheets, you can tape 
the sheets together. 



lfyou specify a 
header or.footer but 
do not check these 
print options, your 
printed spreadsheet 
will not have headers 
or footers. 

SORTING 

LEVEL 4 

Center Horizontally. Use this option to center the printed 
spreadsheet horizontally on the page. 

Center Vertically. Use this option to center the printed 
spreadsheet vertically on the page. 

Print Grid Lines. Select this option if you want grid lines to 
appear on your printed spreadsheet. (To get an idea of how the 
spreadsheet looks with and without grid lines, choose Draw Grid 
Lines from the Options menu.) 

Print Row & Column Titles. Use this option if you want the row 
and column references to be printed on each page of your 
spreadsheet. 

Print Header. Use this option if you want to have headers printed 
on the pages of your spreadsheet. You can specify headers using 
the Header/Footer choice on the Cell menu. 

Print Footer. Use this option if you want to have footers printed 
on the pages of your spreadsheet. You can specify footers using 
the Header/Footer choice on the Cell menu. 

3. Tap Apply, and close the dialog box. GeoCalc records the settings 
you selected. 

You can sort information in a row, column, or range of cells in 
either alphabetical (A-Z) or numeric (1-9) order. In addition, you 
can sort in either ascending (A-Z and 1-9) or descending (Z-A and 
9-1) order. A range is sorted by the row or column containing the 
active cell. 

For example, you may be keeping track of the payments of a 
group of piano students. As shown in the illustration below, you 
can alphabetize the list of names. Select the range of cells 
containing all the names and the payment information, making 
sure that the list you want to alphabetize is the leftmost column in 
the selection. Then, when you sort the list, the names (and the 
payments for each student) are shown in alphabetical order. 

UNSORTED 

Susie Jones 

Izuki Iwamai 

Sean O'Gara 

$25.00 

No Payment 

$25.00 

No Payment 

$25.00 

$25.00 

ADDITIONAL GEOCALC FEATURES 6.61 



SORTED 

Izuki Iwamai 

Sean O'Gara 

Susie Jones 

NOTE 

No Payment 

$25.00 

$25.00 

$25.00 

$25.00 

No Payment 

Be sure to save your work before you perform a sort. Then, if the 
results of the sort are not what you expected, you can choose 
Other from the File menu and then choose Discard Changes from 
the Other submenu. 

To sort information in a spreadsheet (Level 4) 

1. Select the cells containing the information you want to sort. Be 
sure to select all the cells you want to sort. 

2. GeoCalc will sort all selected cells by the row or column 
containing the active cell. 

3. Choose Sort from the Edit menu. A dialog box appears. 

4. Complete the dialog box, specifying the sort criteria you want to 
use: 

Sort By. You can sort either rows or columns. 

Sort Order. You can sort in either ascending or descending 
order - for example, A, B, C, D or Z, Y, X, W. 

Sort Options. You can specify the following sort options: 

• Ignore Case/ Accent. You can have the sort ignore any 
differences in uppercase and lowercase, and ignore accents on 
letters, in alphabetical sorts. 

• Ignore Spaces/Punctuation. You can have the sort ignore 
spaces between words and punctuation marks (such as the 
period in Mr.) in alphabetical sorts, such as in a phone book. 

4. Tap Sort. GeoCalc sorts the selected cells. 

To perform a simple sort more quickly (Level 4) 

1. Select the range of cells you want to sort. 

I i2 I 2. Tap the Sort Forward tool on the Function bar to sort the rows in 
ascending order. 
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or 

Tap the Sort Backward tool on the Function bar to sort the rows in 
descending order. 

GeoCalc sorts the range in the order you selected. 



CREATING NUMBER FORMATS 

LEVELS 3-4 GeoCalc offers a wide variety of standard number and date 
formats. While the date formats are fixed and cannot be changed, 
you can create additional number formats to suit your needs. For 
example, if you want to show values with six decimal places, you 
can create a special number format. 

To create or edit a number.format (Levels ~4) 

1. Choose Number Format from the Properties menu. A dialog box 
appears. 

2. Select a format on which you can base the new format, or one you 
want to edit. For example, if you want to create a format for 
displaying numbers with six decimal places, you might choose 
Fixed and specify six decimal places. 

NOTE 

You cannot create new date formats or edit existing ones. 

3. Tap Create to create a new format, or tap Edit to edit an existing 
one. A dialog box appears. 

4. Complete the dialog box, selecting the options you want. Refer to 
the examples in the dialog box as you set your specifications. 

Name of Format. Enter a name for the new format. 

Places. Enter the number of decimal places, up to 15. 

Offset. Enter the number of offset places. Negative numbers move 
the decimal point to the left and positive ones move it to the right. 

Options. Select format options from the Options drop-down list: 
commas, percent sign, leading and trailing zeros, and the position 
of the sign ( + or - ) relative to the header or trailer. For example, if 
the sign follows the header, then a negative dollar amount would 
be formatted as $-100 (rather than -$100). 

Fixed or Scientific. Select either fixed notation or scientific 
notation. 

Leading. Enter the numbers or characters you want to appear in 
front of each value you enter, like a prefix. You can specify a 
prefix for Positive, Negative, or All Numbers. For example, if you 
enter OM in the All box, every value using this format will begin 
with OM; if you enter 345, it will appear as OM345 in the active 
cell. 

Trailing. Enter the numbers or characters you want to appear at 
the end of each value you enter, like a suffix. For example, if you 
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enter DM in the All box, DM will appear at the end of every value 
using this format; if you enter 345, it will appear as 345DM in the 
active cell. 

5. Tap OK. The new format is saved with the spreadsheet. 

USING RULERS 

LEVELS 2-4 

ADDING GRAPHICS 

LEVELS 3-4 

6.64 GEOCALC 

NOTE 

At Level 4, if you want to create number formats that you will use in 
most of your work, you can create them in a new document and 
save them as the default empty document. For more information 
about changing the default empty document, see Chapter 3. 

The rulers for a spreadsheet are normally the row numbers and 
column letters. You can tum off the row and column headers or 
select alternate rulers. 

In GeoCalc, you can choose the same types of rulers that are 
available in other GEOS applications: Inches, Centimeters, Points, 
Picas, and System Default. After you choose one of these rulers, 
you will see it instead of the spreadsheet column and row headers. 
This is especially useful if you want to see where a page breaks or 
when you are working with graphics. 

You can include charts and drawings in the spreadsheets you 
create with GeoCalc. Charting lets you build graphs and pie charts 
based on data you enter in a spreadsheet. For more information 
about working with charts, see "Charting in GeoCalc" in this 
chapter. 

In addition to charts, at Levels 3 and 4, you can use the Drawing 
tool bar and the Graphics tool bar to create drawings right in your 
spreadsheet. If you prefer, you can also create drawings in 
GeoWrite and then paste them into a GeoCalc document. 

Graphics that you add to a GeoCalc document actually appear on 
a transparent "drawing layer" on top of the spreadsheet. If you fill 
objects with transparent fill patterns, you can see the spreadsheet 
information through the objects. For more information about 



working with fill patterns, see "Using the Drawing Tools" in 
Chapter 8. 

If you are using GeoCalc information for a report or presentation, 
you can create the visual effects right in GeoCalc using the 
drawing tools, charting capabilities, and cell borders. 

If you are already familiar with using drawing tools, you already 
know how to create drawings in your spreadsheet. If not, you may 
want to read Chapter 8, which describes drawing tools and 
techniques. 

USING GEOCALC WITH OTHER GEOS APPLICATIONS 

LEVELS 2-4 You can use information from your spreadsheet in other GEOS 
applications. For example, you can copy a range of cells to a 
GeoWrite document. Once you have pasted your information, you 
can add borders and other visual enhancements with the graphics 
tools. 

Information you paste into other applications is not automatically 
updated if you make changes to your original spreadsheet. 
Therefore, if you change the spreadsheet, you must recopy it into 
the Geo Write document if you want to keep the information in 
both documents the same. 

To use spreadsheet data in another application (Levels 2-4) 

1. Create the spreadsheet data you want to use. 

2. Select the range that you want to paste into another application. 

3. Choose Copy from the Edit menu to copy the selection. The 
selection is copied to the clipboard. 

4. Open the application and the document into which you want to 
paste the information. 

5. Move the insertion point to the location where you want to paste 
the spreadsheet information. 

6. Choose Paste from the Edit menu. The information is pasted into 
your document, with tabs inserted between the columns and with 
each row starting a new line. Borders are not copied. 
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EXPORTING AND IMPORTING GEOCALC INFORMATION 

LEVELS 2-4 

6.66 GEOCALC 

You can export information from GeoCalc in order to use it with 
DOS applications. Similarly, you can also import information from 
DOS applications into GeoCalc. 

With GeoCalc, you can import and export spreadsheet information 
in several formats: Lotus 1-2-3, dBASE, and Comma Separated 
Value (CSV). Comma Separated Value is a format that many 
applications can open or import. In a CSV file, each row of your 
spreadsheet is stored as a line of text, with the values in each 
column separated by commas. 

Exporting 

You can export information in Lotus, dBASE, or CSV format. When 
you export a spreadsheet in dBASE or CSV format, you can leave 
the columns in their original order or you can change the order to 
match the requirements of the application with which you plan to 
use the exported file. 

To export a spreadsheet 

1. Choose Other from the File menu. 

2. Choose Export Document from the Other submenu. A dialog box 
appears: 

Expon Document 

Select Folder and Format for Export 

I fath -I [6()t()f)()(:\.!ri)(;r;q I Dri~es -I Formats 

r.1.1111111111s14m41~1•sm11a11rmm·1•1•amm11111-111111111~ dBase Ill 
dBase IV 

New File Name: IL@llil§h!Ul.csu 

I Map Export Fields ... I 
I Export I J Cancel I 

3. Complete the dialog box, changing the export options to suit your 
needs: 

Select Folder and Format for Export. Using the standard file 
selector controls, select the folder where you want to save the 
exported file. For more information about file selectors, see 
Chapter 1. 



lf the lists in the 

Formats. Choose the application in which you want to use the ex
ported information, or choose Comma Separated Values to export 
information in CSV format. 

New File Name. Enter a name for the exported file. The correct 
extension already appears in this box, so you do not need to enter 
it. Be sure to enter a standard DOS file name, no more than eight 
characters long. For more information about DOS file names, see 
Chapter 1. 

4. Tap Export. GeoCalc creates a file using the specified format. 

To change the order of columns when exporting 

When you export in dBASE or CSV format, GeoCalc creates field 
names (Field 1, Field 2, Field 3, and so on) so that you can map 
the information you are exporting in a different order, if you 
choose. Mapping is available only when you export in these 
formats. 

HINT 

If you prefer, you can rearrange the columns in your spreadsheet 
so they appear in the order you want. If there are a small number 
of columns, this may be faster than mapping the information you 
are exporting. 

1. Create the spreadsheet as usual. 

2. Choose Other from the File menu. 

3. Choose Export Document from the Other submenu. The Export 
Document dialog box appears. 

4. Complete the dialog box, selecting the appropriate format from 
the Formats list. The Map Export Fields button is activated. 

5. Tap Map Export Fields. A dialog box appears with Column A, 
Column B, and so on listed in the Source List box; the columns 
that appear here correspond to the occupied columns in the 
spreadsheet. The Destination List consists of a number of field 
names (Field 1, Field 2, Field 3, and so on) equal to the number of 
occupied columns in the spreadsheet. 

dialog box are 
empty, make sure the 6. Tap Field 1 in the Destination List. 

spreadsheet contains 
data. 

7. Tap the column in the Source List that you want to be Field 1 in 
the export database. The selected name will be the field name 
associated with Field 1. 

8. Tap Map. The field pair appears in the Map List. To break the link 
between a mapped pair of fields, you can select the pair in the 
Map list and then tap Unmap. 
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9. Continue designating pairs until you have specified all the fields 
you want to map. If you leave any source field unpaired, that field 
will not be exported. 

10. Tap Done to close the dialog box. 

11. Tap Export. GeoCalc exports your spreadsheet information in the 
format you specified. 

Importing 

You can import information from files in Lotus, dBASE, or CSV 
format. Many applications can export information in these formats, 
so you do not necessarily have to be using Lotus or dBASE in order 
to import information into GeoCalc. When you import dBASE and 
CSV files, you can change the order of the columns when you 
import. 

NOTE 

Once you begin importing a file, you cannot interrupt the operation. 
You may need to wait when importing a very large file. Make sure 
you select the correct file to import. 

To import spreadsheet, CSV, or database data 

1. Choose Switch Document from the File menu. The following 
dialog box appears: 

2. Tap Import. The following dialog box appears: 

3. Select the application from which you are importing from the 
Formats list. 

4. Using the file selector, select the name of the file you want to 
import. 

5. Tap Import. The information from the import file appears in a 
GeoCalc window. You can edit the information and save the file as 
a GeoCalc file. 

To change the order of columns when importing 

When you import a dBASE or CSV file, GeoCalc enters data in the 
order in which it appears in the database. You can map this 
information in a different order if you choose. 

HINT 

If you prefer, you can rearrange the columns in your spreadsheet 
after importing the file. If there are a small number of columns, this 
may be faster than mapping the information you are importing. 



if the lists in the 
dialog box are 
empty, make sure 
you selected a file in 
step 4. 

Select a field pair in 
the Map List and tap 
Unmap to break the 
link between mapped 
pairs. 

1. Choose Switch Document from the File menu. The New/Open 
dialog box appears. 

2. Tap Import. A dialog box appears. 

3. From the Formats list, select the application from which you are 
importing. 

4. Using the standard file selector controls, select the file you want to 
import. For more information about file selectors, see Chapter 1. 

5. Tap Map Import Fields. A dialog box appears. 

The Source List shows the field names of the incoming file. The 
Destination List shows the names of the fields (Column A, Column 
B, Column C, and so on). 

6. Tap Field 1 in the Source List. 

7. Tap the field name you want for Field 1 in the Destination List. 

8. Tap Map. The field pair appears in the Map List. 

9. Continue designating pairs until you have specified all the fields 
you want to map. If you leave any source field unpaired, it will not 
be imported from the database. 

10. Tap Done to close the dialog box. 

11. Tap Import. The information appears in a GeoCalc window in the 
order you specified. 
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GeoFile Basics 

This section includes a description of what a database is and 
explains how to do the following: 

• Create a database by copying a standard GeoFilc template. 

• Enter, modify, and delete data. 

• Search for data. 

• Perform simple sorts. 

• Change data layouts and layout viewing options. 

As with the GeoWrite application, you will need to use either the 
on-screen keyboard or an external keyboard to enter data. 

This section assumes you are familiar with the information covered 
in Chapter 1 and Chapter 3, which provide an overview of the 
skills you need to use any GEOS application. 

WHAT IS A DATABASE? 

GeoFile 

7.2 GEOFILE 

GeoFile stores the information you enter in a structure called a 
database. Each GeoFile database is a table, in which a row, or 
record, represents a set of related data, and each column or field 
contains a particular type of data. 



For example, if you decided to keep track of the results of your 
spring flower bulb plantings, your database could contain the 
following information. 

FLOWER 

Freesia 

Crocus 

COLOR 

Yellow 

Violet 

PLANTED 

11/24 

11/24 

RESULTS 

Excellent 

Disastrous 

NOTES 

Rabbits ate 
them. 

Each set of entries for a particular flower is a record. Each type of 
information about a flower (for example, its color) is a field. In 
order for you to be able to refer to a field, each field has a name, 
such as RESULTS. 

A GeoFile database can hold up to 16,384 records. To make it easy 
for you to work with such potentially large quantities of data, 
GeoFile provides tools for building forms, or layouts, for entering 
data and for printing it out in attractive reports. You also can use 
GeoFile to sort the information you enter and to find specific data 
quickly. 

THE GEOFILE WINDOW 

When you first start GeoFile, the application opens at Level 1, and 
the GeoFile window looks like this: 

.. - .. ? 
,Eile !;dit ~iew Qptions _!::ayout Qata 

i 
Menu bar I Record control panel 

The appearance of the GeoFile window changes at each user 
level. The user levels are described below. "GeoFile Basics" 
describes basic concepts that you need to understand at all user 
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levels. "Using a GeoFile Database" and "Creating a GeoFile 
Database" desc(ibe the GeoFile features available at Levels 2-4, 
and include illustrations of the GeoFile window at each user level. 

USER LEVELS IN GEOFILE 

7.4 GEOFILE 

GeoFile has four user levels, as described below. For more 
information about changing and saving user levels, see Chapter 3. 

GeoFile Level 1. Level 1 allows you to use the most basic features 
of GeoFile. At Level 1, you can enter, modify, and retrieve data 
using an existing database or one that you create yourself by 
saving a copy of a GeoFile template. "GeoFile Basics" in this 
chapter describes the features available at Level 1. 

GeoFile Level 2. Level 2 allows you to use more advanced data 
entry features, including marking records, performing multilevel 
sorts, and exporting and importing data. You can also control 
more aspects of printed reports. These features are described in 
"Using a GeoFile Database" in this chapter. 

GeoFile Level 3. Level 3 allows you to use all of GeoFile's data 
entry features and to customize your database organization and 
layouts. Level 3 provides basic drawing tools that allow you to 
manipulate graphic objects and to change the text font, style, and 
size. At Level 3, you can change patterns, select line thickness, and 
scale graphic objects. For information about how to use the 
drawing features available at Levels 3 and 4, see Chapter 8. For 
information about using GeoFile to create new fields and layouts, 
see "Creating a GeoFile Database" in this chapter. 

GeoFile Level 4. Level 4 allows you the most complete control of 
your database and layouts. Level 4 provides advanced design 
features for both single- and multi-record layouts, including the 
use of splines, custom duplicate functions, and style sheets for 
both graphics and text. For information about the design features, 
see Chapter 8. For information about style sheets for text, see 
Chapter 5. 



OPENING AN EXISTING DATABASE 

ALL LEVELS At Level 1, you can only work with data in an existing database 
template. You must advance to Levels 2-4 to create a database 
without using a template. 

Using A Template to Create a Database 

Templates are predcsigned documents that you can use to create 
your own databases. Templates provide a set of ready-to-use fields 
and layouts that are designed to perform particular tasks. GeoFile 
provides a template for creating a Mail Merge database of names 
and addresses that you can use with GeoWrite to send individually 
addressed form letters. For information about Mail Merge, see 
Chapter 5. 

-;£ ., 
file J;dit !,!iew Qptions 1=ayout Qata 
Mail Merge Database 
This is a database wh:ich you can use in conjunction with the Geo Write templaties Mail Ma-ge. Busi.n.e.ss Lett.er 
and Mail Merge. Er1:vdope #1 0. For more about mail merge, see your documentation .. 

Tille (Ms.,MrJMrsJDrJelc)o LJ 
Last Name: 

First Name: 

Notes: 

1 Do Not Leave These Fields Blank 
Jf you don't want to type something into one 
of these four fields (for instance, if you don't 
know tlu!, person's r.ciddle n.a.:me), do not 
leave tM field blank-typie a quotation mark 
(") instead. Otherwise, calculatied fields in 

\your mail me1:3e documents will show a "O". 

? 0 ~ 

Choose Switch Document from the File menu to select the 
template. When you open a template, GeoFile makes an untitled 
copy of the template for your use. This copy is a new database, in 
which you can store and retrieve data. When you save the 
database, you can give it a name of your choice. The template 
itself remains unchanged, and you can use it to create another 
GeoFile database. 
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USING THE RECORD CONTROL PANEL 

ALL LEVELS 

7.6 GEOFILE 

The Record Control Panel is a dialog box that appears in the 
GeoFile window when you open a copy of a template or a 
database that already exists. You use the Record Control Panel to 
navigate through the records in a database, and to perform special 
functions, such as saving or deleting a record. 

First Record button 

Previous Record button 

Next Record button 

Last Record button 

Delete Record button 

Cancel Changes button 

Save Record button 

New Record button 

The buttons on the Record Control Panel perform the following 
operations: 

First Record. Use this button to move to the first record in the 
database. 

Previous Record. Use this button to move to the previous record. 

Next Record. Use this button to move to the next record. 

Last Record. Use this button to move to the last record in the 
database. 

Record Number. Use the arrow buttons to select the number of 
the record you want to use. The number of the current record 
appears in the box to the left. 

New Record. Use this button to create a new record. 

Save Record. Use this button to save the current record. 



ENTERING DAT A 

ALL LEVELS 

You can also move 
back through the 
fields by tapping 
Shift +Tab or 
Shift +Enter on the 
floating keyboard. 

Cancel Changes. Use this button to cancel any changes you have 
made to the current record since it was last saved. 

Delete Record. Use this button to delete the current record. 

You add records to a database by entering information in fields. A 
field holds a specific piece of information, such as a person's 
name. Fields in the template for Mail Merge include the name, 
street address, city, state, zip code, and phone numbers. When you 
enter information into fields, you are creating a record 

To add records to a database (All Levels) 

1. Open the database or a copy of a template that you want to use. 
The database appears, along with the Record Control Panel. 

2. If this is a new database, you need not do this step for the first 
record. Tap the New Record button on the Record Control Panel. 
Empty fields appear on the screen. The insertion point is in the 
first field and a dotted box appears around the first field. 

3. Enter infonnation in the field, then tap in the next field. 

or 

Tap Tab or Enter on the floating keyboard. 

The insertion point appears in the next field, and the dotted box 
appears around it. 

4. Repeat step 3 as many times as necessary to enter information in 
all the fields in the record. If you want to change the data in a 
field, tap in the field to place the insertion point. You can then edit 
the text in the field using standard GEOS editing techniques. 

5. Tap the New Record button on the Record Control Panel. 

or 

Tap Ctrl+Enter. 

GeoFile saves the record you just entered and displays empty 
fields on the screen in preparation for a new record. 

GeoFile places each new record that you enter at the end of the 
database. Use GeoFile's sort feature if you want to list the records 
in a different order. For more information, see "Sorting Records" in 
this chapter. 
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MODIFYING DATA 

ALL LEVELS You can easily change information in GeoFile records. You can 
select, copy, cut, and delete information using the same edit 
features that you use in any GEOS document. You can also cancel 
changes that have not yet been saved in the database. 

To modify a record (All Levels) 

1. Locate and display the record you want to modify. You can do this 
by using the Record Control Panel or by using GeoFile's search 
options. 

2. Tap in the field that contains the data you want to modify. The text 
insertion point appears in the field and a dotted box appears 
around the field. 

3. Edit the text in the field using standard GEOS text editing 
techniques. For more information on modifying text, see 
Chapter 1. 

or 

You can use the Cancel Changes button in the Record Control 
Panel to cancel any current changes you have made to a record. 
GeoFile restores the record to its condition before you changed 
any information. 

DELETING RECORDS 

ALL LEVELS 

7.8 GEOFILE 

When you no longer need the information a record contains, you 
can delete that record from the database. 

To delete a record (All Levels) 

1. Locate and display the record that you want to delete. 

2. Tap the Delete Record button in the Record Control Panel. A 
confirmation message appears. 

3. Tap Yes. GeoFile deletes the record from the database. 



SEARCHING FOR RECORDS 

ALL LEVELS In addition to using the Record Control Panel to move through 
records in a database, you can search for records that contain a bit 
of text or a particular piece of information. The text you search for 
is called a text string A text string can be any series of characters, 
numbers, or words that you want to locate. For example, if you 
want to locate all records in a mailing list that include addresses 
located in San Francisco, use "San Francisco" as your text string. 

To search for a particular record (All Levels) 

1. Choose Find from the Data menu. A dialog box appears: 

1:1 Fin cl 

Find: 

I ~pecial Ct1aracters -I D Ignore Case/Accents D .t!atch Partial Words 

r f l;J~JmN~~~tj . i il;~j !'; ;~~;~;;~;~ J I Close I [2J 

2. Complete the dialog box, using the options you want. 

Find. Use this box to enter your text string. For example, if you 
want to search for a tax rate of 37%, enter 37. 

Special Characters. Tap this button to select a wild card. A wild 
card is a symbol used to represent any character or number. 
GeoFile has two wild cards: an asterisk (*) indicates any series of 
characters or numbers; a question mark (?) indicates one character 
or number. For example, if you want to list all records for 
employees whose last names begin with J, enter J and choose 
Match Multiple Characters from the Special Character drop-down 
list. All records for employees whose last names begin with J are 
displayed. If you want to search the records for employees with 
three-letter last names that begin with B, type B and choose the 
Match Any Character option twice from the Special Character 
drop-down list. 

Ignore Case/ Accents. Select this option if you want GeoFile to 
ignore the difference between uppercase and lowercase letters, or 
letters with and without accents while making a search. 

Match Partial Words. Select this option if you want GeoFile to 
match your search string to all occurrences of the text string, even 
within a word. For example, if you choose this option and enter 
rate as your search string, GeoFile will locate such words as rates 
and berated. 
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3. Tap Find Next. The first record that matches your search string 
appears. 

4. Tap Find Next again until you have displayed all records that 
match your search string, or tap Close if you want GeoFile to stop 
searching. 

At Level 2 and above, you can also make a search by marking 
particular records for display. For information about how to mark 
records, see "Using a GeoFile Database" in this chapter. 

SORTING RECORDS 

ALL LEVELS 

For information 
about sorting on 
more than one field, 
see "Using a GeoFile 
Database" in this 
chapter. 

7.10 GEOFILE 

GeoFile automatically stores each new record at the end of the 
database. Therefore, the records may not be arranged the way you 
want them. Using GeoFile's sort feature, you can sort your records 
by the contents of a certain field. For example, you could sort your 
database by its City field if you wanted to sort records by city 
name. 

To sort records in a document (All Levels) 

1. Choose Sort from the Data menu. A dialog box appears: 

First_Name 
Formal_Name 
Full_Name 
Home_Phone 
Last_Name 

Sort Direction: 1.1' .. l "'I 
Sort Options: 
o Ignore ~ase/Accents 
o Ignore §paces/Punctuation 

l[§ortll I Cancel I Cf] 

2. Complete the dialog box, selecting the options you want. 

Select Sort Field. This option lists all fields in your database. Use 
the scroll bar to move through the list and tap the field that you 
want to use for your sort. 



USING LAYOUTS 

ALL LEVELS 

Sort Direction.This option specifies whether you want to list 
your records in ascending or descending order. If you choose the 
Up button, GeoFile lists all records in ascending order; if you 
choose the Down button, GeoFile lists all records in descending 
order. For example, to sort employees by descending zip code, tap 
the Down button. 

Sort Options. This option further defines the way GeoFile sorts a 
database. You use it to request that GeoFile ignore differences 
between uppercase and lowercase letters, accent marks, spaces, or 
punctuation marks when sorting. 

3. Tap Sort. The dialog box disappears. When GeoFile completes the 
sort, the records appear on the screen in the order you requested. 

GeoFile provides additional sort functions if you are working at 
Level 2 or above. For information about additional sort functions, 
see "Using a GeoFile Database" in this chapter. 

You use layouts to organize and present the information stored in 
your GeoFile database. A layout is the visual presentation of your 
data. The style and the fields you use in a layout depend on the 
purpose of the layout. You can group appropriate fields together 
and use various styles of type (and colors, if you have a color 
printer) to present the data in a format that is both attractive and 
easy to follow. 

A database can have more than one layout. When you use a 
template to create a new database, GeoFile copies the template's 
layout into the new database. You can make a copy of that 
database and layout, and change the layout to meet your needs. 
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To choose a layout (All Levels) 

1. Select Switch Layout from the Layout menu. A dialog box appears: 

1 Use to find a layout. 

• 
I Choose Layout Current Layout: l . • ~ List by Region 

Information Card Notes for Credit History 
List by Region All financial history of 

customers, including 
billing, balanaces and 

~ 

purclhase records. 

K~~ff~ht~Il [i:;dit Notes ... ] I Cancel I [2J 

Use to select I Notes for the selected layou t 
layout. 

Use to edit la out notes. y 

2. Select the layout that you want to use. 

3. Tap the Switch To button. The new layout appears in the GeoFile 
window. 

At Levels 3 and 4, you can create your own layouts. In fact, you 
can create up to 255 layouts to meet the needs of a particular 
database. 



Using a GeoFile Database 

This section describes the additional data entry features that are 
available in GeoFile at Levels 2-4. These features include the 
following: 

• Record marking to create subsets of your database 

• Advanced sorting capabilities 

• Importing and exporting capabilities 

• Multi-record data entry (Level 4 only) 

At Levels 3 and 4, you have the choice of working in data entry 
mode or in design mode. In data entry mode, you enter, modify, 
and manipulate the data in a database. This section and "GeoFile 
Basics" describe the functionality available as you work in data 
entry mode. In design mode, you can modify the structure and 
layout of an existing database or design a new database from 
scratch. "Creating a GeoFile Database" describes the capabilities 
available in design mode. 

You should be familiar with the information in "GeoFile Basics" 
before using the techniques described in this section ("Using a 
GeoFile Database"). 

ADVANCING TO LEVEL 2 

LEVEL 2 When you advance your user level, GeoFile provides additional 
options for working with your database. 
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When you advance to Level 2, you have access to all the advanced 
data entry features described in this section ("Using a GeoFile 
Database"), with the exception of multi-record capabilities. The 
advanced data entry features appear on GeoFile menus, so 
GeoFile looks almost the same at Level 2 as it does at Level 1. 

At Level 2, GeoFile looks like this: 

i::::::IEJ bPol'1IP - ScilPs lnfonncit1on Dll 
file J;;dit View Options i,ayout t!ark Qata 

Name: E·tIIV Westington I ~ 
Address: 136890 Pa:rkriver Lane, Chicago, IL 60610 I 

Phone: 1(312) 763-2975 I 
Fax: 1(312) 763-2987 I 

- l Record Control Panel - Information Card 

O!JwwCEJ D./i;;i 

Record: DB of 15 

@] r·~~·-1 ~ I~ I ~ .i . LOI 

WORKING IN DATA ENTRY MODE 

LEVELS 3-4 

7.14 GEOFILE 

At Levels 3 and 4, you use the Data Entry and Design buttons to 
choose between working in data entry mode and in design mode. 

To work in data entry mode (Levels 3-4) 

• Tap Data Entry to work with the data in a database. After you tap 
Data Entry, GeoFile is in data entry mode. 

"Using a GeoFile Database" describes advanced features available 
in data entry mode. For information about working in design 
mode, see "Creating a GeoFile Database" in this chapter. 



WORKING WITH MARKED RECORDS 

LEVELS 2-4 GeoFile's marking features enable you to define a group of records 
and work with that group separately from the rest of your 
database. Once you have marked a group of records, GeoFile can 
quickly retrieve that group so that you can do any of the following: 

• View just a portion of a database. 

• Update a selected group of records. 

• Print records containing specific types of data. 

• Export a subset of a database. 

GeoFile uses marks that look like check marks to indicate each 
member of the group. These marks appear in the upper right 
corner of the Record Control Panel when the current record is 
marked. 

Showing Marked Records or All Records 

By default, GeoFile displays all the records in a database. When 
you have marked records, you can choose to have GeoFile display 
either marked records only or the entire database. 

To show only marked records (Levels 2-4) 

• Choose Show Only Marked from the Mark menu. GeoFile displays 
only marked records. 

To show all records (Levels 2-4) 

• Choose Show All from the Mark menu. GeoFile displays all records 
in the database, both marked and unmarked. 

Marking Records 

GeoFile provides several methods for marking records: 

• You can mark records individually. 

• You can specify a search string for GeoFile to use to select and 
mark a group. This is the simplest way to mark a group of 
records. 

• You can specify a logical expression that GeoFile evaluates for 
each record in order to select and mark a group. This enables 
you to specify more complex criteria for GeoFile to use in 
selecting and marking records. 
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• You can mark every record in a database. 

• You can change the status of all marked records to unmarked, 
and vice versa. 

MARKING A RECORD 

You use the Record Control Panel to mark a particular record. This 
method is useful, for example, when you have just added a new 
record and you want to mark it for later reference. 

To mark a record using the Record Control Panel (Levels 2-4) 

1. Locate and display the record that you want to mark. 

2. Tap the check box in the upper right comer of the Record Control 
Panel. The check box darkens, indicating that the record is 
marked. 

1::1 Recore! Control Panel - lnforrnat1on Card 

liHJI W [[] [EJ 
Record: DB of 15 

USING THE MARK RECORDS OPTION 

Tap box to mark the 
current record. 

You use the Mark Records option on the Mark menu to mark a 
group of records that share similar information. For example, you 
may want to group all records that have "San Francisco" in the City 
field, or that have "February" in the Month field. Mark Records 
searches for the text you specify in a field you choose, and it 
marks the records where it finds a match. 



To use Mark Records (Levels 2-4) 

1. Choose Mark Records from the Mark menu. A dialog box appears: 

Select Mark Field: 

First_Name 
Formal_Name 
Full_Name 
Home_Phone 
Last_Name 

o Ignore Case 
o Match Only at Start of Field 
Text to Match: 

I Mark I I Cancel I 

2. Complete the dialog box, selecting the options you want: 

Select Mark Field. Select the field containing the information you 
want GeoFile to find. 

Ignore Case. Select this option if you want GeoFile to treat 
uppercase text and lowercase text the same way. 

Match Only at Start of Field. Select this option if you want 
GeoFile to mark records only where it matches the string with 
characters at the beginning of the specified field. 

Text to Match. Enter the text you want GeoFile to use as the basis 
for marking records. For example, to mark all records for people 
whose last name is Smith, select Last Name as the mark field and 
enter Smith in the Text to Match box. 

3. Tap Mark. GeoFile marks the records that match your search 
criteria. GeoFile also creates a formula based on these search 
criteria and uses it as the default expression in Mark by Formula 
(discussed in the next section). 

MARKING RECORDS BY FORMULA 

GeoFile can use formulas that reference and combine the 
information stored in your database as the criteria for marking 
records. For example, you could enter income > 30000 and 
(state="CA", city="Sacramento") to select and mark the group 
of records for employees in Sacramento, California with incomes 
over $30,000. 
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For more 
information about 
using this dialog box 
to enter formulas, see 
"Creating a GeoFile 
Database" in this 
chapter. 
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To mark records by formula (Levels 2-4) 

1. Select Mark by Formula from the Mark menu. The following dialog 
box appears: 

Mar-k F1elcls by Formula 

Field names Logic 

Address 
Fax 
Name 
Phone 

ABS 
ACOS 
ACOSH 
AND 
ASIN i ~~ ~~ L::=:========::::.:::J 

Create a record marking expression. 

2. Complete the dialog box, selecting the options you want. 

Field Names. This option lists all the field names in the GeoFile 
database. Selecting a field name pastes it at the insertion point in 
the Expression box at the top of the dialog box. 

Functions. This option lists all the GeoFile functions you can use. 
Selecting a function pastes it at the insertion point in the 
Expression box. 

Math. This option lists all the GeoFile math operators you can use. 
Selecting an operator pastes it at the insertion point in the 
Expression box. 

Logic. This option lists all the GeoFile logical operators you can 
use. Selecting an operator pastes it at the insertion point in the 
Expression box. 

For a list of GeoFile functions, math operators, and logical 
operators, see Appendix B. 

3. Tap OK to mark the records. GeoFile checks the syntax of the 
expression you have typed. If the syntax passes, GeoFile carries 
out the search and marks each record that meets the criteria set by 
the specified formula. 

If GeoFile detects a syntax error, it displays an error box and 
highlights a problem in the Expression Box. Tap OK and resume 
editing the formula until the syntax is accepted. The dialog box 
closes. 



MARKING All RECORDS 

Sometimes it is easiest to start a search with every record in the 
database marked, and then unmark specific records by hand. You 
can mark all records in a simple one-step procedure. 

To mark all records (Levels 2-4) 

• Choose Mark All from the Mark menu. All records in the database 
are marked. 

SWITCHING MARKED RECORDS 

Sometimes you may want to switch between working with your 
marked and unmarked records. An easy way to do this is to mark 
one set of records and then use GeoFile's Switch All Marks option 
to switch the marks from one group to the other as needed. 

To switch all marks (Levels 2-4) 

• Choose Switch All Marks from the Mark menu. GeoFile switches 
the status of all marked records to unmarked, and that of all 
unmarked records to marked. 

Unmarking Records 

When you want to remove marks from records, you can either 
remove the marks individually, using the Record Control Panel, or 
remove them from the entire database using Unmark All. 

To unmark a record using the Record Control Panel (Levels 2-4) 

1. Locate and display the record that you want to unmark. 

2. Tap the check box in the upper right comer of the Record Control 
Panel. The check box changes to indicate that the record is 
unmarked. 

To unmark all records (Levels 2-4) 

• Choose Unmark All from the Mark menu. GeoFile removes the 
marks from all records in the database. 

Setting Mark Options 

You can set options to control whether and when GeoFile should 
automatically retain or remove marks from records. 
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To set mark options (Levels 2-4) 

1. Choose Mark Options from the Mark menu. A dialog box appears: 

Mark Options 

off!~f~l!l~ii~~iiij fi~E~ ~6~966:l~r.~: 
•_!;;!ear All Marks Before Re-Marking 

J OK I J Cancel I [II 

2. Complete the dialog box, selecting the options you want. 

Automatically Mark and Unmark. Select this option to have 
GeoFile mark every record that matches the last specified Mark 
Record or Mark by Formula search criteria. With this setting 
selected as you update your database, GeoFile automatically 
marks any record that you add or change that matches the last 
marking search criteria, and unmarks any record that you change 
in a way that no longer matches the search criteria. By default, 
GeoFile operates with this option off. 

Clear All Marks Before Re-Marking. Select this option to have 
GeoFile unmark all records before performing a Mark Record or 
Mark by Formula search. Deselect this option if you want to use 
Mark Records or Mark by Formula to add records matching new 
search criteria to an already existing marked group. By default, 
GeoFile operates with this option on. 

3. Tap OK to set your options. 

ADVANCED SORTING 

LEVELS 2-4 

Each field you sort 
on is called a sort 

key. 

7.20 GEOFILE 

At Level 1, you can sort records in a database by the contents of a 
single field, and you can specify the order of the sort. For 
information about the basic sort feature, see "GeoFile Basics" in 
this chapter. 

At Levels 2-4, you can use up to six different fields to sort records 
in your database and specify the order of the sort for each field. 
For example, you can sort records first in ascending order by 
customer name and then in descending order by date. 



The following example shows a list sorted in ascending order by 
customer name and in ascending order by date: 

[::: :~~t~~: 11:~ ~s!~~ J::: ~~~:e~: :~~~: ~ ~~~~~::: :: : : : : : : : : : : : : : : : ~~~: I3::::: ): [ 
Date: jt2/16/92 I Name: §sCCompany Qty: ~ 

Date: ~ Name: ~l'sBurgers Qty: ~ 
Date: 11211 s192 I Name: EommTech Qty: ~ 
Date: 112111192 I Name: ~ecords Mania Qty: ~ 
Date: 11 21 21192 I Name: ~ecords Mania Qty: ~ 
Date: p 2122192 1 Name: jUs Express Qty: E:::J 

To use advanced sorting features (Levels 2-4) 

1. Choose Advanced Sort from the Data menu. A dialog box appears: 

Fields in Database 

Custorner 
Date 

Qty 

Add button 

Remove button 

Custorner' 

Sort Direction: ~ Sort Key Priority: 

----------sort Options,--------+-----1~ 

o Ignore ~ase/Accents Dlgnore ~paces/Punct 

Notes: 

Promote Demote 

2. Complete the dialog box, selecting the options you want: 

Fields in Database. Select the field you want GeoFile to use as a 
sort key from this alphabetical list of all the fields in the database. 
If necessary, use the scroll bar to move quickly through the list. 

Add button. Use this button to add the selected field in the Fields 
in Database list to the Sort Keys list. Once a field appears on the 
Sort Keys list, you can no longer select it from the Fields in 
Database list. 
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Remove button. Use this button to remove the selected field from 
the Sort Key list. The field becomes available again for selection 
from the Fields in Database list. 

Sort Keys. This lists all the fields that you have selected as sort 
keys, in order of priority. Select a field from this list of sort keys in 
order to remove it from the list or to change its priority. If 
necessary, use the scroll bar to move through the list. 

Sort Key Priority. This option lets you move a selected field up 
or down in the sort order. If you tap the Up button (arrow pointing 
up), GeoFile moves the selected field in the Sort Keys list up one 
position in the sort order. If you tap the Down button (arrow 
pointing down), GeoFile moves the selected field in the Sort Keys 
list down one position in the sort order. 

Sort Direction. This option specifies whether you want to list 
your records in ascending or descending order. If you tap the Up 
button (arrow pointing up), GeoFile sorts all records in ascending 
order; if you tap the Down button (arrow pointing down), GeoFile 
sorts all records in descending order. For example, if you want to 
sort cities alphabetically beginning with A, tap the Up button. 

Sort Options. This option further defines the way GeoFile sorts a 
database. You use it to request that GeoFile ignore differences 
between uppercase and lowercase letters, accent marks, spaces, or 
punctuation marks when sorting. 

Notes. This displays any information that was entered about the 
selected field when it was created. For more information about 
field notes, see "Creating a GeoFile Database" in this chapter. 

Clear. Use Clear to remove all sort keys from the Sort Keys list. 
Clear also resets the default sort options and sort directions, and 
selects the first field in the Fields in Database list. 

3. Tap Sort. GeoFile sorts your records based on the sort keys and 
options you specify. 

EXPORTING AND IMPORTING DATA 

LEVELS 2-4 

7.22 GEOFILE 

You can use GeoFile to exchange data with many other 
applications. You can also export GeoFile data to GeoWrite for use 
in Mail Merge documents. For more information abut Mail Merge 
documents, see Chapter 5. 



Lm;f!,ejl!es can take a 

ll'hile to exp011. 

Exporting GeoFile Data to Another Application 

You can export all or specified portions of a GeoFile database. In 
either case, GeoFile copies the data into a new document that 
matches the internal format you specify. 

To exp011 portions ofa database (Levels 2-4) 

1. Open the GeoFile database that contains the data you want to 
export. 

2. Select Show Only Marked from the Mark menu if you want to 
export the currently marked group of records only. 

3. Choose Other from the File menu. A submenu appears. 

4. Choose Export Document from the Other suhmenu. A dialog box 
appears: 

Select Folder and Format for Export 

I f:'ath -1 ·<;~;rn\;; r);;;::~ll~~~;;~il I Dri~es -I Formats 

1:5looCUMENT 

New File Name: l(!!@;@iUl.csu 

I Map Export Fields ... I 
Export Options: 

+All <>From ~8 to GS 

~ dBase Ill 
dBase IU 
Lotus 1-2-3, version 1.0 or 1 A 
Lotus 1-2-3, version 2.0 - 2.3 

Comma Separated Value 

I Export I [ Export to Clipboard I [Cancel I 

5. Use the file selector to find the file to which you want to export. 
Also, you can change any of the following options: 

Formats. Choose the application in which you want to use the 
exported information, or choose Comma Separated Values to 
export information in CSV format. 

New File Name. Enter a name for the exported file. The correct 
extension already appears in this box, so you do not need to enter 
it. Be sure to enter a standard DOS file name, no more than eight 
char:o.cters long. For more information about DOS file names, see 
Chapter 1. 
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Large files can take a 
while to import. 
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Export Options. Tap From, and then use the arrow keys if you 
want to specify a numeric range of records to export. For example, 
if you want to export the first 10 records in your database, tap 
From, then use the first set of arrow keys to select 1 and the 
second set of arrow keys to select 10. If you have chosen Show 
Only Marked, GeoFile then exports the first 10 marked records. 

Map Export Fields. The Map Export Fields option appears only 
when you have selected specific export types. Use this button to 
specify the order and number of exported fields. 

6. Tap Export to copy the data to a new document. 

or 

Tap Export to Clipboard to copy records to the clipboard. GeoFile 
uses data on the clipboard in Mail Merge. 

A message appears to indicate that exporting is in progress. When 
GeoFile finishes exporting data, the message disappears. 

Importing Data from Another Application 

You can import data from fields in Lotus, dBASE, or CSV format. 
Many applications can export information in these formats, so you 
do not necessarily have to be using Lotus or dBASE in order to 
import information into GeoFile. When you import dBASE and 
CSV files, you can change the order of the columns that you 
import. 

To import from another application (Levels 2-4) 

1. Choose Switch Document from the File menu. A dialog box 
appears. 



For information 
about using the 
standard file selector 
options, see 
Chapter 1. 

Mapping slows down 
the import procedure 
considerably, so it 
may not be 
convenient to use 
when importing 
large files. 

2. Tap Import. Another dialog box appears: 

Fields in Database 

C~1storncr

Date 
Qty 

Add button 

Custorner 

Date 

Sort Direction: ~ Sort Key Priority: 

.---------sort Options--------t---+o 

o Ignore !;ase/Accents 

Notes: 

Promote Demote 

3. Use the file selector to find the file you want to import. Also, you 
can change any of the following options: 

Formats. Select the format of the document that you want to 
import. 

File Mask. This box displays the file extension for the selected 
format. For example, if you select dBASE, .DBF appears as the 
extension, and only files with that extension will appear. 

Map Import Fields. Use this button to specify the order and 
number of imported fields. 

4. Tap Import. A message informs you that importing is in progress. 
When the process is complete, GeoFile opens an untitled 
document containing the fields and data that you have imported. 
You can name and save this document for later use. 

To map fields for importing (Levels 2-4) 

When you import data in dBASE or CSV format, GeoFile imports 
data in the order in which they appear in the source file. You can 
map the fields you are importing to change their order, if you 
choose. 

1. Choose Switch Document from the File menu. A dialog box 
appears. 
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2. Tap Import in the New/Open dialog box. Another dialog box 
appears. 

3. Select CSV, dBASE II, or dBASE IV from the Formats list. The Map 
Import Fields button activates. 

4. Select a file using the file selector. 



Creating a GeoFile Database 

This section describes how to use the design and layout features at 
Levels 3 and 4 to create a new GeoFile database. It covers the 
process and tasks involved in designing, rather than entering data 
into a GeoFile database. For more information about entering and 
retrieving data using a GeoFile database, see "GeoFile Basics" and 
"Using a GeoFile Database" in this chapter. 

ADVANCING TO LEVELS 3 AND 4 

'[J" ... ,,,. 
.,,. .... 
/ ' 

Advancing to Levels 3 and 4 gives you the tools you need to create 
a new GeoFile database and customize it by adding fields, layouts, 
graphics, and formatting. 

What You Get at Level 3 

If you choose to create a new empty document (as indicated by 
the icon shown at left) from the New/Open dialog box, GeoFile 
asks you first to name the document. Then GeoFile automatically 
puts you into design mode and prompts you to create a new field. 
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At Level 3, in design mode, GeoFile looks like this: 

Tool Bar: Clipboard Tools and Text Tools 

Graphics Tools \ Field Organizer dialog box 

file !;dit !,!iew Qptions !,ayout Q aphics !'roperties 

Fields Not in Current Layout Fields in Current Layout 

Please enter a field name. Every field you ~ 
define should have a unique name. You 
can use this name later to refer to this 

L'.::::========~~fi~el=d~·~~;::====f===============~ 

Data Entry Mode Button 

Design Mode Button 

top creating [TI 

Create New Field dialog box 

In design mode at Level 3, you can create new layouts to display 
information in a different form; for more information, see 
"Creating Additional Layouts" in this chapter. You can use the 
graphics tools to add text and graphic objects to a layout; for more 
information, see "Using Graphics" in this chapter. You can use the 
text attributes tools to change the way text looks on the layout; for 
more information, see "Formatting Text" in this chapter. 

In data entry mode, you have access to all the advanced data entry 
features described in this chapter, with the exception of multi
record capabilities. 



~ 
Multi-Record 

At Level 3, in data entry mode, GeoFile looks like this: 

B GeoF1le - Sales lnfo1 1nat1on ··~ 
file _!;dit ~iew Qptions !::ayout _t1ark Qata 

Name: @arryWestin9;ton 

Address: 136890 Parknver Lane, Ch1caAO, IL 60610 

Phone: (312) 763-2975 

Fax: (312) 763-2987 

Recore! Control Panel - lnfor rnat1on Car cl 

~ 
Design 

Record: DB of 15 

i Tap this button to store 
I and retrieve data. 

Tap this button to use 
database design tools. 

What You Get at Level 4 

D ./o;J 

The GeoFile window at Level 4 appears the same as at Level 3, 
with the addition of the Single-Record and Multi-Record buttons. 

The Multi-Record button changes GeoFile to multi-record mode so 
that you can put multiple records on a layout. For more 
information, see "Using Multiple Records on a Layout" in this 
chapter. 

In addition, you can use graphic styles and text styles to format 
graphic and text objects, respectively. For more information, see 
"Formatting Text" and "Using Graphics" in this chapter. 
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At Level 4, the Create New Field dialog box has additional options: 

cr-eate New Frelcl 

Field Name: lmm!!!ll 
::=========:=;-~~~~---' 

Field Type: I General/Text -I 
Field Attributes 

Set Field Notes ... 

Set Default ... 

Data Attributes 

Length: BB 
Min: 

Max: 

I _!;;reate I I ~top Creating I 

You can specify the data type for a field. You can also define field 
and data attributes, including field notes, default values or 
expressions, the field length for text fields, and minimum or 
maximum values for number fields. 

In data entry mode, you have access to all the advanced data entry 
features described in "Using a GeoFile Database." 

At Level 4, in data entry mode, GeoFile looks like this: 

file J;dit .\!iew Qptions J,ayout J:'.!ark Qata 

Name: FrrvW@stinP,;tot'i 

Addrea: p6B90 Parkriver Lane, ChicAAo, IL 60610 

Phone: F312) 763--2975 

Fax: K312) 763-2987 

- _lRecord Control Panel - Information Card 

D!J[IJITJ[]J D,/m 

Record: DB of 15 

l:1::iJ i '~J i•iii~J l~J l?J 

Tap this button to display 
one record at a time. 

? 

H~d 

Tap this button to display 
multiple records on a screen 

and on a printed page. 



CHOOSING A WORK MODE 

LEVELS 3-4 

~ 
Design 

Llih;J 
Data Entry 

GeoFile has two modes at Levels 3 and 4. In design mode, you can 
design a GeoFile database. In data entry mode, you can add, 
modify, and search for records in a GeoFile database. You can 
switch between modes easily. 

If you create a new GeoFile database, GeoFile goes into design 
mode automatically and prompts you to create a new field. If you 
open an existing GeoFile database, GeoFile goes into the mode 
you were using when you last saved the file. 

To switch to design mode (Levels 3-4) 

• Tap the Design button. GeoFile switches to design mode and 
displays the Field Organizer, which is the command center for 
managing fields in a database and on a layout: 

1:1 Field 01·gan1ze1· - lnfonnat1on Carel 

Fields Not in Current Layout 

~Ii 
Fields in current Layout 

Address ~ 
Fax 
Name 
Phone 

If no fields appear in the database, GeoFile automatically prompts 
you to create new fields. For more information, see "Using the 
Field Organizer" in this chapter. 

To switch to data entry mode (Levels 3-4) 

• Tap the Data Entry button. GeoFile switches to data entry mode 
and displays the Record Control Panel. 

For more information about working in data entry mode, see 
"GeoFile Basics" and "Using a GeoFile Database" in this chapter. 
For more information about the Record Control Panel, see 
"GeoFile Basics" in this chapter. 
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WORKING IN MUL Tl-RECORD MODE 

LEVEL 4 

7.32 GEOFILE 

At Level 4, you have the choice of working in single-record mode 
or in multi-record mode. In single-record mode, GeoFile displays 
one record at a time on your screen, just as it does at Levels 1-3, 
and prints one record on every page. In multi-record mode, 
GeoFile displays as many records as can fit on the current layout, 
and prints as many records as can fit on the current layout on 
every page. 

To work in multi-record mode (Level 4) 

• Tap Multi-Record to display as many records as possible on the 
current layout. This action puts GeoFile in multi-record mode. 

l:IE:i GeoF1le - Customer Orcler-s maim 
Eile J::dit _\/iew Qptions bayout tiark Qata 

("'-----------------------------------------------------------------------1 
: Date: j12/15/92 [ Name fBc Company I Qty: E=:J : 
L-----------------------------------------------------------------------L 

Date: 112/16/92 I Name fBC Company Qty: c::::J 
Date: ~ Name frsBurgers Qty: ~ 

Date: ommTech Qty: EJ 
ty: ~ 

D ./.., 
Date: 

Date: 

Record: DB of 6 

ty: ~ 

~ 
Single-Record 

When you work in multi-record mode, you can edit data in any of 
the records appearing on your screen. Select the field that contains 
the data you want to modify, and use any of the standard GEOS 
editing techniques to change the data. 



When you use the New Record button to add a new record to the 
database, GeoFile displays a set of blank fields to receive your data 
in the position of the next record on the current layout. 

l:IEJ C.eoFlle - Customer Ot cler·s oa~ 
file f;dit !,!iew Qptions 1=ayout tiark Qata 

Date: 11 21 1s192 I 
Date: 112116/92 1 

Date: ~ 
Date: 11211s192 I 
Date: 11 21 11192 I Na.me F'ecords Mania 

Date: 112121192 1 Name e'ecords Mania 

Qty:~ 

Qty:~ 
r-----------------------------------------------------------------------, 
' r---i· ,--, ' : Date: j____j Name Qty: L___J : 

L-----------------------------------------------------------------------l 

If the current layout is full, a new and empty layout page appears. 
You enter data in the position of the first record on the empty 
layout. 

l:IEJ C.eoF1le - Customer Ot tlet s oa~ 
file f;dit !,!iew Qptions 1=ayout tiark Qata 

' r-----1 ,--, ' : Date: j____j Name Qty: L___J : 

L-----------------------------------------------------------------------1 

Reco1 cl Contt ol Panel - Layout 1 

D ./151 

Record: I New I B of 2 1 

~ 
Single-Record 

All of the standard GeoFile data entry features operate normally in 
both single- and multi-record modes. 
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For information about designing multi-record layouts, see "Using 
Multiple Records on a Layout" in this chapter. For information 
about switching layouts, see "Switching Layouts" in this chapter. 

PLANNING A DATABASE 

LEVELS 3-4 

7.34 GEOFILE 

Before you design a database, you should understand basic 
database concepts and design principles. For an introduction to 
database concepts, see "GeoFile Basics" in this chapter. 

When planning a database, you should think about the nature of 
the information you want to track. Consider the following 
questions: 

• What is the scope of the information? For example, to keep 
track of customers, you would include pertinent data about 
each customer, such as address, phone number, contact person, 
and so on. 

• Within this scope, what are the entries involved? For example, 
in a customer database, each customer is a separate entry (or 
record) in the database. 

• What do you need to know about each entity or activity? List 
the pieces of information (or fields) you want to use. For 
example, for each customer you could include the following 
facts: customer identification code, address, main phone 
number, the names of people you work with in the company, 
account number, and sales to date. 

• Is there an existing GeoFile template or database that you could 
use instead of starting from scratch? If so, you can save design 
and layout time. 

At Level 4, you should consider the following additional questions: 

• Do you need to use the same information for different 
purposes? Will you need to create additional layouts? For 
example, in a customer database, you might want to have 
different layouts for entering data, retrieving a phone list, a'nd 
printing mailing labels. 

• Which field type should you use? For example, a street address 
is probably a text field, while the customer identification 
number is likely an integer field, and sales to date a real number 
field. 



• Will any field contain special default data? For example, if most 
or all of the customers reside in the same state, you could make 
that state the default. 

• Will text fields have a maximum length? For example, a state 
abbreviation field requires no more than two characters. 

• Will number fields have a minimum or maximum value? For 
example, you might rank your customers on a scale from 1 to 
10. 

• What calculations will you need in computed fields? For 
example, if you want to calculate the average sales revenue per 
sale, you divide the sales to date by the number of sales. 

When you are finished, you might end up with a schematic like 
this: 

FIELD NAME 

Customer_ID 

Customer_Name 

Address 

City 

State 

Zip 

Account_Number 

Contact 

Phone 

Sales_to_Date 

Number_of_Sales 

Average_Per_Sale 

Create_Date 

Create_Time 

Customer_Rating 

TYPE 

Text 

Text 

Text 

Text 

Text 

Text 

Text 

Text 

Text 

Real Number 

Integer 

Computed 

Date 

Time 

Integer 

ADDITIONAL PROPERTIES 

Size is 2; default value is CA 

Size is 10 

Formula is Sales_to_Date I 
Number_of_Sales 

Min = 1, Max = 10 

Once you have planned the database, you can create it in GeoFile. 
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'[]]' .. ... 
"" .. , ' 

To create a new GeoFile database, you have three options: 

• You can start from scratch using a blank document with no 
fields; you must create the fields and any additional layouts 
yourself. To do this, tap the New Document icon in the 
New/Open dialog box. For more information, see Chapter 1. 

• You can use a GeoFile template as a starting point to save time 
creating, laying out, and formatting the database. To do this, tap 
the Template Document icon in the New/Open dialog box. For 
more information about using a template, see "GeoFile Basics" 
in this chapter. 

• You can use an existing document and save it under a qifferent 
name. This also saves time creating, laying out, and formatting 
the database, although you might need to delete any existing 
data in the database. To do this, tap the Open Document icon 
in the New/Open dialog box. For more information on using an 
existing document, see "GeoFile Basics" in this chapter. 

USING THE FIELD ORGANIZER 

LEVELS 3-4 

7.36 GEOFILE 

In design mode, GeoFile displays the Field Organizer, which is the 
central command center for designing fields in a database. You 
can use it to add fields to and remove fields from the database as 
well as the current layout. 

What the Field Organizer Contains 

Here is an example of a Field Organizer: 

1:1 F1elct 01'garnze1, - Layout 1 

Fields Not in Current Layout 

Average_Per _Sale 
Customer _Rating 
Number _of_Sales 
Sales_to_Date 

Notes: 

~ 
Fields in Current Layout 

.~l:l:D~0lt~l-l;l~ml_l1~111111111 .. ~ 
Phone 
State 

I _!;;reate New Fields I I J;;dit This Field I 



The Field Organizer contains the following elements: 

Fields Not in Current Layout. This list contains the fields that do 
not appear on the current layout. A field can appear on other 
layouts, however. For more information, see "Arranging Fields" in 
this chapter. 

Fields in Current Layout. This list contains the fields that appear 
on the current layout. A field can appear only once on a layout, 
though it can appear on more than one layout. 

Add button. Tap this button to add a selected field from the 
Fields Not in Current Layout list to the current layout. 

Remove button. Tap this button to remove a selected field from 
the Fields in Current Layout list. 

Notes. This box displays the notes for the selected field. For more 
information, see "Changing Field Notes" in this chapter. 

Create New Fields button. Tap to create a new field in the 
database. 

Edit This Field button. Tap this button to edit a field definition 
in the database. 

Delete This Field button. Tap this button to delete a field from 
the database and remove it from any layouts on which it appears. 

For more information on the Create New Fields, Edit This Field, 
and Delete This Field buttons, see "Managing Fields in a Database" 
in this chapter. For more information about the Add and Remove 
buttons, see "Adding and Removing Fields on a Layout" in this 
chapter. 

Moving the Field Organizer 

The Field Organizer may cover up fields on the layout page that 
you want to work with. You can move the field organizer by 
dragging it with the pen, so that you can see the entire layout 
page. 

Closing the Field Organizer 

When in design mode, you cannot close the Field Organizer. 
GeoFile closes it automatically when you switch to data entry 
mode. For more information, see "Choosing a Work Mode" in this 
chapter. 
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This section describes how to create, change, and delete fields in a 
database using the Field Organizer. 

For information about adding and removing fields on a layout, see 
"Adding and Removing Fields on a Layout" in this chapter. 

Creating a Field 

You can create new fields in a database. At Level 3, you can define 
field names. At Level 4, you can also define field types, field 
attributes, and data attributes. 

Once you have added a field, you can change its number 
formatting; for more information, see "Using Field Number 
Formats" in this chapter. You can also change a field's text 
formatting and location on a layout; for more information, see 
"Formatting a Layout" in this chapter. 

PARTS OF A FIELD 

A field has two parts. The data entry area is where, in data entry 
mode, the user enters and sees the contents of the field for a 
particular record. The field label appears next to the data entry 
area and describes the field to the user. The following example 
shows these two parts of a field: 

Name: ~ast Name---+-- Data Entry Area 

I Field Label 

The field edges define the boundaries of the data entry area; for 
more information, see "Showing and Hiding Field Edges" in this 
chapter. 

When you add a field, GeoFile uses the field name for both the 
field label and the data entry area. The field name does not appear 
in the data entry area in data entry mode. Instead, the field label 
identifies the contents of the field to the user. 

In the previous example, the designer has changed the field label 
to make the name more descriptive. The field label is optional 
descriptive text that you can delete if you want. For more 
information, see "Changing Field Labels" in this chapter. 



CREATING A FIELD AT LEVEL 3 

At Level 3, you can add new fields to a layout. 

To create a new field (Level 3) 

1. Tap Create New Fields in the Field Organizer dialog box. A dialog 
box appears. When you create a new blank database with no 
fields, GeoFile displays this dialog box automatically. 

Create New F1elcl 

Please enter a field name. Every field you ~ 
define should have a unique name. You 
can use this name later to refer to this 
field. 

Field Name: lmm!IJ I 
I ~reate I I ~top Creating I [TI 

2. Enter a field name. A field name can consist of any combination of 
letters, numbers, and underscores, up to 40 characters. GeoFile 
does not permit spaces in field names; if you enter a space, 
GeoFile converts it to underscore automatically. 

The name you use must be unique in a database; you cannot have 
the same name for two different fields. Names are not case
sensitive; for example, "Social_Security _Number" and 
"social_security _number" are the same name to GeoFile. 

The name of a field should describe its contents; for example, you 
could use "Employee_Salary" to name a field that contains the 
salary of an employee . 

. 3. Tap Create. GeoFile creates the field in the database and adds the 
field and its field label to the current layout page, as in the 
following example. The field label is optional; you can change or 
delete it as necessary. 

Imp loy e e _Salary:~ ~-m_p_lo_v_e_e_S_a_lar_Y_-.::_-.::_-.::_-=:c--- Data Entry Area 

i Field Label 

GeoFile places the new field below the previous field, if any, on 
the layout page. If the number of fields on the layout exceeds the 
length of the page, GeoFile increases the page size automatically. 

4. Tap Stop Creating when you finish adding all the fields on the 
layout. The Create New Field dialog box closes. 
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CREATING A FIELD AT LEVEL 4 

At Level 4, you can define additional field attributes, such as field 
type, field notes, default values, expressions, field length, and 
minimum and maximum values. 

When defining fields, you can use any of the following GeoFile 
field types: 

General/Text. This field type can contain any combination of 
keyboard characters: letters, numbers, punctuation, spaces, and so 
on (such as "123 Main Street"). By default, general/text values can 
be as large as 511 characters. 

Integer. This field type can contain numbers, such as 
7, 12, 365, and so on, but does not display fractional portions 
(numbers to the right of the decimal point). 

Real Number. This field type can contain numbers with fractional 
portions (including currency values), such as 
98.6, 2.17182, 3.14159, and so on. 

Date. This field type can contain date values, ranging from Jan 1, 
1900 through Dec 31, 2099. 

Time. This field type can contain time values, ranging from 
12:00:00 AM to 11:59:59 PM, within the valid date range. 

Computed. This field type can contain an expression that GeoFile 
computes during data entry when a user adds or edits a record, 
such as "Sales_to_Date + Number_of_Sales." 

In general, use the integer or real number field type for numbers 
involving mathematical calculations. For example, a 
Number_of_Sales field and a Sales_to_Date field would be integer 
or real number fields, so you can use them to calculate the 
Average_Per_Sale field. Integer and real number fields can contain 
values between 10-4932 and 10+4932. All numbers and calculations 
are accurate to 15 decimal places. Even when GeoFile rounds off a 
number to less than 15 decimal places, it uses all 15 decimal places 
in calculations. 

You can use general/text fields for numbers that are not used in 
calculations, including numbers that contain other characters (such 
as phone numbers). 

The following procedure describes the basic steps for creating and 
defining a field at Level 4. 



When you enter a 
~pace, GeoFile inserts 
an underscore 
automatically. 

To create a newfield (Level 4) 

1. Tap Create New Fields in the Field Organizer dialog box. A dialog 
box appears: 

cr·eate New Field 

Field Name: lmm!!IJ 
~==========:::;-~~~~~~ 

Field Type: I General/Text -I 
Field Attributes 

Set Field Notes ... 

Set Default... 

Data Attributes 

Length: BB 
Min: 

Max, 

l~reate I I ~top Creating I 

When you create a new blank database with no fields, GeoFile 
displays this dialog box automatically. 

2. Complete the dialog box, selecting the options you want. 

Field Name. Type a field name. A field name can be any 
combination of letters, numbers, and underscores, up to 40 
characters. 

The name you use must be unique in a database; you cannot have 
the same name for two different fields. Names are not case
sensitive; for example, "Address" and "address" are the same name 
to GeoFile. 

The name of a field should describe its contents; for example, you 
could use "Employee_Salary" to name a field that contains the 
salary of an employee. 

Field Type. This option sets the field type. Select a field type from 
the list. 

Set Field Notes. This field attribute sets the notes associated with 
the field. You can enter up to 256 characters in this field. For 
example, you might enter something like this: "This field is a real 
number that contains the employee's salary information and 
currency formatting." For instructions on setting Field Notes, see 
"Changing Field Notes" in this chapter. 

Set Default (or Set Expression for computed fields). This field 
attribute sets the default or the expression for the field. For 
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If a user enters data 
that are out of range, 
an error message 
appears. 

LEVEL 4 
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instructions on setting the default or expression, see "Using Field 
Expressions" in this chapter. 

Length. This data attribute sets the length of a generaVtext field. 
By default, the length is 511 characters, the maximum length for a 
generaVtext field. Reduce this setting if you do not want the text 
field to exceed a certain length (such as a zip code field or a state 
abbreviation field). All other field types have no default length. 

Min. This data attribute sets the minimum allowable value for a 
real number, integer, date, or time field. 

Max. This data attribute sets the maximum allowable value for a 
real number, integer, date, or time field. 

3. Tap Create to create the field using the options you have selected. 
GeoFile creates the field in the database and adds the field and its 
field label to the current layout page. 

GeoFile places the new field below the previous field, if any, on 
the layout page. If the number of fields on the layout exceeds the 
length of the page, GeoFile increases the page size automatically. 

4. Tap Stop Creating when you finish adding all the fields on the 
form. The Create New Field dialog box closes. 

Changing Field Notes 

You can add notes to a field as a reminder of what the field 
contains when you select it in the Field Organizer. For example, 
you could describe the purpose of a field by entering, "This field 
contains the customer name." 

To change field notes (Level 4) 

1. Select the field you want to change from the Field Organizer. 

2. Tap Edit This Field in the Field Organizer. A dialog box appears. 

3. Tap Set Field Notes. A dialog box appears: 

Set F1elcl Notes 

This field contains the customer name. 

I Cancel I 

Enter or edit the field 
notes in the Notes box. 



LEVELS 3-4 

4. Enter or edit the field notes in the Notes box. You can enter up to 
255 characters. 

5. Tap OK. The dialog box closes. GeoFile saves your changes. You 
will see these notes the next time you select the field in the Field 
Organizer dialog box, as in this example: 

F1elcl Organizer - Layout 1 

Fields Not in Current Layout 

~Y~ti:l9~""~~r:""?~.1.~ .. 
customer _Rating 
Number _of_Sales 
Sales_to_Date 

.......... ~ 
Fields in Current Layout 

a~m:m:~~l~l~l;!~l:E1~mllll!llllll·~ 
Phone 
State 

Notes: This field contains the customer name. 

I _!;;reate New Fields I I ~dit This Field I ! pe!ete ;;:;1;~ii~;i~iJ [2J 

Changing a Field Definition 

Once you have added a field, you can go back and change its 
definition. At Level 3, you can change its field name; at Level 4, 
you can change its field type, field length, field attributes, and data 
attributes. 

When you change a field definition, the changes affect the field 
wherever it appears in the GeoFile database; if the field appears in 
multiple layouts, GeoFile updates your changes on everyiayout on 
which the field appears. 

CHANGING FIEIDS AT LEVEL 3 

You can change the name of a field. You may want to make it 
more descriptive of the information the field will contain, or you 
may want to make it more consistent with other field names. 

To change the name of a field (Level 3) 

1. Select a field from the Field Organizer. You can select a field 
whether it appears on the current layout or not. 
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2. Tap Edit This Field on the Field Organizer. A dialog box appears: 

Edit a Field 

Field Name: !customer _Name 

I Apply I I Reset I I Close I [!] 

3. Enter a new name in the Field Name box. 

4. Tap Apply. GeoFile assigns the new name to the selected field and 
to its field label. 

5. Tap Close to close the dialog box. 

CHANGING FIEIDS AT LEVEL 4 

At Level 4, you can change additional field attributes such as the 
field type, field length, field notes, minimum and maximum 
values, defaults, and expressions. This procedure describes the 
basic steps for changing a field at Level 4. 

To change the field definition (Level 4) 

1. Select a field from the Field Organizer. You can select a field 
whether it appears on the current layout or not. 

2. Tap Edit This Field in the Field Organizer. A dialog box appears: 

1:11 Ecllt a F1elcf 

Field Name: !customer _Name 

Field Type: I General/Text -I 
Field Attributes 

I set Field Notes ... I 

Set Default ... 

! nppl\J 

Data Attributes 

Length: BB 

3. Complete the dialog box, selecting the options you want. 

WARNING 
If you change the field type in a database that has existing data, a 
warning message appears indicating that GeoFile will convert the 
data if possible, but that if conversion fails, GeoFile will erase the 
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data. If you tap OK, GeoFile attempts to convert the data to the 
new data type. However, certain kinds of information may not 
convert. For example, if you change a general/text field to an 
Integer field, data with alphabetic characters do not convert; 
GeoFile erases the data and puts an error in the field instead. 

4. Tap Apply. GeoFile applies the changes to the selected field. 

5. Tap Close to close the dialog box. 

Deleting a Field 

You can delete a field you no longer need from the database. 
Deleting a field from the database removes it from the database, 
including any layout on which it appears, and erases any data that 
it contains. 

Deleting a field from the database differs from removing a field 
from the current layout. For more information, see "Adding and 
Removing Fields on a Layout" in this chapter. 

NOTE 
You cannot delete a field while an expression in another field 
refers to it. For example, if the expression in a Monthly_Salary field 
depends on the Salary field for data, GeoFile will not let you delete 
the Salary field until you have removed the reference to it in the 
Monthly_Salary field. 

Similarly, you cannot delete a field if it appears on the current 
layout. You must first remove it from the current layout. Select the 
field you want to delete, then tap the Remove button in the Field 
Organizer to remove it from the current layout. 

To delete a field (Levels 3-4) 

1. Select a field from the Fields Not in Current Layout list in the Field 
Organizer. You cannot select a field that appears on the current 
layout. 

2. Tap Delete This Field in the Field Organizer. A confirmation 
message appears. 

WARNING 

Once you delete a field, you cannot recover any data that it 
contains. The only way to regain the data is to revert to the last 
saved version of the database by choosing Discard Changes from 
the Other choice on the File menu. For more information, see 
Chapter 3. 
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3. Tap Yes. GeoFile deletes the selected field from any layout on 
which it appears. Doing this eliminates any data stored in this 
field. 

USING FIELD NUMBER FORMATS 

LEVELS 3-4 
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GeoFile provides many ways to display numbers, dates, and times. 
For example, you can display a number with commas (98,765), 
without commas (9876), as currency ($98.77), or as a percent 
(98.8%). You can also create custom formats for special needs. The 
format you use depends on the way you want to display 
information. 

You can set date and time formats as well. Dates are actually 
stored as serial numbers representing the number of days since 
January 1, 1900. Therefore, January 1, 1993 equals 33969. Time 
values are the fractional portion of date serial numbers; for 
example, a date value of 33969.25 is actually January 1, 1993, at 
6:00 AM (the fractional portion represents a percentage of the 24-
hour clock). However, in data entry mode, the user enters dates 
and times in the usual manner, such as "Jan 12, 1994" or "12:35 
PM". 

You can use these formats for any field including (at Level 4) 
general/text fields. At Level 4, each format works for all field 
types, although you might want to use a format that applies to the 
field type you have defined: number formats for integer and real 
number fields, date formats for date fields, and time formats for 
time fields. For computed fields, use the format that corresponds 
to the result; for example, if the result of a computed field is an 
integer, use a number format. 

Available Formats 

GeoFile provides a variety of number, date, and time formats. 
These formats are the same as those available in GeoCalc. For 
more information, see Chapter 6 for tables showing number, date, 
and time formats and for procedures used for changing field 
number formats and creating custom field number formats. 



USING FIELD EXPRESSIONS 

LEVEL 4 

In GeoCalc, you 
normally precede an 
expression with an 
equal sign ( = ); you 
do not do this in 
GeoFile. 

You can use field expressions to calculate defaults and current 
values for fields in a layout. 

An expression is a formula that can include field names, functions, 
math operators, logical operators, numbers, and strings. For 
example, the following expression contains fields, math operators 
( + and + ), and a function (TRUNC): 

Field_l + TRUNC(Field_2 + Field_3) 

In general, for computed fields, avoid using date and time fields 
(stored as serial numbers) in combination with other data types. 
However, you can still perform basic operations on date or time 
values, such as subtracting one date from each another or 
calculating times. 

You can add default values and expressions to fields. For more 
information about expressions, see "Using Field Expressions" in 
this chapter, and see Appendix B. 

GeoFile uses many of the same functions and operators that 
GeoCalc uses. However, not all GeoCalc functions apply to 
GeoFile. GeoFile supports all GeoCalc functions except the 
following: COLS, FILENAME, HLOOKUP, INDEX, IRR, N, NPV, 
PAGE, PAGES, ROWS, and VLOOKUP. Avoid using unsupported 
functions in GeoFile. 

Because GeoCalc supports all the GeoFile functions, you can use 
GeoCalc to test your formulas before putting them in a GeoFile 
database. Doing this can save time as you verify your formulas. 

GeoFile evaluates field expressions according to the alphabetical 
order of field names. Therefore, in your expression, you can refer 
only to field names that precede the current field name 
alphabetically. 

Using Default Values 

Geo File calculates a def a ult value when it creates a new record in 
the database in data entry mode. For example, you can have 
GeoFile put the default area code 510 in a Phone_Number field 
using the following simple expression: 510. Similarly, you could 
have a Date_Created field using the function TODAY to save the 
record creation date in the record. 
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For default values, you can even rely on the default value of 
another field in the new record. For example, you can calculate a 
Date_Payment_Due field using the following expression: 

Date_Ordered + 30 

NOTE 

The expression in the previous example works because 
Date_Ordered comes before Date_Payment_Due in alphabetical 
order. Referring to a field named Date_Shipped, however, would 
not work; you would need to rename the field to use it in the 
formula. 

Using Computed Values 

GeoFile calculates a computed value field whenever it creates a 
new record in the database or when an element in the expression 
changes in data entry mode. 

For example, you can specify the following formula in a field 
called Average_Per_Sale: 

Sales_to_Date + Number_of_Sales 

GeoFile recalculates Average_Per_Sale whenever the value 
changes in the Sales_to_Date field or in the Number_of_Sales field. 

Changing Defaults and·Field Expressions 

Use the following procedure to change a field's default or field 
expression. 

To change defaults and field expressions (Level 4) 

1. Select a field from the Field Organizer. 

2. Tap Edit This Field in the Field Organizer. A dialog box appears. 



3. Tap Set Default. A dialog box appears: 

Expression Box 

Create a default expression. 

ABS 
ACOS 
ACOSH 
AND 

ate a default expres 

Field Names 

I Cancel I 

Math Operators 

Logical Operators 

Field Functions 

4. Complete the dialog box, selecting the options you want. 

Field Names. This option lists all the field names in the GeoFile 
database. Selecting a field name pastes it at the insertion point in 
the Expression box. 

Functions. This option lists all the GeoFile functions you can use. 
Selecting a function pastes it at the insertion point in the 
Expression box. . 

Math. This option lists all the GeoFile math operators you can use. 
Selecting an operator pastes it at the insertion point in the 
Expression box. 

Logic. This option lists all the GeoFile logical operators you can 
use. Selecting an operator pastes it at the insertion point in the 
Expression box. 

For a list of GeoFile functions, math operators, and logical 
operators, see Appendix B. 

5. Tap OK. GeoFile checks the syntax of the expression you have 
entered. If the syntax passes, the dialog box closes. 

If GeoFile detects a syntax error, it displays an error box and 
highlights a problem in the Expression box. Tap OK and resume 
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editing the expression until the syntax passes. The dialog box 
closes. 

FORMATTING A LAYOUT 

LEVELS 3-4 
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The way you format a layout can affect how easily you or others 
can enter, search for, or print information. This section describes 
general design principles for creating a layout, and then explains 
how to use GeoFile's text and graphics features to make your 
layout more visually appealing and useful. 

Planning a Layout 

Designing a layout page is an art that relies on how well you 
understand the nature of the information in the database, how you 
plan to use the information, and what you think is visually 
attractive. Basic design principles can help you design a better 
layout. You might want to start by sketching your ideas on paper. 

You can create a layout from scratch, or you can start with a 
template or another document and adapt it as necessary. For more 
information, see "GeoFile Basics." You can use the clipboard to 
copy fields and other objects between layouts in a database. 
However, you cannot copy fields between databases; each 
database is a separate file, and field definitions differ between 
files. 

You can organize fields into groups or categories. Consider the 
nature of the information in a database. Which fields belong 
together in a group? Which fields or groups should be distinct from 
each other? For example, in a customer database, you might put 
address information, contact information, and financial 
information into separate groups. 

Your design should enhance the way you plan to use the layout. 
For example, if you are designing a data entry layout, you might 
consider ways to make it easier and faster to enter the data: 
arranging the fields in the order in which they appear on paper, 
putting the fields most likely to contain data ahead of those most 
likely to remain empty, and so on. Remember that your eye 
normally travels across a sheet of paper or a screen from left to 
right and from top to bottom. 

How much information do you really need on this layout? Can you 
eliminate fields that are not necessary? For example, if you are 



designing a layout for finding customer phone numbers, you might 
include names and phone numbers but omit addresses and 
financial information to reduce clutter. 

How can you use graphics and text formatting to enhance the 
similarities and contrasts among fields and groups of fields? For 
example, you might put a box around each group of fields, put 
lines between groups, make groups different colors (if you have a 
color printer), use white space, and so on. 

Do you want to make a field or a group of fields stand out? You 
can use colors (if you have a color printer) for highlighting, or you 
can place the field or group in a prominent position on the layout. 
You can also increase the font size of the text, or even put in a line 
with an arrowhead pointing to a particular field. 

Aligning fields can make it easy to scan the information on a 
layout. Similarly, distributing fields evenly across the layout, rather 
than clustering them in a small area, can give the layout a sense of 
balance and proportion. 
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Remember that you want to use visual cues to enhance the clarity 
of the data on the layout, but not to overwhelm the reader with 
too much information. You must use your judgment to determine 
what looks best. Incorporating these aesthetic touches may seem 
subtle on the surface, but their value and importance increase 
every time anyone uses a layout you have designed. 

Distinct groups contrast 
with each other. 

The field order makes 
it easy to enter data. 

-"£ 
file f;dit ~iew 

Income Information a Tax Calculation Database 
This is an':'!xampl.;, of a databas which can help you calculate the iru::ome tax liability for several peoJJle 
(th& i5 o:nly a -IDple; ... not :i;e it to wJuilillt"' 11u:twl tax amounts)_ Yoll. only w:ed to enter- the infor
mation in the data fields with bl k outlines. The Tax Rate, Annual Income Tax, Taki;, Home Fay, and 
Semi-Mcmthly Payd1eckamo O't.i$hlighted with red outlines) will be cakulared automatically, and the 
date and time on which the reco was entered will be added .a.utoma.tically as well 

Fields are aligned vertically. 

Graphics and text enhance 
similarity and contrast. 

Changing Field Labels 

Related fields appear 
visually as a group. 

A field has two parts: the field label and the data entry area. You 
can change the text of a field label, or you can delete a field label 
altogether. Field labels are text objects that you can manipulate as 
you would any text object. For more information on working with 
text objects, see Chapter 8. 

CHANGING THE TEXT 

When you add a field to a database, GeoFile automatically uses 
the name of the field as its field label. You might want to give it a 
different field label, however, to make it more descriptive or more 
visually appealing. For example, if a field is named Work_Phone, 
you might want to make the field label "Work Phone" instead. 
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To change the font, size, or other character attributes of a text 
label, see "Formatting Text" in this chapter. 

To change the text of a field label (Levels 3-4) 

1. Select the Text tool from the tool bar. 

2. Tap to select the field label you want to change. An outline 
appears around the field label, and the insertion point appears 
inside the outline. 

3. Edit the text of the field label. 

DELETING A FIEID LABEL 

You might want to remove the field label altogether if it clutters 
your layout. For example, you might not want individual field 
labels for First_Name, Middle_Initial, and Last_Name fields; you 
might instead want to have just one label, "Name," for all three 
fields. 

To delete a field label (Levels 3-4) 

1. Select the Arrow tool from the tool bar, if it is not already selected. 

2. Tap the field label you want to delete. Handles appear around the 
field. 

3. Choose Delete from the Edit menu. 

or 

Press the Delete key. 

Either way, GeoFile deletes the field label you selected. 

COPYING, CUTTING, AND PASTING USING THE CLIPBOARD 

You can also cut, copy, and paste field labels using the clipboard. 
For more information, see Chapter 1. 

Arranging Fields 

Like a text or graphic object, any field on a layout can be moved 
and resized. You can also align or distribute fields to add 
proportion and balance to your layout. 

SELECTING, MOVING OR RESIZING A FIEID 

To move or resize a field, you must first select it using the Arrow 
tool. For more information about procedures for using the 
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Graphics menu and Graphics tools, see Chapter 8 and "Designing 
Geo Write Documents" in Chapter 5. 

When you resize a field, you can change the positions of field 
edges so that the field fits better on a layout. Changing the field 
edges does not change the amount of information that the field 
can contain; it only changes the way the information appears on 
the layout. 

ALIGNING AND DISTRIBUTING FIEIDS 

You can arrange fields so that they line up with each other 
(aligning) or so that they are equidistant from each other 
(distributing). Doing so makes your layout more readable and 
more visually appealing. You can align and distribute fields along 
their top, bottom, left, or right edges; by width or height; or along 
their vertical or horizontal axes. , 

For more information, see Chapter 8. Note that in GeoFile, the 
Arrange option appears as a submenu under the Graphics menu. 

Setting the Field Order 

For data entry layouts, you can set the sequence by which you can 
move from field to field (after pressing Tab or Enter). By default, 
GeoFile uses the order in which you created the fields. You might 
want to change this if a more natural data entry sequence emerges 
as you use the database. 



LEVEL 4 

To set the field tab order (Levels 3-4) 

1. Choose Set Field Tab Order from the Layout menu. A dialog box 
appears: 

F1elcl Tai) Onler, 

Fields in Database: 

Custorner'_ID 

Customer _l'lamE 
Address 
City 
State 
Zip 
Account_l'lumbe 
Contact 

Field Order Priority: 

l[_q:@ I Reset I Cancel 

Lists fields in the current 
data entry sequence. 

Moves the selected field down 
the sequence. 

Moves the selected field up the sequence. 

2. Select the field you want to move from the Fields in Database list. 

3. Tap the Up button. GeoFile moves the selected field up one field 
in the sequence. 

or 

Tap the Down button. GeoFile moves the selected field down one 
field in the sequence. 

4. Repeat Steps 2 and 3 for each field you want to move in the list. 

5. Tap OK. GeoFile saves the field tab order you selected. 

Showing and Hiding Field Edges 

By default, when you add a new field to a layout, GeoFile puts a 
border around the edges of the field's data entry area, as shown in 
the following illustration: 

~--------q--' Edges Fustomer Name _J 

These edges indicate the outer boundaries of the field in which 
you are entering data. However, you can hide any or all of these 
edges to enhance your layout design. 
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To show or hide field edges (Level 4) 

1. Select the field you want to change. 

2. Choose Field Edges from the Properties menu. A submenu 
appears. 

3. Select the field edges you want to appear. 

or 

Deselect the field edges you want to hide. 

Formatting Text 

You can format text on a layout to give it more emphasis, to 
increase its similarity to other objects, or to provide contrast with 
other text objects. You can also format the data entry area of any 
field so that GeoFile uses the formatting to display any text it 
contains. GeoFile offers many of the text formatting features 
available in GeoWrite. 

In GeoFile, you can use the text formatting choices on the 
Properties menu to change the font, size, and character attributes 
of selected text. You can use the Paragraph choice on the 
Properties menu to change the line spacing, paragraph spacing, 
indents, tabs, borders, and. other attributes of text paragraphs. You 
can even create and use text style sheets. 

At Levels 3 and 4, GeoFile also provides tools on the Function tool 
bar that you can tap to use some of these features: 

Text alignment: left, 
centered, right, and full 

Tap to see a list of fonts. 

I URW Roman -I 

Text styles: plain, bold, 
italic, and underlined 

12 - l t 

Tap to see a list of font sizes. 

Font size: increase and decrease. I 

For more information about these features, see Chapter 5 and 
Appendix A. 

NOTE 

When using a procedure from the GeoWrite chapter for GeoFile, 
remember that GeoFile and GeoWrite have different menu 
structures. For example, to get to the Paragraph menu, you choose 
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it from the Properties menu in GeoFile, but you choose it from the 
main menu in GeoWrite. Similarly, the text formatting features 
appear on the Properties menu in GeoFile, but in GeoWrite they 
appear on the Character menu. 

Using Graphics 

You can add graphics to a layout to help group or contrast fields, 
to clarify the way the information is organized, or to emphasize 
certain information. GeoFile offers the same graphics tools that are 
available in GeoWrite. GeoFile provides tools on the Drawing tool 
bar that you can use to add and manipulate objects on a layout. 
For more information, see Chapter 8. 

At Level 3 in GeoFile, you can use the graphic formatting choices 
on the Graphics menu to create, transform, and arrange graphic 
objects, to set their line and area attributes, and to create and use 
graphic style sheets. At Level 4, you get additional editing features, 
and you can set additional graphic attributes. 

For more information about each of these features, see Chapter 8. 

DEFINING AND MANAGING LAYOUTS 

LEVELS 3-4 Layouts give you different ways to display and print the 
information in your GeoFile database. At Levels 3 and 4, you can 
create additional layouts for specialized ways to work with data in 
the database: entering data, displaying information, printing a 
report, and so on. 

For example, in a customer database, you might have one layout 
for entering data from business cards; another for displaying 
company names, contact names, and phone numbers; one for 
printing mailing labels; and yet another for printing an address 
book. Each layout displays the data in the database in a different 
way to suit a particular purpose. 

Switching Layouts 

To work with a layout you have added, you first need to make it 
the current layout. For an introduction to layouts, see "GeoFile 
Basics" in this chapter. 
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To switch to another layout (Levels 1-4) 

1. Choose Switch Layout from the Layout menu. A dialog box 
appears. 

2. Select the layout you want from the Choose Layout list. 

3. Tap Switch To. GeoFile displays the layout you selected. 

Creating Additional Layouts 

You can create up to 255 layouts in a GeoFile database. 

To create a new layout (Levels 3-4) 

• Choose Create New Layout from the Layout menu. GeoFile creates 
the new layout, assigns it a name (such as Layout 2), and makes it 
the current layout in the Field Organizer. 

Adding Layout Notes 

You can add notes to a layout as a reminder of what the layout 
contains when you switch to it. For example, you can describe the 
purpose of a data entry layout by entering, "Use this layout to 
enter customer data." 

To add layout notes (Levels 3-4) 

1. Choose Switch Layout from the Layout menu. A dialog box 
appears. 

2. Select the layout you want from the Choose Layout list. 

3. Tap Edit Notes. A dialog box appears: 

Ecl1t La~out Notes 

I~ 
I Cancel I 

4. Enter or edit the layout notes in the Notes box. You can enter up 
to 256 characters. 



5. Tap OK. The dialog box closes. GeoFile saves your changes. These 
notes will appear the next time you select the layout in the Switch 
Layout dialog box, as shown in this example: 

Switch Layout 

---Choose Layout---~ Current Layout: 

Addresses Phone List 

Phone List 
Notes for Layout 

Use this layout to enter 
customer data. 

I .!;dit Notes ... I I Cancel I 

Renaming a Layout 

You can change the name of a layout to make it more descriptive 
than the name GeoFile assigns when you create the layout. For 
example, you might want to rename Layout 1 something like "Data 
Entry Form." 

To rename a layout (Levels 3-4) 

1. Switch to the layout you want if it is not the current layout. 

2. Choose Rename Layout from the Layout menu. A dialog box 
appears: 

Rename Layout 

Rename: Layout 

To: [oata Entry! 

I gename Layout 11 Cancel I [!] 

3. Enter a new layout name. You can use any combination of letters, 
numbers, spaces, and punctuation. The name you use should 
describe the purpose of the layout. For example, if your layout is 
for printing mailing labels, you might call the layout "Mailing 
Labels." 

4. Tap Rename Layout. GeoFile changes the name of the layout to 
the name you entered. 
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Deleting a Layout 

You can delete a layout you no longer need. 

To delete a layout (Levels 3-4) 

1. Switch to the layout you want if it is not the current layout. 

2. Choose Delete Layout from the Layout menu. A confirmation 
message appears. 

3. Tap Yes. GeoFile deletes the current layout and switches to 
another layout. 

Adding and Removing Fields on a Layout 

A layout can contain some or all of the fields in a database. The 
same field can appear on more than one layout. You use the Field 
Organizer to add and remove fields on a layout. 

Fields absent from 
the current layout. 

Sales_to_Date 

Notes: 

Adds a field to the current layout. 

Removes a field from the current layout 

Fields in the current layout. 

customer _Name 
Phone 
State 

I !;reate New Fields I I i:;dit This Field I I .11e1ete This Field I [II 

ADDING A FIELD 

You can add a field to a layout so that it appears when you select 
the layout. 

To add a field to a layout (Levels 3-4) 

1. Switch to the layout you want if it is not the current layout. 

2. Select the field you want to add to the layout from the Fields Not 
in Current Layout list. 

3. Tap the Add button. GeoFile adds the field to the layout. 



You cannot delete a 
{ield if it appears on 
the current layout. 

REMOVING A FIELD 

You can remove a field you no longer need from a layout. 

Removing a field does not delete it from the database; the field 
remains until you delete it from the database using the Delete This 
Field button on the Field Organizer. 

To remove a field from a layout (Levels 3-4) 

1. Switch to the layout you want if it is not the current layout. 

2. Select the field you want to remove from the layout from the Fields 
in Current Layout list. 

3. Tap the Remove button. GeoFile removes the selected field from 
the layout. 

Copying Objects Between Layouts 

You can cut, copy, and paste objects between layouts of the same 
database using the clipboard. Doing this can save design and 
layout time. For more information, see Chapter 1. 

WARNING 

You cannot copy fields between different databases using the 
clipboard because databases have different field definitions. 
Attempting to do this can cause unexpected results. 

USING MULTIPLE RECORDS ON A LA VOUT 

LEVELS 4 GeoFile has two record modes at Level 4. In single-record mode, 
you can put one record on a layout at a time. In multi-record 
mode, you can add multiple records to the same layout. For 
example, you might do this to display rows of records on screen, 
such as a phone list. 

IS ervice Express ~udv Rickbaum 1(555) 555-1111 

EBC Company ~ohn Enders 1(555) 555-2222 

Eomm Tech ~ill Moss 1(555) 555-3333 

~est Inc. Ehr istie Parks 1(555) 555-4444 

~ew Tools Co. jsuzv Graham jl555J 555-5555 

Eilliams and Sons jsamuel Mills 1(555) 555-6666 
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You might also use this mode to print mailing labels or an address 
book, as shown in this example: 

--------·- ·------"'"" 

I ••••••••• I ••••••••• 
I I 
I ·,...,:ii; ..... ~ . . I@=•=,_=-----, 

: .-~:w- ........ I : ,nn.. I 
1 e+ 11 - 1m~ 1 E .... - IE]~ 
I I 

f• :a. .... f ..... ..,.-.. 
laMa~ ......... I Inv»-~~ .. I 
F ... !Ele::::J ..... t ... IE]~ 

m a 
~·:11- f ..... :will. 

l!a .... dr..Ll'Ui I I,. ............... I 
~h ...... !~~ ~· !El~ 

By default, every layout page contains a single record. To format a 
layout with multiple records, you must switch to multi-record 
mode and change the page size options. 

Switching Between Single- and Multi-Record Modes 

You can switch between modes by tapping the appropriate 
button. The buttons are shown here: 

~ Switches to Multi-Record mode. 
Single-Recot'"d 

Switches to Single-Record mode. 

Fitting Records on a Page 

Once you have entered multi-record mode, you must change the 
page size options so that multiple records can fit on the layout. For 
an introduction to page size options, see Chapter 1. 

For the Single Record Size option, the default width is the width of 
the page mirus the combined left and right margins. Similarly, its 
default height is the height of the page minus the top and bottom 
margins. By default, a single record fits on a layout page. To fit 



multiple records on a page, you need to reduce the single record 
size in proportion to the number of records you want to fit on a 
layout page. 

For example, suppose you want to print mailing labels that fit six 
on a page in two columns, as shown here: 

.- - - - - - - - - - - - -. 
:m :m~~= 
I • • I • I • I • I I • • • I I •••••• 
I · • ..,:ii;..,.-., , . : ~,,....~,~,...,~~ 
: @•:11-•..... I I ,., .. _ ... """.. I 
I fO'lll .. - !~!!!:]IE ... - !~~ 

I 

........ • .... -GI..-.. 
(llMQwo:;::........ I :;;,""';;;_;;::::;:::_::;_;:;:,=......,, 
@?'"• I~~ 111•..,i:... 11!] er:::::J 

P!U:111- r-·n•ilh 
@~ .......... fiil I ,,.................. I 
....... I e:J !!!!::] e• I El~ 

To calculate the record height, use the following formula: 

R d H . h Page Height - (Top Margin + Bottom Margin) 
ecor eig t = -~-~---~-~------~-

Number of Records per Column 

If the page height is 11 inches and the top and bottom margins are 
0.25 inches each, you would want to reduce the single record 
height to 3.5 inches. 

To calculate the record width, use the following formula: 

R d W'dth Page Width - (Right Margin + Left Margin) 
ecor 1 =--"-------"----"'-------"-

Number of Records per Row 

If the page width is 8. 5 inches and the right and left margins are 
0.25 inches each, you would want to reduce the single record 
width to 4 inches. 

CREATING A GEOFILE DATABASE 7.63 



7.64 GEOFILE 

In another example, suppose you want to print on mailing labels 
that fit 30 on a page in three columns, as shown here: 

s~-t:::::1'"t'CI!!. •!!::l! w=,;;!!d g£S~!!!!d 
E-·:; .. \ Eeruid Ele;r;d 
1Ef?;· r• 11 WJ:l ji &J E3£d 
Fw @A :, e•= e:: 1d li:::ieid 
E4j """ 1• i+e 1md ~l!:J~ 
'Ef?..: .... I, S;.,;d ES'!!::J!!d 
Wice 1, fii4 .. "lJ;d ftS:sl!d 
C" e e 1, ti$\;;,;;;:::\ ~c;r;;d 

For these mailing labels, the record height is 0.35 inches and the 
record width is 2.67 inches. 

Alternatively, you can obtain the desired record size interactively 
by adjusting the record size until GeoFile displays the number of 
records you want on the layout. If you use this approach, it may be 
useful to zoom out so that you can see the entire page. 



To set the page size options for multiple records (Level 4) 

1. Choose Page Size from the File menu. A dialog box appears: 

1:1 Page Size 

Type: + Paper O Envelope 

Size: i ~;aper Layoutl 

~! ~=~t~r Liii ~ I _ 

us Letter· 

JIS B5 Letter 
'--;::::::======:::;-;;;;;---~-;:::~~~~ 

Width: I s.5 in I B Height: I 1 1 in I B 
~~~;:::=~~~~ 

Margins: Left: 10.25 in IB Right: 10.25 in 

Top: 10.25 in IB Bottom: j0.25 in 

IB 

IB 
~-------Single record size'-------~ 

Width: ::=I 8=i=n===~I B 

Height: j 10.5 I B 

Apply Close ? 

Single record size 

2. Reduce the single record size in proportion to the number of 
records you want to fit on a layout page. 

3. Tap Apply. GeoFile displays dotted grid lines on the layout page 
indicating where records appear, as shown in the following 
example: 

································r·······························1 
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Record region 
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LEVEL 4 

LEVELS 3-4 

7.66 GEOFILE 

You can zoom out to see how records appear on the entire layout 
page. If necessary, you can continue to adjust the page size 
options until you achieve the result you want. 

4. Tap Close to close the dialog box. 

Once you have the page size you want, you might need to change 
the position of fields on the layout so that they will fit. 

Fitting Fields into the Record Region 

Once you have determined the record size, you might need to 
adjust the position, size, or formatting of fields on the layout page 
so that the data in the database will fit in the record region. 

For example, suppose you have set the single record width to 
2 inches but some of the data, when displayed, is more than 
2 inches long. If you do nothing, GeoFile will not display or print 
any text that extends beyond the right margin of the record region. 
However, if you reduce the length of the field or reduce the text 
size, more information can appear. 

Alternatively, you can move fields closer together so that there is 
less space between them, or you can move them closer to the 
upper left comer. Use single-record mode to adjust field position. 

Changing the Record Order 

For layouts with multiple records appearing in multiple rows and 
columns, you can decide the order in which GeoFile organizes the 
records on a page. 

In the following example, GeoFile organizes addresses by zip code 
in a vertical manner (the default): 

~3~ 134689 --------716 73 8 9 

+ + 
I j10986 135621 168901 

I + + + 
I 123437 138968 186211 

+ + + 
132896 167386 186309 



In the following example, GeoFile organizes addresses by zip code 
in a horizontal manner: 

102139 110986 123437 
I 

'11 
132896 134689 135621 

I 
'11 

138968 167386 167389 

168901 186211 186309 

To change the record navigation order (Levels 3-4) 

1. Choose Set Record Order from the Layout menu. A dialog box 
appears: 

Recor~cl Navrgatron or~cier 

Record Navigation Order: 

---------+>- Selects Vertical Record Navigation 

lrtrn e 1-r====;----r~~~c===F~=tt- Selects Horizontal Record Navigation I OK I I Cancel I CZ] 

2. Select the record navigation order you want. 

3. Tap OK. GeoFile changes to the record navigation order you 
selected. 
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Using the Drawing Tools 

This section describes the drawing tools available at Level 3; the 
"Advanced Graphics" section of this chapter covers the advanced 
features available at Level 4. 

This section assumes you are using the pen to input characters and 
make menu selections. You may also use an optional mouse. 

DRAWING TOOLS AT LEVEL 3 

LEVEL 3 

8.2 USING GRAPHICS 

When you set your user level to Level 3 in Geo Write, GeoCalc, or 
GeoFile, the drawing tools and Graphics menu appear in the 
application window. The GeoWrite Level 3 window is shown 
below: 

=s GeoWrite - Document &•tii'.I 
_Eile ~dit ~iew Qptions ioayout Qraphics earagraph ~haracter 

lllill• 1~1 
DTITIII 

Iii ~ l@hd Normal -I 11"1"'1§1 I URW Roman -I I 12 -lll~I 

~ 
:t I $. ...!>- -Ii. -I!. _f,... _IL • ~ 

' 

l 



What Are Drawing Tools? 

Drawing tools help you create and manipulate graphic objects. A 
graphic object can be a shape, a line, or a block of text. One 
advantage of using graphic objects is that you can easily select, 
edit, and manipulate individual objects separately from the other 
objects in your document. 

You select a drawing tool by tapping it. The following are 
descriptions of the drawing tools available at Level 3: 

Pointer Tool. Use the Pointer tool to select, move, and resize 
objects. 

Rotate Tool. The Rotate tool lets you rotate an object around its 
center point. You also can use this tool to select and move objects, 
just as you would with the Pointer tool. 

Text Tool. Use the Text tool when you want to place text inside a 
graphic object. 

Line Tool. Use the Line tool to draw straight lines. You can 
change the color and the thickness of the line using the Line 
Attributes choice on the Graphics menu, described in this chapter. 
At Level 4 you can make connected straight lines and curved lines 
using the Polyline tools, described in the "Advanced Graphics" 
section of this chapter. 

Rectangle Tool. Use the Rectangle tool to draw both rectangles 
and squares. 

Rounded Rectangle tool. A rounded rectangle is a rectangle with 
rounded corners. You can use this tool just as you use the 
Rectangle tool. 

Ellipse Tool. Use the Ellipse tool to draw ellipses and circles. 

NOTE 

In GeoCalc and GeoFile, the Ellipse tool is available at Level 4 
only. 
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Drawing Pointers 

Drawing pointers indicate the type and current location of the 
selected drawing tool; these pointers appear only if you are using 
an optional external mouse, attached through the RS-232 port. If 
you are using an external mouse, when you move the mouse into 
the document area, the pointer for the mouse changes to indicate 
the type of drawing tool you are using. If you are using the pen 
only, no pointer is shown. 

Here are descriptions of the different types of pointers you will see 
when you use drawing tools with a mouse: 

Arrow. If you select the pointer tool, the pointer does not change 
as you move it around the screen-it is always the arrow pointer. 

Cross hairs. If you select the Line, Rectangle, or Ellipse drawing 
tool, the pointer changes to cross hairs when you move it over the 
document area. The center of the cross hairs shows where the 
shape will begin as you draw. 

I-Beam. If you select the Text tool and move the pointer over a 
text object, the pointer changes to an I-beam pointer. Use the I
beam pointer to select text and move the insertion point. 

Crossed I-Beams. If you select the Text tool and move the 
pointer into the document area, the pointer changes to crossed I
beams. (If you move the pointer over a text object, the pointer 
becomes a regular I-beam pointer.) The intersection of the I-beams 
shows where text will begin if you tap in the document area to 
define a text object and then enter text characters. 

The pointer always becomes an arrow pointer when you move it 
outside the document area and onto the tool bar or the menu area. 

CREATING BASIC OBJECTS 

LEVELS 3-4 

8.4 USING GRAPHICS 

There are two ways to create objects. You can use the Create 
choice on the Edit submenu on the Graphics menu to quickly 
create a shape, or you can use the drawing tools. 

Drawing Basic Objects with the Drawing Tools 

You can create a shape in virtually any size by selecting the 
appropriately shaped tool, tapping where you want the shape to 
start, dragging the pen to enlarge the object, and then lifting the 
pen when the object is the size you want. 



....... 
Create Bectangle 

Create J;;Ilipse 

Create .!:,ine 

1. 

' • • 2. 

• 3. 

4. 

Create Roun1'ed Rectangle 
Create ~re 

Create Iriangle 
Create Qctagon 
Create ~-Pointed Star 

Create ~-Pointed Star 

~olygons ... 
~tars ... 

To draw a line, rectangle, rounded rectangle, or ellipse (Levels 
3 and 4) 

Tap either the line, rectangle, rounded rectangle, or ellipse tool 
button. These tools function similarly. The tool button is selected . 

Move the pen to the document area . 

Touch the pen to the screen where you want your shape to start . 
(You do not have to move it to exactly the right place now; you 
can rearrange it later.) Drag diagonally until the shape is the size 
you want (or the line is the length you want), as indicated by the 
outlines that appear in the document area. 

Lift the pen. The object appears as a solid shape or line. 

After you create an object, resize handles appear around the 
object, and a move handle appears in the center of the object. You 
can use these handles to move and resize the object. Handles also 
indicate that an object is selected. 

Move handle (the handle in 
the center of the object) 

I Resize handles (the handles 
around the edges of the object) 

To remove the handles from an object (deselect it), create another 
object or tap any place in the document area that is not occupied 
by an object. For more information about selecting objects, see 
"Selecting Objects" in this chapter. 

Adding Objects with the Create Submenu 

The Create submenu, located on the Graphics menu, lists shapes 
you can use in your drawings. When you add an object using the 
Create submenu, the object appears at a standard size in the center 
of the drawing area. Objects you add with the Create submenu 
behave just like objects you create using drawing tools, and you 
can manipulate them as described in this chapter. 

Using the Create submenu, you can add the following types of 
objects to your drawings: 

• Rectangles 

• Ellipses 
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• Lines 

• Rounded rectangles 

• Arcs 

• Triangles 

• Octagons 

• five-pointed stars 

• eight-pointed stars 

• Polygons and stars with variable numbers of sides or points 

Each time you select an object from the Create submenu, that 
object appears in the center of the document area. Unless you 
want to create a stack of objects, you will want to move each 
object away from the center point before you add another object 
with the Create submenu. You move objects by selecting and 
dragging them, as described in "Manipulating Objects" in this 
chapter. 

Drawing Polygons and Stars 

Using the Create choice on the Edit submenu on the Graphics 
menu, you can quickly create polygons or stars with up to 100 
sides. These are some examples of polygons you can create: 

To create a polygon (Levels ~4) 

1. Choose Create from the Edit submenu on the Graphics menu. A 
submenu appears. 

2. Choose Polygons from the Create submenu. A dialog box appears: 

1:11 Polygons 

Number of Polygon Sides: 

Polygon Radius: j 100 pt 

I Create Polygon I I Close I [2J 



3. Tap the up and down arrow buttons to select the number of 
polygon sides you want. 

4. Select the polygon's horizontal radius and vertical radius. The 
default is 100 points (about 1.4 inches); the minimum size is 1 
point (1/72 of an inch), and the maximum size is 576 points (8 
inches). 

5. Tap Create Polygon. The polygon appears in the document. 

6. Tap Close. The dialog box disappears. The polygon is selected, so 
you can reposition it in your document using any of the drawing 
tools. 

Drawing Stars 

Using the Create choice on the Edit submenu on the Graphics 
menu, you can quickly create stars with up to 100 points. These 
are some examples of the stars you can create: 

To create a star (Levels 3-4) 

1. Choose Create from the Edit submenu on the Graphics menu. A 
submenu appears. 

2. Choose Stars from the submenu. A dialog box appears. 

3. Complete the dialog box, changing the options you want: 

Number of Star Points. Select the number of points you want 
your star to have. The default is 5 points; the maximum number is 
100. (Star points are the points of the star, not the point increments 
of measure that you use to specify width and height.) 

Outer Radius. The outer radii of the star represent the radii of an 
ellipse that touches each of the star's points. The star's horizontal 
radius (left box) and vertical radius (right box) are measured in 
point increments. The minimum size is 1 point (1/72 of an inch); 
the maximum size is 288 points (4 inches). The default is 100 
points (about 1.4 inches). 

Inner Radius. The inner radii of the star represent the radii of an 
ellipse that touches each of the star's inverted angles. The left box 
specifies the horizontal measure and the right box specifies the 
vertical measure, in point increments. The minimum size is 1 point 
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(about 1/72 of an inch); the maximum size is 288 points (4 inches). 
The default is 38 points (0.53 inches). 

1:1 Stars 

Number of Star Points: Li B 
outer Radius: I 1 00 pt I B byl ~ 1_0_0_p_t-~I B 
Inner Radius: 138 pt I B by 138 pt I B 

I Create star I I Close I [TI 

4. Tap Create Star. The star appears in the document. 

5 . . Tap Close. The dialog box disappears. The star is selected, so you 
can reposition it in your document using any of the drawing tools. 

MANIPULATING OBJECTS 

LEVELS 3-4 

To select an unfilled 
object, you must tap 
a line or curve on 
the object. 

8.8 USING GRAPHICS 

All drawings are composed of combinations of shapes and lines. 
You can modify and combine these objects in a variety of ways. 
This section describes how you can manipulate objects. 

Selecting Objects 

You can select objects by tapping them with the pen after you 
have selected any of the drawing tools. When you have selected 
an object, any changes you make affect that object. You can tell 
which object is selected because handles appear around it. 

To select an object (Levels 3-4) 

• Using one of the drawing tools, tap the object you want to select. 
Handles appear around the object. 

To deselect an object (Levels 3-4) 

• Tap in any part of the document area where there is no object. 
Handles disappear. 

or 

Select another object. 



To select multiple objects (Levels ~4) 

1. Select the pointer tool. 

2. Drag the pen diagonally across the area containing the objects. A 
box with a dotted line appears. As you continue to drag and 
stretch the box over the objects you want to select, handles appear 
around each object. 

NOTE 
If you are using an external keyboard, you can use Ctrl to select 
multiple non-adjacent objects. 

Moving Objects 

When you create an object, it is not permanently attached to the 
spot where you create it. You can move it around your document 
window as you like. This section describes how to move objects ir 
a drawing. 

NOTE 
Objects that you place outside the print border (the dotted line near 
the perimeter of the document area) will not appear when you print. 

To move an object (Levels ~4) 

1. Select the object you want to move. Handles appear around the 
object: 

• • • 
2. Touch the pen to the diamond-shaped move handle in the center 

of the object. 
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3. Drag the object to the position you want. As you move the pen, an 
outline of the object follows your motion, indicating where the 
object will be placed when you lift the pen: 

:/""" ..... ._,,' 

~ :~: - Moving object outline 
\ j ' /' . '-,,., ... ,.,,,..,... 

To move multiple objects (Levels 3-4) 

1. Select the objects you want to move. Handles appear around the 
objects. 

2. Touch the pen to the move handle on one of the objects, and drag 
the object to the position you want. Moving one object moves all 
the selected objects. As you move the pen, outlines of the object 
follow your motion, indicating where the object will be placed 
when you lift the pen. 

MOVING OBJECTS WITH THE GRAPIDCS MENU 

You can use the Move choice on the Arrange submenu on the 
Graphics menu to move graphic objects. The Move menu choice 
presents you with two options: Nudge and Custom Move. 

To nudge objects (Levels 3-4) 

To nudge an object means to move it just a tiny bit. Sometimes 
using a move handle to reposition an object or group does not 
give you the fine degree of control you need. When you nudge 
objects, you move them up, down, left, or right one pixel at a time. 
Pixels are the small dots that make up the images you see on the 
screen. 

1. Select the object you want to nudge. 

2. Choose the direction in which you want to move the object from 
the Move submenu on the Arrange submenu on the Graphics 
menu. The menu disappears and the object is nudged in the 
chosen direction. 

8.10 USING GRAPHICS 



LEVELS 3-4 

To custom move objects (Levels ~4) 

The Custom Move dialog box allows you to choose the increments 
in which you wish to move objects. Select Inches, Centimeters, 
Points, or Picas, and specify the number of increments vertically 
and horizontally. 

1. Select the object you want to custom move. 

2. Choose Custom Move from the Move submenu on the Arrange 
submenu on the Graphics menu. 

3. Choose the increment type and the number of vertical and 
horizontal increments you want to move the object. 

4. Tap Move. The object is moved as specified. The dialog box 
remains open so you can continue to perform the move operation 
until the object is positioned as you want it. 

5. Tap Close. The dialog box disappears. 

Resizing Objects 

Just as objects are not fixed in their original positions, they are not 
fixed at their original sizes. You can enlarge and reduce an object 
by dragging any of its resize handles. 

To resize an object (Levels ~4) 

1. Select the object you want to resize. Resize handles appear around 
the object. 

2. Drag one of the resize handles (but not the move handle in the 
center of the object). Dragging toward the center of the object 
reduces it, while dragging away from the center enlarges it. As you 
drag, an outline shows the changing size of the object. 

3. When the object is the size you want, lift the pen. The object 
appears in place, at its new size. 

NOTE 

Resizing line objects is a little different: you can only extend the 
length of the line as you drag one of the handles. You cannot 
resize a line to make it thicker. You can change line thickness 
using the Line Attributes choice on the Graphics menu. Setting line 
attributes is described in "Setting Attributes" this chapter. 

Duplicating Objects 

It is often useful to duplicate an object instead of recreating it. For 
example, if you are drawing a floor plan of the layout of six desks, 
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you can save time by drawing the first desk and then duplicating it 
five times. 

To duplicate an object (Levels ~4) 

1. Select the object you want to duplicate. Handles appear around 
the object. 

2. Choose Duplicate from the Edit submenu on the Graphics menu. 
The duplicate appears with handles around it in the center.of the 
screen. You can use the move handle on the duplicate object to 
move it to the position you want. 

You can also choose Duplicate In Place; and the duplicate object 
will appear on top of the original object. 

You can also choose Multi-Duplicate. This choice opens a dialog 
box in which you may specify the number of duplicates, and any 
rotation or horizontal or vertical direction in which to arrange the 
pattern of duplicates. 

NOTE: 
The Edit submenu at Level 3 in GeoFile contains some additional 
choices that are not available in GeoWrite or GeoCalc until 
Level 4. These choices are documented in the "Advanced 
Graphics" section in this chapter. 

Deleting Objects 

You can delete objects from your drawing at any time, 

To delete an object (Levels ~4) 

1. Select the object you want to delete. Handles appear around the 
object. 

2. Choose Delete from the Edit menu. 

8.12 USING GRAPHICS 

Grouping and Ungrouping Objects 

You can group distinct objects together so that you can work with 
them as if they were a single object. For example, after grouping 
three rectangles, you could do any of the following: 

• Change the area attributes for all three rectangles at once. 

• Rotate the rectangles around a common center. 

• Move the rectangles as a group without changing their positions 
relative to one another. 



• Resize the rectangles as a group while maintaining their relative 
scale. 

After you have made the changes you want to a group of objects, 
you can ungroup them to make each component a separate object 
again. 

A group can contain any object, including another group. 

To group objects (Levels 3-4) 

1. Select the graphic objects you want to group. A set of handles 
appears around each object: 

2. Choose Group from the Arrange submenu on the Graphics menu. 
A single set of handles appears around the group, indicating that it 
is now a single object: . o· .D . 

. D. • 
To ungroup objects (Levels 3-4) 

1. Select the group you want to ungroup. 

2. Choose Ungroup from the Arrange menu. Handles appear around 
the individual objects. 

Rotating Objects 

You can rotate a selected object by using the Rotate tool or by 
choosing Rotate from the Transform menu, as described in the 
next section. Using the Transform menu, you can rotate an object a 
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specific number of degrees. The selected object rotates around its 
center point. You can also select multiple objects, and they will 
rotate around their respective center points. If you want multiple 
objects to rotate around a common center point, you must first 
group them; for more information, see "Grouping and Ungrouping 
Objects" in this chapter. 

To rotate an object with the Rotate tool (Levels ~4) 

Using the Rotate tool, you can drag an object around its center 
point until it appears in the position you want. 

1. Select the Rotate tool. 

2. Select the object you want to rotate. Handles appear around the 
object. 

3. Touch the pen to one of the handles surrounding the selected 
object. 

4. Drag the Rotate tool clockwise or counterclockwise until the 
object is in the position you want. A dotted outline shows the 
position of the object as you rotate it. 

5. Lift the pen. The object appears in its new position, with handles 
around it. 

Transforming Objects 

You can transform an object to give it special visual effects such as 
scaling, skewing (slanting), and rotating. You can also undo any 
transformation you make. 

NOTE: 
At Level 3 in GeoFile, some additional choices are available on the 
Transform submenu. These choices are described in the 
"Advanced Graphics" section in this chapter. 

FIJPPING OBJECTS 

You also can use the Transform menu to turn objects over, or "flip" 
them left to right or top to bottom. This is useful for creating 
interesting effects with text objects and for building complex 
designs out of component objects. The following illustration shows 
some text that has been flipped: 

a.ad Jxat airlT 
at ftal bsqqift 

!Jrlgi:I 

fJOQ.OUJi 
{P.bOOq i:ob ID 
.!Jl!:1! lffiCf Jlm3 
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To flip an object (Levels 3-4) 

1. Select the object you want to flip. Handles appear around the 
object. 

2. From the Flip submenu on the Transform submenu on the 
Graphics menu, choose Flip Left to Right or Flip Top to Bottom. 
The object flips in the direction you chose. 

SCAUNG OBJECTS 

You can scale an object to resize it in a precise manner, shrinking 
or stretching its dimensions as desired. You can scale its vertical 
and horizontal dimensions independently or together. 

For example, suppose you had a rectangle that was 2 inches long 
and 1 inch wide. You could make the rectangle half as long by 
changing its width to a 50% scale. You could make it twice as tall 
by changing its height to a 200% scale. 

You can use scaling to elongate or shorten a text object without 
first converting it to a graphic . 

.. To change the scale using standard scale sizes (Levels 3-4) 

1. Select the object that you want to scale. 

2. Choose Scale from the Transform menu. A submenu appears. 

3. Select Half Width, Half Height, Double Width, or Double Height 
from the submenu. The selected objects reappear scaled according 
to the setting you chose. 

To change the scale using a custom scale size (Levels 3-4) 

1. Select the object that you want to scale. 

2. Choose Scale from the Transform menu. A submenu appears. 

3. Choose Custom Scale. A dialog box appears: 

Custom Scale 

m am B 
GI I 1°0 IB 

4. Complete the dialog box, changing the options you want: 
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Width. Select the custom scale percentage to increase or decrease 
the width. You can change the width of an object from 1 to 1000 
percent. 

Height. Select the custom scale percentage to increase or decrease 
the height. You can change the height of an object from 1 to 1000 
percent. 

5. Tap Scale to apply your changes. 

You can tap Scale repeatedly, if you want, to apply different 
scaling percentages until you achieve the desired effect. For 
example, if you are trying to scale a rectangle between two other 
objects, you may need to apply scaling several times to get the 
exact size and shape you want. 

6. Tap Close to close the dialog box. 

ROTATING OBJECTS 

Rotating an object involves turning it in a clockwise or 
counterclockwise direction around its center. You can rotate 
objects using the Rotate tool, as described above, or you can use 
the Transform menu to choose a standard or a custom rotation 
angle for an object. 

To rotate objects using standard rotation (Levels 3-4) 

1. Select the objects that you want to rotate. 

2. Choose Rotate from the Transform menu. A submenu appears. 

3. Choose the rotation you want from the submenu. The object is 
rotated around its center point; if you selected multiple objects, 
each object rotates around its own center point. 

To rotate objects using custom rotation (Levels 3-4) 

1. Select the objects that you want to rotate. 

2. Choose Rotate from the Transform menu. A submenu appears. 

3. Choose Custom Rotate from the submenu. The following dialog 
box appears: 

1:1 Custom Rotate 

•iltE IB 
I Rotate II~[!] 
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4. Select the rotation angle you want. You can set rotation from -359 
to 359 degrees. 

5. Tap Rotate. The object is rotated around its center point; if you 
selected multiple objects, each object is rotated around its center 
point. You can continue to tap Rotate to rotate the objects 
repeatedly until you achieve the visual effect you want. 

6. Tap Close to close the dialog box. 

Changing the Stacking Order of Objects 

When two objects in a drawing overlap each other, one appears to 
be in front of the other. In fact, all objects in your drawing are 
"stacked" one in front of the other, like a deck of cards. Each time 
you create an object, you are adding a layer to the stack. However, 
the layers are only apparent, though, when objects overlap. 

The object in front is on top of the stack; that is, it is not covered 
by any other object. The object at the back of a stack can be 
covered by one or more objects. It is often useful to change the 
order in which objects are stacked - for example, to move an 
object to the front when other objects are stacked on top of it. 

BRINGING AN OBJECT TO TIIE FRONT OR SENDING IT TO TIIE BACK 

The Bring to Front and Send to Back choices on the Arrange 
submenu on the Graphics menu move the selected object directly 
to the front or back of a stack, regardless of the object's original 
position. 

I Object brought to front 

To move an object to the front or back of a stack (Levels ~4) 

1. Select the object you want to move to the front or back of the 
stack. Handles appear around the object. 

2. From the Arrange menu, choose either Bring to Front or Send to 
Back. The stack is rearranged accordingly. 
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PULLING AN OBJECT FORWARD OR PUSHING IT BACK 

The Pull Forward and Push Back choices on the Arrange menu 
move the selected object one level forward or back in the stack, 
relative to the object's original position. 

Object pushed back 

Object pulled forward 

To push or pull an object back or forward in a stack (Levels ~4) 

This technique is useful when you cannot see objects in the layers 
of a stack. You can select an object that is visible and move· it back 
one layer at a time, each time revealing the object that was 
immediately behind it. 

1. Select the object you want to pull forward or push back in the 
stack. Handles appear around the object. 

2. From the Arrange menu, choose either Pull Forward or Push Back. 
The stack is rearranged accordingly. 

SETTING ATTRIBUTES 

LEVEL 3 
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At Level 3, you can set area and line attributes using the Graphics 
menu. You can also choose to display the Graphics bar in your 
document window by selecting it from the Show Tools submenu 
on the Options menu. The Graphics bar allows you to set area, 
line, and text attributes using drop-down menus rather than dialog 
boxes. 

Setting Area Attributes 
Area attributes apply to the areas inside graphic objects other than 
lines and text objects. You can set any of the following area 
attributes: 



Unless you select 
Filled, many of the 
other line attributes 
will not be available. 

• Fill color 

• Color shading 

• Pattern 

• Drawing mode 

USING THE AREA ATTRIBUTES DIALOG BOX 

You can set the area attributes of an object using the options in the 
Area Attributes dialog box. This section describes each attribute in 
detail. 

To set area attributes for a graphic object (Levels 3-4) 

1. Select the graphic object you want to change. 

2. Choose Area Attributes from the Graphics menu. A dialog box 
appears: 

" • Glli 

+[f'ilieCi! <> unfilled 1.::1 D 5 h h d" 
• · ·· ·······' % Shaded: a iiJ 1-- ets t e area S a 1ng 

••lllllllllllllRIRlllllllliiilllllllillllll!~i~l::•:::mml~l(I I Sets the area fill color 

Red EJB Green EJB Blue EJB 1-- Sets the color blend 

Pattern: I I 111 l=l?,;:l::::Slgl0)1 Sets the area fill pattern 
Draw Mode: [ Normal -.J Sets the draw mode 

3. Complete the dialog box, changing the attributes you want: 

Filled or Unfilled. Select Filled to fill the enclosed area of the 
graphic object and to make available the other options in this 
dialog box. By default, the area of the graphic object is unfilled. 

% Shaded. Select the percent shading for the fill color. The lower 
the number, the lighter the color. By default, this setting is 100. If 
Unfilled is selected, this attribute is set to zero (O). 

Color tools. Select the area fill color from the color palette. You 
can also fine tune the color blend by setting the amounts of red, 
green, and blue in the area fill color; the default values depend on 
the selected color. 

Pattern. Select the fill pattern. By default, this setting is solid. 

Draw Mode. Select the draw mode (Normal, Inverse, AND, XOR, 
or OR) to set the prevailing display color for overlapping objects. 
For more information, see "Using Draw Modes" in this chapter. 
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The draw mode 
control is only 
available through the 
Area Attributes 
dialog box. 

II 

4. Tap Apply to apply your changes to selected graphic objects. 
Continue to make changes as desired until you are satisfied with 
the way the graphic object looks. 

5. Tap Close to close the dialog box. 

USING DRAW MODES 

The draw mode controls the prevailing display color (shade of 
gray) for overlapping objects. 

NOTE 

This is an advanced feature that you can experiment with for 
special graphic effects. It is hard to predict the results you will get 
when you use draw modes other than Normal. 

To use the draw modes control (Level 3-4) 

1. Select the objects you want to be affected by a draw mode change. 

2. Choose Area Attributes from the Graphics menu. 

3. Choose a draw mode from the Draw Mode drop-down list. 

Normal displays the top object (including the overlap area) in its 
original color. 

Inverse displays the top object in the inverse of the background 
color and, where two objects overlap, combines the colors of the 
top and bottom objects to form a third color. 

AND displays the top object in its original color and, where the 
objects overlap, combines the color of the top object and the 
underlying object to create a third color. 

XOR combines the original color of the top object with the color 
of the underlying object or background to create other colors. 

OR displays the top object only where it overlaps. It displays the 
overlap area in a different color. 

The application uses the draw mode to calculate, on a pixel-by
pixel basis, the color that appears. 

Setting Line Attributes 

Line attributes apply to line objects, to the lines that make up 
polyline objects (described in "Advanced Graphics" in this section 
of this chapter), and to the border lines around ellipses, rectangles, 
rounded rectangles, and arcs (arcs are available at Level 4). 

Line attributes include: 

• Color 
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Unless you select 
Filled, many of the 

other line attributes 
will not be available. 

• Line width 

• Line style 

• Arrowhead style and direction 

You can set these attributes using the Line Attributes choice on the 
Graphics menu. 

USING THE LINE ATIRIBUfES DIALOG BOX 

You can set the line attributes of an object using the options in the 
Line Attributes dialog box. This section describes each attribute in 
detail. 

To set the line attributes (Levels 3-4) 

1. Select the graphic objects that you want to change. 

2. Choose Line Attributes from the Graphics menu. A dialog box 
appears: 

+[~i~i~~] <>Unfilled 3 Shaded: J 100 I Sets the line shading 

•11llllllllll!lllllllllllll!lliilltllllll!l:~11I :::::1111111 I f-----·---++--- Sets the line fill color 

Red EJ B Green EJ B Blue EJ Sets the color blend 

Width: -1-1-1-1-1-1----- Sets the line width 

Fine Tune Width: J 1 pt I B------+t---- Sets the line width 

style: ---1- I-·- 1-n-I Sets the line style 
Arrowhead: l•l•l-t>l-+1-+l~HI - - ----· - Sets the arrowhead 
o Arrowhead at Start o Arrowhead at End style 

Sets the arrowhead 
position 

3. Complete the dialog box, changing the attributes you want: 

Filled or Unfilled. Select Filled to fill the line or border of the 
graphic object (which makes it visible) and to make available the 
other options in this dialog box. Select Unfilled if you want the 
line or border to be invisible. By default, the line is Filled. 

% Shaded. Select the percent shading for the line color. The lower 
the number, the lighter the color. By default, this setting is 100. A 
zero (O) setting is the same as an unfilled line or border. 

Color Tools. Select the line color from the color palette. You can 
also fine tune the color blend by setting the amounts of red, green, 
and blue in the line color; default values depend on the selected 
color. 
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Width. Select the thickness of the border line using a set of 
standard widths. By default, this setting is one (1) point. You can 
also fine tune the width by selecting a custom thickness; a setting 
of zero (0) is the same as a hairline width, which makes it the 
thinnest line that can appear on your display or that your printer 
can print. 

Style. Select the style of the border line. By default, this setting is a 
solid line. 

Arrowhead. For lines and unclosed objects such as open 
polylines and open splines (described in the "Advanced Graphics" 
section in this chapter), you can select an arrowhead style. By 
default, no arrowhead style is selected. You also can select an 
arrowhead location (at the start or the end of the line). 

4. Tap Apply to apply your changes to selected graphic objects. 

5. Tap Close to close the dialog box. 

The Graphics Bar 

You can use tools on the Graphics bar to set the attributes for 
graphic and text objects. The Edit, Transform, and Arrange menu 
functions are also available through tools on this tool bar. Select 
the Graphics bar from the Show Tools submenu on the Options 
menu. The tools are shown and explained below. 

USING TIIE AREA ATIRIBUTES TOOLS 

You can also use the tools on the Attribute tool bar to change the 
fill color, shading, and fill pattern of an object. For more 
information about each attribute, see "Using the Area Attributes 
Dialog Box" in this chapter. 

To use the Area Fill Color tool (Levels 3-4) 

1. Select the graphic objects you want to fill. 

14~• -I 2. Tap the Area Fill Color tool. A vertical menu appears. 

3. Select the area fill color you want to apply to the selected objects. 

To use the Area Shading tool (Levels 3-4) 

1. Select the graphic objects you want to shade. 

2. Tap the Area Shading tool. A vertical menu appears. The option at 
the top is 100% shading; the option at the bottom is 0%, the same 
as an unfilled object. 
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3. Select the area shading you want to apply to the selected objects. 

To use the Area Pattern tool (Levels 3-4) 

1. Select the graphic objects you want to fill with a pattern. 

2. Tap the Area Pattern tool. A vertical menu appears. 

3. Select the area pattern you want to apply to the selected objects. 

USING THE LINE ATIRIBUTES TOOLS 

You can use the tools on the Graphics tool bar to set or change the 
color, shading, and thickness of a line or border. 

To use the Line Color tool (Levels 3-4) 

1. Select the graphic objects that you want to change. 

14~-1 2· 
3. 

Tap the Line Color tool. A vertical menu appears. 

Select the color you want to apply the line color to the selected 
graphic objects. 

To use the Line Shading tool (Levels 3-4) 

1. Select the graphic objects that you want to shade. 

2. Tap the Line Shading tool. A vertical menu appears. The option at 
the top is 100% shading; the option at the bottom is 0%. 

3. Select the shading you want to apply the line shading to the 
selected graphic objects. 

To use the Line Width tool (Levels 3-4) 

1. Select the graphic objects that you want to change. 

1-,-1 2. 
3. 

Tap the Line Width tool. A vertical menu appears. 

Select the width you want to apply the line width to the selected 
graphic objects. 

Setting Text Attributes 

You can format text in a drawing to give it more emphasis, to 
increase its similarity to other objects, or to contrast it with other 
text objects. For more information about text objects, see "Adding 
Text To Drawings" in this chapter. 
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To use the Text Color tool (Levels 3-4) 

1. To change text within a text object, use the Text tool to select the· 
text you want to change. 

14~-1 2· 
3. 

or 

To change all the text in a text object, use the pen to select one or 
more text objects you want to change. 

Tap the Text Color tool. A vertical menu appears. 

Select the color (gray scale) you want to apply the color to the 
selected text or text objects. 

To use the Text Shading tool (Levels 3-4) 

1. To change text within a text object, use the Text tool to select the 
text you want to change. 

or 

To change all the text in a text object, use the pen to select one or 
more text objects you want to change. 

2. Tap the Text Shading tool. A vertical menu appears. The option at 
the top is 100% shading; the option at the bottom is 0%. 

3. Select the shading you want to apply the shading to the selected 
text or text objects. 
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Edit, Transform, and Align Tools 

Many of the functions available on the Edit, Transform, and 
Arrange submenus are also available as tools on the Graphics bar. 
The tools are identified in the illustration below. They work 
exactly as described in the sections explaining the menu 
selections. For more information, see the function description in 
this chapter. 

Group 

Ungroup 

Duplicate 

Duplicate in Place 

Send to Back 

Push Forward 

Push Back 

Flip Left to Right 

Flip Top to Bottom 
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ALIGNING AND DISTRIBUTING OBJECTS 

Sometimes you want objects to line up with respect to each other. 
For example, you may want a circle and a square centered on each 
other or you may want three circles to line up with their left sides 
on the same vertical line. This is called aligning objects. The 
following illustration shows some objects before they are aligned, 
and after they are aligned in different ways: 

Objects not 
aligned 

Left aligned 

•• 
Center aligned Right aligned 

You can also distribute objects so that they are equally spaced 
from each other. There are as many ways to distribute objects as 
there are to align them. The following illustration shows some 
objects before they are distributed, and after they are distributed 
along their top edges: 

·-···················································· 

Before After 

To align objects to each other (Levels 3-4) 

1. Select two or more objects you want to align. 
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2. Choose Align/Distribute from the Arrange submenu on the 
Graphics menu. A dialog box appears: 

Select two, three or more objects in your document 

::.... ~- •l u I •1 .:.::u:. ltt .. 111 
~ ·=. !:l :1 ::i :::! 
~iHEI ~itt!~itt1· .... 11.l 11..t. ....... 

3. Tap the alignment button you want: 

1111 
!4--mEI 
-+11111+-

-+lllim+-
1111----ti 

llllllli 

Align left edges 

Align centers 

Align right edges 

Align adjoining edges 

Align adjoining edges 

Align bottom edges 

Align centers 

Align top edges 

4. Tap Apply to apply your changes. 

5. Tap Close to close the dialog box. 

To distribute objects (Levels 3-4) 

1. Select three or more objects you want to distribute. 

2. Choose Align/Distribute from the Arrange submenu on the 
Graphics menu. A dialog box appears. 
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3. Tap the distribution button you want: 

Make left edges equidistant 

Make centers equidistant 

Make right edges equidistant 

Make objects equidistant 

Ill]. 11··1· II.. . m.l 
•J I·· · 11.l 1:: : 
11·· . II·· · 11.l 11·l 

Make objects equidistant 

Make bottom edges equidistant 

Make centers equidistant 

Make top edges equidistant 

4. Tap Apply to apply your changes. 

5. Tap Close to close the dialog box. 
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Using the Grid and Guidelines 

At Levels 3 and 4, you can also use the grid and the guidelines to 
align objects more precisely in your document. First you need to 
understand how to set up the grid and the guidelines. 

The grid is a pattern of evenly spaced vertical and horizontal lines 
that help you align and size objects in a drawing. The grid helps 
yc;m set objects in the basic positions where you want them, 
relative to each other: 

11 

1 r ················~ ................ t ................ t ................ t ................ f ...... .. 
5 ! ! i ! 

~ ................ J ................ f ................ f ................ f················f········-Horizontal grid line 

I~ ............... _J.. .............. f ················f ................ f ················f ........ } 
~ l l l l Grid spacing 

.., ................ ~ ................ i ................ i ................ i ................ i ....... . 

~ lverti~I grid li~e i 



Guidelines are also 
referred to as 
"guides" on screen. 
Both terms mean the 
same thing. 

A guideline is a single vertical or horizontal line that you can use 
to align objects in a drawing. You can have multiple vertical or 
horizontal guidelines. You can align objects to guidelines as you 
can with grid lines, although guidelines give you more precise 
control than grid lines. 

_j_ JJ 
t t 

- I T-
i ! 

-

t t 

Guidelines help you manually 
align objects along single 
vertical or horizontal lines. 

Unlike the grid, which automatically covers the drawing area, 
guidelines appear only where you place them. Use guidelines 
instead of grids when you want to align objects along a precise 
vertical or horizontal position. You can use guidelines in 
combination with grid lines, or with grid lines hidden. 

You can combine vertical and horizontal guidelines to create 
corners to which objects can be "snapped." If Snap to Grid and 
Guides is selected, objects are "snapped" to the grid and aligned to 
the grid lines and guidelines. For more information, see "Snapping 
Objects to the Grid and Guidelines" in this chapter. 

You can control whether the grid appears on screen or is hidden 
from view. Displaying the grid can make it easier to see where you 
want to put objects. 

NOTE 

The Grids menu choice is not available in GeoCalc or GeoFile. 
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To show or hide the grid (Level 4) 

1. Choose Grids from the Layout menu. The following dialog box 
appears: 

1:1 Gr,rcls 

Grid Spacing 
+Inches 

10 in 
I e <> ~entimeters 

<> J:'.oints 
<> PiCJ:!S 

• §nap to Grid and Guides 
D ShO.!:!,! Grid 

l[App1yJI lc1osel [I] 

2. Select Show Grid to display the grid. 

or 

Deselect Show Grid to hide the grid. 

If Grid Spacing is set to zero (0), no grid is created or displayed 
whether this option is selected or not. 

3. Tap Apply to apply your changes. 

4. Tap Close to close the dialog box. 

You can also set the distance between grid lines. Decreasing the 
size increments gives you finer control when you snap objects to 

. the grid. 

NOTE 
The Grids menu choice is not available in GeoCalc or GeoFile. 

To set the grid spacing (Level 4) 

1. Choose Grids from the Layout menu. The following dialog box 
appears: 

1:1 Gt'IC!S 

Grid Spacing 
+Inches 

10 in 
I e <> ~entimeters 

<> J:'.oints 
<>Pic~s 

• §nap to Grid and Guides 
o Show Grid 

~App1yU lc1osel [I] 
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You can set the grid 
spacing from 0 to 
455 inches. 

2. In the Grid Spacing area of the dialog box, select the units of 
measure you want (Inches, Centimeters, Points, or Picas). By 
default, the units of measure are the same as the ruler setting. 

3. Select the distance between grid lines. To enable the grid, select a 
number that is greater than zero. 

4. Tap Apply to apply your changes. The grid spacing changes to the 
setting you specified. 

5. Tap Close to close the dialog box. 

NOTE 

The Guides menu choice is not available in GeoCalc or GeoFile. 

To create or change a guideline (Level 4) 

1. Choose Guides from the Layout menu. A dialog box appears: 

1:1 Gu1cles 

+ !,,lertical Guidelines 
<> !:!orizontal Guidelines 
Guidelines: 

r•@iiiliii!WMHI'· ~ 

Guide Position: I 0 in I B 

2. Complete the dialog box, changing the options you want: 

Vertical Guidelines or Horizontal Guidelines. Select the type 
of guideline you want to create. 

Guidelines. Select <<Create New Guideline>> in the Guidelines 
list to create a new guideline, or select the guideline you want to 
change from the Guidelines list. 

Guide Position. Select the position you want. For a vertical 
guide, this sets the distance from the left edge of the drawing area. 
For a horizontal guide, this sets the distance from the top edge of 
the drawing area. 

3. Tap Apply to apply your changes. The new guideline is created in 
the position you specified, or the position of the guideline you 
selected is changed. 

4. Tap Close to close the dialog box. 
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NOTE 

The Guides menu choice is not available in GeoCalc or GeoFile. 

To delete a guideline (Level 4) 

1. Choose Guides from the Layout menu. A dialog box appears: 

Cl Guides 

+ !,1ertical Guidelines 
0 !:jorizontal Guidelines 
Guidelines: 

« Create New Guideline » .... 
I in 
1.5 in 

jj 
Guide Position: IPBD IB 
iii[)[)i\)] I Delete Guide 11 Close I [I] 

2. Complete the dialog box, changing the options you want: 

Vertical Guidelines or Horizontal Guidelines. Select the type 
of guideline you want to delete. 

Guidelines. Select the guideline you want to delete from the 
Guidelines list. 

3. Tap Delete Guide. The guideline you selected is deleted. 

4. Tap Close to close the dialog box. 
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Snapping Objects to the Grid and Guidelines 

The drawing tools include a feature that automatically snaps (posi
tions) objects along grid lines and guidelines when you create 
them. If you activate this feature, when you draw or resize a 
graphic object, the corners of the object are automatically snapped 
to the closest intersection of the grid lines. 

Snapping objects to the grid and guidelines is often faster and 
more accurate than positioning them manually with the pen. If you 
create an object while the snapping feature is inactive, you can still 
align it to the grid or guidelines; for more information, see 
"Aligning Objects to the Grid and Guidelines" in this chapter. 

When you move an object, it keeps its former distance from grid 
lines or guidelines. For example, if an ellipse starts 1/ 4 inch from a 
vertical grid line and you move it horizontally, the program puts 



PressX or period(.) 

to turn grid snapping 
on or off only for the 
next create, move, or 
resize operation. 

the ellipse 1/ 4 inch from the closest vertical grid line in its new 
location, as shown in the following illustration: 

NOTE 

·······················································•·········· 

~Grid lines 

\ , 
"-- / 

'~. ·~ .... ,.,. . .,..,. ,/' 

................... ·················································· ............................................................ r········· 

Previous position, 
I /4" from grid lines 

New position, also 
I /4" from grid lines 

The Grids menu choice and the Snap to Grid and Guides option 
are not available in GeoCalc or GeoFile. 

To snap objects to the grid or guidelines (Level 4) 

1. Choose Grids from the Layout menu. A dialog box appears. 

2. Select Snap to Grid and Guides. 

3. Tap Apply to apply your changes. While Snap to Grid and Guides 
is selected, the corners of objects are snapped to the grid and 
guidelines when you draw, move, or resize the objects. 

4. Tap Close to close the dialog box. 

Aligning Objects to the Grid and Guidelines 

You can arrange objects so that they line up along grid lines, grid 
corners, and guidelines. You might want to do this, for example, 
to align objects created while snapping was turned off. Aligning 
works whether snapping is turned on or off. You can do this 
manually by moving objects in the drawing area, but it is easier 
and more accurate to let the application program do it for you. 

NOTE 

The Align to Grid menu choice is not available in GeoCalc or 
GeoFile. 
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Objects can be 
aligned to the grid 
even when the grid is 
hidden. 

To align objects to the grid and guidelines (Levels 3-4) 

1. Enable the grid by setting the grid spacing to some number greater 
than zero. For more information, see "Using the Grid and 
Guidelines" in this chapter. 

2. Select the object that you want to align to the grid. 

3. Choose Align to Grid from the Arrange submenu on the Graphics 
menu. A dialog box appears: 

Align to Gricl 

4. Tap the alignment arrow you want. The selected objects move to 
the nearest grid line in the direction of the arrow you tap. For 
example, if you tap the upper-left arrow, the upper-left corner of 
each selected object moves to the nearest grid corner. 

5. You can change the alignment again by tapping another arrow. 

or 

Tap Close to close the dialog box. 

ADDING TEXT TO DRAWINGS 

LEVELS 3-4 

~ 1. 
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To treat text graphically, you enter text in text objects. Each text 
object can contain as little or as much text as you like - from a 
single letter to multiple paragraphs. To create text objects, you use 
the Text tool. You can move, delete, and resize text objects just as 
you would any other object (a line, rectangle, or ellipse). 

To create a text object (Levels ~4) 

Select the Text tool from the Tool Bar. 



2. Position the I-beams where you want your text to begin; tap and 
drag diagonally to outline the area in which you want the text to 
appear. A dotted line shows the borders of the text object. 

Homework! 
~----·---·--.. ----·--------·-·········--------: 

3. Lift the pen. The border of the text object appears with a blinking 
vertical line, the insertion point, showing where you can begin 
typing. The default font is 12-point Roman. You can change the 
font as you normally would within the application. 

4. Enter text using the floating keyboard or an external keyboard. 
Text wraps within the text object, and the object automatically 
grows vertically to accommodate new lines of text. Do not use the 
Enter key unless you want to begin a new paragraph. If you later 
resize your text object, word wrap will automatically adjust the 
line endings for you - unless you have pressed Enter at the end 
of each line. 

HINT 
To quickly create a standard-size text object, select the Text tool, 
then tap where you want to begin entering text. A text object six 
inches across and one line deep will appear. As you enter text, the 
text object automatically grows vertically to accommodate new lines 
of text. You can resize the object and respecify the text style and 
size later if you like. 

To move, resize, or delete a text object (Levels 3-4) 

• Use the pointer tool to move, resize, or delete a text object just as 
you would any rectangular object. If you make a text object too 
small, you may not be able to read the text. 

WORKING WITH BITMAPS 

LEVELS 3·4 You can use three types of objects to compose a drawing: text 
objects, draw objects, and bitmap objects. Text objects contain 
text. Draw objects are shapes that you create by using the drawing 
tools. Bitmap objects are special shapes that you create using the 
bitmap tools discussed in this section. 

A bitmap is an object made up of pixels, which are individual dots 
that make up an image, like the dots on a television screen. 
Bitmaps give you the ability to create freehand images. Because 
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bitmaps have special properties, you need to use bitmap tools to 
manipulate pixels in a bitmap. The bitmap tools appear when you 
select Bitmap Tools from the Show Tools submenu on the Options 
menu: 

Frame tool 

Selection tool 

Brush tool 

Eraser tool 

Bitmap Line tool 

Bitmap Rectangle tool 

Bitmap Ellipse tool 

Fill tool 

Pixel View 

Like their counterparts on the drawing tool bar, the bitmap Line, 
Rectangle, and Ellipse tools draw geometric shapes. However, the 
bitmap tools paint pixels in a bitmap, whereas the draw tools 
create distinct graphic objects. You can change the pixels of a 
bitmap object, but not of a draw object; however, you can convert 
draw objects to bitmap objects. For more information about 
converting objects, see "Converting Draw and Text Objects to a 
Bitmap" in this chapter. 

The following sections describe how to use the bitmap tools to 
manipulate pixels in a bitmap. Once a bitmap is created, you can 
move, resize, and transform it as you would any other object in a 
drawing. 

Creating a Bitmap Frame 

A bitmap frame defines the outer bounds of a bitmap. You can 
create a bitmap frame by using the Frame tool or by drawing a 
bitmap shape using other bitmap tools. You can use the bitmap 
tools to change pixels in the object, and you can manipulate the 
bitmap like other objects, moving, resizing, or transforming it as 
desired. 



[i] 1. 
2. 

USING THE FRAME TOOL 

If you know the size of the bitmap you want to create, or if you 
just want to block out an area of the drawing for the bitmap, you 
can use the Frame tool to create a rectangular bitmap frame. 

Any bitmap operations you perform in the frame are bounded by 
the frame and become part of it. The frame acts much like a draw 
object - you can stretch, move, and rotate it. However, you 
cannot move or resize individual bitmap items you place in the 
bitmap frame. Once you place a bitmap item in a frame, it 
permanently becomes part of that frame, unless you choose Undo 
from the Edit menu. 

To draw a bitmap frame (Levels 3-4) 

Select the Frame tool from the tool bar. 

With the pen, touch the screen where you want to anchor the first 
point of the frame, then drag the frame until it is the size you want. 

3. Lift the pen. A frame with a white fill and line color appears, with 
selection handles: 

Drawing a bitmap frame creates the bitmap. Now you can change 
pixels inside the bitmap frame. You can also draw other objects on 
top of the bitmap; however, they remain separate objects, distinct 
from the bitmap. 
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USING A BITMAP SHAPE TOOL 

Another way to create a bitmap frame is to draw a bitmap shape 
(straight line, freehand symbol, rectangle, or ellipse) in a blank 
part of the drawing area. When you do this, the program creates a 
rectangular bitmap frame around the image along its outermost 
points; the boundaries of the frame become the boundaries of the 
bitmap: 

Drawing Bitmap Shapes 

You can use the bitmap tools to draw the following bitmap 
shapes: 

• Straight lines 

• Rectangles 

• Ellipses 

• Freehand shapes 

When you draw a bitmap shape, you change the pixels that the 
shape touches. Once you draw a bitmap shape, it becomes part of 
the bitmap frame. You cannot change a bitmap shape as you can a 
draw object. For example, you cannot move or resize a bitmap 
ellipse directly; you can only draw another ellipse in the new 
location or size you want. For this reason, you should choose 
Undo from the Edit menu to correct any mistakes you make. 

You normally select the attributes of a bitmap shape before you 
draw it, including the color, shading, line weight, and so on. You 
can change these attributes after you have drawn the shape. 

The default background color for a bitmap is white. You can 
change the background color by drawing a bitmap shape in a 
different color using one of the bitmap tools. The Attribute tools 
do not apply to bitmaps. 

NOTE 

Unlike other graphic objects, a bitmap is always opaque and never 
transparent (unfilled). As a result, if you place a bitmap on top of 
other objects, you cannot see the underlying objects. 



To draw a straight line (Levels 3-4) 

You can draw a straight line in a bitmap using the Bitmap Line 
tool. 

1. Select the line color, shading, and width you want. To do this, you 
can use the Line Attributes tools or choose Line Attributes from the 
Graphics menu. For more information, see "Setting Attributes" in 
this chapter. 

1· ... 1 2. Select the Bitmap Line tool from the tool bar. 

3. With the pen, touch the screen where you want to anchor the first 
point of the line, then drag to where you want the line to end. 

4. Lift the pen. A straight line appears with the attributes you 
selected: 

.. ~····························· . 

............................. ! 

To draw a rectangle (Levels 3-4) 

You can draw a rectangle in a bitmap using the Bitmap Rectangle 
tool. 

1. Select the area fill color, shading, and pattern you want. To do 
this, you can use the Area Attributes tools or choose Area 
Attributes from the Graphics menu. For more information, see 
"Setting Attributes" in this chapter. 

~ 2. Select the Bitmap Rectangle tool. 

3. With the pen, touch the screen where you want to anchor one 
corner of the rectangle, then drag until the rectangle is the size you 
want. 

4. Lift the pen. A rectangle appears with the attributes you selected: 

To draw an ellipse (Levels 3-4) 

You can draw an ellipse in a bitmap using the Bitmap Ellipse tool. 
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1. Select the area fill color, shading, and pattern. You can use the 
Area Attributes tools or choose Area Attributes from the Graphics 
menu. For more information, see "Setting Attributes" in this 
chapter. 

2. Select the Bitmap Ellipse tool from the tool bar. 

3. With the pen, touch the screen where you want to start the ellipse, 
then drag until the ellipse is the shape and size you want. 

4. Lift the pen. An ellipse appears with the attributes you selected: 

To draw a freehand shape (Levels 3-4) 

You can draw a freehand shape in a bitmap using the Brush tool 
on the tool bar. This technique is similar to using a paintbrush to 
make strokes on a canvas. 

1. Select the line color, shading, and width you want. You can use 
the Line Attributes tools or choose Line Attributes from the 
Graphics menu. For more information, see "Setting Attributes" in 
this chapter. 

I/I 2. Select the Brush tool from the Bitmap tool bar. 

3. Tap once to change one pixel. 

or 
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With the pen, touch the screen where you want to start the 
freehand shape, then drag to draw the shape you want, and then 
lift the pen. 

If you draw a shape, it appears with the attributes you selected: 



Editing Bitmap Pixels 

Once you have created a bitmap, you can use the Bitmap tools to 
change pixels in the object, to erase portions of the image you do 
not want, and to select all or part of the image for cut, copy, and 
paste operations. 

SELECTING A BITMAP 

Whenever you use a bitmap tool in a bitmap, the bitmap becomes 
the selected object. The frame appears around the bitmap to show 
you that it is the selected object, as shown in the following 
illustration: 

l 1 

~ : : _________________________ : 

USING ffiE SELECTION TOOL 

You can use the Selection tool to select a rectangular region within 
a bitmap so that you can perform copy, cut, and paste operations 
using the pixels in the region. You can select all or part of the 
object. For more information about clipboard operations, see 
Chapter 1. 

To select a region within a bitmap (Levels 3-4) 

LJ 1. Tap the Bitmap Selection tool on the tool bar. 

2. With the pen, touch the screen where you want to anchor one 
corner of the selection, then drag until the selection region is the 
size you want. 

3. Lift the pen. A rectangular selection region appears, as shown in 
the following illustration: 

At this point, you can cut or copy the selected region to the 
clipboard and, if desired, paste it in a different location in the 
bitmap. For more information about copy, cut, and paste 
operations, see Chapter 1. 
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To select all the pixels in a bitmap (Levels 3-4) 

1. Choose the Bitmap Selection tool from the tool bar. Tap inside the 
bitmap. A dotted outline appears, indicating that the bitmap is 
selected. 

2. Choose Select All from the Edit menu to select all the pixels in the 
bitmap. 

CHANGING ffiE Fill COLOR OR Fill PATI'ERN 

You can change the color of a contiguous group of pixels using 
the Bitmap Fill tool. Unlike the Fill tool for graphic objects, which 
fills the entire interior of a graphic object, the Bitmap Fill tool fills 
an enclosed area with the current area fill color. The enclosed area 
is bounded by pixels of a different color. 

To change the pixels in an enclosed area (Levels 3-4) 

1. Select the Bitmap Fill tool from the tool bar. 

2. Select the fill color and the pattern you want. You can use the Area 
Fill Color tool or choose Area Attributes from the Graphics menu. 
For more information, see "Setting Attributes" in this chapter. 

3. Tap anywhere in the enclosed area. All the pixels in the enclosed 
area are changed to the current area fill color. 

ERASING IN mE BITMAP FRAME 

You can use the Eraser tool to erase all or part of a bitmap. When 
you use the Eraser tool, the program changes the color of affected 
pixels to white. It has the same effect as painting pixels white 
using a different bitmap tool (such as the Rectangle tool). 

HINT 

To erase a rectangular region, you can use the Selection tool and 
the Cut or Delete choice on the Edit menu. For more information, 
see "Using the Selection Tool" in this chapter. However, to erase a 
non rectangular region, including freehand erasing, use the Eraser 
tool instead. 

To erase pixels in a bitmap frame (Levels 3-4) 

1. Select the Eraser tool from the tool bar. 

2. With the pen, touch the screen where you want to start erasing, 
then drag over the parts of the image you want to erase. 
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USING THE PIXEL VIEW TOOL 

You can use the Pixel View tool on the tool bar to change 
individual pixels in the Pixel View. The Pixel View tool enlarges 
your drawing and displays a grid of pixels that you can change 
individually. 

Once an image appears in the Pixel View, you can use any of the 
bitmap tools to make subtle changes to it, such as "smoothing out" 
a rough edge or corner. For example, to change the colors of 
individual pixels, you can select a line color, select the Brush tool, 
and then tap the pixels you want to change. Similarly, to change a 
rectangular region of pixels, you can select a fill color, select the 
Rectangle tool, and then draw a rectangle over the region of pixels 
you want to change. 

To display the Pixel View (Levels 3-4) 

1. Select the Pixel View tool from the tool bar. 

2. With the pen, touch the screen where you want to change pixels. 
The Pixel View appears: 

1:1 Pixel View 

Each square is a single pixel. 

3. Select the bitmap tool you want to use to change pixels. 

4. In the Pixel View window, use any of the Bitmap tools to change 
pixels individually or in groups. 

To change the Pixel View area (Levels 3-4) 

• Tap any pixel in the Pixel View window. 

or 

Tap in the bitmap image outside the Pixel View window. 

Either way, the pixel you tap becomes the center pixel in the Pixel 
View window. 
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Converting Draw and Text Objects to Bitmaps 

You can convert a graphic or text object to a bitmap so that you 
can edit individual pixels within the object. Doing so can make it 
easier to fine tune visual details in your drawing. 

When you convert an object or a group of objects to a bitmap, the 
image is converted to a grid of pixels, and transformations 
(rotation, skewing, and so on) are made part of the object. 

NOTE 

Once you convert to a bitmap, the identities of individual objects 
are lost. You cannot convert the bitmap back to a graphic or text 
object and edit it using the Graphics or Text tool. In a bitmap, you 
can edit individual pixels only. For example, if you converted four 
rectangles to a bitmap, you could not convert the bitmap back to its 
four component rectangles and then edit them individually. 

To convert objects to a bitmap (Level 4) 

1. Select the object that you want to convert. If you select multiple 
objects, they will be converted to a single bitmap. 

2. Choose Convert from the Transform menu. A submenu appears. 

3. Choose Convert to Bitmap. The selected objects are converted to a 
bitmap. You can edit the new bitmap as you would any other 
bitmap. 
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Advanced Graphics 

When you advance to Level 4 in GeoWrite, GeoCalc, and GeoFile, 
the additional drawing tools and Graphics menu choices give you 
more extensive drawing capability. For example, at Level 4, you 
can create complex objects called polylines and splines, you can 
paste objects within other objects, and you can develop graphic 
style sheets. 

This section explains how to use the tools and menu choices that 
become available at Level 4. 

DRAWING TOOLS AT LEVEL 4 

LEVEL 4 Five new drawing tools are available on the Level 4 tool bar. The 
following tools are described in this section: 

The Zoom Tool 

The Zoom tool lets you zero in on a portion of your drawing. Use 
it to enlarge a portion of your drawing so that you can focus on 
the fine details. 

To zoom in on a particular point in a drawing (Level 4) 

1. Select the Zoom tool from the tool bar. 

2. Tap the area you want to examine. You can tap again to move 
closer, up to the maximum zoom. 
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To zoom out (Level 4) 

• Use the View menu to zoom out or to return to normal size. For 
more information about the View menu, see Chapter 3. 

8.46 USING GRAPHICS 

The Arc Tool 

An arc is a portion of a circle or ellipse. You create arcs using the 
Arc tool. When you create an arc, it appears as one quarter of a 
circle or ellipse: 

' ' •, 
', 

.,. ..... ---- .... - .... 
.. .... 

' 

You can make an arc appear as one eighth or one sixteenth of a 
circle or ellipse. For more information, see "Changing Arc 
Attributes" in this chapter. 

You use the Arc tool in the same way as you use the other Shape 
tools. For information about how to use Shape tools, see "Using 
the Drawing Tools" in this chapter. 

The Polyline Tools 

Polylines are objects made up of line segments that are connected 
end to end. There are two Polyline tools: 

Polyline tool. Use this tool to create an object composed of 
straight line segments. 

Rounded Polyline tool. Use this tool to create an object 
composed of curved line segments. 

The Polyline tools give you great flexibility in drawing objects that 
are composed of many line segments. For more information, see 
"Creating Complex Objects" in this chapter. 

The Spline Tool 

The Spline tool lets you create and edit polylines with more 
precision and control than the Polyline and Rounded Polyline 
tools. You should be familiar with basic polyline techniques before 
you attempt to master the Spline tool. 



CREATING COMPLEX OBJECTS 

LEVEL 4 At Level 4 you can create objects that are more complex than those 
you work with at Level 3. This section describes how to create and 
modify the complex objects that are composed of polylines. 

Drawing Polylines 

There are two Polyline tools. A polyline is an object made up of 
line segments that are connected end to end. You use the Polyline 
tool to create objects with straight lines joined by angled corners. 
You use the Rounded Polyline tool to create curves. 

Curved polyline object 

Straight polyline object 

You also can create polyline objects with both straight and curved 
segments. To do so, first create a straight line object, then modify 
some of the segments so they are curved. You can also go the 
other way: create a curved polyline object, then modify some line 
segments so they are straight. 

A polyline object can be open or closed. An open polyline is one in 
which the last line segment does not end at the polyline's starting 
point. A closed polyline is one in which the last line segment ends 
at the first segment's starting point. You can add fill patterns and 
other area attributes to closed objects. For more information about 
area attributes, see "Using the Drawing Tools" in this chapter. 

r---- Open polyline object 

--- Closed polyline object 
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CREATING A POLYIJNE AND A ROUNDED POLYIJNE 

To create a polyline object (Level 4) 

1. Select one of the Polyline tools from the tool bar. 

2. Tap where you want the polyline object to begin. A small unfilled 
circle appears, representing the first anchor point. Anchor points 
are the points where angles or curves connect the individual 
polyline segments you draw. 

A dotted box appears around the anchor point indicating that the 
object consists of only one anchor point, so far. 

3. Tap where you want to end the first line segment. The line 
segment appears . 

. / 
4. Tap again. Another anchor point appears, and the completed line 

segment remains in place. The dotted box also changes to 
encompass the object. 

5. Continue adding line segments until the object is complete. 

6. Double-tap the final anchor point to finish the object. All the 
anchor points appear in the polyline object, and a dotted box 
surrounds it, indicating that the object is selected. 
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TRANSFORMING A POLYIJNE 

Once you have created a polyline object, you can grab any of its 
anchor points and move it to change the shape of the object. You 
also can change one, some, or all of the points in the polyline 
object from corners to curves or from curves to corners. 



To change the shape of a polyline object (Level 4) 

1. Select one of the Polyline tools, then tap the polyline object whose 
shape you want to change. The object's anchor points are 
displayed as unfilled circles, and a dotted box appears around the 
object. 

2. Select the point you want to move by tapping it. The selected 
point is filled, then disappears. 

3. Drag the point to change the shape of the object as you like. The 
affected segments change to show the result of your motion. 

4. Lift the pen. The object is redrawn in the new shape. 

To change polyline points from corners to curves (Level 4) 

This procedure is useful if you want to create a polyline object in 
which some of the lines are straight and some are curved. 

1. Select a Polyline tool, then tap the polyline object you want to 
change. The anchor points appear, and a dotted box surrounds the 
object. 

2. Tap the anchor point you want to change. You can select multiple 
points by touching the pen to an empty area within the dotted box 
and then dragging the pen across the points you want to select. 
Each point you select is filled to distinguish it from unselected 
points. 

3. Choose Polyline from the Transform menu. A submenu appears. 

4. Choose either Make Curved Point(s) or Make Comer Point(s) from 
the submenu. The selected points change accordingly. 

Corner points changed to curves 
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HINT 

You can change a single point from a corner to a curve (or vice 
versa) by double-tapping it. Double-tapping again changes it back. 

INSERTING AND DELETING ANCHOR POINTS 

You can change the shape of a polyline object by inserting or 
deleting anchor points. Each point anchors one end of a line 
segment. You can increase the number of segments in the object 
by adding anchor points, or reduce the number by deleting anchor 
points. By making the lines shorter (inserting points) or longer 
(deleting points), you can control the curves and angles that shape 
the object. 

To insert anchor points (Level 4) 

1. Select a Polyline tool, then tap the polyline object to which you 
want to add points. The anchor points appear, and a dotted box 
surrounds the object. 

2. Tap a line segment at the position where you want to insert an 
anchor point. The new anchor point appears. 

To delete anchor points (Level 4) 

1. Select a Polyline tool, then tap the polyline object from which you 
want to delete anchor points. The anchor points appear, and a 
dotted box surrounds the object. 

2. Tap the point you want to delete. You can select multiple points 
by touching the pen to an empty area within the dotted box and 
then dragging the pen across the points you want to select. 
Selected points appear filled. 

3. Choose Polyline from the Transform menu. A submenu appears. 

4. Choose Delete Point(s). The submenu disappears and the selected 
points are deleted. 

OPENING AND CLOSING POLYllNES 

You can change a polyline object from open to closed, or from 
closed to open. Closed polyline objects are filled and can be 
colored; open polyline objects are unfilled. 

To open or close a polyline object (Level 4) 

1. Select a Polyline tool, then tap the polyline object you want to 
open or close. The anchor points appear, and a dotted box 
surrounds the object. 
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2. Choose Polyline from the Transform menu. A submenu appears. 

3. Choose Close or Open from the submenu. The submenu 
disappears and the object changes accordingly, o~ening or closing 
the object at the last anchor point that you created or selected. 

USING THE SPLINE TOOL TO CREATE AND EDIT POLYLINE$ 

LEVEL 4 

Polylines are 
sometimes called 
splines or Bezier 
curves. 

At Level 4, the Spline tool appears on the tool bar. 

Polylines are comprised of segments and endpoints, called anchor 
points. Actually, the curves are more complicated than that-you 
just see the simplified version when you use the Polyline tools. 
Using the Spline tool, you can see all the elements of a polyline. 
The following illustration shows the elements of a polyline that 
become visible with the Spline tool: 

Bezier curve 

Tangent line 

,-,.---------[ Segmoot 

l.. ______ .. _______ r.:::::. _____________________ _ 

Anchor points 

Control points 

Segment. One of the lines or curves that make up a polyline. 

Anchor point. An anchor point defines the end of a segment. An 
anchor point can fall between two straight segments, two curved 
segments, or a straight segment and a curved segment. 

Endpoints. Endpoints are the first and last anchor points for an 
open polyline. Closed polylines do not have endpoints. 

Control points. Control points are handles that you use to 
change the curvature of a curved segments. To see the control 
points for a segment, select the Spline tool and tap on a curved 
segment. The control points you see govern the shape of the 
selected segment and of the segments next to it. 
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Tangent line. A tangent line is the line that connects an anchor 
point and its control points. It runs tangent to the curve at the 
anchor point. 

When working with polyline tools, you do not see the control 
points or their tangents. When you use the Spline tool, however, 
you can see and separately manipulate the control points and 
tangents. 

Creating a Polyline with the Spline Tool 

Drawing a polyline with the Spline tool can seem difficult at first. 
It takes practice to learn to handle the Spline tool effectively. The 
following procedures give you the basic steps, but you might want 
to experiment on your own to perfect your technique. If you 
prefer, you can use the Rounded Polyline tool to create a polyline, 
and then use the Spline tool to edit it. 

To draw a polyline with the Spline tool (Level 4) 

1. Select the Spline tool. 

2. Tap where you want to start the first segment of the polyline. A 
circle surrounds this first anchor point, which is one of the 
endpoints of the object. 

3. Tap where you want to end the segment. A dotted rectangular 
outline surrounds the object. 

4. Tap to create a comer anchor point. 

or 
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Drag the pen to create a curved anchor point. As you drag, a 
tangent line appears in the direction in which you are dragging 
and the first segment appears, as· shown in the following 
illustration: 

' --~.-. __ __,___ Tangent 

a .. 
.. 

··-.: 

l .... ·····--·------------j 
Spline segment in process 

End point 



5. If you dragged in Step 4, lift the pen when you are satisfied with 
the curve of the segment. An anchor point appears, as shown in 
the following illustration: 

(
~~Anchor point 

'\,L 
I 

-------------------· 

The object outline expands, if necessary, to include the new 
anchor point. 

6. Repeat steps 3, 4, and 5 for each segment you want to create. As 
you add segments, remember the following: 

• The shape of the current segment is affected by the shape of the 
previous segment. 

• If you move the pen, you will see the segment move. 

• The first and last anchor points remain on screen, but all other 
previous anchor points disappear while you are drawing. 

7. For the last segment in the polyline, tap the first anchor point to 
create a closed polyline. 

or 

Double-tap the last anchor point to create an open polyline. (You 
can later connect the endpoints, if you want, by choosing Polyline 
from the Transform submenu of the Graphics menu and then 
choosing Close from the submenu.) 

Manipulating Polylines with the Spline Tool 

You can use the Spline tool to add anchor points to the polyline, 
precisely edit the curves in the polyline, and change the attributes 
of control points. 

ADDING AND DELETING ANCHOR POINTS 

You can add and delete anchor points using the Polyline and the 
Curved Polyline tools. 

To insert anchor points using the Spline tool (Level 4) 

1. Select the Spline tool. 
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2. If it is not already selected, select the polyline that you want to 
edit. 

3. Tap the polyline segment at the spot where you want to add an 
anchor point. 

4. Choose Polyline from the Transform submenu of the Graphics 
menu. A submenu appears. 

5. Choose Insert Point(s) from the submenu. The new point appears 
at the spot you indicated. 

To delete anchor points using the Spline tool (Level 4) 

1. Select the Spline tool. 

2. If it is not already selected, select the polyline that you want to 
edit. 

3. Tap to select the anchor point or points you want to delete. 
Selected anchor points are filled. 

4. Choose Delete from the Edit menu. The selected anchor points 
disappear. 

CHANGING CURVED SEGMENTS 

You can fine tune the shape of a segment using the Spline tool. 

To reshape a segment using the Spline tool (Level 4) 

1. Select the Spline tool from the tool bar. 
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Jfyou makea 
mistake, choose 
Undo Move from the 
Edit menu. 

2. Select a segment, and drag the segment to change its shape. 

or 

Tap a control point to select it, and drag the control points that 
appear. 

or 

Tap a segment to select it, and drag the control points that appear. 

Regardless of which method you use, both the former curve and 
the outline of the new curve are displayed, as shown in the 
following illustration: 

I New curve 

i-r;v·····················-

:~\\;{ ' 
.. : ......... : ........ ··························' 

Original curve 

4. Lift the pen when you are finished. The new curve is displayed. 
The control points remain visible. 

To turn a curved point into a corner point, or turn a corner point 
into a curved point (Level 4) 

1. Select the Spline tool. 

2. If it is not already selected, select the polyline that you want to 
edit. 

3. Select the point you want to change. 

4. Choose Polyline from the Transform submenu of the Graphics 
menu. A submenu appears. 

5. Choose Make Comer Point(s) or Make Curve Point(s) from the 
submenu. The anchor point changes to a comer point or curved 
point. 

Changing Control Point Attributes 

You can set the attributes for control points to change the way 
they behave when you change the smoothness of a curve. 
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To change control point attributes (Level 4) 

1. Select the Spline tool from the tool bar. 

2. If it is not already selected, select the polyline that you want to 
edit. 

3. Tap to select the anchor point with the control points you want to 
change. 

4. Choose Polyline from the Transform submenu of the Graphics 
menu. A submenu appears. 

5. Choose Control Points from the submenu. Another submenu 
appears. 

6. Select the control point attribute you want: 

Automatic. Under this option, the positions of the control points 
are automatically calculated to maintain a high degree of 
smoothness and to ensure an even curve through the anchor point. 
The two control points and the anchor point must be on the same 
tangent and they must be the same distance from the anchor point. 

Symmetric. This option ensures that the two control points and 
the anchor point appear on the same tangent, and that the control 
points are equal distances from the anchor point. 

Collinear. This option ensures that the two control points and the 
anchor point appear on the same tangent, but allows the control 
points to be at different distances from the anchor point. 

Independent. This option allows two control points to be entirely 
independent. 

The attribute is applied to the selected anchor point as soon as you 
move the anchor point or either of its control points. 

Experiment by changing the setting, then manipulating the control 
points. If you do not like the results of a move, choose Undo Move 
from the Edit menu. 

USING GRAPHIC STYLE SHEETS 

LEVEL 4 
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Like text styles, graphic styles allow you to record a set of graphic 
attributes and give them a common name. Then you can use the 
style to apply all the attributes to an object at the same time. You 
can record the following graphic attributes in a graphic style: 

• Area attributes, including area fill color, shading, pattern, and 
draw mode 



• Line attributes, including line color, shading, line width, line 
style, and arrowheads 

• Background color 

• Gradient fill 

• Arc angles for arcs 

• Bitmap format for bitmaps 

• Extended attributes (annotations and locks) 

Graphic styles make it easy for you to apply a group of attributes 
to one or more objects all at once. This saves you the effort of 
setting the same attributes for each object individually. For more 
information about changing the attributes of a graphic object, see 
"Setting Attributes" in this chapter. 

When you create a style, you give it a name. Styles help ensure a 
consistent look for your drawing. They also make it easier to 
reformat a drawing, because changing a style automatically 
updates graphic objects in that style. A graphic style sheet is the set 
of all the named graphic styles used in a drawing. 

All GEOS documents include one style, Normal. If you create a 
drawing based on a template, you may find that other styles have 
been defined in the template. 

Graphic style sheets are similar to text style sheets. For more 
information, see "Formatting GeoWrite Documents" in Chapter 5. 

Defining a New Graphic Style 

You can add a new graphic style by giving it a name and defining 
its attributes. 

You can use the formatting defined in another style with similar 
attributes as the base style for a new style. A base style is a style on 
which other styles depend. If you change an attribute in the base 
style, all dependent styles will change except those that define the 
attribute uniquely. 

For example, suppose you define a style called "Dark Fill" using 
another style, "Filled Objects," as its base style. If you changed the 
line width in "Filled Objects" to 3 points, the line width in "Dark 
Fill" would increase to 3 points. The program also updates all 
objects drawn in either style with the new attributes. 

Alternatively, you can define a style so that its unique attributes 
change relative to changes in the base style. For example, if the 
line width in "Dark Fill" is 4 points and you increase the line width 
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in "Filled Objects" by 2 points, the line width in "Dark Fill" would 
also increase by 2 points. 

You can also define a new style without using a base style. The 
program uses the default attributes or the attributes of a selected 
object as the starting point instead. 

To define a new graphic style (Level 4) 

1. Select a graphic object with graphic attributes identical or similar 
to those of the style you want to create. The attributes in the 
selected (or base) style define the initial attributes of the new style. 
You can also start from scratch, with no objects selected. 

2. Choose Graphic Style Sheets from the Attributes submenu of the 
Graphics menu. A submenu appears. 

3. Choose Define New Style from the submenu. A dialog box 
appears: 

1:1 Define New StLJle 

~l~INormal =-Descriptio_n~ _-l~I 

o Display in Tool Bar Pop-Down List 

.----------Attributes---------~ 

o Area Color Relative 
o Area Mask Relative 
o Line Color Relative 
o Line Mask Relative 
o Line Width Relative 

Name: 

4. Complete the dialog box, changing, the options you want: 
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Display in Tool Bar Pop-Down List. Select whether the style 
appears in the graphic styles list, if the styles list is available. The 
styles list appears only if you customize tool bars to show style 
sheets using the Customize tool bars choice on the Options 
submenu of the Graphics menu. For more information about 
customizing tool bars, see Chapter 3. 

Area Color Relative. Select to make the area color blend relative 
to the area color blend of the base style. Changing the area color 



blend in the base style changes the area color blend in the current 
style by the same amount. 

Area Mask Relative. Select to make the area shading (mask) 
percentage relative to the area shading percentage of the base 
style. Changing the area shading percentage in the base style 
changes the area shading percentage in the current style by the 
same amount. 

Line Color Relative. Select to make the line color blend relative 
to the line color blend of the base style. Changing the line color 
blend in the base style changes the line color blend in the current 
style by the same amount. 

Line Mask Relative. Select to make the line shading (mask) 
percentage relative to the line shading percentage of the base 
style. Changing the line shading percentage in the base style 
changes the line shading percentage in the current style by the 
same amount. 

Line Width Relative. Select to make the line width relative to the 
line width of the base style. Changing the line width setting in the 
base style changes the line width setting in the current style by the 
same amount. 

Name. Enter a new style name. You can use letters, numbers, and 
spaces. Choose a name that indicates what the style does. For 
example, you could use the name "Dark Area Fill" for a style that 
fills the area of the graphic object with the specified shading. 

5. Tap Define New Style to define the style. 

6. Tap Close to close the dialog box. 

Applying a Graphic Style 

You can change the appearance of a graphic object simply by 
applying a style from the graphic style sheet. 

To apply a graphic style (Level 4) 

1. Select the graphic object to which you want to apply the style. 

2. Choose Graphic Style Sheets from the Attributes submenu of the 
Graphics menu. A submenu appears. 
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3. Choose Apply Style from the submenu. A dialog box appears, 
listing styles from the style sheet, though not necessarily all the 
styles listed here: 

Normal 

Flow Region ~ 
Rule Lines 
Header I Footer 
Graphics Fram€ 

4. Select the style you want from the list. The style is applied to the 
selected graphic object. 

5. Tap the window control button to close the dialog box. 

Changing a Graphic Style 

You can change a style in two ways. You can change its visual 
attributes (area attributes, line attributes, gradient fill, and so on), 
or you can change its style attributes (area color relative, area 
mask relative, and so on). If the style serves as the base style for 
other styles, changes can affect those dependent styles as well. 

CHANGING VISUAL ATfRIBUTES 

You can redefine a style based on the attributes of a selected 
object. You can change an attribute for one graphic object, then 
redefine its style to add the attribute to all other graphic objects in 
the same style. 

To change the visual attributes of a graphic style (Level 4) 

1. Select an object in the style you want to redefine. For example, if 
you want to redefine a style called "DarkFill," select an object in 
the DarkFill style. 

2. Change any attributes you want for the style you are redefining. 

3. Choose Graphic Style Sheets from the Attributes submenu of the 
Graphics menu. A submenu appears. 

4. Choose Redefine Style from the submenu to update the style with 
the attributes of the selected graphic object. The program also 
updates any other graphic objects in that style. 
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CHANGING STYLE AITRIBUTES 

You can modify the definition of any style in the styles list to 
change its style attributes (area color relative, area mask relative, 
and so on). 

To change the style attributes of a graphic style (Level 4) 

1. Choose Graphic Style Sheets from the Attributes submenu of the 
Graphics menu. A submenu appears. 

2. Choose Manage Styles from the submenu. The following dialog 
box appears, though not necessarily with all the styles shown here: 

The current style is highlighted. 

Rule Lines 
Header I Footer 
Graphics Frame 

~------1---Description,--------~ 

Area: Black + Lin : Black, I point 

Styles List Style description 

3. Select the style you want to modify from the list. 
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4. Tap Modify. A dialog box appears: 

Modify Style 

Style Name: ~lll_t._1!_11_f<a_§_•11!ill_• ____________ ~ 
o Display in Tool Bar Pop-Down List 

---------Attributes-------------, 

D Area Color Relative o Line Width Relative 

D Area Mask Relative 

o Line Color Relative 

o Line Mask Relative 

Base Style: 

« No Base style » 
Normal ~ 
Flow Region 
Rule Lines 
~-----' 

l!'.!odiry I I Cancel I 

5. Complete the dialog box, changing the options you want. 

For a description of these options, see "Defining a New Graphic 
Style" in this chapter. 

6. Change the base style, if you want, by selecting it in the list. If you 
do not want a base style, choose <<No Base Style>>. 

7. Tap Modify to apply the changes to the selected style. The dialog 
box disappears. 

8. Tap Close to close the Manage Styles dialog box. 

Deleting a Graphic Style 

You can delete a style you no longer need. This eliminates clutter 
in the graphic style sheet. Once you delete a style, you cannot 
recover it. You cannot delete the Normal style. 

To delete a graphic style (Level 4) 

1. Choose Graphic Style Sheets from the Attributes submenu of the 
Graphics menu. A submenu appears. 
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2. Choose Manage Styles from the submenu. The Manage Styles 
dialog box appears. 

3. Select the graphic style you want to delete from the list. If the 
selected style has a base style, the name of the base style appears 
in the style description box. 

4. Tap Delete to delete the selected graphic style. The program 
attaches the base style to any graphic objects in the style you just 
deleted. However, it does not actually change the current graphic 
attributes of those objects. 

or 

Tap Delete and Revert. The program deletes the selected graphic 
style, attaches the base style to any graphic objects in the style you 
just deleted, and overrides the current graphic attributes of those 
objects with the attributes in the base style. 

Reverting to a Base Graphic Style 

If, after you apply a style to an object, you change the attributes of 
the object, you can remove all your changes by reverting to the 
object's original style attributes. 

To revert to the base graphic style (Level 4) 

1. Select the graphic object to which you want to reapply the style. 

2. Choose Graphic Style Sheets from the Attributes submenu of the 
Graphics menu. A submenu appears. 

3. Choose Revert to Base Style from the submenu. The program 
applies the base style to selected graphic objects, overriding the 
current attributes of selected graphic objects with the attributes in 
the base style. 

Using Style Sheets from Other Drawings 

You can copy style sheets (text and graphic styles) from another 
drawing into a drawing you are working on. That way, you do not 
need to define the same styles all over again. 

To get the graphic style sheet from another drawing (Level 4) 

1. Choose Graphic Style Sheets from the Attributes submenu of the 
Graphics menu. A submenu appears. 

2. Choose Bring in Style Sheet from the submenu. A standard file 
selector appears. 
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3. Use the file selector to find and select the drawing containing the 
styles you want to bring in. 

4. Tap Load Style Sheet. The styles are imported from the drawing 
you selected. If two styles with the same name appear in the two 
drawings, the style attriqutes in the source drawing are used. 

5. Tap Close to close the dialog box. 

Storing and Recalling Graphic Attributes Temporarily 

You can temporarily store the graphic attributes for one object and 
then apply them to other objects without first creating a named 
graphic style. To do so, you use the Store Style choice. Named 
styles are saved with your document, but graphic styles you record 
with the Store Style choice a.re not saved when you exit the 
application. 

To store or recall graphic attributes (Level 4) 

1. Select a graphic object that has the formatting attributes you want 
to store. 

2. Choose Graphic Style Sheets from the Attributes submenu of the 
Graphics menu. A submenu appears. 

3. Choose Store Style from the submenu. The program remembers 
the attributes of the selected graphic object. 

Select another object and choose Recall Style from the submenu. 
The program applies the graphic attributes you stored to the 
selected graphic object. 

SETTING EXTENDED ATTRIBUTES 

LEVEL 4 
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You can set two extended attributes for an object: 

• Object annotation 

• Object locks 

Object annotation allows you to mark objects in your drawing that 
you do not want printed, or that you want hidden. You can also 
make annotated objects unselectable and uneditable, locking them 
against any inadvertent changes. 

Annotated objects are useful when you want to place reference 
objects in your drawing, but you do not want them printed. For 
example, if you need a diagonal guideline, but you do not want 



the line to print along with the other objects in your drawing, draw 
the line and annotate it. Then set the annotation options (in the 
Options menu) so that the diagonal guide does not print, but still 
appears on the screen. 

You can also lock an object against specific changes. For example, 
you can lock the delete operation so that you do not inadvertently 
delete an object you want to keep. Similarly, you can lock the 
move operation so that the object remains in a fixed position and 
is unaffected by subsequent move, align, or distribute operations. 

To set extended attributes for an object (Level 4) 

1. Select the object for which you want to set extended attributes. 

2. Choose Extended Attributes from the Attributes submenu of the 
Graphics menu. A dialog box appears: 

1:1 Extencled Attnbutes 

o[ijn~()t~(i()h; 
.--~~~Locks~~~~ 

o Move o Attribute 

o Resize o Group 

o Rotate o UnGroup 

o Skew o Draw 

D Edit o Print 

o Delete 

r··;;i;i;i;~··i lc1osel [II 

3. Select the attributes you want: 

Annotation. Select this attribute to mark the object as an 
annotation. By default, this attribute is not selected. For 
information about annotating documents, see Chapter 3. 

Locks. Select any of these attributes to prevent the applicable 
operation (Move, Resize, Rotate, Skew, Edit, Delete, Attribute, 
Group, Ungroup, Draw, or Print). By default, these attributes are 
not selected. 

4. Tap Apply to apply your changes. 

5. Tap Close to close the dialog box. 

To annotate an object (Level 4) 

1. Select the object you want to annotate. 

2. Choose Extended Attributes from the Attributes submenu of the 
Graphics menu. A dialog box appears. 
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3. Tap to select Annotation. All annotated objects will be affected by 
choicE;s you make on the Annotations submenu in the Options 
menu. 

To print annotated objects (Level 4) 

The default setting for annotated objects is that they do not print. 

1. Choose Annotations from the Options menu. The Annotations 
submenu appears. 

2. Select Print. To turn off the printing for annotated objects, deselect 
the Print option. 

To make all annotated objects unselectable and uneditable 
(Level 4) 

1. Choose Annotations from the Options menu. The Annotations 
submenu appears. 

2. Tap Make Annotations Unselectable/Uneditable. All your 
annotated objects are now unselectable and uneditable. 

To make all annotated objects selectable and editable (Level 4) 

1. Choose Annotations from the Options menu. The Annotations 
submenu appears. 

2. Tap Make Annotations Selectable/Editable. All your annotated 
objects are now selectable and editable. 

To hide all annotated objects (Level 4) 

Annotated objects, by default, appear on the screen. You can hide 
them using this procedure: 

1. Choose Annotations from the Options menu. The Annotations 
submenu appears. 

2. Deselect Draw Annotations. The annotated objects in your 
drawing disappear. To see the annotated objects in your drawing, 
reselect Draw Annotations. 

To delete all annotated objects (Level 4) 

1. Choose Annotations from the Options menu. The Annotations 
submenu appears. 

2. Tap Delete Annotations. All annotated objects in your drawing are 
deleted. 

8.66 USING GRAPHICS 



ADVANCED VIEW FEATURES 

LEVEL 4 Level 4 offers you two additional ways to change the view of your 
drawing: hiding objects and changing the size of selection handles. 
Both can make it easier for you to see objects on your screen that 
might otherwise be obscured by other objects. 

Hiding and Showing Objects 

You can select the objects you want to work with and then hide all 
other objects in the drawing. This feature is helpful if you are 
working on subtle details in a complex drawing and you want to 
focus on the area you are changing while ignoring everything else. 

Hiding an object merely conceals it from view; it does not change 
the object's size, position, or other attributes in any way. 

To hide unselected objects (Level 4) 

1. Select the object that you want to remain visible. 

2. Choose Hide from the Edit submenu of the Graphics menu. A 
submenu appears. 

3. Choose Hide Unselected Objects from the submenu to hide all 
objects that are not selected. 

To show hidden objects (Level 4) 

1. Choose Hide from the Edit submenu of the Graphics menu. A 
submenu appears. 

2. Choose Show Hidden Objects to display all hidden objects. 
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Changing the Size of Selection Handles 

You can increase the size of selection handles to make them easier 
to see and to grab with the pen. You can reduce their size so that 
they cover less of the drawing area, or you can make them 
disappear if you do not want to see them. 

- Small handles 

-
I + I - Medium handles -
. - ' 

I + I - Large handles 

. - " 

-~ Invisible handles 

To change the display size of selection handles (Level 4) 

1. Choose Handles from the Options submenu of the Graphics menu. 
A submenu appears. 

2. Choose Small, Medium, Large, or Invisible Handles from the 
submenu to change selection handles for all objects to the size you 
want. The new size stays in effect until you exit the application. 

ADVANCED DUPLICATING 

LEVEL 4 At Level 4, you can automatically scale and skew objects when 
you duplicate them. 

To custom duplicate an object (Level 4) 

1. Select the object that you want to custom duplicate. 

2. Choose Duplicate from the Edit submenu of the Graphics menu. A 
submenu appears. 
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3. Choose Custom Duplicate. A dialog box appears: 

4. 

1:1 Custom Duplicate 

,. of Duplicates: DB Move 

C--+ 10 pt IB Rotate 

IBI •il0 '10 pt IB 
Scale Skew 

E!l] I 100 IB , .. DB 
11100 18 ~DB 

I Duplicate I I Close I [I] 

Complete the dialog box, changing the options you want: 

# of Duplicates. Select the number of duplicates you want to 
make of the original. 

Rotate. Select the number of degrees by which you want to 
incrementally rotate each duplicate. 

Scale. Select the scale percentage by which you want to 
incrementally resize each duplicate. 

Move. Select the vertical and horizontal distance by which you 
want to incrementally move each duplicate. 

Skew. Select the number of left/right and upward/downward 
degrees by which you want to skew each duplicate. 

5. Tap Duplicate to duplicate the selected object using the options 
you specified. 

6. Tap Close to close the dialog box. 
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PASTING AN OBJECT INSIDE ANOTHER 

LEVEL 4 
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At Level 4, you can paste one object inside another to produce 
creative visual effects: 

Pasting Inside 

When you paste an object inside another object, the objects are 
combined into a single object that you can manipulate as you 
would any other graphic object. You can use this feature just as an 
airbrush artist would use a stencil overlay on an image. 

The outside object is called the container object and the inside 
object is called the interior object. The boundaries of the container 
object become the boundaries of the interior object. The following 
procedure will use a progressive example thaJ shows how you can 
paste one object inside another. 

Container object 

I Interior object 



To paste inside (Level 4) 

1. Place the interior object over the container object. Position the 
interior object in relation to where you want it inside the container 
object, as shown in the following example: 

Interior object 

. ·1 Container object 

If the two objects do not overlap, you cannot paste inside. 

NOTE 

Be sure to position the interior object as close as possible to where 
you want it. You can fine tune it later, nudging it one pixel at a time, 
but you can save time by setting the position precisely in this step. 

2. Select the interior object. 

l~I 3. Tap the Cut icon. 

or 

Choose Cut from the Edit menu. 

Either way, the object is placed on the clipboard. 

4. Select the container object. 

Container object 

5. Choose Paste Inside from the Edit submenu of the Graphics menu. 
A submenu appears. 

6. Choose Paste Inside. The interior object is pasted inside the 
container object: 
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Nudging Inside 

Once you have pasted an object inside another, you can fine tune 
the position of the interior object by moving it one pixel at a time. 

To nudge inside (Level 4) 

1. Select the object that .contains the object you want to nudge inside. 

2. Choose Paste Inside from the Edit submenu of the Graphics menu. 
A submenu appears. 

3. Choose Nudge Inside. A submenu appears. 

4. Select Left, Right, Up, or Down to nudge the interior object one 
pixel in the direction you select. 

Breaking Out Paste Inside 

Once you have pasted one object inside another, you can break 
the object into its component objects using the Break Out Paste 
Inside choice. That way, you can manipulate the resulting 
individual component as objects rather than as a group. 

To break out paste inside (Level 4) 

1. Select the object you want to break out. 

2. Choose Paste Inside from the Edit submenu of the Graphics menu. 
A submenu appears. 

3. Choose Break Out Paste Inside to split the component objects into 
separate objects. 

SETTING ATTRIBUTES 

LEVEL 4 
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This section explains how to set the new attributes that are 
available at Level 4. For information about area and line attributes, 
see "Using the Drawing Tools" in this chapter. 

Setting the Background Color 

When you apply a pattern or shading to a graphic object, it 
appears transparent - allowing you to see any graphic objects or 
text behind it. You can, however, make the object appear 
completely opaque by turning on the object's background color. 



The following illustration shows what an object looks like with its 
background color turned off and turned on: 

No shading 
No pattern 
Background 
color off 

Pattern fill 
Background 
color off 

Pattern fill 
Background 
color on and 
set to white 

To set the background color (Levels 4) 

1. Select the graphic objects for which you want to change the 
background color. 

2. Choose Background Color from the Attributes submenu of the 
Graphics menu. A dialog box appears: 

i::::ll Backgr·ouncf C olot 

1--------H-- Sets the background 

Cl B Cl B Cl color. 
Red a Green a Blue a Sets the color blend. 

<>Draw Background •Don't Draw Background Determines whether 
!i;if;-f;i~Jl ~ [I} the background color 

is drawn. 

3. Complete the dialog box, changing the attributes you want: 

Color Tools. Select the background color from the color palette. 
You can also fine tune the color blend by setting the amounts of 
red, green, and blue in the background color; default values 
depend on the selected color. 

Draw Background or Don't Draw Background. Select Draw 
Background if you want background color. By default, the 
program does not, and objects are transparent. Setting the 
background color has no effect unless Draw Background is 
selected. 

4. Tap Apply to apply your changes to selected objects. 

5. Tap Close to close the dialog box. 

Setting the Gradient Fill 

A gradient fill is a type of area fill that gradually fades from one 
color (gray scale) to another. A gradient fill can give graphic 
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objects a three-dimensional appearance and can be a visually 
appealing background for other objects. 

You specify a starting color, an ending color, and the number of 
times (intervals) the color changes between the starting and 
ending points. You also select one of the following types of 
gradient fill: 

• A horizontal gradient goes from left to right, beginning with 
the start color on the left edge of the graphic object and ending 
with the end color on the right edge. 

• A vertical gradient goes from top to bottom, beginning with the 
start color on the top edge of the graphic object and ending 
with the end color on the bottom edge. 

• A rectangular gradient goes in a rectangular pattern from the 
outside edge of the graphic object to its center, beginning with 
the start color on the outside edge and ending with the end 
color at the center. 

• A radial gradient goes in an elliptical pattern from the outside 
edge of the graphic object to its center, beginning with the start 
color on the outside edge and ending with the end color at the 
center. 

To set the gradient fill for an object (Levels 4) 

1. Select the graphic object that you want to fill. 

2. Choose Gradient Fill from the Attributes submenu of the Graphics 
menu. A dialog box appears: 
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i:::::I Gracl1ent Fill 

~-----start Color-----~ 

••llllllllllllllllllllllllllllllllllillHiHl!::;:::lallll ·•••·I -----+tt- Sets the Start Color 

Red EJ B Green EJ B Blue EJ B Sets the Start Color 
blend 

~-----End Color·------~ 

••1111111111l•llllillllllllll!lliil!)i)l!:i:i;iJllllllll I l----++1---- Sets the End Color 

Red EJ B Green EJ B Blue EJ B Sets the End Color 
blend 

l•~t llllllc:llc:>I Sets the type of 
c:-1 B gradient fill 

Number of Intervals ~ 

[i\[;[;i\ij I Close I [1J Sets the number of 
intervals in the gradient 



3. Complete the dialog box, changing the attributes you want: 

Color Tools. Select the start and end colors (gray scale) for the 
gradient fill from the color palette. You can also fine tune the color 
blend by setting the amounts of red, green, and blue in the start 
and end colors; default values depend on the selected color. 

Gradient Fill Type. Select the type of gradient fill (vertical, 
horizontal, rectangular, or radial). 

Number of Intervals. Select the number of changes in color 
(gradations) from start to end. Some video hardware and printers 
may be unable to reproduce finer gradations (a higher number of 
intervals). 

4. Tap Apply to apply your changes. 

5. Tap Close to close the dialog box. 

To remove a gradient fill from an object (Levels 3-4) 

1. Select the graphic object that you want to change. 

2. Choose Gradient Fill from the Attributes submenu of the Graphics 
menu. A dialog box appears. 

3. Tap the selected gradient type to deselect it. 

4. Tap Apply to apply your changes. The gradient fill is removed. 

5. Tap Close to close the dialog box. 

Changing Arc Attributes 

An arc is a portion of an ellipse. Since a full ellipse is 360-degrees 
around, a 90-degree arc is exactly one quarter of an ellipse; a 180-
degree arc is half of an ellipse. 

You can set the precise size (in degrees) of the starting angle and 
ending angle of any arc. You can also specify whether you would 
like your arc's endpoints connected by radii or by a chord. The 
following illustration shows what radii- and chord-connected arcs 
look like. 

Arc connected by chord 

Arc connected by radii 
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To change the arc attributes (Levels 4)) 

1. Select one or more arcs that you want to change. 

2. Choose Arcs from the Attributes submenu of the Graphics menu. A 
dialog box appears: 

Jt Starting Angle Li 
/Jlt. Ending Angle ~ 

Starting Angle 

Ending Angle 

l•J..-..1---+1----- Options for connecting the endpoints 

[i=i~;~;i~)J I Close I CZ] 

3. Complete the dialog box, changing the options you want: 

Starting Angle. Select the starting angle, measured 
counterclockwise from horizontal. You can specify from zero (O) 
to 360 degrees, inclusive. 

Ending Angle. Select the ending angle, measured 
counterclockwise from horizontal. You can specify from zero (O) 
to 360 degrees, inclusive. 

Endpoints Connected. Select whether you want the endpoints 
connected by two radii or by a chord. 

NOTE 

The starting and ending angles for the arc of a circle represent 
angles measured counterclockwise from horizontal. The starting 
and ending angles of an elliptical arc are slightly different: they 
represent the angles of a circular arc that has been stretched. 

4. Tap Apply to apply your changes. 

5. Tap Close to close the dialog box. 

8.76 USING GRAPHICS 

Setting Default Attributes 

The default attributes are the area, line, and other attributes that 
are used automatically when you create a new graphic object. 

When you draw multiple objects with similar attributes, you can 
save time by formatting the first object, then saving its attributes as 
the default attributes. The default attributes are applied to any new 
objects you create. 

For example, if you want to draw four patterned squares with 
heavy borders, you can simply draw the first square, give it a fill 



pattern and a heavy line border, set default attributes, and then 
draw the other three squares (which will automatically have the 
same formatting). 

You can use the tools on the Attribute tool bar to specify default 
attributes even if no object is selected. For example, you can select 
a line weight from the Line thickness tool and it will be applied to 
any new objects you create. 

Default attributes apply regardless of the shape you draw. For 
example, after drawing the four squares in the previous example, 
you could continue drawing squares, ellipses, arcs, and polylines 
with the same fill pattern and border thickness. 

To change the def a ult attributes (Level 4) 

1. Select an object that has the attributes you want to use for the 
default attributes. 

2. Choose Set Default Attributes from the Attributes submenu of the 
Graphics menu to save the new attributes of the selected object as 
the default. 

You can change the default attributes as often as you like. 
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WHAT IS GEOMANAGER? 

GeoManager is the unit's central application. GeoManager is the 
first application you see, and it serves as a platform for starting 
other GEOS applications (Geo Write, GeoCalc, GeoFile) or DOS 
programs. 

THE GEOMANAGER WINDOW 

When you start the unit, the GEOS operating system starts, and the 
GeoManager window opens. The GeoManager window usually 
remains open, though it may close automatically when you start 
large applications such as GeoWrite. In some situations, for 
example when you are running several smaller applications and 
want to improve application speed, you may choose to close the 
GeoManager window using Close from the File menu. To reopen 
the GeoManager window, simply choose Go to GeoManager from 
the Express menu. 

Although you can close the GeoManager window, normally you 
never exit GeoManager. For more information, see "Exiting 
GeoManager" in this chapter. 
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The GeoManager window consists of three separate areas: 

Information bar. The Information bar displays the folder path 
name, the number of files and folders currently appearing in the 
folder window, the amount of disk space in bytes used by the files 
shown, and the amount of space remaining on the disk containing 
the folder. 

Folder window. This area shows the contents of the currently 
opened folder. (The name and path of the folder appear in the 
Information bar.) When the GeoManager window first opens, it 
displays the contents of the WORLD folder, where all GEOS 
applications are stored. This area can show only one folder at a 
time. 

Tool area. These buttons give you easy access to drives, special 
folders, and common operations. 

Each of these areas is described below. 

The Folder Window 

The folder window shows the contents of the currently opened 
folder. When you want to perform tasks with a document or a 
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folder in the folder window, you take some action with the 
document or folder icon. For instance, to open a folder, you 
double-tap its icon. 

There are several kinds of icons that appear in the folder window: 

GEOS application icons. These icons represent GEOS 
applications. (The icon for Geo Write is shown at left.) You can 
double-tap a GEOS application icon to start the application. For 
more information, see Chapter 1. 

DOS application icons. These icons represent optional DOS 
applications that you can run. The files for DOS applications 
usually end in .EXE, .BAT, or .COM. You can double-tap a DOS 
application icon to run it. For more information, see "Starting DOS 
Applications" in this chapter. 

WARNING 
Do not start a DOS application unless you have an external 
keyboard attached to your unit. If you start a DOS application that 
requires a keyboard, and you do not have a keyboard, you must 
restart the unit to return to GeoManager. To restart the unit, press 
the restart button on the front of the unit. To connect an external 
keyboard, turn the unit off, connect the keyboard, and then turn the 
unit on again. 

GEOS document icons. Each type of GEOS document has a 
unique icon. This icon usually contains the icon of the application 
used to create the document. If you double-tap the icon, the 
application starts and automatically opens the document. 

Folder icons. Folder icons in the folder window represent 
directories. The terms "folder" and "directory" are often used 
interchangeably, in much the same way as "file" and "document" 
are. 

DOS users should note that although folders correspond to DOS 
directories, the names of folders do not have to conform to the 
DOS naming standard. In GEOS, folder names can be as long as 32 
characters and can contain upper- and lowercase letters. 

The Wastebasket 

The icon for the Wastebasket is shown at the left. Drag folders and 
files onto this icon to throw them away. Use this icon carefully! 
Once you have dragged a file or folder onto the Wastebasket, it is 
permanently deleted and cannot be retrieved. 
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The WORLD, DOCUMENT, and DOSROOM Folders 

The icons for the WORLD, DOCUMENT, and DOSROOM folders 
are shown at the left. Tap these icons to open their respective 
folders. You can also copy and move documents and folders to 
these folders by dragging the icons onto the appropriate button. 

The Connect/Disconnect Button 

The icon for the Connect/Disconnect button is shown at the left. 
Tap the button to connect to or disconnect from a computer that is 
running GeoHost. The button icon toggles between connect and 
disconnect, depending on the current connection status. For more 
information, see Appendix C. 

The Drive Buttons 

Icons for the drive buttons are shown at the left. Every drive 
available on the unit, including the RAM-drive and ROM-drive, is 
represented by a button. A floppy disk button appears for an 
optional floppy disk drive. Additional buttons appear for other 
optional devices (such as IDE, SRAM, and flash cards) installed in 
the unit. Tapping a button opens the root folder of the 
corresponding drive; similarly, dragging document and folder 
icons onto a drive button copies or moves the items to the root 
folder of that drive. 

Drives are identified by a single letter (always followed by a 
colon). This letter appears on the button. "A:" is the default drive 
assignment for the optional floppy disk drive. "C:" is normally 
assigned to the ROM-drive and "D:" is normally assigned to the 
RAM-drive. The rest of the letters are for other storage devices 
attached to or installed in the unit. 

The Information Bar 

The Information bar at the top of the folder window shows 
information about the folder, and about the drive on which it is 
located. 
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Open Parent Folder button 

DOS path of folder 

·• D:(RAM-DISK) \GEOWORKS\WORLD - 736,256 bytes free. 

Free space on drive 

Open Parent Folder button. Tap this button to quickly open the 
folder that contains the current folder and is one level higher. (This 
higher-level folder is the parent folder.) 

Number of icons in the folder. This is the number of items 
contained in the folder. When you select one or more icons, this 
number changes to show how many icons are selected. 

Total size of icons. This is the total size of all the document icons 
in the folder. The amount is expressed in bytes, or characters. 
When you select one or more icons, the figure changes to show 
the total size of all the selected items. Note that this total does not 
include the size of items contained within any folders in this 
folder. 

Free storage. This figure shows the amount of space remaining 
on the drive that contains this folder. 

Path of folder. This shows all the folders you went through to 
reach the current folder. Reading from left to right, it starts with the 
top folder (the root folder) of the drive. It then shows the highest
level parent folder. Then the folder that is contained in that folder 
(the next-lower-level parent folder), and so on until it reaches the 
current folder. Backward slashes ("\ ") separate the folder names. 

Reading a path is a little like reading an address. For example, if 
you have a file named "Main Street" in the folder "Ourtown," 
which is in the folder "California," on the disk named "USA," the 
path name for "Main Street" would read: 

USA\California\Ourtown\Main Street 

WORKING WITH DOCUMENT AND FOLDER ICONS 

When you want to perform a task with a document or folder, you 
perform the task by using its icon. 
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Selecting Icons 

Before you can do something with a document or a folder, you 
must first select its icon by tapping it. The icon is highlighted to 
show that it is selected, like the icon at the left. 

To select multiple icons using the pen 

1. Place the pen slightly above and to one side of the icons you want 
to select, and then hold it on the screen. 

2. Holding the pen down, drag it down and across the icons until an 
outline box surrounds the icons you want to select: 

i PolmSchedule Preferences i 

3. Lift the pen when the outline box completely surrounds the icons. 
The icons you selected are highlighted. 

To select multiple icons using the pen and an external keyboard 

This procedure works only if you have attached an external 
keyboard to the unit. 

1. Press and hold down the Ctrl key, then tap each icon you want to 
select, while still holding down the Ctrl key. Each icon you select 
is highlighted. 
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Selected icons 

2. You can deselect (unhighlight) an icon by tapping it again while 
still holding down the Ctrl key. Other selected icons stay selected. 

3. Release the Ctrl key. The icons you have selected remain 
highlighted. 
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At this point, you can press the Ctrl key again and continue to 
select and deselect as you like. As long as you press the Ctrl key, 
your selection will continue where you left off. 

Dragging Icons 

You can copy or move files and folders simply by dragging the 
icons with the pen and dropping them where you want them to 
go. When you drag and drop a document icon onto another drive 
button, a copy of the document is placed in the root folder of the 
other drive. When you drag and drop a document onto a folder 
icon on the same drive, the document is moved to that folder. 

To drag and drop an icon 

1. Select the icon you want to move by tapping the icon and holding 
down the pen. A small outline (as shown at left) appears on top of 
the icon. 

2. With the pen still held down, drag the pen to move the outline on 
the screen to the location you want. 

3. Lift the pen to drop the icon. The icon appears in the new 
location. 

To drag and drop multiple icons, follow the same procedure as 
above, only first select all the icons you want to drag, move the 
pen directly over one of the highlighted icons, and then tap the 
pen and hold it down until the small outline appears. With the pen 
held down, drag it to move the outline to the location you want. 
Lift the pen; the icons appear in the new location. 

OPENING FOLDERS 

Games 

In GeoManager, folders look like little manila folders, like the one 
shown at left. To view the contents of a folder, you open it so that 
the contents of the folder are displayed in the GeoManager 
window. When you start the unit for the first time, GeoManager 
automatically opens the WORLD folder. 

To open a folder, double-tap the folder's icon or select the folder's 
icon and choose Open from the File menu. The folder opens and 
its contents are displayed in a window. (This menu choice is 
disabled if more than one folder is selected; you can open only 
one folder at a time.) 
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Viewing Files and Folders as a List 

You can view the contents of a folder as an alphabetized word list 
(with or without details) instead of as icons. Of the three viewing 
options (listed below), the highlighted option is the one currently 
in effect. 

To change the current viewing option, open the folder you want to 
change. Choose the option you want from the View menu. You 
have these choices: 

Names Only. This shows the contents of the folder as a list of 
very small icons with the name of each item on the right (instead 
of below). This view is especially useful if you have many files in a 
folder and want to see as many as possible without scrolling. 

Names and Details. This also shows the contents of the folder as 
a list of small icons, but with the name, size, modification date, 
and attributes to the right of each icon. Each file attribute is 
represented by a single letter: Read-Only (R), Hidden (H), System 
(S), and Archive (A). For more information about file attributes, 
see "Viewing Information About Files and Folders" in this chapter. 

Icons. This is the standard option. It shows the contents of the 
folder as file or folder icons, with the name of each item below its 
icon. 

Sorting the Contents of Folders 

In addition to being able to view size, type, and date information 
for files and folders, you can also sort the icons in the folder 
window by choosing Sort By from the View menu. You can sort 
the icons in the following ways: 

Name. This sorts the contents of the folder alphabetically by the 
entire DOS name. 

DOS Extension. This sorts the contents of the folder 
alphabetically by the one- to three-letter suffix appearing after the 
period in the DOS name for the file or folder. 

Modification Date and Time. This sorts the contents of the 
folder by date and time of last modification, in reverse 
chronological order. 

Creation Date and Time. This sorts the contents of the folder by 
date and time of creation, in reverse chronological order. 

Size. This sorts the contents of the folder in ascending size. 

DOS Order. This sorts the contents of the folder in the order in 
which they would appear in DOS. 
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Showing Hidden Files 

Hidden files and files with the System attribute do not 
automatically appear in the folder window. To view these files and 
have them included in the file size count at the top of the window, 
you must turn on the Show Hidden Files option from the View 
menu. When you turn this option off, these files disappear again. 

Compressing the Folder Display 

.The Compress Display option on the View menu changes the 
spacing of icons in the folder window. Turning it on brings the 
icons closer together, so that more of them can fit in a window. 
Turning it off returns icons to their normal spacing. 

Opening the WORLD, DOCUMENT, and DOSROOM Folders 

In GeoManager, you can view the contents of three special folders: 
WORLD, DOCUMENT, and DOSROOM. The WORLD folder 
contains GEOS applications, the DOCUMENT folder contains 
documents (data files created with GEOS applications), and the 
DOSROOM folder contains DOS application launchers. 

To open the WORLD, DOCUMENT, or DOSROOM folder, tap the 
appropriate folder button at the bottom of the GeoManager 
window. The folder opens and its contents are displayed in the 
window. 

Opening a Parent Folder 

You can open the parent folder of the current folder by tapping 
the Parent Folder button on the Information bar. A parent folder is 
one level higher than the current folder and is the folder that 
contains the current folder. When you move up as far as the root 
folder, the Parent Folder button dims to indicate that the current 
folder has no parent. 

Opening a Folder on Another Drive 

You can open a folder on another drive by tapping the appropriate 
drive button. If the folder is on a floppy disk, remember to insert 
the floppy disk into the optional floppy disk drive before tapping 
the drive button. If the folder is on a PCMCIA card, you will not 
see the drive button until you insert the card into the unit. 

9.10 MANAGING DOCUMENTS WITH GEOMANAGER 



Opening Your BACKUP Folder 

Whenever you use the Make Backup function in an application, 
the backup document is saved into the BACKUP folder. If you 
need to open a backup document directly, you do so by first 
choosing Go to Backup from the Utilities menu to open the folder, 
and then double-tapping the document icon in this folder. 

CREATING A NEW FOLDER 

You can create a new folder inside any open folder. The new 
folder is empty until you move or copy items into it. 

To create a new folder 

1. Open the folder in which you want to place the new folder. If the 
folder is already open, make it active. 

2. Choose Create Folder from the File menu. A dialog box appears, 
asking you to name the new folder: 

Create Folder 

current Folder is D:[RAM-DISK) 
\GEOWORKS\WORLD 

New folder Name: l~---------~J 
I Cancel I 

3. Type a name for the folder. You can use any characters, and the 
name can be as long as 32 characters. 

4. Tap Create. A new folder appears in the current folder. 

RENAMING A FILE OR FOLDER 

The name that you give a folder or file is not necessarily 
permanent. You can change it at any time by using Rename from 
the File menu. First select the item (or items) you want to rename, 
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then choose Rename from the File menu. When the dialog box 
appears, enter the new name and tap Rename to apply the new 
name. If a file with the same name already exists, a dialog box 
asks you to type a different name. 

If you've selected several items, you get a separate dialog box for 
each item. Tap Next to leave the name of the current item 
unchanged and go on to the next item. Tap Cancel to close the 
dialog box without renaming the remaining selected files. 

Moving and Copying Files and Folders 

The easiest way to move or copy a file or folder is to drag it to its 
destination. Dragging an item to a folder on the same disk moves 
the item to that folder, whereas dragging it to another disk copies 
the item. But you can always force a move by holding down the 
Alt key while you drag the item, or force a copy by holding down 
the Ctrl key. 

You can tell what GeoManager is going to do by checking the 
pointer that you see as you drag the item: 

POINTER MEANING 

A filled square below the arrow indicates that the item will 
be copied. 

An unfilled square below the arrow indicates that the item 
will be moved. 

The circle-slash indicates that you cannot move or copy the 
item to this destination. 

To move or copy one or more items by dragging, first select the 
item or items you want to move or copy. Position the pen over 
one of the selected items and hold it down. The pointer indicates 
whether you are dragging a single item or several items. Drag the 
pen and position it over one of the following (depending on 
where you want to move or copy the items): 

• A folder icon in a folder window. The items are placed in that 
folder. 

• The Parent Folder button in a folder window. The items are 
moved to the parent folder, one level up in the folder hierarchy. 

• One of the drive buttons at the bottom of the GeoManager 
window. 
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• One of the special folder buttons (Wastebasket, WORLD, 
DOCUMENT, or DOSROOM) at the bottom of the GeoManager 
window. The items are copied to the special folder. 

When you move or copy more than one item, a dialog box 
appears, showing you the progress of the operation. If you want to 
halt the move or copy operation, tap Stop. The operation stops 
after finishing with the current file. 

You can also move or copy an item by using Move or Copy from 
the File menu. A file selector appears when you choose either 
action. Use it to find and open the destination folder. Tap Move to 
move the items, or Copy to copy the items, into the folder. 

DUPLICATING A FILE OR FOLDER 

You can make copies (identical in all but their names) of both files 
and folders. For example, you may want to duplicate a document 
file before making extensive changes to it, in order to have a 
backup copy of the original. 

To duplicate an item, first select the item (or items) you want to 
duplicate, then choose Duplicate from the File menu. When the 
dialog box appears, type in a name for the duplicate or the 
duplicate will be named "Copy of (file or folder name)." Tap 
Duplicate. A duplicate of the selected item appears in the same 
folder as the original. 

If you're duplicating more than one item, the name of the next 
item appears in the dialog box and the whole process repeats. Tap 
Next to skip the current item altogether. Tap Cancel to close the 
dialog box without duplicating the remaining items. 

DELETING A FILE OR FOLDER 

There are times when you need to make room by deleting files or 
folders you no longer need. Deleting a file or folder with 
GeoManager is as simple as placing it in the Wastebasket. You can 
also delete files by choosing Delete from the File menu. 

CAUTION 

You cannot recover or retrieve items from the Wastebasket. When 
you place an item in the Wastebasket or use Delete, the item is 
permanently removed from the unit. Be careful to delete only those 
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files you know you will not need later. You can set up warnings 
(through the Options menu) to appear before you delete or throw 
away an item. For more information, see "Changing GeoManager 
Options" in this chapter. 

To throw away an item by dragging it to the Wastebasket, first 
select the item (or items) you want to throw away; then position 
the pointer over the selected item (or one of the items, if several 
items are selected). Hold down the pen and drag the item to the 
Wastebasket. The item (or group of items) is deleted. If any 
applicable warnings are turned on, a dialog box appears, asking 
you to confirm the deletion. Tap Yes to delete the item. Tap 
Cancel to close the dialog box without deleting any items. 

To delete an item using Delete, first select the item (or items) you 
want to delete; then choose Delete from the File menu. The item 
(or group of items) is deleted. If any applicable warnings are 
turned on, a dialog box appears, asking you to confirm the 
deletion. Tap Delete to delete the item. Tap Cancel to close the 
dialog box without deleting any items. Deleting a file removes the 
file from your disk, so be careful to delete only those files you 
know you will not need later. 

VIEWING INFORMATION ABOUT FILES AND FOLDERS 

You can view the following information about files and folder: 

• GEOS and DOS names 

• DOS location 

• Creation and last modification dates and times 

• Creator and file owner 

• DOS and GEOS file types and attributes 

• Size 

• User notes 
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To view information about files or folders, select one or more files 
or folders, then choose File Information from the File menu. A 
submenu appears. Tap Get Info. A dialog box appears, displaying 
information about the first file or folder you selected. 

Get Info 

Name: Papers 

_DOS Name: PAPERS 
Path: D:[RAM-DISK] 

\GEOWORKS\DOCUMENT 

Last Modification: 8: 1 1 :22 AM 10/25/93 

Created: 8: 1 1 :22 AM 10/25/93 

Attributes: D 

File Size: 29,473 

Creator: -

!!ser Notes: 
Papers and Reports 

File Owner: -

File Type: Folder 

Release: 0.0 0-0 

I Cancel I 

You can enter notes about the 
file or folder here. 

Name. This is the GEOS name for the file or folder. 

DOS Name. This is the DOS name for the file or directory that 
corresponds to your GEOS file or folder. DOS names have up to 
eight characters, with a three-character extension. The DOS name 
of a file or folder (directory) may or may not correspond to the 
name that appears in GEOS. 

Path. This is the location of the file. 

Last Modification. This is the time and date of the last change 
that was made to the file or folder. 

Created. This is the time and date when the file or folder was 
created. 

Attributes. These are abbreviations for DOS or GEOS options that 
have been set on a file. If a particular attribute is attached to that 
file, it appears as one of the following letters: 

• Archive (A). This attribute is used as a flag by some DOS 
commands. 

• Directory (D). This indicates that the item is a DOS directory, 
which appears as a folder in GEOS. 

• Hidden (H). This indicates that DOS does not display the file or 
folder in a directory list. 
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• Read-Only (R). This indicates that you cannot modify the file or 
folder. 

• System (S). This indicates that the item is a special-purpose file 
or folder for use by DOS. 

• Template (T). This indicates that the item is a GEOS application 
template. For more information about templates, see Chapter 3. 

File Size. This is the number of bytes in the file or folder. 

Creator. This is the name of the application with which a file was 
created. 

File Owner. This shows the file owner's name if the computer is 
attached to a network that supports this field. 

File Type. This identifies the system function of the file or folder. 
File types include the following: 

• Executable. This indicates that the file is a GEOS application. 

• Data File. This indicates that the file is a GEOS data file. 

• V7l.f File. This indicates that the file is a GEOS data file that uses 
the GEOS virtual memory storage system. 

• Folder. This indicates that the item is a folder or DOS directory. 

• 1.X V7l.f File. This indicates that the item is a VM data file from 
an older version of GEOS. 

• DOS File. This indicates that the file is a DOS data file or 
application. 

Release. This is an internal version number displayed for GEOS 
applications only. More recent releases of an application have 
higher release numbers than older releases. 

User Notes. You can type your own notes in this text box. If the 
file is a GEOS file and it is not read-only, you can type comments 
about it in the User Notes area. 

When you are finished with the dialog box, tap either OK or 
Cancel to close it. If you selected several items for which you 
wanted to view information, tap Next to see information about the 
next selected file or folder. 

Changing File and Folder Attributes 

You can set a number of options or attributes on files and folders 
that will alter the way you use them with DOS or GEOS 
applications. Only very experienced DOS and GEOS users should 
change these attributes. 
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There is one attribute you may find useful for protecting special 
files or folders. You can set the Read-Only attribute on a file or 
folder so that you can view it but not modify it in any way. You 
also cannot move it, but you can throw it away or delete it using 
Delete on the File menu. 

To change file and folder attributes 

1. Select one or more files or folders. 

2. Choose File Information from the File menu. A submenu appears. 

3. Tap Change Attributes. A dialog box appears: 

Change Attnt)utes 

Current Folder is C:\GEOWORKS\DOCUMEHT 

Change Attributes: Market Report 
Io: o gead Only • f!rchive o .!::!idden o ~ystem 

o T~mplate 

I Cancel I 

4. Change the attributes to your liking: 

Archive (A). This attribute is used as a flag by some DOS 
commands. 

Directory (D). This indicates that the item is a DOS directory, 
which appears as a folder in GEOS. 

Hidden (H). This indicates that DOS does not display the file or 
folder in a directory list. 

Read-Only (R). This indicates that you cannot modify the file or 
folder. 

System (S). This indicates that the item is a special-purpose file or 
folder for use by DOS. 

Template (T). This indicates that the item is a GEOS application 
template. For more information about templates, see Chapter 3. 

The attributes are applied or removed, depending on the choices 
you made. 

5. Tap Change to apply the attributes to the file or folder. 

or 

Tap Next to change attributes on the next selected file or folder. 
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USING THE FOLDER TREE 

One of the best ways to see the folder structure of a drive is to 
view the organization as an upside-down tree, with the root folder 
of the drive at the top of the tree. Folders directly under the root 
folder form the main branches, their subdirectories branch off from 
them, and so on. Using the Tree menu, you can see this structure 
on the screen. 

Here is the Tree window for a typical drive: 

:r~ ?J •II%! 
Fne Uiew o:etions Disk Tree Utilities 
D:[RAM-DISK) \ 
G\ 

~"""~' DATABASE 
GEOWORKS 
GRAPHICS 
REPORTS 

ffiBlillll 
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You control how much of the folder tree is displayed by 
expanding or collapsing the branches (folders) of the tree. 
Expanding a folder displays its subdirectories; collapsing a folder 
hides them. A plus sign ( +) indicates that a folder can be 
expanded. A minus sign (-) indicates that a folder is already 
expanded. 

~ 

k"'l 

The Tree window does not show the files within a folder. You can, 
however, view a folder's files by double-tapping the folder name. 
You can also perform all folder management tasks (such as 
creating, copying, or moving folders) from within the Tree 
window. You can tap the folder name to select it, then choose the 
action you want from the File menu. Or just drag a folder from the 
Tree window to move or copy it into another folder. 

To open the Tree window 

• Choose Show Tree Window from the Tree menu. The tree for the 
current drive appears. 
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To expand all.folders in the tree 

• Choose Expand All from the Tree menu. This shows every folder 
(including those contained in other folders) on the current drive. 

To expand the next folder level 

1±1 • Tap the plus sign ( +) next to the folder you want to expand. 

or 

Tap to select the name of the folder you want to expand (do not 
tap the plus or minus sign) and choose Expand One Level from the 
Tree menu. 

To expand all folders within a branch 

1. Tap to select the name of the folder you want to expand (do not 
tap the plus or minus sign). 

2. Choose Expand Branch from the Tree menu. This shows you every 
folder (including those contained in other folders) inside the 
selected one. 

To collapse all folders within a branch 

B • Tap the minus sign(-) next to the folder you want to collapse. 

or 

Tap the name of the folder you want to collapse (do not tap the 
plus or minus sign), and choose Collapse Branch from the Tree 
menu. 

To display the folder tree for another drive 

1. Choose Tree Drive from the Tree menu. A cascade menu appears, 
listing the drives connected to your unit. 

2. Tap the drive you want to display. The Tree window changes to 
show the contents of the selected drive. 

To return to the regular GeoManager window 

• Choose Close from the Window Control menu. This closes the 
Tree window. GeoManager is automatically activated. 
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MANAGING DISK DRIVES 

The Disk menu lets you perform the following disk management 
tasks: 

• Copy a drive's contents onto another drive 

• Format a disk so that it can be used 

• Rename a disk 

• Rescan any drives needed to update the contents of the open 
folders 

• View the contents of a disk 

• Connect to a remote computer 

For more information on connecting to a remote computer, see 
Appendix C. 

Copying a Floppy Disk 

Copy Disk on the Disk menu lets you create an exact duplicate of 
a floppy disk. The original disk is called the source disk; the 
duplicate disk is called the destination disk. Because GeoManager 
makes an exact duplicate of the source disk, the destination disk 
must be the same size as the source disk. This means you must 
duplicate a 3.5-inch, high-density floppy disk onto a 3.5-inch, 
high-density floppy disk. Also, during a disk copy, GeoManager 
will write over all files that are on the destination disk. Be 
absolutely sure your destination disk contains nothing you want to 
keep. 

To copy a floppy disk 

1. If you have not already done so, label the source and destination 
disks so you do not inadvertently confuse them. 

2. Choose Copy Disk from the Disk menu. A dialog box appears: 

Copy Disk 

Select source and 
destination for disk copy: 

~ource: +A: 
Qestination: +A: 

l!!:oPY!I I Cancel I [I] 

3. Tap to select the source drive and the destination drive. If you 
have only one drive, drive A appears as both the source and the 
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destination drive. (You can do this with only one disk drive, 
though you will have to exchange disks in the drive.) 

4. Tap Copy. 

5. GeoManager tells you whenever you need to insert a new disk. 
Follow the instructions on the screen. 

NOTE 

If you have turned on Show Advanced Disk Options (in the Options 
menu), you will see Memory Usage in the Copy Disk dialog box. 
You can use this option to change the amount of memory that 
GeoManager uses for copying, which in turn changes the copy 
speed. Tap High for more memory and faster copying; tap Low for 
less memory and slower copying. 

Formatting a Floppy Disk 

Before you can use a disk, you must format it. To check whether a 
floppy disk is formatted or not, insert it into a floppy disk drive 
and tap the floppy disk drive button. If the disk needs to be 
formatted, a message appears, telling you that the disk is 
unreadable. 

To format a floppy disk, choose Format Disk from the Disk menu. 
A dialog box appears: 

Format Drsk 

Select drive and size for 
format: 
.Qrive: +[~:] 
~ize: + J.44M 

<> ]20K 

~ I Cancel I [II 

Tap the drive that contains the floppy disk, then tap the option for 
the disk capacity you want, and then tap OK when you're done. 
Another dialog box appears, requesting a volume name for the 
disk. The disk name can be from 1to11 characters long. You can 
use numbers, letters, and blank spaces in the name. For example, 
you could type FILE 12. Type a name and tap Format. 

The disk is formatted according to the options you specified. A 
message tells you how the formatting is proceeding and when it is 
complete. 
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NOTE 
If, for security reasons, you need to erase ("zero out") every bit of 
information on a disk, select Show Advanced Disk Options from the 
Options menu before you format the disk. Then, when you format 
the disk, turn off the Quick Format option in the Format Disk dialog 
box. When Quick Format is turned off, it takes longer to format a 
disk, but every bit on the disk is erased. 

Renaming a Disk 

You can easily change the name of a floppy disk by choosing 
Rename Disk from the Disk menu. When you choose Rename 
Disk, a dialog box appears: 

Rename Dtsk 

Select drive for disk rename: 
+A:<) I: 

From: (Unnamed I) 

To: l J 
I gename I I Cancel I [I] 

Tap the drive that contains the disk you want to rename. In the 
"To" area, type a new name for the disk. Tap Rename to rename 
the disk. 

NOTE 
You cannot rename drive C: because it is read-only. 

Rescanning 

It is possible for a folder display to become out of date. This can 
happen, for example, if you view the contents of a floppy disk on 
the unit; eject it from the floppy disk drive; and then, using 
another machine, add a file to that floppy disk. When you reinsert 
the disk into the unit's floppy disk drive, the GeoManager window 
does not automatically show the new file. 

In this situation, GeoManager doesn't know that the contents of a 
disk or drive have changed, so it doesn't update the window. To 
remedy the situation, simply rescan the disk or drive by choosing 
Rescan Drives from the Disk menu. GeoManager rereads the 
contents of any disk or drive whose folders are displayed in the 
window you see, updating folder windows as needed. 
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CHANGING GEOMANAGER OPTIONS 

The GeoManager options allow you to customize GeoManager to 
your liking. Once you are satisfied with your settings, save them so 
that they will apply the next time you start GeoManager. The 
GeoManager options appear on the Options menu: 

IP1wwm. 
. ---lot 
Warnings on Qelete/Throw Away ... 

• Warn on Overwrite 
o J".linimize GeoManager on Run 
o f!sk Before Returning to GEOS 
o ~how Advanced Disk Options 
o !;onfirm When Exiting GeoManager 
Drive !,ocations ... 
Sa_1,1e Options 

To turn an option on or off, choose the option from the Options 
menu. If the option is currently on, choosing it turns it off; if the 
option is off, choosing it turns it on. When options are turned on, 
they are selected on the menu. For example, when a confirmation 
option is deselected (turned off) for a given action, no 
confirmation message appears when you perform the action. 

NOTE 
You should leave confirmation options on, since most of them warn 
you about actions that cannot be undone. Remember, when you 
delete or replace a file, you cannot undo the operation if you 
change your mind. 

Warnings on Delete/Throw Away. Tap this to see a submenu 
with the following options. It is strongly recommended that you 
leave these options on. When they are off, you are not given a 
warning that you are about to delete a file or files. 

• Single Warning. When on, this option displays a single 
confirmation message before you delete a group of files. 

• Warning for Each Item. When on, this option displays a 
confirmation message before you delete each file in a group. 

• Read-Only Files. When on, this option displays a confirmation 
message before you delete a read-only file. For more 
information, see "Changing File and Folder Attributes" in this 
chapter. 

• GEOS Executable Files. When on, this option displays a 
confirmation message before you delete a GEOS application. 
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Warn on Overwrite. When on, this displays a confirmation 
message before you copy or move a file to a folder that already 
contains another file with the same name. When this option is off, 
you risk overwriting files in the destination folder. 

Minimize GeoManager on Run. When on, this option causes 
GeoManager to shrink to an icon when you run another 
application. With this option off, the GeoManager window remains 
open when you run another application. 

Ask Before Returning to GEOS. This only applies when you run 
a DOS program from GeoManager. When it is on, you must press 
Enter when you exit from a DOS application before GEOS will 
start up again. (At this point, you can return to DOS instead of 
starting GEOS.) 

Show Advanced Disk Options. Turn this option on to see 
advanced options in the Copy Disk and Format Disk dialog boxes. 
For more information, see "Managing Disk Drives" in this chapter. 

Comirm When Exiting GeoManager. When on, a dialog 
appears when you exit GeoManager. The message gives you the 
option to simply exit GeoManager, exit to DOS, or cancel. Note 
that this option does not eliminate the "Are you sure you want to 
exit?" confirmation dialog box that appears when you exit to DOS. 

Drive Locations. This allows you to move the drive buttons 
around GeoManager, or hide them. There are three options: 

• In Tool Area. This is the usual location for the drive buttons. 
The buttons are immovably placed at the bottom of the 
GeoManager window. 

• Floating. The drive buttons appear in a separate window that 
you can move and resize independent of the GeoManager 
window. 

• Hidden. Hides the drive buttons from view. You can see the 
drive buttons again by choosing either of the other two drive 
location options. 

STARTING DOS APPLICATIONS 

You can start a DOS application from GEOS by double-tapping 
either the icon that represents the DOS application program or a 
launcher icon for the program. A launcher icon is an icon that you 
create so that you can start the application from a more accessible 
folder, such as the DOSROOM folder. For more information about 
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DOS launcher icons, see "Creating a DOS Application Launcher" in 
this chapter. 

WARNING 
Do not start a DOS application unless you have an external 
keyboard attached to your unit. If you start a DOS application that 
requires a keyboard, and you do not have a keyboard, you must 
restart the unit to return to GeoManager. To restart the unit, press 
the restart button on the front of the unit. To connect an external 
keyboard, turn the unit off, connect the keyboard, and then turn the 
unit on again. 

To start a DOS application or batch file directly, open the folder 
that contains the application or batch file you want to launch. 
Double-tap the file's icon or select the file and choose Open from 
the File menu. 

To start a DOS application using its launcher icon, double-tap the 
launcher icon (usually in the DOSROOM folder). Depending on 
the launcher's settings, you may have to respond to some dialog 
boxes. 

In either case, GEOS temporarily shuts down while the DOS 
application or batch file runs. When you quit the DOS application, 
or the batch file finishes, GEOS starts up again automatically, 
exactly as it was before. (If you used a launcher icon, you may see 
a message box before GEOS starts up again that lets you either 
return to GEOS or go directly to DOS.) 

CREATING A DOS APPLICATION LAUNCHER 

If you often use DOS applications or batch files, you will find it 
helpful to create launchers for them. A launcher is a custom icon 
that corresponds to a specific DOS program; when you double-tap 
the icon, GEOS shuts down and runs the program. 

Unlike the GEOS applications in the WORLD folder, DOS 
applications are rarely collected into one folder on a drive - each 
DOS application usually has its own separate folder. A DOS 
application often will not work unless it remains in its folder, 
surrounded by other specific files. When you want to start the 
application, you have to open folder after folder until you have 
located the program's icon. 

If you create a launcher for the application, however, you can 
place the launcher in a top-level folder, such as WORLD or 
DOSROOM, where it is readily available. To start the application, 
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simply open the folder where you have put the launcher icon, 
then double-tap the icon. 

To create a DOS application launcher 

1. Choose Create Launcher from the Utilities menu. A file selector 
appears. 

2. Using the file selector, select the name of the executable file for 
the DOS application. The name of a DOS executable is usually the 
command you type (at the DOS prompt) to run the program, plus 
a .EXE, .BAT, or .COM file extension. 

3. Tap Use This File. A dialog box appears: 

DOS Launct1e1~ Settings 

,bauncher Name: ._lg_e_o_s_I _____ ~ 
~rompt For A Single File? <>Yes +No 

.---------command line Options---------. 
+ ~o Command Line Options 
<> f!sk For Options Each Time 
<> ~pecify Options Now 

Op~iom:l: [ ............. ·.·.·.-................................................................................................... ·.·.·.· ................................................ ·.·.· ......... ·.· ................... ] 

Confirm Arguments !;!efore Running? <> Yes + No 
Ask Before geturning? +Yes <> No 

Place Launcher in: + ~OSROOM Folder <> ~ORLD Folder 

I ~se These Settings I I Qptions ... I I Cancel I [!] 

4. Choose the icon you would like to use for the launcher by tapping 
to select one of the icons in the Icon list. Use the scroll bar to see 
more icons in the list. 

5. Type the name that you want to appear under the icon in 
GeoManager. The default name is the name of the DOS executable 
file without its extension. The name under the icon can be as long 
as 32 characters. 

6. Change these options if you would like to customize the launching 
process: 

Prompt for a single file? Some programs allow you to specify a 
file you'd like to open in the command line. Turn this option on if 
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you would like to specify a file using a file selector. When the 
option is on, GEOS presents a file selector when you double-tap 
the launcher icon. The path name for the file you select is placed 
on the command line along with the other options. 

No Command Line Options. This is the default setting. Tap this 
if you want GEOS to run the DOS application without any 
command line options. 

Ask For Options Each Time. Tap this button if you want GEOS 
to prompt you for command line options whenever you launch the 
DOS application. Also, when you tap this button, the Options text 
field becomes available. If you want, you can type options in this 
text field. Text you type in this field appears in a dialog box 
whenever you start the application. You can change the command 
line options in the dialog box. 

Specify Options Now. Tap this if you want GEOS to use the 
same command line options every time. When you tap this button, 
the Options text field becomes available. Type the options you 
would like in this field. 

Confirm Arguments Before Running. When this option is 
turned on, a dialog box appears just before GeoManager starts the 
DOS application. All the command line options you have specified 
appear in the text field of this dialog box. You can check the 
options, and edit them if you like, before the command is carried 
out. When this option is turned off, the dialog box does not 
appear. 

Ask Before Returning. When this option is turned on, you are 
presented with a message after you exit the DOS application, 
asking if you want to return to GEOS. When this option is turned 
off, no message appears - you are returned immediately to GEOS 
as soon as you exit the DOS application. 

7. Select the place where you want the launcher icon to appear when 
you are finished. To put the icon in the WORLD folder, tap the 
WORLD button. To put the icon in the DOSROOM folder, tap the 
DOSROOM button. 
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8. Tap the Options button if you would like to further customize the 
launching process. A dialog box appears: 

§tarting Folder: le:\ 
1==~~~~~~~~~~~~ 

file To Check: 

S,!;lCOnd File To Check: 

I Cancel I 

Change the options to your liking: 

Starting Folder. Type the path of the folder where you would 
like the DOS application to save its files. If you type something 
here, your application will act as if you had started the application 
from this folder. 

File To Check. Type the path name of a file. GeoManager checks 
to make sure this file exists before attempting to run the 
application. This file is often a batch file (ending in the extension 
.BAT). This option is rarely needed. 

Second File To Check. Type the name of another DOS file. 
GeoManager checks to make sure this file exists before attempting 
to run the application. Typically, this file is an executable (ending 
in the extension .COM or .EXE) contained in the batch file 
mentioned above. This option is rarely needed. 

9. Tap OK when you are finished with the options. In the Create 
Launcher dialog box, tap Use These Settings when you are 
satisfied with the current settings. The dialog box disappears and 
the DOS launcher icon appears in the folder you specified. 

To change a DOS launcher's settings, select the icon for the DOS 
launcher you want to change and choose Edit Launcher from the 
Utilities menu. A dialog box appears with the current settings; 
change them to your liking. (This dialog box is identical to the 
DOS Launcher Settings dialog box.) Tap Use These Settings when 
you are satisfied. 

To remove a DOS application launcher, drag the launcher icon 
onto the Wastebasket.[The launcher icon is deleted. Note that the 
corresponding DOS application is not deleted. 
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EXITING GEOMANAGER 

EXITING TO DOS 

Exit (on the File menu) allows you to exit from GeoManager, and 
then closes the GeoManager window. Normally you never exit 
GeoManager, but if you are running several additional applications 
and notice that the unit is running slowly, you can exit 
GeoManager to free up some memory on the unit. (You also exit 
GeoManager when you use Exit to DOS. For more information on 
exiting to DOS, see "Exiting to DOS" in this chapter.) 

To exit GeoManager, choose Exit from the File menu. The 
GeoManager window closes, and you exit GeoManager. 

CAUTION 

You cannot exit GeoManager unless at least one other application 
is open. If you try to exit GeoManager when all other applications 
are closed, the unit automatically reactivates GeoManager. 

To restart GeoManager, choose Go to GeoManager from the 
Express menu of any application. GeoManager restarts. 

Exit to DOS (on the Express menu) allows you to exit GeoManager 
and go to DOS. You can only exit to DOS if you have an external 
keyboard attached. 

(!) You have no keyboard 
connected, and therefore 
cannot exit to DOS. 

To exit to DOS 

• Choose Exit to DOS from the Express menu. A dialog box appears: 

[1] Are you sure you want to 
exit GEOS? 

Tap Yes to exit to DOS. Tap No to cancel and return to 
GeoManager. 
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To return to GEOS from DOS 

• At the DOS prompt, type GEOS and press Enter. 
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The following are the standard Tool Bars: 

• Style tool bar. For changing the format of text. 

• Function tool bar. For working with documents (opening, 
closing, saving), using the clipboard (cutting, copying, and 
pasting), and other functions. 

For a general overview of tool bars and information on 
customizing tool bars, see Chapter 3. 

THE STYLE TOOL BAR 

Normal -I 

~ 
~ 

The Style tool bar allows you to change the text characteristics -
font, text size, and style. In addition, you can use the tools on the 
Style tool bar as shortcuts to perform common word processing 
functions. 

Normal -I •~l°"l'"'I I URW Roman -I I 12 -IIltl 

The following list shows each tool and describes the action it 
performs. 

Scrolls to the top of the previous page of the document. 

Shows the current page number. If you want to go to a specific page, doubl1 
tap this number and enter the page number you want. 

Scrolls to the top of the next page of the document. 

Starts the spell checker, displaying the dialog box so that you can specify th 
options you need. 

Prints the current document. 

Stores the style definition of the current paragraph so that you can use it in t 
future by clicking Recall Style. 

Recalls the style stored by Store Style. 

Displays the style for the current paragraph. To change the style, click the 
button, then select the style you want from the drop-down list. 

Aligns the left side of the current paragraph text with the Left Indent market 

Centers the current paragraph text between the Left and Right Indent marke 
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I URW Roman -I 

[!] 

rn 
[l3 
[i] 

I 12 -I 

Aligns the right side of the current paragraph text with the Right Indent 
marker. 

Aligns both sides of the paragraph text with both the Right and Left Indent 
markers. 

Displays the font of the selected characters. To change the font, click the 
button, then select the font you want from the drop-down list. 

Changes the selected text to plain text style. 

Changes the selected text to bold text style. 

Changes the selected text to italic text style. 

Changes the selected text to underlined text style. 

Displays the size of the selected text. To change the text size, click the butto 
then select the size you want from the drop-down list. 

Increases the size of the selected text. 

Decreases the size of the selected text. 

THE FUNCTION TOOL BAR 

Em 
~ 
~ 

The Function tool bar contains tools to perform file functions, such 
as opening, closing, and saving files. It also contains editing tools 
and zooming tools. The tools available on the Function tool bar 
vary depending on the application. This section describes the tools 
common to the applications that have the Function tool bar. 

The following list shows each tool and describes the action it 
performs: 

Creates a new document. 

Makes a copy of the current document. 

II 1-1-11 

Displays the Find and Replace dialog box to enable you to find and, if 
you want, change text or formatting. 

Reverses the last editing action. 
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EJ 

Removes the selection from the document and places it on the 
clipboard. 

Places a copy of the selection on the Clipboard without removing it 
from the document. 

Pastes the contents of the Clipboard into the current document at the 
insertion point. 

Selects all text. 

Deletes the selection. 

Displays the document at its normal size. 

Displays the document at a larger size. 

Displays the document at a smaller size. 

Redraws the screen. 

Turns on hyphenation for the selected paragraph. Click again to turn 
off hyphenation. 

Adds no extra line space between each row of text in the paragraph 
containing the selection. 

Adds a half a line space between each row of text in the paragraph 
containing the selection. 

Adds a whole line space between each row of text in the paragraph 
containing the selection. 

Adds two line spaces between each row of text in the paragraph 
containing the selection. 
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ARGUMENT RULES 

A function is represented by a keyword followed by arguments en
closed in parentheses. The function returns a value based on the 
arguments you enter. For example, in the expression SQRT(144), 
SQRT is the keyword for the square root function and 144 is the 
argument. This function returns 12, the square root of 144. 

This appendix describes the math and database functions you can 
use in formulas in the spreadsheet cells in GeoCalc and the 
computed fields in GeoFile. It includes the following information: 

• Rules governing arguments 

• A quick reference to all functions, organized by function type 

• A full-function reference, organized alphabetically 

This appendix assumes you are familiar with the information 
covered in both Chapter 1 and Chapter 3, which provide an 
overview of the skills you need to use any GEOS application. For 
information about using functions in GeoCalc, see Chapter 6. For 
information about using functions in GeoFile, see Chapter 7. 

CAUTION 
GeoCalc, GeoFile, and Calculator all use floating-point math. 
Though floating point calculations have benefits such as speed, 
they are inherently inaccurate. All spreadsheets and calculators 
based on floating-point math produce errors in the 17th or 18th 
significant digit. Though this often is not detectable, the errors 
become apparent in some calculations, especially financial 
functions such as IRR and NPV. GeoCalc, GeoFile, and Calculator 
all adhere to the IEEE 754 standards for floating-point calculations. 
However, you should consult a financial specialist before you 
invest significant sums of money based on floating-point 
calculations from any source. 

The following rules apply to using arguments in functions: 

• You can use numbers, strings, addresses, ranges, or cell and 
range names in GeoCalc. You can use numbers, strings, and 
field names in GeoFile. 

• You must enclose text string arguments in quotation marks. 

• You must specify interest rates as decimal values and they must 
be expressed in the same time units as the term. For example, 
payments that are monthly require a monthly interest rate. 
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• You must express trigonometric angle arguments in radians. If 
you want to convert degrees to radians, use the RADIANS() 
function. 

• Some trigonometric functions return radians. If you need the 
returned value expressed in degrees, use the DEGREES( ) 
function. 

For a description of each function and its arguments, see "Function 
Descriptions" in this appendix. 

FUNCTIONS AVAILABLE IN GEOCALC ONLY 

You can use the following functions only in GeoCalc: 

• CHOOSE 

• COLS 

• COUNT 

• FILENAME 

• HLOOKUP 

• INDEX 

• IRR 

• N 
• NPV 

• PAGE 

• PAGES 

• ROWS 

• VLOOKUP 

If you try to use any of these functions in GeoFile, you will see an 
error message. 
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FUNCTION QUICK REFERENCE 

This section gives an overview of the built-in functions, grouped 
by category. For more detailed descriptions of the functions and 
their arguments, see "Function Descriptions" in this appendix. 

Financial Functions 

The arguments for financial functions are either numbers or field 
names or addresses of cells that contain numbers. When the 
argument is the interest rate, express it as its actual value (for 
example, enter .07 or 7% rather than 7 to indicate 7%). Be certain 
to specify the same units for the term and the interest. If the 
interest is monthly, the term is also monthly. The results of these 
calculations are always numbers: 

CTERM 

DDB 

FV 

IRR* 

NPV* 

PMT 
PV 

RATE 

SLN 

SYD 

TERM 

Number of compounding periods required for an investment 
to grow to a future value. 

Double-declining balance depreciation of an asset. 

Future value of an investment. 

Internal rate of return of an investment. 

Net present value. 

Payment of loan. 

Present value. 

Required interest rate to reach a future value. 

Straight-line depreciation. 

Accelerated depreciation of an asset, using the sum-of-years' 
digits method. 

Required number of payment periods to reach a future 
value. 

*Available for use in GeoCalc only. 
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Information Functions 

The information functions return information about a cell, a range 
of cells, or a field. 

CHOOSE* 

COLS* 

COUNT* 

ERR 

HLOOKUP* 

INDEX* 

I SERR 

IS NUMBER 

ISSTRING 

N* 

NA 

ROWS* 

VLOOKUP* 

Chooses a value from a list. 

Number of columns in a range. 

The number of items in a list - that is, the number of non
blank cells in a range. 

Causes the formula to evaluate to the #ERROR# message. 

Returns a value from a horizontal lookup table. 

Returns the value of the cell at the intersection of a row and 
column. 

Returns 1 if an expression is an error or 0 if it is not. 

Returns 1 if an expression is a number or 0 if it is not. 

Returns 1 if an expression is a string or 0 if it is not. 

Returns the value from the first cell in a range. 

Causes the formula to evaluate to the #N/ A# (Not Available) 
error. 

Number of rows in a range. 

Returns a value from a vertical lookup table. 

*Available for use in GeoCalc only 

Logical Functions 

The logical functions evaluate relationships and return "true" or 
"false" results. True = 1 (or non-zero values) and false = 0. 

AND 

FALSE 

IF 

OR 

TRUE 

Logical AND. 

Returns 0. 

Evaluates a condition, returning one specified value if it is 
true and another if it is false. 

Logical OR. 

Returns 1. 
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Mathematical Functions 

The arguments for mathematical functions are either numbers or 
field names, or addresses of cells that contain numbers. The results 
of these calculations are always numbers. 

ABS 

EXP 

FACT 

INf 

LN 

LOG 

MOD 

PRODUCT 

ROUND 

SQRT 

SUM 

TRUNC 

Print Functions 

Absolute value of a number. 

Value of e (the mathematical constant) raised to the rfh 

power. 

Factorial of a number. 

Value rounded to the next lowest integer. 

Natural logarithm of a number. 

Logarithm of a number. 

Modulus, the remainder of a division calculation. 

Result of multiplication of a list of numbers. 

Value rounded to the specified number of decimal places. 

Square root of a number. 

Total of a list of numbers. 

The integer portion (without rounding) of a number. 

The print functions return the name of the file, the current page, 
and the number of pages for inclusion in headers and footers 
when printing documents in GeoCalc. The print functions are not 
available for use in GeoFile. 

FILENAME 

PAGE 

PAGES 

Returns the file name. 

Returns the current page number. 

Returns the total number of pages. 

Statistical Functions 

The arguments for statistical functions are either numbers or field 
names, or addresses of cells that contain numbers. The results of 
these calculations are always numbers. 

AVG 

MAX 

MIN 
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Average of the values in a list. 

Largest number in a list. 

Smallest number in a list. 



RANDOM 

RANDO MN 

STD 

STDP 

VAR 

VARP 

Random number between 0 and 1. 

Random number between 0 and a number you specify. 

Standard deviation of the values in a list. 

Standard deviation of a population. 

Simple variance of sample population. 

Population variance of the values in a list. 

String Functions 

String arguments A string is a series of characters. The string functions extract text 
must be enclosed in (including numbers) or return numbers based on text. For 
quotation marks. example, you can extract the last four digits of a stock number that 

might identify the manufacturer of a product. 

GeoCalc and GeoFile use GEOS code numbers internally to 
represent each character. The CHAR and CODE string functions 
convert GEOS codes to characters and vice versa. 

CHAR 

CLEAN 

CODE 

EXACT 

FIND 

LEFT 

LENGTH 

LOWER 

MID 

PROPER 

REPEAT 

REPLACE 

RIGHT 

STRING 

TRIM 

UPPER 

VALUE 

Converts a GEOS code number to characters. 

Strips unprintable characters from a string. 

Converts a character to its GEOS code number. 

Compares two strings for an exact match. 

Searches within a string for a specific string. 

Returns the leftmost characters in a string. 

Returns the number of characters in a string. 

Converts uppercase characters to lowercase. 

Returns specified characters within a string. 

Capitalizes the first letter of each word in a string. 

Repeats a string a specified number of times. 

Replaces matching characters in a string with a specified 
string. 

Returns the rightmost characters in a string. 

Converts numbers to a string. 

Removes leading, trailing, and extra internal spaces in a 
string. 

Converts a string to uppercase. 

Converts a number in string form to a value. 
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Time and Date Functions 

GeoCalc and GeoFile use serial numbers to represent times and 
dates. The serial numbers begin with 1 =January 1, 1900. The 
DATE and DATEVALUE functions return the serial number for a 
given date. These functions are most useful in formulas in which 
the time and date are calculated rather than entered as a constant. 

DATE 

DATEVALUE 

DAY 

HOUR 

MINUTE 

MONTH 

NOW 

SECOND 

TIME 

TIMEVALUE 

TODAY 

WEEKDAY 

YEAR 

Converts a numeric date (day, month, year) to the GeoCalc 
and GeoFile serial number format. 

Converts a date (in text form) to the GeoCalc and GeoFile 
serial number format. 

Extracts the day from the GeoCalc and GeoFile serial 
number format. 

Extracts the hour from the GeoCalc and GeoFile serial 
number format. 

Extracts the minute from the GeoCalc and GeoFile serial 
number format. 

Extracts the month from the GeoCalc and GeoFile serial 
number format. 

Returns the current date (month, day, and year) and time 
(hour, minute, and second). No arguments are necessary. 

Extracts the second from the GeoCalc and GeoFile serial 
number format. 

Converts a numerical time (hour, minute, and second) to the 
GeoCalc and GeoFile serial number format. 

Converts a time (in text format) to the GeoCalc and GeoFile 
serial number format. 

Returns the current date (month, day, and year) from the 
GeoCalc and GeoFile serial number format. 

Returns the number for the day of the week from the 
GeoCalc and GeoFile serial number format (Sunday= 1, 
Monday = 2, and so on). 

Returns the current year from the GeoCalc and GeoFile serial 
number format. 

Trigonometric Functions 

The arguments for trigonometric functions are either numbers or 
field names, or addresses of cells that contain numbers. The results 
of these calculations are always numbers. 
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ACOS 

A CO SH 

ASIN 

ASINH 

ATAN 

AT ANH 

ATAN2 

cos 
COSH 

DEGREES 

PI 

RADIANS 

SIN 

SINH 

TAN 

TANH 

FUNCTION DESCRIPTIONS 

Returns the angle that is the arccosine of a number. 

Returns the angle that is the hyperbolic arccosine of a 
number. 

Returns the angle that is the arcsine of a number. 

Returns the angle that is the hyperbolic arcsine of a number 

Returns the angle that is the arctangent of a number. 

Returns the angle that is the hyperbolic arctangent of a 
number. 

Returns the arctangent of the angle determined by the 
coordinates (x,y). 

Returns the cosine of an angle. 

Returns the hyperbolic cosine of an angle. 

Converts radians to degrees. 

Value of 7t. 

Converts degrees to radians. 

Returns the sine of an angle. 

Returns the hyperbolic sine of an angle. 

Returns the tangent of an angle. 

Returns the hyperbolic tangent of an angle. 

The following alphabetical list describes each function, including 
its arguments, and provides one or two simple examples for each. 

ABS(va/ue) 
This mathematical function returns the absolute value of the 
number represented by value. Value can be a cell or field 
reference. 

EXAMPLES 

ABS(12) returns 12. 

ABS(-12) returns 12. 
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ACOS( value) 

This trigonometric function returns the arccosine, the angle for 
which the cosine equals value. Value can be a cell or field 
reference. Value must be from -1 to 1. 

EXAMPLE 

ACOS(.50) returns l.05 radians. 

ACOSH( value) 

This trigonometric function returns the hyperbolic arccosine of 
value. Value can be a cell or field reference. Value must be equal 
to or greater than 1. 

EXAMPLE 

ACOSH(5) returns 2.30. 

AND( togica/1,logica/2, ... ) 

This logical function returns 1 if all of the arguments are true or 0 if 
any of the arguments is false. This function is particularly useful 
with IF statements. 

You can have as many logical arguments as you want. Logical 
arguments can be either logical values or arrays, or references to 
cells or fields that contain logical values. Text is ignored. If the 
argument does not contain a logical value, AND returns the 
#TYPE# error. See also OR. 

EXAMPLES 

AND(l +3=4,3+ 1 =3) returns 0. 

AND(l +3=4,3+ 1 =4) returns 1. 

IF(AND(Al>Bl,Al <Cl),100,200) returns 100 if Al is greater than 
Bl and less than Cl. Otherwise, it returns 200. 

ASIN(va/ue) 

This trigonometric function returns the arcsine of value. The angle 
is between -rt/2 and rt/2 radians. Value must be from 1 to -1. 
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EXAMPLE 

ASIN(.75) returns 0.85 radians. 

ASINH(va/ue) 

This trigonometric function returns the hyperbolic arcsine of value. 

EXAMPLES 

ASINH(lO) returns 2.99. 

ASINH(15) returns 3.40. 

AT AN( value) 

This trigonometric function returns the arctangent of value. 

EXAMPLE 

ATAN(90) returns 1.56 radians. 

ATAN2(x,y) 

This trigonometric function returns the arctangent of x,y- the 
argument representing an x,y coordinate. The arctangent is the 
angle formed by the x-axis and a line passing through the origin 
(O,O) and the specified x,y coordinate. The coordinates x,y can be 
in any quadrant. 

y 

I 

I 
/(x,y) 

~gle 
-~-~---x 

The angle is returned in radians from -n/2 to n/2. A positive result 
indicates a counterclockwise angle from the x-axis. 

You cannot use the origin for the x,y argument. If you use 0,0 for 
x,y, the #VALUE# error appears in the cell. 
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EXAMPLE 

ATAN2(1.5,2.0) returns 0.93 radians. 

AT ANH( value) 

This trigonometric function returns the hyperbolic arctangent of 
value. 

EXAMPLE 

ATANH(0.75) returns 0.97. 

AVG( value1, value2, ... ) 

This statistical function returns the arithmetic mean of a list of 
values. You can use as many arguments as you want, including 
values, ranges, addresses, named cells, named ranges, and field 
names for arguments. AVG treats empty cells as zero values. You 
cannot average cells or fields containing text. 

EXAMPLE 

AVG(89,94,91,98) returns 93. 

CHAR( value) 

This string function returns the GEOS character code 
corresponding to value. You can use values between 32 and 255. 
The function of CHAR( ) is the inverse of that of CODE( ). If the 
value is out of the 32-255 range, CHAR returns a #VALUE# error. 

EXAMPLES 

CHAR(65) returns A. 

CHAR(68) returns D. 
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CHOOSE(index, va/ue1, va/ue2, ... ) 

This information function returns the nth value in the list of 
arguments, where the first value is 0 and index indicates the nth 
value. Value can be from 0 to n-1. You can use as many values as 
you want. Index and values can be numbers, cell references, 
defined names, text, formulas, or functions. For example, if the 
values are the months of the year and the index is 4, then 
CHOOSE returns May. This function returns an error if your index 
is less than zero or greater than the number of values. 

EXAMPLES 

CHOOSE(S,Al, A2, A3, A4, AS, A6) returns the contents of cell A6. 

CHOOSE(3, 11vanilla 11 , 11 chocolate11 , "toasted almond", "peach") 
returns peach. 

CLEAN( string) 

This string function removes control characters from string. This is 
useful for removing nonprintable characters from imported text. 

In the following example, CHAR(13) is the return character, which 
neither prints nor displays on screen. 

EXAMPLE 

CLEAN(CHAR(13)&"text") returns text. 

CODE( string) 

This string function returns the GEOS code for the first character in 
string. 

EXAMPLES 

CODE("A") returns 65. 

CODE("D") returns 68. 

CODE("Now is the time") returns 78. 

COLS( range) 

This information function returns the number of columns in range. 
COLS is not available for use in GeoFile. 
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NOTE 

Do not place the COLS function in the range of columns it is 
intended to count. 

EXAMPLE 

COLS(B2:F65) returns 5. 

COS( angle) 

This trigonometric function returns the cosine of angle. You must 
express angle in radians. If you know an angle in degrees, you can 
use the RADIANS function to convert it to radians. 

EXAMPLES 

COS(l.5) returns 0.07. 

COS(RADIANS(40)) returns 0.77. 

COSH(ang/e) 

This trigonometric function returns the hyperbolic cosine of value. 

EXAMPLE 

COSH(2) returns 3.76. 

COUNT( value1, value2, ... ) 

This information function returns the number of arguments. Values 
can be numbers, null, logical values, or dates. In GeoFile, the 
arguments can only be a comma-separated list. Values referring to 
blank cells or fields are not counted. 

EXAMPLES 

COUNT(23,42,65,23) returns 4. 

COUNT(B3:B6) returns the number of nonblank cells in the range. 

CTERM(interest,future_ value,present_ value) 

This financial function returns the number of compound periods 
required for an investment to grow to a future value. Interest is the 
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Notice that the year 
argument appears 
before the month 
and day arguments. 

interest rate for the calculation. Future_value is the proposed 
value of the asset. Present_value is the current value of the asset. 

EXAMPLE 

CTERM(.05,1000,500) returns 14.2 periods. 

DATE(year,month,day) 

This date function returns the serial number for the date year, 
month, day. Year can be a value from 1900 to 2099. For the years 
1900 to 1999, you can enter just the last two digits - for example 
96 rather than 1996. Month can be a value from 1 to 12. Day can 
be a value from 1 to 31, depending on the number of days in 
month. If you use year, month, or day values that are out of range, 
DATE returns #VALUE#. 

EXAMPLES 

DATE(93,01,20) returns 33988. 

DATE(93,01,32) returns #VALUE# because the day value 32 is out 
of bounds. 

DATEVALUE( string) 

This date function converts a text date into a serial number. 

EXAMPLES 

DATEVALUE("l/20/93") returns 33988. 

DATEV ALUE(''.Jan 20, 1993") returns 33988. 

DAY( date_ value) 

This date function returns the day of the month from date_value. 
Date_value must be a serial number. Use DATEVALUE to convert 
dates entered as labels. 

EXAMPLES 

DA Y(33988) returns 20. 

DAY(DATEV ALUE("l/20/93")) returns 20. 
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DDB(cost,salvage,life,period) 

This financial function calculates the depreciation of an asset, 
using the double-declining balance method. Depreciation is 
highest in the first period and decreases in successive periods. 
Each year's depreciation is a constant percent of the book value of 
the asset and continues until the book value equals the salvage 
value. Book value is the value of the asset in any given period, 
taking depreciation into account. Cost is the original cost of the 
asset. Salvage is the ending value of the asset. Life is the duration 
of the depreciation, using the same units as period. Period is the 
time period for which the depreciation calculation occurs. 

DDB = cost - salvage - total depreciation from previous periods • 
2 I life 

NOTE 

This is not a cumulative calculation. 

EXAMPLES 

DDB(5000,250,60,1) returns 166.67, the depreciation during the 
first month. 

DDB(5000,250,60,2) returns 161.11, the depreciation during the 
second month. 

DDB(5000,250,5,1) returns 2000, the depreciation during the first 
year. 

ERR() 

This information function causes the formula to evaluate to 
#ERROR# and stop. This is particularly useful with IF functions to 
say, "If the condition is true, then return #ERROR#." You must 
include the empty parentheses. 

EXAMPLE 

IF(A5>100,ERR( ),A5) returns #ERROR# if the value in A5 is 
greater than 100; otherwise, it returns the value in A5. 

EXACT( string1 ,string2) 

This string function compares two strings to determine whether 
they match exactly. EXACT is case-sensitive, meaning that "April" 
and "april" are not considered an exact match. If stringl and 
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string2 match, EXACT returns 1; if they do not match, EXACT 
returns 0. This action is similar to the equal sign except that the= 
is not case-sensitive. This is particularly useful with IF statements. 

EXAMPLES 

EXACT(" iteration", "iteration") returns 1. 

EXACT(" iteration", "Iteration") returns 0. 

IF(EXACT(A5,"Hotel"),1000,0) returns 1000 if A5 contains "Hotel". 

IF(A5="Hotel",1000,0) returns 1000 if A5 contains ''Hotel" or 
"hotel". 

EXP(va/ue) 

This mathematical function returns e raised to the power of value, 
where e is approximately equal to 2.718, the base of the natural 
logarithm. 

EXAMPLE 

EXP(2) returns e2 or7.39. 

FACT{va/ue) 

This mathematical function returns the factorial of value. The 
factorial is equal to 1 * 2 • 3 ... * value, where value is a positive 
integer. If value has a fractional portion, FACT calculates the 
factorial for the integer portion of value. 

EXAMPLES 

FACT( 4) returns 24. 

F ACT(2.5) returns 2. 

FALSE{) 

This logical function returns a zero. You can use FALSE in a 
calculation or enter it directly into a cell or field where it is 
interpreted as a logical value by GeoCalc or GeoFile. You must 
include the empty parentheses. See also TRUE. 

EXAMPLE 

IF(A5>100, TRUE( ),FALSE()) returnsO if A5<100. 
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Be careful to enter 
the interest rate for 
the same time period 
as the payments. 

FILENAME() 

This print function returns the file name of the current file for 
inclusion in a GeoCalc header or footer. You must include the 
empty parentheses. FILENAME is not available for use in GeoFile. 

FIND( substring,string,start) 

This string function finds the substring within the entire string and 
returns the numeric position of the first character of the substring. 
You can specify the numeric position of the starting character for 
the search with the start argument. The first character in the string 
is in position 0. 

EXAMPLES 

FIND("all","Now is the time for all good men",O) returns 20. 

FIND("i","Mississippi",3) returns 4. 

FV(payments,interest,term) 

This financial function returns the future value of a stream of 
regularly invested payments. For example, if you save $250 every 
month, will that pay your child's college education costs of 
$40,000 in 10 years? Payments is the payment made each period. 
Interest is the interest rate for the same time period as payments. 
Term is the total number of payments that are made. The following 
is the formula used by the FV function: 

[ 
(1 + rate)term - 1] 

FV = payment x 
rate 

EXAMPLE 

FV(250,.05/12,120) returns 38820.57. 

H LOOKUP( va/ue,range,offset) 

This information function allows you to use a spreadsheet table 
like a database. You can enter values in the table and then extract 
information from the rows of the table according to your 
specifications. HLOOKUP extracts information from the horizontal 
rows in the same way as VLOOKUP extracts information from 
vertical columns. HLOOKUP and VLOOKUP assume the entries in 
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the first row or column are sorted. They return the entry 
corresponding to the nearest ascending value that is not greater 
than value. These functions are useful when you have several 
alternatives to "look up," such as tax rates, commissions, or 
discounts. 

HLOOKUP is not available for use in GeoFile. 

Value is the value to be found in the first row of the table. Value 
can be a number, an address, or a text string. The first row of the 
table needs to be sorted. Range is the address of the range that 
defines the table. Ojf<;et defines the row that contains the 
information. The offset of the top row is zero. 

EXAMPLE 

c D E 

Kyle iStew ! 
i6.oor············r501t 

· ·· s.oo: · ·········· 6foi ····· 

HLOOKUP("Jane",Bl:E5,2) returns 11. 

HOUR( time_ value) 

This time function returns the hour of the day from the time_ value 
serial number. You can use TIMEVALUE to convert text time. The 
hour is an integer from 0 to 23. Time serial numbers are decimal 
fractions and can be part of a date/time combination. If there is no 
fractional part, the time is midnight. 

EXAMPLES 

HOUR(29453.5) returns 12. 

HOUR(TIMEVALUE("11:58PM")) returns 23. 

IF(logical,true_ value,fa/se_ value) 

This logical function creates a conditional statement that says, "If 
this is true, then do A; otherwise, do B." For example, 
IF(B12=C12,50,25) means "If the value in B12 equals that in C12, 
then display 50; otherwise, display 25." For more detailed 
information about the IF function, see Chapter 6. Logical is any 
expression or value that can be evaluated as true or false. 
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True_value is the value returned if the logical expression is true. 
False_value is the value returned if the logical expression is false. 

EXAMPLES 

IF(B13=500,50,-50) returns 50 if B13 contains 500. Otherwise, the 
expression returns-50. 

IF(D 14 = "warm", "red", "yellow") returns red if D 14 contains 
"warm". Otherwise, the expression returns yellow. 

IF(Al>A2,"Ascending","Descending") returns Ascending if Al is 
greater than A2. Otherwise the expression returns Descending. 

INDEX(range,column_offset,row_offset) 

This information function returns the data in the cell at the 
intersection of the column and row offsets. The top row is 0,0. 

INDEX is not available for use in GeoFile. 

Range is the address defining the range. Column_ offset defines the 
column offset in the specified range. Row_ offset defines the row 
offset in the specified range. 

EXAMPLE 

INDEX(Bl:H24,5,6) returns the contents of G7. 

INT(va/ue) 

This mathematical function returns the integer portion of value, 
rounding down to the nearest integer. Value can be a positive or 
negative number or a reference to a cell or field that contains a 
number. 

EXAMPLES 

INT(123.456) returns 123. 

INT(123.567) returns 123. 

INT(-123) returns-123. 

INT(-123.456) returns-124. 
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IRR(guess,range) 

This financial function calculates the internal rate of return on a 
series of irregular payments at regular intervals. It returns the 
nominal rate when you know the initial investment and know you 
will get regular payments of varying amounts. (NPV finds the 
initial investment when you know the interest rate.) 

IRR assumes that the income from the investment is reinvested at 
the internal rate of return and calculates the percentage rate at 
which the PV (present value) of a series of cash flows is equal to 
the initial investment. 

IRR is not available for use in GeoFile. 

Guess is the number you guess is approximately the interest rate. 
Range is the address defining the range for the cash flow table. 

EXAMPLE 

For example, your friend is starting a pizza restaurant and you 
invest $10,000 initially. He then pays you back varying amounts 
every month. You make an additional investment after six months 
to add more staff to the restaurant for the summer. The 
spreadsheet below shows the cash flow in the range Bl:Bl2. 

IRR(.05,Bl:Bl2) returns 2.82% if rounded to two decimal places. 

ISERR(va/ue) 

This information function tests an expression and returns 1 (TRUE) 
if the expression is an error. This function is particularly useful in 
IF statements. 

EXAMPLES 

ISERR(B2) returns 1.00 (TRUE) if the value in B2 is an error. 
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IF(ISERR(B2), 1111 ,B2) returns an empty string if there is an error. 
Otherwise, the expression returns the contents of B2. 

ISNUMBER( value) 

This information function tests an expression and returns 1 (TRUE) 
if the expression is a number. This function is particularly useful in 
IF statements. 

EXAMPLES 

ISNUMBER(B2) returns 1.00 (TRUE). 

IF(ISNUMBER(B2), 1111 ,B2) returns an empty string if B2 contains a 
number. Tbe expression returns the contents of B2 if B2 does not 
contain a number. 

ISSTRING( value) 

This information function tests an expression and returns 1 (TRUE) 
if the expression is a string. This is useful in IF statements. 

EXAMPLES 

ISSTRING(B2) returns 1.00 (TRUE). 

IF(ISSTRING(B2),'"',B2) returns an empty string if B2 contains a 
string Otherwise, the expression returns the contents of B2. 

LEFT( string,num) 

This string function returns the characters in the leftmost position 
in string Num is the number of characters to return. The first 
character in the string is in position 0. A reference to cells 
containing values produces an error. 

The RIGHT function extracts characters beginning with the 
rightmost character; LEFT extracts characters beginning with the 
leftmost character; MID extracts characters starting with an internal 
position. For more information, see the descriptions of the RIGHT 
and MID functions. 

EXAMPLES 

LEFT(11Hale11 , 1) returns H. 

LEFT(11 12 items left11 ,2) returns 12. 
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LENGTH( string) 

This string function returns the number of characters in string. 
LENGTH counts all characters, punctuation marks, and spaces 
enclosed in quotation marks. 

EXAMPLE 

LENGTH("Now is the time.") returns 16. 

LN(va/ue) 

This mathematical function returns the natural logarithm of value, 
using the mathematical constant e as a base. LN is the inverse of 
EXP. Value must be a positive number. 

EXAMPLE 

LN(2) returns 0.70. 

LOG(va/ue) 

This mathematical function returns the base 10 logarithm of value. 
Value must be a positive number. 

EXAMPLE 

LOG(lOO) returns 2. 

LOWER( string) 

This string function converts all characters in string to lowercase. 

EXAMPLE 

LOWER("SUMMER,1993") returns summer,1993. 

MAX(va/ue1,value2, ... ) 

This statistical function returns the largest value in the list. The list 
can include values or addresses, separated by commas. MAX 
ignores empty cells and treats text as a zero. See also MIN. 

EXAMPLES 

MAX(2,4,6,8) returns 8. 
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MAX(-2,-4,-6,-8) returns-2. 

MAX(B3:B13) returns the largest number in the range B3:B13. 

Ml D( string,start,num) 

This string function returns the specified number (num) of 
characters in string, beginning at the position you indicate (start). 
The first character in the string is in position 0. A reference to cells 
containing values produces an error. 

The RIGHT function extracts characters beginning with the 
rightmost character, LEFT extracts characters beginning with the 
leftmost character, and MID extracts characters starting from an 
internal position. For more information, see the descriptions of the 
LEFT and RIGHT functions. 

EXAMPLE 

MID("The United States",4,6) returns United. 

MIN(value1,value2, ... ) 

This statistical function returns the smallest value in the list. The 
list can include values or addresses, separated by commas. MIN 
ignores empty cells and treats text as a zero. See also MAX. 

EXAMPLES 

MIN(2,4,6,8) returns 2. 

MIN(-2-4,-6,-8) returns-8. 

MIN(B3:B13) returns the smallest number in the range B3:Bl3. 

MINUTE(time_va/ue) 

This time function returns the minute from the time_value serial 
number. The minute is an integer from 0 to 59. Time serial 
numbers are decimal fractions and can be part of a date/time 
combination. If there is no fractional part, the time is midnight. 
You can use TIMEVALUE to convert text time. 

EXAMPLES 

MINUTE(TIMEVALUE("l1:58PM")) returns 58. 

MINUTE(29453.55) returns 12. 
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MOD( value, divisor) 

This mathematical function returns the modulus, the remainder 
from the division of value by divisor. If you attempt to divide by 
zero, MOD returns an error. 

EXAMPLE 

MOD(147,12) returns 3. 

MONTH( date_ value) 

This date function returns the month from the date_value serial 
number. The month is an integer from 1 to 12. Use DATEVALUE to 
convert dates entered as labels. 

EXAMPLES 

MONTH(DATEVALUE("May 6, 196811)) returns 5. 

MONTH(25420) returns 8. 

N(range) 

This information function returns the contents of the first cell in a 
range, if that cell contains a number, time, or date. If the cell 
contains text, the function returns 0 (zero). N is not available for 
use in GeoFile. 

EXAMPLE 

N(Bl:B13) returns 2365 if Bl contains 2365. 

NA() 

This information function stops the evaluation of a formula and 
generates #N/ A# in the formula cell. NA is the abbreviation for 
"Not Available." This function is useful if you are creating a 
spreadsheet and do not have all the required values. If a formula 
refers to a cell containing #N/ A#, it returns #N/ A# so that you do 
not inadvertently forget to complete the spreadsheet. You can type 
#NI A# directly into the cell. You must include the empty 
parentheses. 
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NOW() 

This time function returns the serial number for the current date 
and time. The whole number represents the date as a serial 
number starting January 1, 1900. The decimal fraction of the 
number represents the time, where midnight= 0. You must 
include the empty parentheses. 

EXAMPLE 

NOW() returns 33988.50 Uanuary 20, 1993, 12 noon) if it is now 
12 noon onjanuary 20, 1993. 

NPV (interest, range) 

This financial function returns the net present value, which is the 
amount of money (in today's dollars) of a future sum to be spent 
or received. When you want to discount a future cash flow, 
calculate its present value. If you want to discount multiple future 
cash flows, use net present value to calculate their present values 
and add them together. 

Use NPV when you know the interest rate and want to know the 
initial investment. Use IRR when you know the initial investment 
and want to calculate the rate. Both NPV and IRR use irregular 
payments at regular intervals. 

The future cash flows are figured at a constant interest rate, 
assuming that payments are made at the end of each period. If 
there is a down payment at the beginning of period 1, add that 
amount to the result of the NPV calculation. 

NPV is not available for use in GeoFile. 

Interest is the interest rate for the calculation. Range is the cells 
containing the cash flow information. 

The following is the formula used by the NPV function: 

n 
""' values; NPV = £,.. . 
i~I (1 +rate)' 

EXAMPLE 

Suppose you want to send your daughter to design school in the 
coming year. You know that the tuition payments are due in 
August and November, and that she will need living costs every 
month. If the total expense will be $10,500, how much will you 
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have to set aside now in an interest account paying 6.25% to cover 
the necessary expenses each month? 

NPV(.0625/12,B2:Bll) returns 10326.87. 

OR(logica/1,logica/2, ... ) 

This logical function returns 1 if at least one of the arguments is 
true or 0 if all of the arguments are false. The arguments can be 
values or cell or field references. You can have as many logical 
arguments as you want. OR ignores text. If an argument does not 
contain a logical value, OR returns the #TYPE# error. OR is 
particularly useful with IF expressions. See also AND. 

EXAMPLES 

OR(1+2=3,2+3=5) returns 1. 

OR(l +2=3,2+3=4) returns 1. 

OR((l +2=2,2+3=3) returns 0. 

IF(OR(Al>lOO,Al=Bl),25,50) returns 25 if Al is 100 or more, or 
Al equals Bl. 

PAGE() 
This print function returns the current page number for use in a 
GeoCalc header or footer. You must include the empty 
parentheses. If you use PAGE outside of a GeoCalc header or 
footer, PAGE is calculated when you print. PAGE is not available 
for use in GeoFile. 

EXAMPLE 

"Page"& PAGE()&" of"& PAGES() returns Page 3of15. 
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PAGES() 

This print function returns the total number of pages in the 
document for use in a GeoCalc header or footer. You must include 
the empty parentheses. If you use PAGES outside of a GeoCalc 
header or footer, PAGES is calculated when you print. PAGES is 
not available for use in GeoFile. 

EXAMPLE 

"Page "&PAGE()&" of"& PAGES() returns Page 3 of 15. 

Pl() 

This trigonometric function returns the value of 1t. You must 
include the empty parentheses. 

PMT(principal,interest, term) 

This financial function calculates the constant payment required to 
repay a loan at a specified interest rate over a given period of time. 
Principal is the amount of the loan. Interest is the interest rate for 
the same time period as the term. Term is the total number of 
periods over which the payments are made. 

EXAMPLE 

Use the PMT function to determine the monthly payment for a 20-
year loan of $75,000, at 5% annual interest. 

PMT(75000,.05/12,240) returns 494.97. 

PRODUCT( value1, value2, ... ) 

This mathematical function returns the product of multiplying the 
values given. You can have as many arguments as you want. 
Value can be numbers, references, and logical values. 

EXAMPLE 

PRODUCT(250,3,2) returns 1500. 
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PROPER( string) 

This string function capitalizes the first letter of every word and the 
first letter following any nonletter character. PROPER converts all 
other characters to lowercase. 

EXAMPLES 

PROPER("Now is the time") returns Now Is The Time. 

PROPER("1993 BUDGET") returns 1993 Budget. 

PV(payment,interest,term) 

This financial function returns the present value of an investment, 
given constant payment stream and interest rate. When you want 
to discount a future cash flow, calculate its present value. If you 
want to discount multiple future cash flows, use net present value 
(NPV), which calculates their present values and adds them 
together. Payment is the amount of each payment. Interest is the 
interest rate for the same time period as the term. Term is the total 
number of periods over which the payments are made. 

EXAMPLE 

If you have car payments of $250 every month for 10 years at an 
interest rate of 5%, what is the present value of the loan? 

PV(250,.05/12,120) returns 23570.34. 

RANDOM() 

This statistical function returns a random number between 0 and 1. 
RANDOM returns a new random number every time GeoCalc or 
GeoFile recalculates. 

EXAMPLE 

RANDOM( ) returns a decimal value. 

RANDOMN( value) 

This statistical function returns a random number between 0 and 
value-I. RANDOMN returns a new random number every time 
GeoCalc or GeoFile recalculates. 
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EXAMPLE 

RANDOMN(lOO) returns a number between 0 and 99. 

RATE(future_ va/ue,present_ va/ue,term) 

This financial function calculates the interest rate required to 
change the present value of an investment into the future value. 
Future_value is the value of the annuity at the end of the 
investment period. Present_value is the value of the annuity today. 
Term is the total number of periods over which the payments are 
made. 

EXAMPLE 

If you have $5,000, what annual interest rate would you need to 
have $8,000 in 5 years? 

RATE(8000,5000,5) returns 9.86%, provided that you have set the 
cell number properties to show percentages. 

REPEAT(string,num) 

This string function returns string the specified number of times. If 
num is zero, REPEAT returns an empty string. 

EXAMPLES 

REPEAT("Ha",6) returns HaHaHaHaHaHa. 

REPEAT("Ha 11 ,6) returns Ha Ha Ha Ha Ha Ha. 

REPLACE( original,start,num,replace) 

This string function replaces characters within text. Original is the 
text string in which you want to replace characters. Start is the first 
character in the original string that you want to replace. The first 
character in the string is in position 0. Num is the number of 
characters in the original string that you want to replace. Replace is 
the replacement string. You can use more or fewer replacement 
characters than are replaced in the original string. 

EXAMPLES 

REPLACE("1992",3,l,"3") returns 1993. 

REPLACE("Now is the time for all good men",29,3,"people") 
returns Now is the time for all good people. 
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RIGHT(string,num) 

This string function returns a specified number of characters from 
the rightmost character in string. The rightmost character in the 
string is in position 0. A reference to cells containing values 
produces an error. 

RIGHT extracts characters beginning with the rightmost character; 
LEFT extracts characters beginning with the leftmost character; 
MID extracts characters starting from an internal position. See also 
LEFT and MID. 

EXAMPLES 

RIGHT("Section A",1) returns A. 

RIGHT("Number of Items, 25",2) returns 25. 

ROUND( va/ue,places) 

This mathematical function rounds value to the number of decimal 
places you specify. 

EXAMPLE 

ROUND(12.23761,2) returns 12.24. 

ROWS( range) 

This information function returns the number of rows in a range. 
ROWS is not available for use in GeoFile. 

NOTE 
Do not place the ROWS function in the range of rows it is intended 
to count. 

EXAMPLE 

ROWS(B2:F65) returns 64. 

SECOND( time_ value) 

This time function returns the second from the time_value serial 
number. The second is an integer from 0 to 59. Time serial 
numbers are decimal fractions and can be part of a date/time 
combination. If there is no fractional part, the time is midnight. 
You can use TIMEVALUE to convert text time. 
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EXAMPLE 

SECOND(TIMEVALUE("11:58:45PM")) returns 45. 

SECOND(29453.49) returns 36. 

SIN(ang/e) 

This trigonometric function returns the sine of angle. You must ex
press angle in radians. If you know an angle in degrees, you can 
use the RADIANS function to convert it to radians. 

EXAMPLE 

SIN(RADIANS(45)) returns 0.71. 

SINH(ang/e) 

This trigonometric function returns the hyperbolic sine of angle. 
You must express angle in radians. If you know an angle in 
degrees, you can use the RADIANS function to convert it to 
radians. 

EXAMPLE 

SINH(0.5) returns 0.52. 

SLN( cost,salvage,life) 

This financial function returns the straight-line depreciation of an 
asset for a period of time. Cost is the initial cost of the asset. 
Salvage is the value of the asset at the end of the time period. Life 
is the useful life of the asset, the number of time periods the asset 
is being depreciated. 

EXAMPLE 

SLN(12000,2000,5) returns 2000. 
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SQRT( value) 

This mathematical function returns the square root of value. Value 
must be a positive number. 

EXAMPLE 

SQRT(144) returns 12. 

STD(value1,va/ue2, ... ) 

This statistical function returns the standard deviation of the 
sample of values. You can use as many values as you want. 

The following is the formula used by the SID function: 

n(n -1) 

EXAMPLE 

STD(254,255,253,248,257,255,256) returns 2.94. 

STDP(value1,value2, ... ) 

This statistical function returns the standard deviation of an entire 
population. You can use as many values as you want. You can use 
values, addresses, ranges, named cells, and field names for 
arguments. 

The following is the formula used by the STDP function: 

EXAMPLE 

STDP(254,255,253,248,257,255,256) returns 2.73. 

STRING(va/ue,n) 

This string function converts value into a string, using n decimal 
places. N can be a number from 0 through 15. 
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EXAMPLE 

STRING(245.356,1) returns 245.4. 

SUM(value1, va/ue2, ... ) 

This mathematical function returns the total of the value list. You 
can use as many arguments as you want, including values, 
addresses, ranges, named cells, and field names for arguments. 

EXAMPLES 

SUM(B3:Bl3) returns the sum of cells B3 through B13. 

SUM(23,45,67) returns 135. 

SYD( cost,salvage,life,period) 

This financial function returns the depreciation of an asset for the 
current period, using the sum-of-years' digits method. Cost is the 
initial cost of the asset. Salvage is the value of the asset at the end 
of the time period. Life is the useful life of the asset, the number of 
time periods the asset is being depreciated. Period is the period to 
analyze. 

EXAMPLE 

What is the depreciation in the fourth year for a computer system 
that initially cost $12,000, which after five years could be sold for 
$2,000? 

SYD(12000,2000,5,4) returns 1333.33. 

TAN(ang/e) 

This trigonometric function returns the tangent of angle. You must 
express angle in radians. If you know an angle in degrees, you can 
use the RADIANS function to convert it to radians. 

EXAMPLE 

TAN(RADIANS(45)) returns l.O. 

TANH(ang/e) 

This trigonometric function returns the hyperbolic tangent of 
angle. You must express angle in radians. If you know an angle in 
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degrees, you can use the RADIANS function to convert it to 
radians. 

EXAMPLE 

TANH(0.5) returns 0.462117. 

TERM(payments,interest,future_ value) 

This financial function returns the number of time periods required 
for a number of equal investment payments to reach a future 
value. Payments are made at the end of each period and earn a 
constant interest rate. Payments is the amount of the periodic 
payments. Interest is the interest rate for the investment per time 
period. Future_value is the value of the annuity at the end of the 
investment period. 

EXAMPLE 

How long will it take to accrue $10,000 if you make monthly 
payments of $250 at an annual interest rate of 5.5%? 

TERM(250,.055/12,10000) returns 36.8. 

TIME(hour,minute,second) 

This time function returns the serial value from the hour, minute, 
and second arguments. 

EXAMPLE 

TIME(12,34,23) returns 0.52. 

TIMEVALUE(string) 

This time function returns the serial value for string. 

EXAMPLE 

TIMEVALUE("l:lOPM") returns 0.55. 

TODAY() 

This date function returns the serial number for the current day. 
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EXAMPLE 

TODAY() returns 33988.00 if today's date isjanuary 20, 1993. 

TRIM( string) 

This string function removes extra spaces before, after, and 
between words. 

EXAMPLE 

TRIM(" Cleveland, Ohio ") returns Cleveland, Ohio. 

TRUE() 

This logical function returns 1. You can use TRUE in a calculation 
or enter it directly into a cell or field where it is interpreted as a 
logical value by GeoCalc or GeoFile. You must include the empty 
parentheses. See also FALSE. 

EXAMPLE 

IF(A5>100, TRUE( ),FALSE()) returns 1 if A5>100. 

TRUNC(va/ue) 

This mathematical function removes the fractional portion of value 
without rounding off. 

EXAMPLE 

TRUNC(23.66) returns 23. 

UPPER( string) 

This string function converts string to uppercase. 

EXAMPLE 

UPPER("usa") returns USA. 

VALUE( string) 

This string function converts string to a value. 
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EXAMPLE 

VALUE("l.75") returns l.75. 

VAR( value 1, value2, ... ) 

This statistical function returns the population variance from a 
sample of values. You can use as many arguments as you want, 
including values, addresses, ranges, named cells, and field names 
for arguments. 

The following is the formula used by the VAR function: 

n(n-1) 

EXAMPLE 

VAR(254,255,253,248,257,255,256) returns 8.67. 

VARP(va/ue1,va/ue2, ... ) 

This statistical function returns the population variance from an 
entire population represented by values. You can use as many 
arguments as you want, including values, addresses, ranges, 
named cells, and field names for arguments. 

EXAMPLE 

VARP(254,255,253,248,257,255,256) returns 7.43. 

VLOO KUP( value,range,offset) 

This information function allows you to use a spreadsheet table 
like a database. You can enter values in the table and then extract 
information from the columns of the table according to your 
specifications. VLOOKUP extracts information from vertical 
columr1s in the same way as HLOOKUP extracts information from 
horizontal rows. HLOOKUP and VLOOKUP assume the entries in 
the first row or column are sorted. They return the entry 
corresponding to the nearest ascending value that is not greater 
than value. 

These functions are useful when you have several alternatives to 
"look up,'' such as tax rates, commissions, or discounts. 

MATH AND DATABASE FUNCTIONS B.37 



VLOOKUP is not available for use in GeoFile. 

Value is the value to be found in the first column of the table. 
Value-can be a number, an address, or a text string. The first 
column of the table needs to be sorted. Range is the address of the 
range that defines the table. Offset defines the column that 
contains the information. The first column is 0. 

EXAMPLE 

VLOOKUP(''.Jane",A2:E5,2) returns ll.00. 

WEEKDAY( date_ value) 

This date function returns the day of the week for date_value. 
WEEKDAY returns a number representing the day of the week: 1 
for Sunday, 2 for Monday, and so on. Date_value must be a serial 
number. Use DATEVALUE to convert dates entered as labels. 

EXAMPLES 

WEEKDA Y(33988) returns 4 (Wednesday). 

WEEKDAY(DATEVALUE("l/20/93")) returns4 (Wednesday). 

YEAR( date_ value) 

This date function returns the year from date_value. Date_value 
must be a serial number. Use DATEVALUE to convert dates 
entered as labels. 

EXAMPLES 

YEAR(33988) returns 93. 

YEAR(DATEVALUE("l/20/93")) returns 93. 
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INSTALLING AND STARTING GEOHOST 

To use GeoHost, you must have: 

• An IBM-PC 286 compatible or better. 

• At least 1 MB RAM installed. 

• At least 3 MB available hard disk space. 

• MS-DOS or PC-DOS version 3.11 or higher. 

• A LapLink cable (CE-303CB) for connecting the unit to the PC. 
For more information about attaching the LapLink cable, see 
"Options" in the Operation Manual. 

To install and start GeoHost 

1. Insert the GeoHost floppy disk into the appropriate PC floppy disk 
drive. 

2. At the DOS prompt, type: 

A:INSTALL 

(If GeoHost is inserted into a disk drive other than A, substitute 
that letter for A.) 

3. Press Enter, then follow the on-screen instructions. 

4. Once GeoHost is installed on your PC, start it by typing 

CD GEOHOST 

at the DOS prompt and then pressing Enter. If GeoHost is 
installed in a directory other than GEOHOST, substitute that 
directory name for GEOHOST. 

5. Type: 

GEOS 

6. Press Enter. 

If you are starting GeoHost for the first time, you will see screens 
for installing your mouse and video drivers. Follow the instructions 
on the screen. When you have completed the installation process, 
the Host GeoManager window appears. 

NOTE 

If you do not have a mouse attached to your PC, choose Arrow Key 
Mouse when the installation program asks what kind of mouse you 
have. Arrow Key Mouse allows you to use the arrow keys on your 
keyboard to move the mouse pointer. 

To enable the arrow key mouse, press F4. Use the arrow keys to 
move the mouse pointer and use the Insert and Delete keys as 
your left and right mouse buttons, respectively. When you want to 
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return to text editing mode, turn off the arrow key mouse by 
pressing any other key on the keyboard. The Insert key, Delete 
key, and arrow keys return to their usual functions. 

ABOUT GEOHOST WINDOWS 

GeoHost application windows are very similar to regular GEOS 
windows, with two exceptions: 

• GeoHost application windows are always full-screen. Since you 
cannot change the size of these windows, the title bar does not 
contain either a Minimize or a Maximize-Restore button. The 
windows also have no resize border. 

• GeoHost application windows do not have an Express menu. 
The only way to leave the current application is to choose Exit 
from the File menu or to double-dick the Window Control 
button. 

THE HOST GEOMANAGER WINDOW 

From Host GeoManager, you can connect your PC to the unit, 
manage files on both the PC and the unit, and start Host 
Preferences. 
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The Host GeoManager window looks this: 

Proefererice::: 

Preferences 

Overlapping windows 

Full-sized windows 

Wastebasket 

I Disk drives 

Connect/Disconnect 

Wastebasket. Drag folders and files to the wastebasket to throw 
them away. You can also open the wastebasket to see the items 
you have thrown away but not yet deleted. 

Full-sized windows/Overlapping windows. Choose between 
displaying only one folder at a time or several folders at the same 
time. 

When you display several folders, each one has its own window 
within the Host GeoManager window. You can move and resize 
these windows and drag icons from one folder to another. 

Preferences. Tap to start Host Preferences. 

Connect/Disconnect. Use to open or close a connection 
between two machines. When no connection is open, the button 
represents Connect. When there is a connection, the button 
changes to represent Disconnect. 
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Disk drive buttons. One appears for each available PC drive. 
When a connection is open, additional disk drive buttons appear, 
representing each available drive on the unit. 

Each disk drive button is labeled with the letter of the 
corresponding drive. If the button corresponds to a drive on the 
unit, the name of the unit (the default is "remote") precedes the 
letter. 

CONNECTING THE UNIT AND THE PC 

Before you can transfer files from the unit to the PC and vice versa, 
you must connect the LapLink cable and set up both machines. 

To connect the LapLink cable, use the serial ports of the host PC 
and the unit. For more information, see "Options" in the Operation 
Manual. 

To set up the unit or change the unit's name, port, or baud rate, 
use the Connect option in the unit's Preferences application. For 
more information, see "Preferences" in Chapter 4. 

Setting Up the PC 

Follow this procedure the first time you set up the PC to transfer 
files. From then on, you only need to do this if you want to change 
your setup. 

To set up the PC 

1. In Host GeoManager, click the Preferences icon. The Host 
Preferences window appears. 
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2. Click Connect. The following dialog box appears: 

Change the following options as necessary: 

Name. Type a name to identify the PC. This name appears on 
every PC drive button that appears on the unit. The name is 
initially set to GeoHost. 

Drives. Choose the PC drives you want to appear on the unit. 

Port. Choose the serial port you are using for the connection. 

Baud Rate. Choose the connection speed between the PC and the 
unit. The baud rate you set must be the same on both machines. 

Interrupt Level Options. Click the arrows to change or disable 
the interrupts assigned to each serial port. (A question mark 
appears next to each interrupt assignment until GeoManager has 
actually used the port and verified that the interrupt works 
correctly.) 

3. Click OK to close the dialog box; then exit Preferences. 

Opening a Connection 

Once the unit and the PC are set up, you open a connection 
between them so that you can transfer files between the machines. 

To open a connection between the two machines 

(In the following procedure, you can reverse the order of steps 1 
and 2.) 

1. Tap the Connect button at the bottom of the GeoManager window 
on the unit. A dialog box appears, informing you that a connection 
is being attempted. If you want to stop the connection, tap Cancel. 
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2. Click the Connect button at the bottom of the Host GeoManager 
window on the PC. A dialog box appears, informing you that a 
connection is being attempted. If you want to stop the connection, 
click Cancel. 

3. When a successful connection is made, the drives from the PC 
appear as additional drive buttons in GeoManager on the unit and 
the drives from the unit appear in Host GeoManager on the PC. 
The Connect button changes to a Disconnect button. 

Only the unit's drive D appears on the PC and only those drives 
you have selected in Host Preferences appear on the unit. For 
information on Host Preferences, see "Host Preferences" in this 
appendix. 

TRANSFERRING FILES 

Once the connection is open, you can work with folders and files 
on any disk drive whose icon appears at the bottom of the 
GeoManager or Host GeoManager window. You can transfer 
folders and files back and forth between the two machines, move 
or copy them between folders, delete files and folders, and 
perform other GeoManager functions. 

Although you can transfer files using either GeoManager on the 
unit or Host GeoManager on the PC, it is strongly recommended 
that you work with Host GeoManager on the PC, since it is 
considerably faster and offers some additional tools. 

NOTE 

To transfer files to and from any PCMCIA cards that you have 
attached to the unit, you must use GeoManager on the unit. This is 
because PCMCIA card drives do not appear as icons in Host 
GeoManager, but they do appear in GeoManager. 
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Working with Multiple Folders 

Initially, you view folders one at a time in a full-sized Host 
GeoManager window. Each folder you open fills the window, 
covering up any folder that previously appeared there. There is a 
way, however, to view many folders simultaneously as smaller, 
overlapping windows. It is much easier to transfer folders and files 
when you use overlapping windows. 

Overlapping windows 

Host GeoManager includes a new menu, called the Window 
menu. You can use this menu to switch between one folder and 
another. You can also choose to display the folders Full-Sized, 
Overlapping, or Tile. The names of all open folders appear at the 
bottom of the Window menu. 

When the display is full-sized and you have more than one folder 
open, you can only see the one on top, like seeing only the top 
page on a stack of reports sitting on your desk. You can switch 
between folders by choosing the name of the folder you want to 
be on top from the Window menu. 
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Overlapping folders are stacked so that you can see the upper left 
corner of each folder. You can resize and move overlapping 
folders in the application window. By choosing Tile from the 
Window menu, you can display the folders side by side. 

To move one of the overlapping windows to the front, click on 
that window. The folder you specified appears on the top of the 
stack with its title bar highlighted. 

Copying and Moving Folders 

To move a folder from one disk (or folder) to another, select the 
folder you want and use the right mouse button to drag it to its 
new location. Dragging an item to a folder on the same disk moves 
the item to that folder; dragging it to another disk copies the item. 
You can, however, move (and not copy) an item to a different disk 
by holding down the Alt key as you drag the item. Similarly, you 
can copy (and not just move) an item on the same disk by holding 
down the Ctrl key as you drag the item. 

Move Folder icon positioned 
over a PC drive window 
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DELETING FILES USING HOST GEOMANAGER 

Deleting files with Host GeoManager is a two-step process. The 
first step is to throw the document or folder away, by placing it in 
the Wastebasket. The second step is actually deleting the file by 
emptying the Wastebasket. 

NOTE 

On the unit, these two steps are combined. When you throw 
something away, it is immediately deleted. 

Host GeoManager's Wastebasket works much like a real 
wastebasket. Items you throw away remain in the Wastebasket 
until you empty it. That way, you can recover items from the 
Wastebasket by pulling them out before the Wastebasket is 
emptied. 

Once you empty Host GeoManager's Wastebasket, everything in it 
is deleted. Deleting a file removes the file from your disk, so be 
careful to delete only those files you know you won't need later. 
The Wastebasket is automatically emptied when you, exit to DOS. 

You can also delete files by selecting the files you want to delete 
and then choosing Delete from the File menu, but it is much safer 
to throw them into the Wastebasket first. 

To throw away items into the Wastebasket, select the item or items 
you want to throw away and drag them to the Wastebasket using 
the right mouse button. 

To view the contents of the Wastebasket, tap its icon. If you want 
to recover any of these items, select one or more of them and drag 
them to another folder. You can also choose Wastebasket from the 
File menu and then choose Recover from the Wastebasket menu. 
You will be asked to choose a destination for the recovered file. 

To permanently delete specific items in the Wastebasket 

1. Open the Wastebasket window and select the files and folders you 
want to delete. 

2. Choose Delete from the File menu. The files you selected are 
deleted. 

To permanently delete all items in the Wastebasket 

1. Choose Wastebasket from the File menu. 

2. Tap Empty Wastebasket. All the files and folders in the 
Wastebasket are deleted. 
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BREAKING THE CONNECTION 

HOST PREFERENCES 

To break the connection between the machines, tap or click the 
Disconnect button at the bottom of the unit or the Host 
GeoManager window. You can break the connection from either 
machine. 

You can start Host Preferences by clicking its icon. Host 
Preferences can only be accessed when the PC and the unit are not 
connected. Host Preferences contains four groups of options: 

Connect. For information about the Connect option, see "Setting 
Up the PC" in this appendix. 

Keyboard. Functions the same as the Keyboard option in the 
unit's Preferences. For more information, see "Preferences" in 
Chapter 4. 

Mouse. Functions the same as the Mouse option in the unit's 
Preferences. For more information, see "Preferences" in Chapter 4. 

Video. Allows you to specify or change the type of video adapter 
you are using. For more information, see "Changing Your Video 
Adapter" in this appendix. 

Changing Your Video Adapter 

The video adapter is the type of graphic display your computer 
uses. The Video option in Host Preferences allows you to change 
your video adapter. 
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To change your video adapter 

1. Open Preferences and click the Video button. A dialog box 
appears: 

2. Select the appropriate type of video adapter from the list, then 
click OK. A dialog box appears, informing you that the system 
software will shut down and then restart to change the video 
setting. 

3. Click Yes to restart. 

or 

Click No, then click Reset to change the video setting back to its 
original setting. 

4. If you chose to restart, you will see a series of test screens to 
ensure that your choice is correct. If the display is jumbled or stays 
blank for more than two minutes, press FlO to return to your 
original video setting. 

ADDITIONAL OPTIONS 

The Options menu for Host GeoManager includes additional 
options you can use to customize Host GeoManager. Once you're 
satisfied with your settings, save them so that they will apply the 
next time you start GeoManager. 

Warn on Emptying Wastebasket. When on, this option displays 
a confirmation message whenever you empty the wastebasket. 

Hold Items in Wastebasket. When this option is on, any file that 
you drag to the wastebasket remains there until you empty the 
wastebasket or exit to DOS. When it is off, files are deleted as soon 
as you drag them to the wastebasket. 
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NOTE 

Remember, when you delete or replace a file, you cannot undo the 
operation if you change your mind. We suggest you leave 
confirmation options on. Most of them warn you of actions that 
cannot be undone. 

All other Host GeoManager functions are the same as those in the 
unit GeoManager. For more information on any of these functions, 
see Chapter 9. 
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WHAT ARE FILES? 

0.2 GEODOS 

When you store information on a disk, GeoDOS creates a file to 
hold it, with a unique name given by you. By storing information 
in a file, you can retrieve it later to edit it, print it, send it to 
another computer, and so on. 

If you are using an application (such as Text File Editor, Date 
Book, or GeoCalc), it will create, name, save, or retrieve files for 
you, by instructing GeoDOS to do what you want. 

GeoDOS also provides commands to manipulate files directly, 
such as those to copy, rename, delete, and display files. For 
example, if you have saved several files to the internal disk and 
want to copy them to a PCMCIA memory card, a single COPY 
command will do this for you. (Alternatively, you can use 
GeoManager, described in Chapter 9.) 

Naming Files 

When you create a file you must give it a unique name. File names 
must follow certain rules. First, a file name generally has two parts: 
the name (up to 8 characters) and the extension (up to 3 
characters), separated by a period. For example, ABC.1XT is a 
valid file name. 

The name identifies the file. The extension typically categorizes 
the file; it is optional, but very useful for identifying files in the 
same category. For example, the ABC.1XT file might have the 
extension 1XT to indicate it is a text file. 

Files stored in the same directory must have unique names. 

NOTE 

The rules for naming files described in this section only apply when 
you are not using GEOS. When you are using GEOS, the rules are 
very different. (For instance, files created while using GEOS can 
have names that are 32 characters long.) For more information 
about GEOS naming files, see Chapter 1. 

ACCEPTABLE CHARACTERS 

The following characters are acceptable in file names: 

• Any letter in the alphabet (capitals and small letters are 
equivalent) 

• The numbers 0 through 9 
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• The following punctuation marks: 

!@#$%&/\()-_'{}-

UNACCEPTABLE CHARACTERS 

Characters other than those shown above are unacceptable 
characters in a file name. For example, commas, double quotation 
marks, and spaces are not acceptable. 

NOTE 

If you use a period in a file name, GeoDOS will assume that the 
characters following it are the file's extension. 

UNACCEPTABLE FILE NAMES 

Do not use any of the following as file names, since they are 
reserved by GeoDOS for its own use: AUX, COMl, COM2, COM3, 
COM4, LPTl, LPT2, LPT3, NUL, and PRN. 

Saving Files 

When you save a file to a disk, GeoDOS stores additional 
information about the file in the file directory. This information 
includes the file name and extension, the size of the file, (the 
number of "bytes," or characters), and the date and time the file 
was created or last updated. 

To start GeoDOS, choose Exit to DOS from the Express menu. 

NOTE 

You need to connect an external XT keyboard and the AC adaptor 
to start GeoDOS. 

Returning to GEOS 

To return to GEOS, enter the following command at the GeoDOS 
prompt: 

GEOS 

and press Enter. 
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Specifying a Drive 

GeoDOS assigns letters to the various storage devices you have in 
the unit. For example, the letter A identifies a floppy disk drive 
(which your unit won't have); the letter D identifies the RAM 
storage built into the unit. The following table identifies the letters 
for each type of storage device. 

DEVICE ASSIGNMENT 

ROM c 
RAM D 

Floppy AorB 

IDE card, slot 1 E 

IDE card, slot 2 F 

SAAM, slot 1 G,H 
SAAM, slot2 I, J 

Flash, slot 1 K 

Flash, slot 2 L 

Changing the Current Drive 

To specify a drive in a GeoDOS command, type its drive letter 
followed by a colon. 

The default DOS command line prompt displays the current drive 
and directory. For example, C:\DOS> shows that you are in the 
DOS directory of drive C. 

To change the current drive, simply type the new drive letter and a 
colon, and press Enter. For example, to select drive C, type: 

C: 

and press Enter. 

To change to another directory, use the CD command. For 
example, to change to the DOS subdirectory, type: 

CD \DOS 

and press Enter. (For more details on using directories, see 
"Directories" in this chapter.) 

USING THE KEYBOARD 

0.4 GEODOS 

When the GeoDOS prompt is displayed, you can type commands. 
Commands can be entered in either uppercase, lowercase, or a 
combination of both. Commands and options must be separated 



by spaces. A command only begins executing when you press the 
Enter key. 

The keyboard key functions are described as follows: 

KEY 

Enter 

Ctrl, Alt 

Esc 

Backspace 

Pause 

Break 

Ctrl+P 

NOTE: 

FUNCTION 

Executes the GeoDOS command typed at the prompt. 

Control, Alternate keys. Used with other keys as 
"shift" keys for certain control functions. 

Escape key. Cancels the command line you are 
typing. 

Backspace key. Erases the character to the left of the 
cursor. 

Halts scrolling of the screen. To continue scrolling, 
press any key. Ctrl+S performs the same function. 

Hold down the Ctrl key and press Pause to interrupt 
execution of the current command or a GeoDOS 
batch file. Ctrl+C performs the same function. 

Turns on or off screen printing to the printer. 
Everything that is printed on the screen is echoed to 
the printer. 

When you enter commands and data, make sure not to confuse the 
0 (zero) and 0 (uppercase o) keys, as well as the 1 (one) and I 
(lower case L) keys. 

GeoDOS Editing Keys 

To continue a long command on the next line, Press Ctrl+Enter 
and continue typing the command. 

To enter ASCII characters which are not on the keyboard, hold 
down the Alt key and type the character's ASCII code on the 
numeric keypad. Release Alt and the character is displayed on the 
screen. 

Certain keys have special functions when used at the GeoDOS 
prompt, to make entering and editing commands easier: 

KEY 

Fl 

F2 c 

FUNCTION 

(COPYl) Displays the last command line one 
character at a time. 

(COPYUP) Displays the last command line up to the 
first occurrence of the character c. 
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DIRECTORIES 

0.6 GEODOS 

F3 

F4c 

F5 

F6 

Del 

Ins 

Esc 

(COPYALL) Displays all of the last command line. 

(SKIPUP) Skips over the characters in the last 
command line up to the first occurrence of the 
character c. 

(NEWLINE) Stores the current command line for 
editing and displays a prompt for new input. 

(EOF) Types an End-of-file character Ctrl+Z (AZ). 

Skips over a character from the last command line. 

Toggles insert mode. 

Cancels the current command line and allows re-entry 
on the next line. 

To organize your files, you can divide them into named groups, 
called directories. 

Creating a Directory {MD or MKDIR) 

The MD, or MKDIR, command creates a new directory. To create a 
directory called WP (for your word processing program and files) 
on drive D, select drive D and type: 

MD WP 

and press Enter. 

Then, if you use the DIR command to list the current directory, 
you will see a new entry, WP, with the label <DIR> instead of the 
file size. 

Each disk starts off with a single directory called the root directory. 
When you create directories, you place them either in the root, or 
in other directories which you have created, producing a "tree" 
structure. 

PAIBNAMES 

To refer to a file in another directory, you can use a path name. 
The path name describes where on the disk the file is located. The 
\ (backslash) character is used both to indicate the root directory 
and to separate names in a path. 



For example, to copy LEITER.1XT from drive E to the WP 
directory on drive D, type: 

COPY E:LETTER.TXT D:\WP 

and press Enter. 

CAUTION 

At the top of each directory listing are the entries . (dot) and 
.. (double-dot) which represent the directory and its parent 
directory. Do not delete these entries. 

Removing a Directory {RD or RMDIR) 

The RD, or RMDIR, command deletes a directory. To delete a 
directory, first use the DEL command to delete all files from the 
directory, then type RD followed by the directory name. 

Changing the Working Directory {CD or CHOIR) 

The CD, or CHDIR, command changes the directory in which you 
are working. GeoDOS always considers you to be "in" a directory. 
This is called your current directory. If you type a file name 
without a path, or omit the directory name from a command which 
expects one, GeoDOS will assume you mean your current 
directory. If you want to work with files in another directory, you 
can use path names, but you'll generally find it easier to first use 
the CD command to move to the directory in which you want to 
work. 

For example, to move to the WP directory on the current drive, 
type: 

CD \WP 

and press Enter. 

To move to the root directory, type: 

CD \ 

and press Enter. 

USING OTHER COMMANDS 

This section introduces some additional simple but useful GeoDOS 
commands. 
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0.8 GEODOS 

Using Wild Cards to Create Global Commands 

Global commands are commands that are carried out on a group 
of files. Instead of typing the exact file name to copy, delete, 
rename, or whatever, you type a name which specifies a group of 
file names, using one or both of two special characters: query (?) 
and asterisk (*). These are called wild cards, and you can use them 
to replace part or all of a file name. 

THE ? CHARACTER 

Query(?) specifies a single wild card character. For example, DIR 

FILE. 0? will list FILE.01, FILE.02, and FILE.03, but not FILE.IO. 

THE * CHARACTER 

Asterisk (*) specifies any characters from its position forward 
within the file name. For example, DIR * . TXT will list all file 
names with the extension TXT, such as ABC.TXT, SHARP.TXT, and 
SALES.TXT, but not ABC.TNT. 

CAUTION 

Although global commands can save a lot of time and typing, use 
them very carefully, especially with the DEL command. For 
example, DEL*.* means delete all the files in the current directory! 

Displaying a File List (DIR) 

In its simplest form, the DIR command displays a list of all the files 
in the current directory, with file name, extension, size in bytes, 
and the date and time that the file was last modified. Type DIR 

and press Enter. 

To list information about a particular file, type the name and 
extension after the command. For example, to display information 
about LETTER.DOC, type: 

DIR LETTER.DOC 

and press Enter. 

You can add two options to the end of any DIR command to make 
it more convenient when listing a large number of files. To make 
DIR list files a screenful at a time, add /P. To make DIR list just the 
names and extensions, add /W. 



Displaying the Contents of a File (TYPE) 

The TYPE command displays the contents of a text file. To stop 
the display from scrolling off the screen, press Ctrl+S. To interrupt 
the process before the end of the file is reached, press Ctrl+C. 

Copying a File (COPY) 

The COPY command copies files from one directory or disk to 
another. 

COPYING A FILE TO ANOTHER DISK 

To copy EXAMPLE.1Xf from the current directory to drive A, type: 

COPY EXAMPLE.TXT A: 

and press Enter. 

To copy NEW.1Xf from drive A to the current directory, type: 

COPY A:NEW.TXT 

and press Enter. 

COPYING A FILE TO THE SAME DIRECTORY 

To copy a file to the same directory you must give the copy a 
different name. For example, to make a copy of LETTER.1Xf and 
name it MEM0.1Xf, type: 

COPY LETTER.TXT MEMO.TXT 

and press Enter. 

Changing the Name of a File (REN or RENAME) 

The REN, or RENAME, command changes the name of a file. Using 
the wild card characters(* and?) you can rename groups of files 
in a similar way. 

For example, to rename LETTER.1Xf to MEM0.1Xf, type: 

REN LETTER.TXT MEMO.TXT 

and press Enter. 

(If you choose a name which already exists on that disk, or if you 
mistype the name of the file you want to rename, you will get an 
error message.) 
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You can use wild cards to rename groups of files. For example, to 
change all the files in the current directory that have the extension 
.TXT to the extension .DOC, type: 

REN * . TXT * . DOC 

and press Enter. 

To rename a file on another drive, type the drive name before the 
file name. For example, to rename TEST.01 on drive A to TEST-
01.DOC, type: 

REN A:TEST.01 TEST-01.DOC 

and press Enter. 

Deleting a File (DEL) 

The DEL command deletes files from a disk. At some point your 
disks may become cluttered with files that you no longer need. 
Deleting unwanted files is an important part of good 
housekeeping for your system. You can delete a single file or 
groups of files with the DEL command. 

For example, to delete EXAMPLE.TXT type: 

DEL EXAMPLE.TXT 

and press Enter. 

To delete all files with the extension .BAK, type: 

DEL *.BAK 

and press Enter. 

CAUTION 

Be careful when using DEL with wild card characters. It is easy to 
delete the wrong files by mistake. 

If you type DEL*.* (which would delete all the files in the 
directory), you will be asked for confirmation: Are you sure? 
(Y /N)? To delete all the files in the directory, type Y and press 

Enter. To abort the process, type N and press Enter. 

CONFIGURATION FILES 

0.10 GEODOS 

GeoDOS uses two files when starting up: CONFIG.SYS and 
AUTOEXEC.BAT. These files are located on drive C. You can also 



create new CONFIG.SYS and AUTOEXEC.BAT files manually, with 
Text File Editor. 

CAUTION 

Do not edit CONFIG.SYS or AUTOEXEC.BAT manually unless 
you know what you are doing. Certain mistakes are difficult to 
correct. 

If you create a new CONFIG.SYS or AUTOEXEC.BAT, you will 
find it in the root directory of drive D. 

Before a new version of CONFIG.SYS or AUTOEXEC.BAT can take 
effect, you must restart your computer. If you push the restart 
switch quickly, the unit will restart using the information in the 
new configuration files. If you hold down the restart switch for five 
seconds, the unit will restart with the settings in the original 
CONFIG.SYS and AUTOEXEC.BAT. GEOS then overrites these 
files on CONFIG.SYS and AUTOEXEC.BAT in drive D. If you wish 
to restore these files to your states prior to the restart, run 
RESETINI.BAT in the DOSROOM folder. 
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IN.2 INDEX 

1 
1.X VM File type 9.16 

A 
ABORT command 4.78 
ABS mathematical function B.9 
absolute reference 6.16, 6.17, 6.35 

in formulas 6.17 
ACOS trigonometric function B.10 
ACOSH trigonometric function B.10 
active cell 6.5 
active cell address 6.5 
active memory 4.8, 4.9 

functions 4.10 
recalling numbers 4.11 
storing numbers 4.10 

addition operator 6.18 
address book 

adding entries 2.12 
adding to an entry's sketch page 2.13 
creating new documents 2.16 
customizing fields 2.14 
deleting entries 2.13 
duplicating entries 2.14 
editing entries 2.13 
entry view 2.11 
hiding fields 2.15 
index view 2.10 
moving entries 2.13 

Advanced Power Management 4.56 
Advanced Sort 7.21 
Align to Grid 8.34 
Align/Distribute 8.27 
aligning 

fields 7.54 
justifying text 5.14 
object to grid and guidelines 8.33 
object, relative 8.26 
objects 8.26 
text 5.14 to 5.15 

alignment buttons 8.27 
All Exploded chart variation 6.47 
alphabetic keyboard 1.5 
Alphanumeric button 6.6 
anchor point 8.49, 8.51 

deleting 8.50, 8.54 

inserting 8.50 
inserting with Spline tool 8.53 

AND B.10 
AND functions 6.41 
annotated object 8.66 
annotating objects 8.65 
annotation 3.28, 3.29 
apostrophe in spreadsheet 6.10 
append 

page 5.65 
section 5.50 

Append Section 5.51 
application 

exiting 1.24 
icons 1.10 
menus 

see menu 
opening 1.21 
setting options 3.30 

Apply button 1.18 
Apply Style 5.40, 8.60 
appointment book 

see datebook 
arc 8.46 
arc attribute 8. 75 
Arc tool 8.46 
Archive attribute 9.15, 9.17 
area attribute 5.62, 8.18 
Area Attributes, graphics 8.19 
area chart 6.46 
Area Fill Color tool 8.22 
Area Pattern tool 8.23 
Area Shading tool 8.22 
Area tool button 6.50 
argument 

in built-in function 6.19 
placeholder 6.19 
rules for B.2 

arrow controls 
Writing grid keyboard 1.6 

Arrow pointer 8.4 
ASCII text files, importing 5.46 
ASIN trigonometric function B.10 
ASINH trigonometric function B.11 
Ask Before Returning to GEOS option 

9.24 
aspect ratio 6.52 
ATAN trigonometric function B.11 
ATAN2 trigonometric function B.11 



ATANH trigonometric function B.12 
attribute 

arc 8.75 
changing file and folder 9.16 
chart 6.52 
default for object 8.76 
extended 8.65 
graphic 8.60 
recalling from style 8.64 
storing in styles 8.64 

Auto Linefeed terminal setting 4.61 
AUTOEXEC.BAT D.10 
automatic pagination 5.76 
automatic recalculation 6.37 
AVG statistical function B.12 
Axis 6.56 
axis markings 6.56 
axis title 6.55 

B 
background color 8.72 
backing up documents 3.8 
Backup 3.6 
bar chart 6.45 

see also chart 
Bar tool button 6.50 
base style 5.41, 5.44, 8.57, 8.62 

reverting to 8.63 
baud rate 4.58 
BELL command 4.79 
Bezier curve 8.51 
binary file 4.76 
bitmap 

changing pixels 8.42 
converting objects 8.44 
defined 8.35 
ellipse 8.38, 8.39 
erasing pixels 8.42 
frame, drawing 8.37 
freehand line 8.38 
freehand shape 8.40 
pixel view 8.43 
rectangle 8.38, 8.39 
selecting a region 8.41 
selecting pixels 8.42 
shape tool 8.38 
straight line 8.38, 8.39 
tools 8.36 

Bitmap Ellipse tool 8.36, 8.40 
Bitmap Fill tool 8.42 
bitmap frame 8.36 to 8.38 
Bitmap Line tool 8.36, 8.39 
Bitmap Rectangle tool 8.36, 8.39 
Bitmap Selection tool 8.41 
Bitmap tool bar 3.23 
Border Color 5.27 
Border Color, GeoCalc 6.32 
border, paragraph 5.25 to 5.28 

color 5.27 
Borders, GeoWrite 5.26 
Break Out Paste Inside 8.72 
Break Out Paste Inside button 8.25 
break signal 4.67 
brief messages 4.68 
Bring in Style Sheet 5.45, 8.63 
Bring to Front 8.17 
Bring to Front button 8.25 
Brush bitmap tool 8.36 
Brush tool 8.40 
built-in function 6.14, 6.18 to 6.22 

see also function 
bullet 5.11 to 5.13 

c 
C/CE button 4.4 
Calculate button 6.38 
Calculate Now, GeoCalc 6.38 
Calculate tool 6.59 
calculating 4.6 

basic calculations 4.3 
copy and paste 4.7 
error conditions 4.8 
hierarchy of operations 4.7 
inverse sin, cosine, or tangent of angles 

4.18 
memory 

see active memory 
see register memory 

powers of numbers 4.18 
RPN mode 4.15 
sin, cosine, or tangent of angles 4.18 
using the keyboard 4.7 
using the pen 4.7 

calculation order 6.18 
Calculation, GeoCalc 6.37, 6.39 
Calculator 4.2 
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see also calculating 
buttons 4.4 
calculation buttons 4.5 
converting measurements 4.21 
currency conversions 4.22 
decimal places displayed 4.16 
exchange rates 4.22 
key combinations 4.4, 4.14, 4.17 
key combinations for calculating 4.5 
key combinations for memory 4.5 
memory buttons 4.5 
modes 4.4 
paper tape 4.21 
saving custom settings 4.13, 4.21 
window 4.3 
worksheets 4.20 

calendar 
see datebook 

call waiting 4.72 
Cancel button 1.18 
Cancel Changes button 7.8 
Category Titles chart variation 6.47 
CD D.7 
cell 

active 6.5 

IN.4 INDEX 

address, described 6.5 
adjusting column width 6.29 
adjusting row height 6.29 
border 6.28 
border color 6.32 
copying 6.22, 6.23 
described 6.4 
deselecting 6.7 
moving 6.22 
selecting 6.6 

Cell Borders 6.28 
Cell menu 1.11 
Change Directory command D.7 
Change Type, GeoCalc 6.51 
Change User Level option 3.4 
CHAR string function B.12 
Character Attributes 5.20 
chart 

area 6.46 
as object 6.50 
attribute 6.52 
axis markings 6.56 
axis title text 6.55 
bar 6.45 

changing attributes 6.53 
changing type 6.50 
column 6.44 
copying to another GEOS application 

6.53 
creating 6.48 to 6.50 
defined 6.43 
deleting 6.53 
elements 6.48 
grid markings 6.56 
handle 6.51 
high/low 6.48 
line 6.45 
maintaining aspect ratio 6.52 
marker shape 6.57 
move handle 6.51 
moving 6.51 
numbers in titles and category names 

6.49 
pie 6.47 
resizing 6.52 
scatter plot 6.46 
text properties 6.52 
title text 6.55 
titles and legends 6.54 to 6.55 
types 6.43 
x-y plot 6.46 

CHDIR D.7 
check box 1.17 
Check Spelling 5.16 
check spelling 5.36 to 5.38 

options 5.37 
Text File Editor 4.26 

Check Spelling button 5.10, 5.16 
checksum 4.75, 4.76 
Choose Define Name, GeoCalc 6.36 
CHOOSE information function B.13 
circular reference 6.38 to 6.39 

iteration 6.39 
CLEAN function B.13 
CLEAR command 4.79 
clicking 1.18, 1.27 
clipboard 1.28, 4.31 

copying text received by modem to 
clipboard 4.73 

database use 7.53 
sending contents 4.68, 4.70 
warning, databases 7.61 

clock speed 4.45 



Close button 1.18 
closing documents 1.24 
CODE function B.13 
collapsing branches 9.18 
color 

cell border 6.32 
GeoWrite 5.28 to 5.34 
graphic frame 5.62 
object background 8.72 
palette 5.29 
paragraph 5.29 
paragraph borders 5.27 
patterns 5.29 
printer tips 1.44 
spreadsheet 6.30 
spreadsheet background color 6.31 
text 5.29 
text background 5.29 

COLS function B.13 
column 5.53 

adjusting cell width 6.29 
deleting, spreadsheet 6.25 
headers, spreadsheet 6.4 
inserting, spreadsheet 6.25 
selecting, spreadsheet 6.7 

column chart 6.44 
Column tool button 6.SO 
Column Width, GeoCalc 6.29 
column, GeoWrite 5.77 to 5.80 

breaks 5.24, 5.77 
changing 5.80 
inserting break 5.80 
multiple 5.78 
section, options 5.79 

COMM command 4.79 
comma in spreadsheets 6.10 
compressing folder display 9.10 
Computed field type 7.40 
computed value 7.48 
concatenation operator 6.18 
Condensed display mode 5.68, 5.70 
conditional operator 6.41 
CONFIG.SYS D.10 
configuring modem 4.61 
Confirm When Exiting GeoManager 

option 9.24 
Connect/Disconnect button 1.11, 9.5, C.4 
container object 8.70 
contents, table of 5.87 

control point attributes 8.55 
Control Points 8.56 
convergence 6.38 
Convert to Bitmap 8.44 
COPY command D.9 
Copy Disk 9.20 
copy pointer 9.12 
Copy To 3.10 
copy-blocked pointer 9.12 
copying 

absolute reference 6.17 
cancelling the copy 9.13 
cell contents 6.22, 6.23 
chart to another GEOS application 

6.53 
documents 3.10 
file 9.12 
files 9.8 
floppy disks 9.20 
folder 9.12 
formula 6.16, 6.17, 6.23, 6.36 
graphic frame 5.62 
graphic object 5.62 
Ink items 2.6 
relative reference 6.16 
scraps 4.30 
sketch pages 2.7 
spreadsheet 6.36 
spreadsheet data to another GEOS 

application 6.65 
text 1.28 
text received by modem to clipboard 

4.73 
to drives 9.5 

COS function B.14 
COSH function B.14 
cosine 4.19 
Count Again 5.73 
COUNT function B.14 
Counts, GeoWrite 5.73 
CR/LF 4.75 
CRC (Cyclic Redundancy Check) 4.75, 

4.76 
Create Folder 9.11 
Create Graphic Frame 5.60 
Create Launcher dialog box 9.28 
Create New Field dialog box 7.28 
Create New Fields 7.41 
Create New Layout 7.58 
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Create Title Page 5.36 
Create, graphics 8.4, 8.5 
Cross hairs pointer 8.4 
Crossed I-Beam pointer 8.4 
CTERM function B.14 
currency 

conversions 4.22 
Preference options 4.46 

Current Page button 5.10 
curved polyline object 8.47 
Custom Border 5.26 
Custom Duplicate 8.69 
Custom Move 8.11 
Custom Rotate 8.16 
Custom Spacing 5.21 
customizing 

address book fields 2.14 
cutting 

IN.6 INDEX 

Ink items 2.6 
sketch pages 2.7 

D 
data bits 4.59 
data document 5.81 
data entry area 7.52 
Data Entry button 7.29, 7.31 
data entry mode 7.13, 7.14, 7.28, 7.30, 

7.31 
Data Entry Mode button 7 .28 
Data file type 9.16 · 
data packets 4. 71 
database 

see also database formatting 
see also field 
adding record 7. 7 
advanced sorting 7.21 
copying objects between layouts 7.61 
creating 7.36 
data entry mode 7.14, 7.28, 7.30, 7.31 
defined 7.2 
deleting layout 7.60 
design mode 7.28, 7.31 
exporting data to another GEOS 

application 7.22 to 7.24 
field 

see field 
fitting multiple records on a page 7.62 
graphic options 7.57 

graphics 7.57 
importing data 7.24 
key combinations 7.7 
layout 7.11, 7.57 
layout not~~ 7.58 
layout switching 7.57 
mark record options 7.20 
marking records 7.15 
menu structure 7.56 
multi-record mode 7.32, 7.61 
multiple records 7.66 to 7.67 
new layout 7.58 
opening 7.5 
page layout 7.62 
page size options 7.65 
planning 7.34 to 7.35 
record 7.7 to 7.11 

see also record 
Record Control Panel 7.6 
record order 7.66 to 7.67 
record region 7.66 
renaming layout 7.59 
single-record mode 7.61 
sorting records 7 .10 
switching between single- and multi-

record mode 7.62 
template 7.36 
text attributes 7.52 
text formatting 7.56 
unmarking record 7.19 
using Field Organizer 7.36 

database formatting 
planning the design 7.50 
text 7.56 

date 
format options 4.47 
incremental range 6.25 
inserting current date in documents 

5.75 
Preference options 4.43 

Date field type 7.40 
date format 6.63 

database fields 7.46 
date formats, table of 6.13 
DATE function B.15 
date functions B.8 
date in spreadsheet 6.11 
Date of Printing button 5.35, 5.56 
date book 



creating new documents 2.34 
Day view 2.23 
displaying specific date 2.23 
event page 2.25 

see also event 
Month view 2.21 
purging items 2.34 
Six-month view 2.20 
switching to another document 2.34 
Week view 2.22 

DATEVALUE function B.15 
DAY function B.15 
Day view 2.18, 2.23 
daylight bar 2.41 
daylight savings time 2.43 
DDB function B.16 
Default Tabs 5.24 
default value 7.47 
Define Name, GeoCalc 6.37 
Define New Style 5.41 
DEL command D.10 
Delete 9.14 
Delete Column tool 6.59 
Delete Entry 2.13 
Delete Row tool 6.59 
Delete Row/Column 6.25 
Delete Section 5.51 
Delete Title Page 5.36 
deleting 9.13 to 9.14 

address book entries 2.13 
anchor points 8.50, 8.54 
annotated objects 8.66 
cell or range name 6.37 
chart 6.53 
database layout 7.60 
events 2.28 
field 7.45 
field label 7.53 
files 9.13, C.10 
folders 9.13 
gradient fill 8.75 
graphic frame 5.61 
graphic style 8.62 
guidelines 8.32 
hard page break 5. 77 
launcher icon 9.28 
objects 8.12 
page 5.65 
printer from the list 4.40 

record 7.8 
row or column, spreadsheet 6.25 
scrapbook page 4.32 
section 5.51 
style 5.44 
tab stop 5.24 
templates 3.17 
text 1.29 
text, with pen gestures 1. 7 
title page 5.36 
To Do items 2.31 
wastebasket items C.10 

deselecting 
cell 6.7 
icons 9.7 
objects 8.8 

Design button 7.29 
design mode 7.13, 7.28, 7.31 
Design Mode button 7.28 
desk accessories 1.20 
Desk Accessories, Express menu 1.13 
Destination button 

World Clock 2.41, 2.42 
destination disk 9.20 
DIAL command 4.79 
dialing 4.63 to 4.66 

hanging up 4.64 
outside phone line 4.64 

dialog box 1.16 to 1.18 
clicking in 1.18 
described 1.16 
elements in 1.17 
ellipsis in 1.18 
file selectors in 1.24 
font size in 4.49 
scrolling list in 1.18 
types 1.16 

dictionary editing 5.38 
DIR command D.8 
directory D.6 
Directory attribute 9.15, 9.17 
Discard Changes 3.10 
disk drives 9.5, C.5 
disks 

identifying 9 .5 
Display Fields 2.16 
display mode 5.67 to 5.71 

changing 5.68 
Display Modes 5.68 
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Display Section Name 5.52 
distributing 

fields 7.54 
distributing objects 8.26, 8.27 
division operator 6.18 
Do Not Delete Pages With Graphics 

option 5.65 
document 

backing up 3.8 
changing options 1.36 
closing 1.24 
copying 3.10 
counters 5.73 
creating 1.22 
creating new with template 3.13 
discarding changes 3.10 
empty 3.12 
graphics 

see graphics 
naming 1.23 
new 1.22 
notes 3.11 
opening 1.22 
PalmAddress 2.16 
PalmNotes 2.39 
printing to a file 1. 42 
printing with standard settings 1.35 
read-only 3.11 
recalculating document counters 5.73 
renaming 3.11 
restoring 3.8, 3.9 
retrieving 1.25 
safeguarding 3.29, 4.27, 4.49 
saving 1.24 
saving as template 3.11 
saving with Save As 3.8 
storing 1.25 
viewing document counters 5.73 

DOCUMENT folder 1.11, 1.25, 9.5, 9.10 
document, GeoWrite 

color 5.28 to 5.34 
contents, table of 5.87 
current date and time 5.74 
exporting 5.45 
footer 5.34 
header 5.34 
importing into 5.45 
leafing through pages 5.7 
numbering 5.74 

pasting graphics 5.62 
scrolling 5.7 
special characters 5.73 
spell checking 5.36 
style sheet 5.39 
viewing 5.67 

DOS application 
creating launcher icons 9.25 to 9.28 
icons 9.4 
importing scrap from 4.32 
starting 9.24 

DOS file 
attributes 9.15 
name 4.28 

DOS File type 9.16 
DOS file, naming 1.23 
DOS text file 

line endings 4.25 
sending 4.70 
sending on modem 4.68 
Text File Editor 4.27 

DOSROOM folder 1.11, 9.5, 9.10 
double-tapping 1.2, 9.24 

in spreadsheets 6.7 
Draft With Styles display mode 5.68, 5.70 
Draft Without Styles display mode 5.68, 

5.71 
drag and drop 9.8 
drag and drop pointer 1.29 
dragging 1.2, 9.12 

icons 9.8 
to a disk C.9 
to a folder C.9 

Draw Grid Lines 6.27 
draw modes 8.20 
Drawing tool bar 3.23, 6.64 
drawing tools 

described 8.3 
GeoCalc 6.64 
level 3 8.2 
level 4 8.45 
pointers 8.4 

drive 
assignments 9.5 
opening folders 9.10 
rescanning 9.22 
specifying D .4 

Drive Locations option 9.24 
Drives drop-down list 1.26 



Drop Lines chart variation 6.45, 6.46 
drop-down list 1.18 
DTP mode 5.64 
Duplex terminal setting 4.60 
Duplicate button 8.25 
Duplicate Entry 2.14 
Duplicate in Place button 8.25 
duplicating 9.13 

E 

address book entries 2.14 
folders 9.13 
objects 8.12, 8.68, 8.69 

e (Euler's constant) 4.19 
Edit area 6.5 
Edit bar, GeoCalc 6.5 
Edit Custom Field Labels 2 .14 
Edit Footer 5.35 
Edit Header 5.35 
Edit Master Page 5.56 
Edit menu 1.11 
editing text 5.10 
Ellipse tool 8.3 
ellipsis in dialog boxes 1.18 
embedding functions 6.22 
empty document 3.12 

default settings 3.12 
reverting to GEOS default settings 3.12 

Empty Times 2.29 
EMS memory 4.49 
emulation types 4.60 
END command 4.79 
End Lines with CR/LF option 4.75 
entering text 

see text 
entry view, address book 2.10 
Eraser bitmap tool 8.36 
Eraser tool 8.42 
ERR function B.16 
error conditions, calculating 4.8 
event 

adding 2.25 
changing an event 2.28 
deleting 2.28 
ending time 2.26 
repeating 2.27 
scheduling 2.25 
selecting frequency 2.27 

setting an alarm for 2.26 
show/hide empty events 2.29 
showing duration 2.29 
starting time 2.26 

event page 2.19, 2.23 
Event tab 2.23 
EXACT function B.16 
exchange rates 4.22 
executable file 9.26 
Executable file type 9.16 
Exit 3.7 
Exit to DOS 9.29 

Express menu 1.14 
Exit to GeoManager, Express menu 1.14 
exiting 

applications 1.24 
GeoManager 9.29 

EXP function B.17 
Expand Branch 9.19 
exponentiation operator 6.18 
Export Document 

GeoCalc 6.66, 6.67 
GeoFile 7.23 
GeoWrite 5.46, 5.84 

Export to Clipboard button 7.24 
exporting 5.45 

data to another GEOS application 7.22 
to 7.24 

GeoWrite documents 5.45, 5.46 
spreadsheet data 6.66, 6.67 

Express button 1.10 
Express menu 1.13 
external keyboard 1.7 

F 
FACT function B.17 
factorial 4.19 
FALSE function B.17 
field 7.2, 7.7 

adding to a layout 7.60 
aligning 7.54 
changing 7.53 
changing address book display 2.15 
changing default expression 7.48 
computed value 7.48 
copying labels 7.53 
creating 7.38, 7.39, 7.40, 7.41 
customizing address book fields 2.14 
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data entry 7.38 
data entry area 7.38 
date formats 7.46 
default value 7.47 
definition, changing 7.43, 7.44 
deleting 7.45 
deleting a label 7.53 
distributing 7.54 
edges 7.55 
editing customized address book fields 

2.14 
elements 7.38, 7.52 
expressions 7.47 
field label 7.38 
fitting withing layout 7.66 
hiding address book fields 2.15 
label text 7.52 
labels 7.52 
mapping for import 7.25 
moving 7.53 
name, changing 7.43 
naming 7.39 
notes, changing 7.42 
number formats 7.46 
numbers in 7.40 
PalmAddress 2.12 
removing from layout 7.61 
resizing 7.53 
selecting 7.53 
setting tab order 7.54 
show/hide edges 7.55 
time formats 7.46 
type, warning when changing 7.44 
types 7.40 
warnings about deleting 7.45 

Field Edges 7.56 
field expression 7.47 to 7.50 

changing 7. 48 
field label 7.38 
Field Organizer 7.31, 7.36 to 7.37, 7.60 

closing 7.37 
dialog box 7.28 
elements 7.36 
moving 7.37 

Fields In Current Layout 7.37 
Fields Not in Current Layout 7.37 
Fields Not in Current Layout list 7.45 
file 

attributes 9.15 

INDEX 

changing attributes 9.16 to 9.18 
copying 9.12 
defined D.2 
deleting 9.13 
deleting with Host GeoManager C.10 
duplicating 9.13 
getting information about 9.14 
hidden 9.10 
management 9.20 
moving 9.12 
naming 1.23, D.2 
protecting 9 .17 
renaming 9 .11 
saving D.3 
transfer with GeoHost C.5 
transferring C. 7 
types 9.16 
viewing as list 9.9 

File Information 9.15 
File Mask option 5.46 
File menu 1.11 

common options 3.6 
file selector 1.24 

buttons 1.26 
FILENAME function B.18 
Fill bitmap tool 8.36 
Fill Down 6.23, 6.24 
Fill Right 6.23, 6.24 
Fill Series 6.26 
Fill, GeoCalc 6.22 
financial functions B.4 
Find and Replace 5.31 
Find and Replace button 5.31 
find and replace text 5.30 to 5.33 

Text File Editor 4.26 
FIND function B.18 
find options 5.31, 5.32 
Find, GeoFile 7.9 
Fine Tune dialog box 3.5 
first line indent 5.21 
First Wedge Exploded chart variation 

6.47 
first-line indenting 5.12 
Flip 8.15 
Flip buttons 8.25 
flipping an object 8.14 
floating keyboard 1. 4 

switching keyboard layouts 1.5 
floating point math 6.14, B.2 



floppy disk 
button 9.5 
copying 9.20 
formatting 9.21 
renaming 9.22 
rescanning 9.22 
security while formatting 9.22 

folder 
BACKUP 9.11 
changing attributes 9.16 to 9.18 
collapsing within a branch 9.19 
compressing display 9.10 
copying 9.12, C.9 
deleting 9.13 
displaying for another drive 9.19 
dragging 9.12 
duplicating 9.13 
expanding 9.18, 9.19 
getting information about 9.14 
icon 9.4 
minus sign 9.18 
moving 9.12, C.9 
multiple C.8 
new 9.11 
opening 9.8, 9.10 
other drive 9.10 
parent 9.10 
plus sign 9.18 
protecting 9 .17 
renaming 9 .11 
sorting attributes 9.9 
stacking C.9 
Templates 3.13 
tiling C.9 
transferring C. 7 
tree 9.18 
tree window 9.18 
viewing as list 9.9 
window 9.3 

folder window 
GeoManager 9.3 

font 1.30 
buttons 5.10 
changing 1.30 
viewing 1.31 

Font Viewer option 1.31 
footer 

GeoCalc 6.30 
GeoWrite 5.34 

importing and exporting 5.45 
spreadsheet 6.29 

Footer style 5.34, 5.39, 5.44 
foreign characters 1.30 
Forever option 2.28 
format 

image 4.33 
Format Disk 9.21 
formatting 

cell information 
see cell formatting 

database 
see database formatting 

floppy disk 9.21 
GeoWrite document 5.19 to 5.47 
Geo Write documents see also 

document, GeoWrite 
Geo Write documents see also style 

sheet 
paragraph 

see paragraph formatting 
text 5.19 to 5.20 

formula 6.8, 6.14 to 6.22 
absolute reference 6.17 
argument 6.19 
built-in function 6.18 to 6.22 
circular reference 6.38 to 6.39 
convergence 6.38 
copying 6.24, 6.36 
deleting cell or range name 6.37 
elements 6.14 
entering 6.15 
entering date 6.11 
function in 6.14 
function within a function 6.21 
inserting cell name 6.36 
inserting function, using the Formula 

menu 6.20 
iteration 6.38 
moving 6.22 
naming cell 6.35 to 6.37 
naming range 6.35 to 6.37 
operator 6.14 
operators (table) 6.17 
placeholder argument 6.19 
reference 6.14 
relative reference 6.16, 6.22 
renaming named cell or range 6.36 
show/hide 6.34 to 6.35 
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specifying iteration 6.39 
value 6.14 

Formula menu 1.11 
Frame bitmap tool 8.36 
free space on drive 9.5 
Full-Sized windows/Overlapping 

windows button C.4 
function 

AND 6.41 
arguments in 6.40 
basic Calculator 4.3 
built-in 6.14 
built_in 6.18 to 6.22 
function within 6.21 
IF 6.40 
in formulas 6.14 
inserting 6.20 
logical operators (table) 6.41 
lookup 6.42 
OR 6.41 
types 6.40 
typing 6.21 

Function bar 
GeoCalc 6.58 

Function tool bar 3.23, A.2, A.3 
functions 

arguments in B.2 
date B.8 
financial B.4 
information B.5 
logical B.5 
mathematical B.6 
print B.6 
statistical B.6 
string B.7 
time B.8 
trigonometric B.8 

functions, GeoCalc 
functions list B.3 

functions, GeoFile B.1 
FY function B.18 

G 
Galley display mode 5.68, 5.69 
General/Text field type 7.40 
Geo Cale 

see also spreadsheet 
see also spreadsheet formatting 

INDEX 

arguments in functions B.2 
chart 

see chart 
exporting 

see exporting 
functions list B.3 
importing 

see importing 
printing 

see printing 
tools 6.59 
user levels 6.3 
using with other applications 6.65 
window 6.4 

GeoComm 
see also dialing 
see also modem 
see also script 
break signal 4.67 
counters 4.67 
CRC (Cyclic Reduncancy Check) 4.75 
cursor 4.57 
described 4.56 
dialing 4.63 to 4.66 
hanging up 4.64 
line status 4.66 to 4.67 
logging in and out 4.64 
monitoring connection quality 4.67 
protocol setings 4.58 to 4.60 
Quick Dial 4.64, 4.77 
receiving information 

see receiving information 
saving screen text 4.73 to 4.74 
saving scroll-back buffer text 4.73 
saving text to a file 4.74 
saving text, using XMODEM 4.75 
scrolling text 4.72 
sending information 

see sending information 
starting 4 .56 
terminal emulation 4.60 
terminal settings 4.60 to 4.61 
window 4.57 
window settings 4.63 

GeoDOS D.2 
starting D.3 

GeoFile 
see also database 
see also template 7.5 



arguments in functions B.2 
data entry mode 7.14 
database 

see database 
exporting data 

see exporting 
Field Organizer 7.36 to 7.37 
functions 7.47 
graphics 7.57 
importing data 

see importing 
menu structure 7.56 
window 7.3, 7.28 

Geo Host 
installing C. 2 
installing without mouse C.2 
system requirements C.2 
transferring files C. 5 
window C.3 

GeoManager 
defined 9.2 
exiting 9.29 
options 9.23 
window 1.10 

GEOS 
application icons 9.4 
application user levels 3.2 
document icons 9.4 
file attributes 9 .15 
naming documents 1.23 

Geo Write 
described 5. 2 
document counters 5.73 
documents 

see document, Geo Write 
DTP mode 5.64 
entering text 

see text 
menu structure 7.56 
Style bar, described 5.9 
template 

see template 
user levels 5.3 
window 5.4 

Get Info button 9.15 
Global Power Management Preference 

option 4.55 
Go to Backup 9.11 
Go to Cell 6.7 

Go To Cell dialog box 6.7 
Go To Day 2.23 
Go to Document folder button 1.26 
Go to GeoManager 9.2 
Go to Page 5.7 
Go to Title Page 5.36 
GOTO command 4.80 
gradient fill 8. 73 

options 8.75 
removing 8.75 
setting 8.74 

graphic frame 5.60 to 5.62 
copying 5.62 
selecting 5.61 

graphic style 8.56 to 8.64 
applying 8.59 
attributes 8.56 
base style 8.57 
changing style attributes 8.61 
changing visual attributes 8.60 
deleting 8.62 
described 8.56 
getting stylesheet from other drawings 

8.63 
naming 8.57 
new 8.58 
options 8.58 
recalling attributes 8.64 
reverting to base 8.63 
storing attributes 8.64 

graphic style sheet 8.57 
Graphic tool bar 3.24 
graphics 

see also object 
adding frame 5.59 to 5.63 
database 7.57 
GeoCalc 6.64 to 6.65 
GeoWrite 5.59 to 5.63 
master page 5.56 
spreadsheet header and footer 6.30 
text wrapping options 5.63 

Graphics bar 8.18, 8.22 
Graphics tool bar 6.64 
Graphics tool buttons 7.28 
grid 6.27 

aligning objects to 8.33 
defined 8.28 
markings 6.56 
setting spacing 8.30 
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show/hide 8.29, 8.30 
show/hide lines 6.27 
snapping objects to 8.33 
spacing 8.30 

grid line 6.27 
GeoFile 7.65 

Grid Lines 6.56 
Grids 8.30 
Group button 8.25 
Group, graphic objects 8.13 
grouping 

objects 8.12 
pages in PalmNotes 2.37 

guideline 
aligning objects to 8.33 
changing 8.31 
creating 8.31 
defined 8.29 
deleting 8.32 
snapping objects to 8.33 

gutter 5.78 

H 
handle 5.61 

changing size 8.68 
chart 6.51 
polyline 8.51 
size options 8.68 
text regions 5.57 

handshake 4.59 
handwriting recognition 1.2, 2.3, 2.13 

tips 1.3 
hanging indent 5.11 to 5.13, 5.22 
hanging up 4.64 
hard icon, reassigning 4.44 
hard page break 5.77 
Hardware Preference options 4.45 
header 

GeoCalc 6.30 
GeoWrite 5.34 
importing and exporting 5.45 
spreadsheet 6.29 

Header or Footer 5.35 
Header style 5.34, 5.39, 5.44 
Header/Footer, GeoCalc 6.30 
Help button 1.10, 1.19 
Help window 1.19 
Hewlett-Packard style 4.4 

INDEX 

Hidden attribute 9.15, 9.17 
hidden file 9.10 
Hide Unselected Objects 8.67 
high/low chart 6.48 
High/Low tool button 6.50 
HLOOKUP function B.18 
Hold Items in Wastebasket option C.12 
Home button 

World Clock 2.41, 2.42, 2.43 
home town, World Clock 2.43 
horizontal gradient 8.74 
Host Code Page terminal setting 4.61 
Host GeoManager 

window C.3 
host PC 

connecting to unit C.5 
Host Preferences C.11 
HOUR function B.19 
Hyphenation 5.28 
hyphenation 5.28 

I-Beam pointer 8.4 
icon 

application 1.10 
creating launcher 9.25 
deselecting 9.7 
dragging 9.8 
folder 1.10 
GEOS documents 1.10 
Hard Icon Preference options 4.44 
launcher 

see launcher icon 
number in folder 9 .5 
selecting 9.7 
total size of 9.5 
types 9.4 

IF function 6.40, B.19 
image format 4.33 
Import button 7.25 
Import Scrap 4.33 
importing 5.45 

column rearranging when importing 
6.68 

data from other application 7.24 
Geo Write documents, ASCII text files 

5.46 
images from a DOS application 4.32 



into GeoWrite documents 5.45 
spreadsheet information from DOS 

6.66, 6.68 
incremental value 6.25 
indentation 5.4, 5.11, 5.13 
indenting paragraphs 5.11 

bullet 5.11 to 5.13 
first-line 5.12 
GeoWrite 5.4 
indent marker 5.11 

Indents 5.22 
INDEX function B.20 
index view, address book 2.10 
information bar 

buttons 9.5 
elements 9.5 
GeoManager 9.3 

information functions B.5 
Insert Column tool 6.59 
Insert Function 6.20 
insert mode 1.30 
Insert Name, GeoCalc 6.36 
Insert Page Break 5.77 
Insert Point(s) 8.54 
Insert Row tool 6.59 
Insert Row/Column 6.25 
Insert Section 5.51 
Insert Special 5.74 
inserting 

anchor points 8.50, 8.53 
built-in function 6.21 
current date and time 5.74 
function 6.20 
hard page break 5.77 
name in a formula 6.36 
new line, with pen gestures 1.7 
page 5.65 
row or column, spreadsheet 6.25 
section 5.50 
special characters 5.73 
special dates and times 5.75 
text 5.6 
text, with pen gestures 1. 7 

insertion point 1.27, 5.5, 8.35 
INT function B.20 
Integer field type 7.40 
interest rates 

rules for arguments B.2 
interior object 8.70 

International keyboard 1.5 
International Preference options 4.37, 

4.45 
inverse logarithm 4.19 
inverse natural log 4.19 
invisible characters 5.72 

displaying 5.72 
table of 5.72 

IRR function B.21 
!SERR function B.21 
ISNUMBER function B.22 
ISSTRING function B.22 
iteration 6.38 

options 6.39 

J 
justification 5.14 
justifying text 1.33 

K 
key combinations 

Calculator 4.4 
database 7.7 
editing values and labels in cells 6.9 
moving insertion point 5.5 
scrolling 5.7 
selecting text 5.8 
trigonometric calculations 4.17 

keyboard 
changing Preference options 4.37 
Preference options 4.48 
switching layouts 1.5 

keyboard equivalents 
scientific extension options 4.19 

L 
label. 

defined 6.8 
entering data 6.10 
entering date 6.11 
entering in spreadsheet 6.8 
entering with key combinations 6.9 

landscape page layout 1.39 
LapLink C.5 
launcher icon 9.24 

changing settings 9.28 
creating 9.25 
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custom options 9.28 
location 9.27 
options for creating 9.26 
removing 9.28 

layout 
database 7.11 
GeoFile 7.3 

leading 5.15 
manual 5.21 

leafing through pages 5.7 
LUT function B.22 
left indent marker 5.4, 5.11 
legend, in a chart 6.54 
LENGTH function B.23 
line 

attribute 5.62, 8.20 to 8.22 
breaks 5.24 
ending 4.25 
length, printing in Text File Editor 4.27 
spacing 5.15, 5.20 
status, GeoComm 4.66 

Line Attributes 8.21 
line chart 6.45 
Line Color tool 8.23 
Line Shading tool 8.23 
Line tool 8.3 
Line tool button 6.50 
Line Width tool 8.23 
linefeed 4.70 
Lines Only chart variation 6.45, 6.47 
LN function B.23 
LOG function B.23 
logarithm, base 10 4.19 
logarithm, natural 4.19 
logging in and out 4.64 
logical function 6.40 to 6.41 
logical functions B.5 
logical operators 

table 6.41 
long date format 4.47 
Look & Feel Preference options 4.49 
lookup function 6.42 
LOWER function B.23 

M 
mail merge 5.82 to 5.83, 5.84 

copying GeoFile records 5.83 
creating merge document 5.81 

INDEX 

data document 5.81 
designing GeoCalc data document 

5.82 
GeoWrite 5.80 to 5.87 
merge document 5.81 
preparing GeoCalc data document 

5.83 
printing merge document 5.86 to 5.87 
setting up merge document 5.84 

Main Applications, Express menu 1.14 
Make Backup 3.9 
Make Directory comman D.6 
Manage Styles 5.43, 5.44 
Map Export Fields 5.84 
Map Export Fields button 6.67 
Map Import Fields button 6.69 
mapping fields 7.25 
margin 5.4, 5.11, 5.34, 5.53 
Mark All, GeoFile 7.19 
Mark by Formula 7.18 
Mark by Formula search 7.20 
Mark Options, GeoFile 7.20 
Mark Record search 7.20 
Mark Records 7 .17 
marker 6.57 
Marker Shape 6.57 
Markers Only chart variation 6.45, 6.47 
marking records 7.13 
marks, database records 7.15 
master page 5.54 to 5.59 

applying to a section 5.58 to 5.59 
column 5.57, 5.80 
defined 5.55 
editing 5.55, 5.56 to 5.57 
graphics in 5.56 
header and footer 5.57 
text region 5.57 to 5.58 

MATCH command 4.80 
Math symbols keyboard 1.6 
mathematical functions B.6 
MAX function B.23 
Maximize-Restore button 1.10 
MD D.6 
measurement units 3.29 
memory 

active 
see active memory 

buttons, Calculator 4.5 
Preference options 4.49 



register 
see register memory 

Memory box 4.9 
menu 1.11 to 1.14 

bar 1.10, 1.11 
font size in 4.49 

merge document 5.81 
merge field 5.81 
merge options 5.86 
Message 4.69 
MID function B.24 
MIN function B.24 
Minimize button 1.10 
Minimize GeoManager on Run option 

9.24 
MINUTE function B.24 
MKDIR D.6 
mnemonics 1.5 
MOD function B.25 
modem 4.56 

call waiting 4.72 
configuration 4.59 
configuring 4.61 to 4.63 
Connect Preference options 4.42 
line connection quality 4.67 
Preference options 4.38 
protocol settings options 4.58 

modem port 4.58 
MON1H function B.25 
Month view 2.18, 2.21 
mouse 

changing Preference options 4.37 
forced copy 1.29 
forced move 1.29 
installing 4.52 
moving and copying 1.29 
Preference options 4.50 

Move Entry 2.13 
move handle 6.51, 8.5, 8.9 
move pointer 9.12 
move-blocked pointer 9.12 
moving 

address book entries 2.13 
cancelling the move 9.13 
field 7.53 
files 9.8, 9.12 
folder 9.12 
folders C.9 
graphic frame 5.61 

insertion point 5.5 
multiple objects 8.10 
notebook pages in table of contents 

2.39 
objects 5.63, 8.9 

Multi-Duplicate 8.12 
Multi-Record button 7.29, 7.30 
multi-record mode 7.32 to 7.34, 7.61 
multiplication operator 6.18 

N 
N function B.25 
NA function B.25 
Name style option 8.59 
naming 

documents 1. 23 
file 1.23 
files D.2 
scrapbook pages 4.32 

naming field, database 7.39 
new document 1.22 
New Event 2.25 
New Page At End 2.36 
New Page Here 2.36 
New Record button 7.7 
New/Open dialog box 1.22 

buttons 1.22 
Next Page 5.7 
Next Page button 5.7, 5.10 
No Idea (Auto-Detect) option 5.46 
non-printing characters 5.72 
non-printing object 8.64 
Normal style 5.39, 5.44 
note 

database field 7.42 
notebook 

adding new page 2.36 
grouping pages 2.37 
table of contents 2.38 
titling a page 2.36 

notes 
database layout 7.58 
document 3.11 
spreadsheet 6.32 to 6.33 

Notes, GeoCalc 6.33 
NOW function B.26 
NPV function B.26 
nudging 8.10 
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objects 8.72 
Num Lock key 6.8 
Number 5.75 
number 

entering in GeoWrite documents 5.6 
format 6.63 
in database fields 7.40 
Preference options 4.46 

Number Format 6.14 
number format 

database fields 7.46 
Number Format, GeoCalc 6.63 
number formats, table of 6.12 
Number only button 6.5 
numbered list 5.12 
numbering 

documents 5.74 
options for GeoWrite 5.75 
page 5.36 

numeric keypad 5.6, 6.8 

0 
object 

INDEX 

adding 8.5 
aligning 8.26 
aligning to grid and guidelines 8.33 
aligning, relative 8.26 
anchor points in polylines 8.49 
annotating 8.65 to 8.66 
annotation 8.64 
arc 8.46 
arc attributes 8. 75 
area attributes 8.18 
background color 8.72 
bitmap 8.35 
breaking out pasted objects 8.72 
bring to front 8.17 
chart as 6.50 
container objects 8. 70 
control point attributes 8.55 
converting to a bitmap 8.44 
copying between database layouts 

7.61 
creating basic 8.4 to 8.6 
curved polyline 8.47 
default attributes 8.76 
deleting 8.12 
deleting anchor points 8.50 

described 8.3 
deselecting 8.8 
distributing 8.27 
distributing equally 8.26 
draw modes 8.20 
duplicating 8.12, 8.68 
extended attributes 8.65 
fill with a pattern 8.23 
filling with color 8.22 
flipping 8.14 
gouping 8.12 
gradient fill 8.73, 8.74 
hide unselected 8.67 
inserting anchor points 8.50 
interior objects 8.70 
line attributes 8.20 to 8.22, 8.23 
locking 8.65 
move handle 8.5 
moving 8.9 
moving multiple 8.10 
non-printing 8.64 
nudging 8.10, 8.72 
overlapping 8.20 
pasted, breaking out 8.72 
pasting an object inside 8.70 to 8.72 
pasting in documents 5.62 
polygon 8.6 
polyline 8.46, 8.47 to 8.56, 8.48, 8.49, 

8.50 
see also polyline 

printing an annotated object 8.66 
pulling forward 8.18 
pushing back 8.18 
removing 5.63 
removing gradient fill 8.75 
resize handle 8.5 
resizing 5.63, 8.11 
resizing line objects 8.11 
reversing Paste Inside 8.72 
rotating 8.13, 8.16 
rounded polyline 8.48 
scaling 8.15 to 8.16 
selecting 8.8 
send to back 8.17 
shading area 8.22 
shapes list 8.5 
show hidden objects 8.67 
show/hide 8.67 
snapping to grid or guideline 8.33 



stacking order 8.17 
stars 8.7 
storing attributes temporarily 8.64 
straight polyline 8.47 
tangent line 8.52 
text attributes 8.23 to 8.24 
transforming 8.14 
ungrouping 8.13 
zooming 8.45 

OK button 1.18 
on-line help 1.19 
One Color with Category Titles chart 

variation 6.47 
opening 

application 1.21 
document 1.22 

operator 
Calculator 4.6 
in formula 6.14 
in spreadsheet (table) 6.17 

Options menu 1.11 
OR function B.27 
OR functions 6.41 
orientation 1.39 
orphan 5.25 
Other, Express menu 1.14 
overlapping an object 8.20 
overstrike mode 1.30 

Preference options 4.49 

p 
page break 5.25, 5.73, 5.77 

symbol 5.72 
Page display mode 5.68, 5.69 
PAGE function 6.30, B.27 
Page Layouts 5.65 
Page Number button 5.35, 5.56 
page numbering 5.36, 5.53, 5.74 

spreadsheet 6.30 
Page Send/Recieve Preference options 

4.43 
Page Setup 3.7, 5.53, 5.54, 5.79, 6.27 

GeoCalc 6.60 
page setup 

column 5.78 
spreadsheet 6.60 

Page Size 1.41, 3.7, 5.53 
GeoFile 7.65 

PAGES function B.28 
pagination 5.76 to 5.77 
paging area 1.16 
paging, Scrapbook 4.34 
Palm applications 2.2 

Powerlnk 2.3 
printing 2.8 

PalmAddress 
see also address book 
see also event 
see also To Do items 
new documents 2.16 
printing 2.8 
switching to another document 2.17 
views 2.10 

PalmNotes 
see also notebook 
creating a new document 2.39 
organizing into topics 2.36 
printing 2.8 
switching to another document 2.39 
views 2.35 

PalmSchedule 
see also datebook 
see also event 
creating new documents 2.34 
customizing preferences 2.33 
preferences 2.32 
printing 2.8 
purging items 2.34 
switching to another document 2.34 
views 2.18 

paper layout 1.41 
paper options, printing 4.42 
Paragraph Attributes 5.25 
Paragraph Color 5.30 
paragraph formatting 

aligning text 5.14 
attribute 5.39 
attributes 5.25 
border color 5.27 
borders 5.25 to 5.28 
bullet 5.11 to 5.13 
color 5.29 
column break 5.24 
first line indent 5.21 
hanging indent 5.22 
hyphenation 5.28 
importing and exporting 5.45 
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indentation 5.11 
indenting 5.11 to 5.13 
justifying 5 .14 
line break 5.24 
line spacing 5.15, 5.20 
numbered list 5.12 
spacing between paragraphs 5.21 
tab stop 5.11, 5.13 to 5.14, 5.22 

paragraph mark symbol 5.72 
Paragraph Spacing 5.21 
parallel port 4.54 
parent folder 9.6, 9.10 
parity 4.59 
parity bit 4.67 
Password options 4.52 
Paste at End, Scrapbook 4.31 
Paste button 5.63 
Paste Inside 8.72 
Paste Inside button 8.25 
pasting 

Ink items 2.6 
object inside object 8.70 to 8.72 

Path drop-down list button 1.26 
path name 9.6, D.6 
pattern 

graphic frame 5.62 
PAUSE command 4.81 
PC 

opening a connection with the unit 
C.6 

setup C.5 
PCMCIA card C.7 
pen 

basic actions 1.2 
Calculator 4.7 
digitizer Preference options 4.53 
gestures 1.6 
Powerlnk 2.2 
selecting icon 9.7 
selecting text 5.8 
text area 5.4 
uses for 1.2 

percentage operator 6.18 
pi (mathematical constant) 4.19 
PI function B.28 
pie chart 6.47 
Pie tool button 6.50 
pinning menus 1.13 
pixel 8.10, 8.35 

INDEX 

changing individually 8.43 
erasing 8.42 
selecting all 8.42 

Pixel View bitmap tool 8.36 
Pixel View tool 8.43 
place holders 2.12, 3.13 
placeholder argument 6.19, 6.22 
PMT function B.28 
point 

Text File Editor 4.26 
text measurement 1.31 

Point tool button 6.50 
Pointer tool 5.57, 8.3 
pointers, types 9.12 
polygon, creating 8.6 
Polygons 8.6 
polyline 8.46, 8.47 to 8.56 

anchor points 8.49 
changing points 8.49 
changing shape 8.49 
closed 8.47 
closing 8.50, 8.53 
control point 8.55 
comer point 8.55 
creating 8.48 
curved point 8.55 
deleting anchor points 8.54 
inserting anchor points 8.53 
open 8.47 
opening 8.50 
reshaping segment 8.54 
using Spline tool 8.52 

Polyline tool 8.46 
PORT command 4.81 
portrait page layout 1.39 
ports, Preference options 4.54 
PostScript file, printing to 1.42 
power management 

Preference options 4.54 
Powerlnk 1.3, 2.3 

cutting, copying and pasting items 2.6 
magnifying areas 2.6 
pen 2.2 

Preference options 4.35, 4.36 
Preferences button C.4 
Previous Page 5.7 
Previous Page button 5.7, 5.10 
Print 3.7 
print border 8.9 



Print button 5.10 
Print Cell Notes 6.33 
PRINT command 4.81 
Print dialog box 1.34 
print functions B.6 
print queue 1.43 
printer 

deleting 4.40 
editing an existing 4.40 
installing a new printer 4.40 
paper options 4.42 
port options 4.41 
Preference options 4.39, 4.40 
serial port options 4.41 
testing 4.40 

Printer Control Panel, Express menu 1.14 
Printer Options 1.34 
printing 

annotated objects 8.66 
canceling 1.43 
canceling from queue 1.44 
changing printers 1.37 
checking print job 1.43 
color printer tips 1.44 
customized settings 1.35 
grid lines 6.27 
landscape 1.39 
mail merge document 5.86 to 5.87 
moving print job within the queue 

1.43 
notes, spreadsheets 6.33 
options, GeoCalc 6.60 
page size 1.41 
Palm applications 2.8 
PalmAddress 2.8 
PalmNotes 2.8 
PalmSchedule 2.8 
paper options 1.38 
portrait 1.39 
Postscript file 1.42 
printer options 1.37 
Printer Preference options 4.40 
printer setup 1.34 
removing a job from the print queue 

1.44 
sideways, GeoCalc 6.60 
spreadsheet 6.59, 6.60 
standard settings 1.34 
Text File Editor documents 4.27 

to a file 1.42 
PRODUCT function B.28 
PROMPT command 4.80 
PROPER function B.29 
Properties menu 1.11 
Protocol Options dialog box 4.58 
protocol settings 4.58 

changing default 4.59 
XMODEM 4.69 

prototype 5.55 
Pull Forward, objects 8.18 
PULSE command 4.82 
purging PalmSchedule items 2.34 
Push Back button 8.25 
Push Back, objects 8.18 
Push Forward button 8.25 
PY function B.29 

a 
Quick Dial 4.64, 4.77 
quick format 9.22 
quick sort 6.62 
quotation marks 

in spreadsheet 6.10 
Preference option 4.47 
smart 4.37 
typographer's 4.37 

R 
radial gradient 8.74 
radio button 1.17 
ragged right 5.14 
RAM disk 4.49 
RAM drive 9.5 
RANDOM function B.29 
RANDOMN function B.29 
range 

address 6.6 
defined 6.6 
entering data 6.9 
incremental value 6.25 
selecting 6.6, 6.7 

RATE function B.30 
RCL 4.11 
RD D7 
Read-Only attribute 9.16, 9.17 
read-only document 3.11 
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Real Number field type 7.40 
Reapply Master Page 5.59 
recalculation 6.37 to 6.38 
Recall Style 5.41 
Recall Style button 5.40 
receiving information 4.72 to 4.77 

copying text to clipboard 4.73 
XMODEM 4.76 

record 7.2, 7.7 
adding 7.7 
changing text 7.8 
deleting 7.8 
editing 7.8 
layout order 7.66 
mark options 7.19, 7.20 
marking 7.13, 7.15, 7.20, 7.16 
marking all 7.19 
marking by formula options 7 .18 
marking options 7.17 
marking with formulas 7.17 
searching for 7.9 
show all 7.15 
showing marked 7.15 
sorting 7 .10 
switching between marked and 

unmarked 7.19 
unmarking 7.19 

Record Control Panel 7.6, 7.16 
Rectangle tool 8.3 
rectangular gradient 8. 7 4 
Redefine Style 5.43 
redo 1.30 
reference 

absolute 6.16 
in formula 6.14 
in spreadsheet 6.16 
relative 6.16 

register memory 4.8, 4.9, 4.11 
changing register name 4.12 
copying numbers from readout bar 

4.11 
functions 4.10 
recalling numbers 4.12 
typing numbers 4.12 
using Memory box 4.11 

regular notation 4.16 
relative reference 6.16, 6.22, 6.23, 6.35 
Remove Directory command D.7 
REN D.9 

INDEX 

RENAME D.9 
Rename command D.9 
Rename Layout 7.59 
Rename Section 5.51 
renaming 

files 9.11 
floppy disks 9.22 
folders 9.11 

renaming document 3.11 
REPEAT function B.30 
repeating event 2.27, 2.28 
REPLACE function B.30 
replace options 5.32 
replacing text 1.27 
Rescan Drives 9.22 
rescanning 9.22 
Reset button 1.18 
Reset Counters, GeoComm 4.67 
Reset Empty Document 3.13 
resize handle 8.5 
resizing 

chart 6.52 
field 7.53 
graphic frame 5.61 
line objects 8.11 
object 5.63, 8.11 

Restore button 6.5 
Restore from Backup 3.9 
restoring document 3.8, 3.9 
retrieving document 1.25 
returning to GEOS from DOS 9.29, D.3 
Revert to Base Style 5.45, 8.63 
RlGHT function B.31 
right indent marker 5.4, 5.11 
Ring Alarm Before Event 2.27 
RMDIR D.7 
ROM drive 9.5 
root folder 9.5, 9.6 
Rotate tool 8.3, 8.14 
rotating objects 8.13, 8.14, 8.16 
ROUND function B.31 
Rounded Polyline tool 8.46 
Rounded Rectangle tool 8.3 
row 

adjusting cell height 6.29 
deleting, spreadsheet 6.25 
headers 6.4 
inserting, spreadsheet 6.25 
selecting, spreadsheet 6.7 



Row Height, GeoCalc 6.29 
ROWS function B.31 
RPN (Reverse Polish Notation) 4.4, 4.14 

mode, buttons 4.14 
ruler 3.29 

GeoWrite 5.4, 5.11 
spreadsheet 6.64 

running a script 
see script 

s 
safeguarding 3.29 

documents 4.27 
Save 3.6 
Save As 3.6, 3.10 

described 3.7 
Save as Template 3.11 
Save Buffer 4.74 
saving 

configurations 3.30 
document as template 3.11 
documents 1.24 
files D.3 
SaveAs 3.7 
screen text to a file 4.73 
scroll-back buffer text to a file 4.73 
text in GeoComm 4.74 
time between saves 4.49 

scaling objects 8.14, 8.15 to 8.16 
scatter plot 6.46 
scheduling events 2.25 
scientific extension 

buttons and keyboard equivalents 4.19 
options 4.17 

scientific notation 4.16 
spreadsheet 6.10 

scrap 4.29 
adding 4.31 
copying 4.30 
copying to other applications 4.31 

Scrapbook 4.31 
see also scrap 
copying scrap to other applications 

4.31 
creating new document 4.33 
default document 4.33 
default scrapbook 4.30 
deleting pages 4.32 

importing images from DOS 
applications 4.32 

naming pages 4.32 
paging through 4.34 
starting 4.30 
user levels 4.29 
window 4.30 

screen redraw 3.20 
screen text 

saving to a file 4.74 
script 4.63, 4.65 to 4.66, 4.77 to 4.82 

commands 4.78 to 4.82 
creating 4.65 
described 4.65, 4.77 
labels in 4.78 
running 4.66 
samples 4.65 
stopping 4.66 
syntax guidelines 4.77 

Script Display window 4.66 
scripting language 

see script 
scroll bar 5.7 
scroll-back buffer 

saving text 4.73 
scrolling 

key combinations 5.7 
list, dialog box 1.18 
scroll arrows 1.16 
scroll bar 1.16 
spreadsheet 6.6 
text, GeoComm 4.72 

searching for a record 7.9 
SECOND function B.31 
Section 5.50 
section 

adding 5.50 
adding a page 5.55 
column 5.79 
deleting 5.51 
described 5.48 
displaying name 5.52 
master page 

see master page 
numbering 5.52, 5.74 
page setup 5.53 
planning documents 5.49 
reapplying master page 5.58 
renaming 5.51 
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selecting 5.51 
section break symbol 5.72 
Select All, GeoCalc 6.7 
selecting 

bitmap region 8.41 
canceling a selection 1.28 
cell range 6.6 
changing handle size 8.68 
field 7.53 
GeoCalc row/column 6.7 
graphic frame 5.61 
icons 9.7 
menu choices 1.12 
objects 8.8 
pixel 8.42 
section 5.51 
spreadsheet cell 6.6 to 6.7 
text 1.27, 5.7 to 5.9 
text, key combinations 5.8 
text, using pen gestures 1. 7 

Selection bitmap tool 8.36 
Send Break Signal 4.68 
SEND command 4.82 
Send to Back 8.17 
Send to Back button 8.25 
sending information 

brief messages 4.68 
clipboard text 4.68, 4.69 
DOS text files 4.68, 4.70 
messages 4.68 
using XMODEM 4.68, 4.71 to 4.72 

Serial Mouse Port option 4.52 
serial port 4.54 

options 4.41 
Series Name chart variation 6.46 
Set Default Attributes 8.77 
Set Empty Document 3.12 
Set Field Notes 7.42 
Set Field Tab Order 7.55 
Set Footer 6.30 
Set Header 6.30 
Set Record Order 7.67 
Set Starting Section # 5.53 
setup 

PC and the unit C.5 
printer 4.39 

shapes list 8.5 
short date format 4.47 
Shortest Prefix option, hyphenation 5.28 

IN.24 INDEX 

Shortest Suffix option, hyphenation 5.28 
Show Advanced Disk Options 9.21, 9.24 
Show All To Do's 2.32 
Show All, GeoFile 7.15 
Show Empty Fields 2.15 
Show Formulas 6.35 
Show Grid 8.30 
Show Hidden Objects 8.67 
Show Llne Status 4.67 
Show Notes 6.33 
Show Only Marked 7.15, 7.23 
show/hide formula 6.34 
Sides to Border option 5.26 
Simple button 1.26 
SIN function B.32 
sine 4.19 
Single-Record button 7.29, 7.30 
single-record mode 7.61 
SINH function B.32 
Six-month view 2.18, 2.20 
Sketch page 2.3, 2.19 

see also Powerlnk 
copying pages 2.7 
cutting pages 2.7 
PalmSchedule 2.19 
tools 2.4 
using 2.4 
zooming 2.7 

Sketch tab 2.23 
sketch tools 2.4 

see also Powerlnk 
list of 2.5 

skewing objects 8.14 
slider 1.16 
SLN function B.32 
smart quotes 4.24, 4.37 
Smart Select button 6.4, 6.7 
snapping objects 8.33 
soft page break 5.76 
Sort 

GeoFile 7.10 
sort 

options, spreadsheet 6.62 
quick sort 6.62 

Sort Backward tool 6.59, 6.62 
Sort Forward tool 6.59, 6.62 
sort key 7.20 
Sort, GeoCalc 6.62 
sorting 



cells 6.61 
database records 7.10 to 7.11 
database, advanced 7.21 

'SDJJ.r= di'51:'. 9 .2.Q 

space symbol 5.72 
special characters 1.30 

current date and time 5.74 
inserting 5.73 
inserting number (counter) 5.74 to 

5.75 
inserting special dates and times 5.75 
invisible (table) 5.72 
Section Number 5.52 
Text File Editor 4.24 

Special Date 5.76 
Special Time 5.76 
spell checking 5.36 to 5.38 

options 5.37 
Preference options 4.37 
Text File Editor 4.26 

Spline tool 8.46, 8.51 
spreadsheet 

see also function 
see also row 
absolute reference 6.35 
apostrophe 6.10 
attaching notes 6.33 
automatic recalculation 6.37 to 6.38 
cell 6.4 
cell address 6.5 
cell naming 6.36 
changing value format 6.14 
charting 

see chart 
comma 6.10 
copying 6.36 
copying data to another GEOS 

application 6.65 
date format 6.63 
described 6.2 
entering data in a selected range 6.9 
entering dates 6.11 
entering labels and values 6.8, 6.10 
exporting data to DOS 6.66 
floating point math 6.14 
formatting cell information 6.12 
formulas 6.8, 6.14 to 6.22 
graphics 6.64 
grid, defined 6.4 

importing from DOS 6.68 
label 6.8 
logical function 6.40 to 6.41 
mnvi.ng =ll cont.1~x:iJs 6 .22. 
notes 6.32 to 6.33 
number format 6.63 
page numbering 6.30 
print options 6.60 to 6.61 
printing 6.33, 6.59 to 6.61 
quotation marks 6.10 
range naming 6.36 
relative reference 6.35 
row and column headers 6.4 
ruler 6.64 
scientific notation 6.10 
scrolling 6.6 
selecting 6.6 to 6.7 
show/hide grid 6.27 
sorting cells 6.61 
value 6.8 

spreadsheet formatting 
background color 6.30, 6.31 
cell border color 6.30, 6.32 
column width 6.29 
header and footer 6.29 to 6.30 
row height 6.29 
text color 6.30 

SQRT function B.33 
Stacked Percentage chart variation 6.46 
stacking objects 8.17 
standard file selector 1.24 
Standard mode, Calculator 4.4 
star 

creating 8.7 
Stars 8.7 
statistical functions B.6 
STD function B.33 
STDP function B.33 
stop bits 4.59 
Stop button 1.18 
Store Style 5.40 
Store Style button 5.40 
storing 

active memory numbers 4.10 
documents 1.25 

straight polyline object 8.47 
STRING function B.33 
string functions B.7 
Strip Linefeeds 4.70 
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style 
attribute 5.42, 5.43, 8.60, 8.61 
contents, table of 5.87 
defined 5.39 
defining new 5.41 

Style bar 
GeoCalc 6.58 
GeoWrite 5.9 

style sheet 
applying a style 5.40 
changing existing 5.43 
changing format 5.42 
default style 5.39 
defining new 5.41 to 5.42 
deleting 5.44 
Footer style, GeoWrite 5.39 
from other documents 5.45 
Header style 5.39 
Normal style 5.39 
reverting to base 5.44 

Style tool bar 3.22, A.2 
subtraction operator 6.18 
SUM function B.34 
Switch All Marks 7.19 
Switch Document 3.6, 5.18 
Switch Layout 7.12, 7.58 
Switch To button 7.12 
SYD function B.34 
Symbols keyboard 1.5 
syntax error, GeoFile 7.18 
System attribute 9.16, 9.17 
system clock 2.44 
system requirements C.2 

T 
tab order 

GeoFile 7.54 
tab stop 5.4, 5.11, 5.13 to 5.14, 5.22, 5.34 
tab symbol 5.72 
table of contents, notebook 2.36 

moving a page 2.39 
show/hide grouped pages 2.38 

Tabs 5.23 
TAN function B.34 
tangent 4.19 
tangent line 8.52 
TANH function B.34 
tapping 1.2 
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selecting text 1.27, 5.8 
template 

changing 3.15 
creating new 3.14 
defined 5.48 
deleting 3.17 
described 3.13, 5.17 
GeoFile 7.36 
new template from existing 3.16 
predefined 5 .17 

Template attribute 9.16, 9.17 
Template button 5.18 
template, GeoFile 7.5 to 7.6 

defined 7.5 
naming 7.5 
opening 7.5 

Templates folder 3.13 
TERM command 4.82 
TERM function B.35 
terminal 

defined 4.60 
emulation types 4.60 
settings 4.60 to 4.61 

text 
see also text formatting 
attributes "5.39, 8.23 to 8.24 
attributes in a database 7.52 
attributes, recalling temporarily stored 

5.40 
attributes, storing temporarily 5.40 
axis title 6.55 
background color 5.29 
changing size in Text File Editor 4.26 
character attributes, described 5.10 
character formatting, importing and 

exporting 5.45 
character spacing 5.20 
character width 5.20 
chart title 6.55 
color 5.29 
coloring 8.24 
copying 1.28 
copying, with a mouse 1.29 
cutting 1.28 
deleting 1.29 
deleting, with pen gestures 1.7 
dragging 5.8 
editing 5.10 
finding and replacing 5.30 to 5.33 



foreign characters 1.30 
formatting 5.19 to 5.20 
formatting, GeoFile 7.56 
handwriting recognition tips 1.3 
insert mode 1.30 
inserting 5.6 
inserting, with pen gestures 1. 7 
insertion point 1.27, 5.5 
moving, with a mouse 1.29 
numbers, entering 5.6 
overstrike mode 1.30 
pasting 1.28 
Preference options 4.37 
properties, in chart 6.52 
redo 1.30 
replacing 1.27, 1.28 
saving GeoComm text 4.74 
saving, with XMODEM 4.75 
selecting 1.27, 5.7 to 5.9 
selecting, key combinations 5.8 
selecting, with pen gestures 1.7 
shading 8.24 
size 5.19 
size variations when printing in Text 

File Editor 4.27 
special characters 1.30 
spell checking 5.37 
style sheet 

see style sheet 
tapping 1.27, 5.8 
undo 1.29 
word wrap 5.5 
word wrap options 5.63 

Text alignment buttons 5.10 
text area 5.4 
Text Background 5.30, 6.31 
Text Color 5.30, 6.31 
text entry box 1.18 
Text File Editor 

changing text size 4.26 
checking spelling 4.26 
creating scripts 4.65 
DOS text files 4.27 
finding and replacing text 4.26 
printing 4.27 
printing to a DOS text file 4.27 
safeguarding documents 4.27 
special characters 4.24 
starting 4.24 

1XT extension 4.28 
window 4.24 

text formatting 1.30 to 1.34 
alignment 1.33 
character attributes 5.20 
color 5.28 to 5.34 
font 1.30 
justification 1.33 
size 1.31, 5.19 
style 1.32 

text object 
see also object 
described 8.34 

text region 5.57 to 5.58 
copying 5.58 
deleting 5.58 
deselecting 5.57 
moving 5.58 
resizing 5.58 

text string 
database 7.9 

text string arguments B.2 
Text style buttons 5.10 
text style sheet, defined 5.39 
Text tool 

graphics 8.3 
text wrapping 5.63 
Tile view C.9 
time 

changing system clock 2.44 
format 4.48 
incremental range 6.25 
inserting current time in documents 

5.75 
Preference options 4.43 

Time field type 7.40 
time format 

database fields 7.46 
time formats, table of 6.13 
TIME function B.35 
time functions B.8 
time usage bars 2.22 
time zone 2.41 

checking 2.43 
daylight savings time 2.43 

TIMEV ALUE function B.35 
title bar 1.10, 1.16 
title in charts 6.54 
title page 5.35 to 5.36, 5.50 

INDEX IN.27 



IN.28 

deleting 5.36 
Titles & Legends 6.54 
To Do item 2.30, 2.32 

describing items 2.31 
To Do page 2.19, 2.20, 2.30 

see also To Do item 
To Do tab 2.23 
TOC 5.87 
TODAY function B.35 
TONE command 4.82 
Tool area, GeoManager 9.3 
Tool bar 7.28 
tool bar A.1 

customizing 3.25 
described 3.21 
displaying 3.24 
moving groups 3.26 
show/hide tool groups 3.25 
using 3.21 

touch pen 
see pen 

transferring 
files with GeoHost C.5, C.7 
folders with GeoHost C.7 

transforming an object 8.14 
Tree window 9.18 
trigonometric calculations 4.17 
trigonometric functions B.3, B.8 
TRIM function B.36 
TRUE function B.36 
TRUNC function B.36 
TXT extension 4.28 
TYPE command D.9 

u 
un-pinning menus 1.13 
undo 1.29 
Ungroup button 8.25 
ungrouping objects 8.13 
unit 

connecting to PC C.5 
Unmark All 7.19 
updating drive 9.22 
UPPER function B.36 
User City Name entry box 2.43 
user dictionary 5.38 

Preference options 4.38 
user levels 3.2 to 3.5 

INDEX 

fine tuning 3.4 
GeoCalc 6.3 
GeoFile 7.4 
GeoWrite 5.3 
Scrapbook 4.29 
verifying 3.3 

v 
value 

defined 6.8 
entering 6.10 
entering in spreadsheet 6.8 
in formula 6.14 
incremental range 6.25 

VALUE function B.36 
value selector 1.18 
VAR function B.37 
VARP function B.37 
vertical gradient 8.74 
video adapter C.11 
video display mode 4.45 
View at% option 3.19 
View menu 1.11 
viewing 

at% option 3.19 
changing options 3.20 
file information 9.14 
files 9.9 
folder information 9.14 
folder sorting attributes 9.9 
folders 9.9 
font 1.31 
GeoWrite documents 5.67 
multiple folders C.8 
PalmAddress 2.11 
PalmNotes 2.35 
PalmSchedule 2.18 
redrawing screen 3.20 
saving settings 3.18 
scaling 3.19 
scrapbook pages 4.34 
wastebasket contents C.10 
zooming 3.18 

visual attribute 5.42, 8.60 
VLOOKUP function B.37 
VM File type 9.16 



w 
Warn on Emptying Wastebasket option 

C.12 
Warn on Overwrite option 9.24 
Warnings on Delete/Throw Away option 

9.23 
wastebasket 9.4, C.10 

deleting items permanently C.10 
emptying C.10 
viewing contents C.10 
warning 1.10, 9.13 
warnings and options C.12 

Wastebasket button C.4 
Week view 2.18, 2.22 
WEEKDAY function B.38 
widow 5.25 
wild card 5.32, 7.9, D.8 
window 

full-sized C.8 
GeoCalc 6.4 
GeoComm settings 4.63 
GeoHost C.3 
GeoManager 1.10 
GeoWrite 5.4 
maximizing 1.14 
minimizing 1.15 
moving 1.15 
Pixel View 8.43 
Preferences 4.36 
resizing 1.15 
scaling 3.19 
Script Display 4.66 
scrolling in 1.16 
Text File Editor 4.24 
tree 9.18 
View at% 3.19 
zooming 3.18 

Window Control button 1.10, 1.16 
Window Control menu 1.16 
With Percentages chart variation 6.47 
word wrap 4.25, 5.5, 5.25, 8.35 
work modes, GeoFile 7.27 to 7.34 
World Clock 

adding own home town 2.42 
checking time zone 2.43 
selecting home or destination country 

2.42 
WORLD folder 1.11, 1.21, 9.5, 9.10 

Wrap lines at Edge terminal setting 4.61 
Wrap Type 5.63 
wrapping text 5.63 
Writing grid keyboard 1.6 

arrow controls 1.6 

x 
x-y plot chart 6.46 
XMODEM 4.68, 4.69, 4.71 to 4.72 

receiving information 4.76 
saving text 4.75 

XON/XOFF 4.59 

v 
YEAR function B.38 

z 
Zoom tool 8.45 
zooming 2.7, 3.18, 5.5, 7.66, 8.45 
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